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N T R o D u c T o N 

Welcome to Sprint-Borland's fast and flexible word processor. Whether 
you're a beginner or a seasoned computer user, we think you'll find that 
Sprint meets all your word processing needs-from simple text editing to 
complex desktop publishing applications. In fact, this manual was created 
with Sprint's formatting commands and a PostScript typesetter! 

Sprint is full of the bells and whistles that Borland customers have grown 
accustomed to-unique features that other word processors don't come 
dose to: 

• Sprint automatically saves your text as you type, so you never lose a file, 
even if the power goes down. 

• You can have up to 24 files open at one time. 
• You can use alternative user interfaces. 
• Sprint drives over 200 printers and typesetters, including PostScript laser 

printers and phototypesetters. 

• You can check your spelling as you type and get synonyms for words 
with a few keystrokes. 

Besides Borland's standard user interface, which behaves a lot like 
Borland's SideKick and Turbo Pascal/Basic/C editors, you can also choose 
interfaces that work like Microsoft Word, WordPerfect, and WordStar. So if 
you know Borland's other editors, or any of the other three, you already 
know a lot about using Sprint. 

Here's a closer look at a few of Sprint's many features: 

• Easy-to-use menus. Sprint's extensive pop-up menu structure consists of 
clear instructions that even the most inexperienced word processor can 
understand . 

• Automatic "incremental" saving. Sprint creates a continuous backup file 
as you work. If there's a power failure, you won't lose much, if any, of 
your work, even if you haven't saved your file recently. 
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• Powerful formatting capabilities. Sprint is capable of formatting 
everything from a business letter to a highly complex technical manual 
(like this one!). 

• Multiple files and windows. You can work with up to 24 files at the same 
time. You can also open up to six windows at once, to work with 
different parts of the same file or more than one file at the same time. You 
can easily move text back and forth between open files and windows . 

• Macro language. If you're a power user, you can use Sprint's macro 
language to create your own commands, modify existing ones, change 
the menu structure, and more . 

• File import/export. You can transfer ASCII, MultiMate, Microsoft Word, 
WordStar, DisplayWrite 4, Wang, and WordPerfect files to and from 
Sprint. 

• Form letter/mailing list generation. SprintMerge lets you create and vary 
customized form letters, as weB as mailing lists and labels. 

• Extensive printer support. Sprint comes with drivers for over 200 
printers, including laser printers and phototypesetters that understand 
PostScript. 

How to Use the Manuals 

Your Sprint documentation consists of several books: the User's Guide (this 
book), a Reference Guide, and the Advanced User's Guide. Also available is a 
booklet on Alternative User Interfaces. 

• The User's Guide tells you how to install Sprint on your computer system, 
and provides a basic tutorial and other information to get you going right 
away. It also contains an overview of Sprint, chapters on basic editing 
and formatting techniques, as well as information about customizing 
Sprint, SprintMerge, and other Sprint utilities. 

• The Reference Guide is a concise, comprehensive, alphabetical listing of 
Sprint commands and concepts. 

• The Advanced User's Guide contains information about Sprint's advanced 
text formatting capabilities, as well as a tutorial and complete reference 
to programming with Sprint. 

Beginners should thoroughly read the first few chapters in the User's Guide: 
"Before You Begin" and "Notes for -the- Beginning Word Processor," then 
work through. the Quick Start tutorial to get hands-on practice with the 
editor. From there, you can explore the rest of the User's Guide and refer to 
the Reference Guide for alphabetically listed information as needed. 
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If you're an experienced computer user or familiar with one of Borland's 
other ASCII text editors (SideKick, Turbo Pascal/Basic/C, or Eureka), read 
the "Before You Begin" and "Notes for the Experienced User" chapters, 
browse through the "Quick Start Tutorial", and then take a look at the 
Quick Reference card; that may be all you'll need to get going. You can then 
refer to the Reference Guide for more details about specific commands and 
concepts. There are a few differences in the way Sprint works compared to, 
say, SideKick-for instance, blocks are handled differently. Also, Sprint is 
far more sophisticated than a simple text editor, so once you get your feet 
wet you may want to refer to the "how-to" information in the User's Guide 
and Advanced User's Guide. 

If you want to use one of the alternative user interfaces-Microsoft Word, 
WordStar, or WordPerfect-be sure to read the Alternative User Interfaces 
booklet. 

Inside This Manual 

Following is a complete listing of the contents of this manual. See the other 
Sprint manuals for information about their respective contents. 

Part 1, "Getting Started," contains the following chapters: 

Chapter 1, "Before You Begin," describes how to get Sprint up and running 
on floppy-disk and hard-disk systems, how to install it for your printer, and 
how to choose different user interfaces. 

Chapter 2, 'Notes for the Beginning Word Processor," is designed for the 
novice word processor. If Sprint is your first excursion away from your 
typewriter, this chapter is for you. 

Chapter 3, "Notes for the Experienced User," is for the experienced 
computer user. If you've used one of Borland's other text editors or another 
word processor, or if you're a programmer or otherwise familiar with 
computing, refer to this chapter for tips on how to get started quickly with 
Sprint. 

Chapter 4, "Quick Start Tutorial," is a tutorial that should get you going 
with Sprint in less than an hour. You'll use basic editing techniques to 
create and print a business letter and proposal. 

Part 2, "Editing and Formatting," contains the following chapters: 

Chapter 5, "Sprint Overview," takes an overall look at many of Sprint's 
features. This chapter introduces you to the editor and formatter, the menu 
system, multiple files and windows, and printing. 
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Chapter 6, "Editing: Tips, Tricks, and Techniques," is a compendium of 
how-to information about the Sprint editor. It discusses file and block 
operations, the ruler line, searches, menus and shortcuts, and other 
miscellaneous editing topics. 

Chapter 7, "Working with Files," shows you how to open, close, and save a 
file, as well as work with multiple files. 

Chapter 8, "Basic Formatting," details how to make use of the Sprint 
formatter. Refer to this chapter for information about formatting simpler 
documents like memos and straightforward business reports. We discuss 
the ruler line, setting margins and tabs, page headers and footers, 
hyphenation, and typestyles. 

Chapter 9, "Printing," tells you all you need to know to print your Sprint 
files. We'll tell you how to print from the command line and from the menu 
system, how to set print options, and how to resolve formatter errors. 

Chapter 10, "Customizing Sprint," tells you how to use the Customize 
menu to modify Sprint's default settings. 

Chapter 11, "Sprint Utilities," discusses the commands on Sprint's Utilities 
menu, including the spelling dictionary and thesaurus. 

Part 3, "SprintMerge," contains an introduction and the following 
chapters: 

Chapter 12, ''Your Template, Records, and Letter File," walks you through 
the basics of the program. It discusses the template file, the record file, and 
the letter file. It also explains the command-line options. 

Chapter 13, "Merging and Printing Your Files," covers the process of 
merging and printing your Sprint files, as well as running SprintMerge 
from DOS and using it with files from database programs like Reflex: The 
Analyst, Paradox, and dBASE. 

Chapter 14, II A Tutorial on Merging," walks you through creating and 
editing form letters and mailing labels. 

Chapter 15, liThe SprintMerge Reference," discusses each element of 
SprintMerge in detail and gives the technical specifications of the program. 
The elements are listed alphabetically. 

Chapter 16, "SprintMerge Troubleshooting and Error Messages," offers two 
checklists: causes of common problems and SprintMerge's error and other 
messages. 

Part 4, "Appendixes," contains the following appendixes: 

Appendix A, II A DOS Primer," contains basic information about DOS, with 
particular emphasis on creating and using directories. You should refer to 
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this appendix if you are new to computing, especially if your computer has 
a hard (fixed) disk. 

Appendix B, "Using Sprint on a Local Area Network," provides tips for 
using Sprint in a multi-user environment, such as the Novell network. 

Appendix C, "Converting Files to and from Other Word Processors," tells 
you how to take files created with another word processor and convert 
them to Sprint format-and vice versa. 

Appendix D, "Help!," provides answers to commonly asked questions 
about Sprint. Look here if you're having a problem getting Sprint to do 
what you want it to. 

Appendix E, "Working with ASCII Files," provides complete information 
on translating, editing, and printing ASCII files. 

Appendix F, "Glossary," gives definitions of key terms used in this manual 
and in Sprint. 

Typographic Conventions 

All typefaces used in this manual were produced by Sprint and output on a 
PostScript typesetter. Their uses are as follows: 

Monospace type 

Italics 

Keycap 

This typeface represents text as it appears on thescreen 
and anything you must type. 

Italics are used to introduce a new term; all new terms 
are defined in the Glossary. 

This special typeface indicates a key on your keyboard. 
It is often used when describing a particular key you 
should type; for example, "Press Esc to cancel a menu." 

Hardware and Software Requirements 

Sprint runs on the IBM PC family of computers, including the XT, AT, and 
the PS/2 series, along with true IBM compatibles. 

Sprint requires 

• a two-floppy or hard-disk system 

• DOS 2.0 or higher 
• at least 384K of RAM 
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The Sprint program is in the file called SP.EXE. It is not copy-protected, so 
you can easily transfer it to a hard disk or RAM disk. However, you should 
read Borland's No-Nonsense License Statement at the front of this manual 
for an explanation of your responsibilities with respect to copying Sprint, 
and then sign it and mail to us. 

Borland's No-Nonsense License Statement 

This software is protected by both United States Copyright Law and 
International Treaty provisions. Therefore, you must treat this software just 
like a book, with the following single exception: Borland International 
authorizes you to make archival copies of Sprint for the sole purpose of 
backing up your software and protecting your investment from loss. 

By saying, "just like a book," Borland means, for example, that this 
software may be used by any number of people and may be freely moved 
from one computer location to another, as long as there is no possibility of its 
being used simultaneously at two locations. 

How to Contact Borland 

The quickest and easiest way to contact Borland is to log on to Borland's 
Forum on CompuServe: Type GO BOR from the main CompuServe menu and 
choose "Enter Applications Products Forum" from the Borland main menu. 
Leave your questions or comments there for the support staff to process. 

If you prefer (or do not suscribe to CompuServe), write a letter detailing 
your comments and send it to: 

Technical Support Department: Sprint 
Borland International 

P. O. Box 660001 
Scotts Valley, CA 95066-0001, USA 

You can also telephone our Technical Support department at 408-438-5300. 
Please note that you must be a registered owner to receive telephone 
support; be sure to send in your license statement. Please have the 
following information handy before you call: 

• Sprint version number and serial number 
• computer make, model number, and amount of RAM 
• operating system and version number 
• the Sprint user interface you are using 
• contents of your CONFIG.SYS and AUTOEXEC.BAT files 
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c H A p. T E R 

1 

Before You Begin 

This chapter provides all the information you need to get Sprint up and 
running on your computer. Topics covered: 

• how to copy Sprint's files to your work disk(s) 
• how to install Sprint for your computer (two-floppy or hard disk), screen, 

and printer(s) 

• how to choose an alternative user interface 
• how to install Sprint utilities that will allow you to transfer files to and 

from Sprint and Microsoft Word, WordStar, WordPerfect, and MultiMate 

Note: If your computer is part of a local area network (LAN), your system 
administrator should read Appendix B, "Using Sprint on a Local Area 
Network," for instructions. 

Reading the README File 

Any last-minute changes or additions to the Sprint program are docu­
mented in a file on the Program Disk called README. You should review 
this file carefully before working with Sprint and make note of any 
changes. 

To display the README file one screenful at a time, simply insert the 
Program Disk in Drive A. On the DOS command line, type 

A: Enter 
README Enter 
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Sprint will print the file for you from the DOS command line if you type 
SPFMT README and press Enter. You can also print this file with the DOS 
PRINT command. This may not work if your printer hasn't been installed 
yet; if it doesn't, then install your printer with SP-SETUP and print the 
README file when you're finished. 

The README file contains a complete list of the files on the distribution 
disks. Follow the prompts given by the installation program (described 
shortly) to copy the files to your floppy or hard disk. If you have a two­
floppy system with no hard disk, you'll need to be certain that your 
Program A Disk is in Drive A at particular times when you use Sprint; see 
page 21 for guidelines. 

Don't worry if you don't understand what some of these files actually do; 
for the most part, you don't need to know what they do, you just need to 
make sure you've got them in the right place at the right time. 

The Installation Program 

You use the SP-SETUP program (SP-SETUP.EXE on the Setup Disk) to set 
up Sprint for your particular computer system and printer. You can also use 
it to optionally choose an alternative user interface or install file conver­
sions. 

Although the remainder of this chapter explains how to use this program, 
it's very easy to use; you'll be prompted by the program and given instruc­
tions when necessary. You use SP-SETUP before you run Sprint the first 
time, and to make changes to your setup later on. For instance, if you get a 
different printer at some point, you'll need to run SP-SETUP again to 
reinstall the printer. 

To run SP-SETUP, put the Setup Disk in Drive A, type A: SP-SETUP on the 
DOS command line, and press Enter. You'll see the welcome screen. Press 
Enter again to see the Sprint Installation main menu. 

Note: On some monitors, the screen or color combination may be hard to 
read; you can press the Tab key to change it. 

Any time you're in the SP-SETUP program, you can press Enter to continue 
the installation process. To choose an item, move the cursor to the item and 
press Enter, or press the letter key corresponding to the first letter of the 
item. For instance, to choose Printer Installation, press P, then Enter. To 
terminate the current step in the installation process at any time, press Esc; 
this will return you to the previous menu or to the Sprint Installation main 
menu. To exit the SP-SETUP program at any time, press Esc repeatedly 
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until the highlight bar is positioned on the Exit command on the Sprint 
Installation main menu, then press Enter or Esc. 

The SP-SETUP program can detect your particular hardware configuration 
(that is, whether you have a hard disk or two-floppy system, and what type 
of monitor you have). As you work through the questions in the program, 
Sprint will automatically position the highlight bar on the next question 
you should answer. 

Any menu options not currently available to you (such as installing alter­
nates when you haven't already chosen a default), will be dimmed 
onscreen. 

Depending on whether you have a hard disk or two-floppy system, the 
highlight bar will first be positioned on Hard Disk Installation or Floppy 
Disk Installation. All you need to do is press Enter to go on to the first set of 
questions. 

Note: If you don't understand some of the questions you're asked by the 
SP-SETUP program, or some of the explanations given in this chap­
ter-chances are you don't need to. In fact, in most instances, you can 
accept Sprint's default settings by simply pressing Enter when presented 
with a choice. And, if you return later to SP-SETUP to make any changes or 
additions, you can press Enter to confirm the default settings you installed 
before. 

SP-SETUP copies the Sprint files you need to your floppy or hard disk(s). 
Once you finish with SP-SETUP, put the original distribution disks in a safe 
place in case anything happens to the copies. Always use the installed 
version SP-SETUP creates for any work you do. That way, if something 
happens to them, you've always got the originals to make new copies from. 
You'll also need to use the distribution disks again if you want to set up 
Sprint for a different printer, monitor, or user interface. 

Note to users with RAM disks: If you have a RAM (virtual) disk in your 
computer, SP-SETUP may interpret it as a hard disk (usually, "Drive" D). If 
you have a two-floppy system, you'll need to manually choose Floppy Disk 
Installation, since the highlight bar will be automatically positioned on 
Hard Disk Installation. If you have a hard disk system, be sure not to select 
the RAM disk "drive" when you install Sprint. (If you don't know what a 
RAM disk is, just ignore this note.) 

Floppy Disk Installation 

Before you use SP-SETUP to install Sprint for your system, you need to 
have some blank, formatted floppy disks ready. The number you'll need 
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depends on the capacity of your disks; SP-SETUP uses as few as it can. It's a 
good idea, however, to prepare extra blank disks, since you may want to go 
back after you install your default settings and set up some alternate user 
interfaces or file conversions. For now, use the following guidelines to 
format the apppropriate number of blank, formatted disks you'll need to 
run SP-SETUP on your system (if you' prefer, you can use a batch file called 
MAKEDISK.BAT on the Setup Disk to format the disks-just insert the 
Setup Disk in Drive A and type A:MAKEDISK.BAT at the DOS prompt): 

Standard 360K Disks: Six Disks Minimum 

1. Format one blank disk by inserting it in Drive A and typing FORMAT A: /S 
at the DOS prompt. This will be your Program A Disk (label it); Sprint 
needs to have the DOS operating system and COMMAND. COM on it. 
When DOS asks Format another?, press N for No. You need to format the 
rest of the disks differently. 

2. To format the five remaining blank disks, insert each one in Drive A and 
type FORMAT A:. When DOS asks Format another?, press Y for Yes until 
you've formatted all five. 

3. Next, label one disk as Program B and copy just the COMMAND. COM 
file to it from your DOS System Disk. Put the DOS System Disk in Drive 
B, your Program B Disk in Drive A, and type 

COPY B:COMMAND.COM A: 

on the DOS command line. 

4. The other four disks are ready to go as is; just label them as shown, so 
you have the following set of disks ready when you start SP-SETUP: 

Program A (with the DOS operating system and COMMAND. COM) 
Program B (with just COMMAND.COM) 
Data 
Help 
Speller /Hyphen 
Thesaurus 

5. You may want to format two other optional blank disks: one for user 
interfaces, if you want more than one user interface, and one for 
conversion utilities, if you want to translate files from or into other 
formats. 
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720K and High-Density Disks: Three Disks Minimum 

1. Format one disk with FORMAT:A/S and label it Program A. Format the 
other two with plain FORMAT: A and label them Data and Dictionary. 

Program A (with the DOS operating system and COMMAND. COM) 
Data 
Dictionary 

2. The exact configuration of the Dictionary and Data Disks will differ 
between 720K and high-density drive systems. You may also want to 
prepare separate User Interface and Conversion disks if you'll be instal­
ling alternate user interfaces or file conversion formats. 

Now you're ready to start SP-SETUP. Insert the Setup Disk in Drive A and 
type A:SP-SETUP. If you're using a two-floppy system with no hard disk, the 
highlight bar will be positioned on Floppy Disk Installation on the Sprint 
Installation main menu. When you choose Floppy Disk Installation, you'll 
see a screen with information about the disks you just prepared. If you 
have your formatted disks ready, press Enter to begin copying the Sprint 
files from the distribution disk to your blank disks. Follow the prompts and 
insert disks when told to; SP-SETUP lets you know if you've inserted the 
wrong source disk at any time. As well as copying files from the distri­
bution disks, SP-SETUP will also create a fixed-size backup (swap) file on 
your Data Disk (the disk on which you'll be storing files you create with 
Sprint). You don't need to know what the backup file does yet, but it's 
essential for Sprint's operations. Later on, when you use Sprint, you'll need 
to keep the Data Disk with its backup file in Drive B at all times. 

As it copies your files, SP-SETUP will display the file names it's copying. Be 
sure to label each disk, if you haven't already, for ease of use later on. When 
it's finished, you'll be returned to the Sprint Installation main menu, with 
the highlight bar positioned on Printer Installation. Skip the next section 
(for hard-disk users) and go on to page 15 for further instructions on instal­
ling Sprint. Once you've run the SP-SETUP program, be sure to read 
1/ Additional Notes for Two-Floppy Systems" on page 21 for information 
about using Sprint with your computer. 

Hard Disk Installation 

If you're using a hard-disk system, SP-SETUP will automatically position 
the highlight bar on Hard Disk Installation on the Sprint Installation main 
menu. Press Enter. 

If you have only one hard disk in your system (the usual configuration), 
SP-SETUP will ask you what name you want to use for the directory that 
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will contain your Sprint files. Note: A directory is simply an area of your 
hard disk. If you're unfamiliar with DOS directories, you might want to read 
Appendix A, "A DOS Primer." By default, SP-SETUP will create a directory 
called SPRINT. If that name is acceptable, just press Enter. If you want to 
give it another name, simply type in the name and press Enter. 

If you have more than one hard disk in your system, if you have a RAM 
disk, or if you are connected to a local area network, SP-SETUP will first 
ask you which hard disk drive you want to copy the Sprint files to. In most 
systems, the main hard drive is C, and you'll probably want to specify this 
as the disk to store your Sprint files on. You can then specify the directory 
name. 

Also Note: If there's not enough room on your hard disk for the Sprint files, 
Sprint will tell you so and exit to DOS. You'll need to delete some files to 
make room for the Sprint files, then type A:SP-SETUP again on the DOS com­
mandline. 

Once you've specified the directory name, Sprint will begin copying the 
Sprint files from the distribution disks to your hard disk. Follow the 
prompts and insert the distribution disks when told to. As it copies your 
files, SP-SETUP will display the file names it's copying. It won't copy every 
file on the distribution disks, just the ones you'll need. (If your needs 
change, you can run SP-SETUP again later to copy the additional files you 
need.) 

SP-SETUP will next ask if you want it to create sample AUTOEXEC.BAT 
and CONFIG.SYS files and modify your existing ones, or simply create the 
sample files and leave your original files undisturbed. You can also choose 
Exit to avoid creating any sample files. If you choose to modify your 
AUTOEXEC.BAT file, SP-SETUP will add a path to Sprint that will allow 
you to load Sprint from anywhere on your system, not just from the direc­
tory where you store your Sprint files. We recommend that you allow 
SP-SETUP to modify your files; if you choose that option and you don't 
already have an AUTOEXEC.BAT file, SP-SETUP will create one that 
includes a path to Sprint. 

Note: If you don't understand what path and AUTOEXEC.BAT mean, you 
can refer to Appendix A," A DOS Primer," although it isn't strictly 
necessary that you understand them at this point. If you let SP-SETUP 
modify your files, just remember that you can load Sprint from anywhere 
on your system by typing SP Enter. 

You'll now be returned to the Sprint Installation main menu, with the 
highlight bar positioned on Printer Installation, which is described in the 
next section. 
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Printer Installation 

Once you've finished installing Sprint for your floppy or hard disk system, 
SP-SETUP will return to the Sprint Installation main menu and auto­
matically position the highlight bar on Printer Installation. Printer Instal­
lation allows you to choose one or more printers for use with Sprint. By 
default, Sprint is installed for a plain printer with no special capabilities. If 
you don't install your particular printer, Sprint will still work with most 
printers; however, it won't be able to take advantage of any of your 
printer's fonts or other special features. So, it's likely you'll want to tell 
Sprint which printer you're using. 

To do so, make sure the highlight bar is positioned on Printer Installation 
and press Enter. You'll see a list of supported printers from which you can 
select your printer. 

Use the arrow keys to move to the name of your printer's manufacturer, 
then press Enter to choose your printer type. Note: If your printer is not 
listed, stop reading here and skip to the next section, "If Your Printer Isn't 
Listed." 

If your printer has multiple fonts, you'll next be asked to select which font 
you want Sprint to use by default. Note that-no matter which font you 
choose-you'll still be able to use all the other fonts your printer supports; 
you're simply selecting the font Sprint will use when you don't tell it other­
wise. 

After you answer a couple of questions about the printer you'll be using, 
SP-SETUP will ask you where you want your formatted files sent. There are 
three choices: PRN, FILE, and OTHER. Normally, PRN is the correct choice, 
so you can just press Enter to accept it. If you select FILE, your formatted 
files will be printed to a file instead of sent to your printer. 

Note: If you will usually want to send your files to the printer, and only 
occasionally to a file, select PRN. When you are ready to print your file, 
Sprint allows you to specify a file as the destination even though you have 
installed it to go to the printer by default. 

You'll only need to select Other if you're using a serial printer, or if your 
printer is unable to operate directly through DOS. SP-SETUP will display a 
list of other output ports. 

Select the output port used by your printer (for a serial printer, that's 
usually COM1), then press Enter. 

Note to two-floppy system users: If you have 360K drives and you want to 
install a PostScript printer, it's best to choose any printer except a PostScript 
one as your default. Then, you can go back and install the PostScript 
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printer, inserting your Program B Disk when Sprint prompts you to insert a 
disk in Drive A. 

If Your Printer Isn't Listed 

If SP-SETUP does not list your printer, first check the reference manual that 
came with your printer; it may mention that your printer is compatible 
with some other printer type that is listed. If not, you can just press Esc and 
not select anything. By default, Sprint will work automatically with a 
"plain" printer. It will still be able to print your files, but as mentioned 
earlier, you won't be able to take advantage of any special typestyles (such 
as italic) or other capabilities your printer may have. Finally, check with 
Borland Technical Support to see whether they have a customized printer 
driver file for your printer. 

It's possible to tell SP-SETUP about your printer and all its capabilities by 
creating a customized printer driver file called an .SPL file. This is a rather 
technical task; you can find instructions for creating an .SPL file in the 
"Build Your Own Printer and Screen Drivers" appendix in the Advanced 
User's Guide. 

If You Have Trouble with Your Printer 

If, after installing your printer, you find that Sprint either doesn't print 
properly (or at all), please refer to the "Help!" appendix in this book. 

Alternate Printer Installation 

Sprint allows you to select both a default printer and any number of alter­
nate printers. Once you've installed a default printer, you can return to 
Printer Installation on the main menu and install your alternate(s). For 
example, suppose you have a dot-matrix printer that you use for printing 
drafts, and a laser printer that you use for final printouts. You would first 
install the laser printer as your default (so the right fonts can be installed), 
then go back and install the dot matrix printer as your alternate. 

To install an alternate printer, go through the complete printer installation 
again, choosing the printer you want to be an alternate as you did for the 
default. At the end, Sprint will remind you that you've already installed a 
default printer and will display a Default or Alternate? message. In this 
case, you want to install an alternate printer, so press A for Alternate. (If 
you wanted to install a new default printer, you'd press D for Default.) 
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When you tell Sprint to print a file, you must switch to the alternate printer; 
otherwise, it will send the file to the default printer. 

Monitor/Screen Installation 

Sprint automatically detects the type of video hardware you're using, so in 
most cases you needn't set up your screen. However, there may be times 
when you want to change the installation. For example, if you have an 
EGA, you could install Sprint to display in 43-line mode instead of 25-line 
mode. If you want to do this, make sure the highlight bar is positioned on 
Monitor /Screen Installation and press Enter. Sprint will display a list of 
supported screen/video board types. 

SP-SETUP will position the highlight bar on the default video setup. To 
choose it, press Enter. To choose another one, move the cursor to the item 
you want (for example, EGA43), and press Enter. 

Sprint allows you to select both a default screen and any number of alter­
nate screens. You'll only want to install an alternate screen if your computer 
is (or will be) connected to more than one monitor. Once you've already 
installed your default screen, you can install the alternate screen by 
returning to Monitor/Screen Installation on the Sprint Installation main 
menu. Choose the screen from the list as you did for the default. At the 
end, SP-SETUP reminds you that you've already installed a screen, and 
asks if you want to reinstall the default or install an alternate screen. In this 
case, you want to install an alternate screen, so press A for Alternate. When 
you start Sprint, you can tell it to switch to the alternate screen by typing 

SP -s=<ScreenName> 

where ScreenName is the name given to the alternate screen; for example, 
EGA43. 

Note to two-floppy system users: If you have 360K drives, you won't be 
able to choose Hercules-RamFont as your screen type; choose Monochrome 
instead. 

User Interface Installation 

When you choose User Interface Installation from the Sprint Installation 
main menu, Sprint will prompt you to insert the distribution disk that 
contains user interface files, the Build disk; after you've inserted it, press 
Enter. First, highlight Default User Interface Installation and press Enter; you 
must do this before choosing any other options. You'll see a list of available 
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user interfaces; we recommend that you choose the SPTUTOR user inter­
face, which you'll need to work through the tutorial-in Chapter 4. However, 
if you're using one of the alternative user interface packages (which help 
Sprint respond to many of the same commands you'd in use another word 
processor, such as Microsoft Word, WordStar, and WordPerfect), you'll have 
the option of installing one of these user interfaces as the default. Note that 
installing one of these alternative user interfaces is entirely optional; we 
recommend that you do this only if you're familiar with (and addicted to) 
one of these programs, and want Sprint to behave in ways you're already 
accUstomed to. Also note that Sprint will not look at all or behave exactly 
like these programs, although many of the key sequences and menu names 
will be similar. See the Alternative User Interfaces booklet (supplied with the 
Alternative User Interface packs) for complete details. 

If you want to see more user interface choices, just choose Other; Sprint will 
prompt you to insert another disk containing additional user interfaces that 
you can install as your default. After you choose your default user inter­
face, Sprint copies the relevant user interface file to your hard disk (or 
Program A Disk, for two-floppy system users) and returns to the User 
Interface Installation menu. 

Once you've specified a default user interface, you can move on (if you 
like) to Borland User Interface installation. Sprint comes with three ver­
sions of its user interface: 

• SPTUTOR, a much-simplified version of the standard Borland interface 
you'll need to work through the Quick Start Tutorial in Chapter 4. You 
may want to install this now if you'll be working through the tutorial 
shortly, but it's not necessary; the tutorial will show you how to do it. 

• SPBASIC, the user interface version to which Sprint defaults unless you 
specifically install another default user interface. 

• SP ADV, an advanced version of the standard Borland interface that 
contains all the menu commands. 

If you have a hard disk, you may choose to load all versions of the standard 
(Borland) user interface-one as your default, and the rest as alternates; 
that way, you can switch from one to another at your discretion without 
leaving Sprint. 

Another menu option is Alternate User Interface Installation. Once you 
install an alternate user interface with SP-SETUP, you'll be able to switch to 
it "on the fly" while using Sprint (see Chapter 10, "Customizing Sprint," for 
details). (Two-floppy system users, please see the next section, "User 
Interface Installation on a Two-Floppy System.") When you choose Alter­
nate User Interface Installation, Sprint will prompt you to insert the disk 
that contains the user interface files; when you press Enter, you'll see a list of 
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available user interfaces. You can choose any of these as alternates; 
moreover, if you don't see the ones you want or you'd like to see all the 
choices before deciding, you can choose Other. 

If you really want a free hand when it comes to loading alternate user inter­
faces without leaving Sprint, you might want to install all user interfaces 
after choosing a default. When you choose this option, SP-SETUP will 
prompt you to insert the disk with user interface files; it will pause when 
the files on that disk have been copied and ask whether you want to insert 
the second Sprint user interface disk and copy its contents, too. 

User Interface Installation on a Two-Floppy System 

First, you must choose Default User Interface Installation. When you do, 
SP-SETUP will prompt you to insert the Sprint disk with user interface 
source files in Drive A and your Program A Disk in Drive B. It will then 
copy the default user interface you pick to your Program A Disk. Unless 
you have high-density disks, there's really not enough room on your 
Program A Disk for any other user interface files. (You might be able to fit 
one on a 720K disk, but it would be better to put it on a separate user 
interface disk.) 

So how do you install alternate user interfaces after you've already 
installed the default user interface on your Program A Disk? Technically, 
there may be room on your Program B Disk, but it's better to leave that 
space available for something like a printer driver file. You have two 
choices. The first is simply to run SP-SETUP again to install a new default 
user interface on your Program A Disk whenever you want to switch user 
interfaces. 

The second allows you to switch user interfaces later on without leaving 
Sprint; you make this possible by letting SP-SETUP copy additional alter­
nate user interface files to a separate disk, like this: 

1. After you install a default user interface, go back and choose Alternate 
User Interface Installation from the User Interface Installation menu. 

2. SP-SETUP knows you've already copied a default user interface to your 
Program A Disk and will prompt for another disk. 

3. Insert a blank, formatted floppy that you have designated as your alter­
nate user interface disk. (See page 12 for how create one.) Label this disk 
and put it aside. 

4. After starting Sprint, keep the disk with your alternate user interfaces 
on it handy; the "Changing User Interfaces" section of Chapter 10 will 
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show you how to switch this disk to load alternate user interfaces lion 
the fly." 

In short, those two-floppy users with 360K and 720K drives are best off 
when they install alternate user interfaces on a separate user interface disk; 
those with 1.2M drives can store alternate user interfaces on their Program 
A Disk, so other disks usually aren't necessary. The important thing to 
remember is that, once you've installed alternate user interfaces on a disk, 
you'll be able to use that disk to load them without leaving Sprint. (Chapter 
10 will show you how.) 

Speller and Thesaurus Installation 

Sprint comes with a built-in spelling corrector and thesaurus. If you want 
to use either or both of these features, you'll want to choose Speller Instal­
lation and/or Thesaurus Installation from the Sprint Installation main 
menu. SP-SETUP will prompt you to insert the disks containing the 
necessary files and copy them to your hard or floppy disk(s). 

Note to hard disk users who also have RAM disks: If you have a RAM 
disk, you can create a batch file to copy the spelling corrector and/or 
thesaurus files to the RAM disk each time you load Sprint. The response 
time for correcting misspelled words and getting synonyms will be much 
faster that way. To do this, you need to create a special file called 
SPRINT.BAT that will automatically copy the files and then load Sprint for 
you. 

First, add the RAM disk "drive" to the PATH command in your AUTO­
EXEC. BAT file before Sprint. For example, 

PATH=D:\;C:\SPRINT; 

Next, to create the SPRINT.BAT file, exit the SP-SETUP program (when 
you've finished your installation). Then, be sure you're in the C:\SPRINT 
directory (assuming that's where your Sprint files are stored; if not, switch 
to the directory where they're stored) and start Sprint by typing SP on the 
DOS command line. 

Press F10 FN, then type SPRINT. BAT when Sprint prompts you for a file name. 
Assuming your RAM disk is assigned to "Drive" D (the usual config-
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uration), and assuming your Sprint files are in the directory C:\SPRINT, 
include the following lines in the file: 

COpy C:\SPRINT\SPELLER.ENG D: 
COPY C:\SPRINT\AMERICAN.LEX D: 
COPY C:\SPRINT\USER.DOC D: 
COPY C:\SPRINT\THESAUR.* D: 
SP 

To start Sprint from now on, type SPRINT (not SP) on the DOS command line. 

Conversion Utility Installation 

Sprint's conversion utility lets you import files from and export files to 
other file formats (like ASCII, for example.) When you choose Conversion 
Utility Installation from the Sprint Installation main menu, Sprint will 
prompt you to insert the distribution disk with conversion utility source 
files in Drive A (hard disk users) and press Enter; you'll see a list of available 
conversion utilities from which to <;hoose. Just choose those you'll find 
useful; you can always go back to SP-SETUP and add more later on. 

Note to two-floppy system users: For best results when installing conver­
sion files on floppy disks, create a separate conversion files disk as you did 
for alternate user interfaces. Keep in mind that each conversion format will 
fill one disk, and have enough blank, formatted floppy disks on hand. 

That's all there is to installing Sprint. If at any point you want to change 
your printer, screen type, or user interface defaults, you can simply run 
SP-SETUP again. You can also install more alternate printers, screens, or 
user interfaces at any time; choosing new alternates doesn't affect any of 
the previously installed alternates. If you ever want to delete a previously 
chosen alternate from your setup, you can just delete the appropriate file 
(for example, a printer file with the extension .SPP, or a user interface file 
with the extension .UI) from your Sprint directory. 

Additional Notes for Two-Floppy Systems 

This section provides special notes for users with two-floppy systems (and 
no hard disk). You should read this section after you run the SP-SETUP 
program (described in the previous sections). 

If you have a computer with two floppy disk drives and no hard disk, 
you'll need to do some juggling with the Sprint disks and your Data Disk 
(the disk on which you store the text files you create with Sprint) in order 
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to take full advantage of Sprint's features. Once you've installed Sprint for 
your computer system, there are a few guidelines you'll need to keep in 
mind from then on. For instance, when you try to use certain commands, 
Sprint may prompt you to remove the Program A Disk from Drive A and 
replace it with another disk. As explained earlier, during floppy disk instal­
lation, SP-SETUP copies as many files as it can from the Sprint disks to your 
Program A Disk (or, if you have a 360K system, your Program A and B 
Disks). It automatically copies the rest of the files you need to a minimum 
of two other floppy disks. Sprint keeps track of how many floppies you 
used during installation; therefore, it may automatically prompt you to 
insert a specific disk when you choose a command, depending on whether 
the necessary files are on your Program A Disk. You'll get more information 
about the items listed as you work with Sprint and refer to this manual. 

If you want to create additional Data Disks to use with Sprint, put your 
Program A Disk in Drive A and a blank, formatted floppy disk in Drive B. 
Then type 

SPRECOVE CREATE 

This command creates a fixed-size backup file on your Data Disk. (The first 
time you run SP-SETUP, it 'adds the line SET SP. SWP=B: to the AUTO­
EXEC.BAT file on your Program A Disk; this forces Sprint to use the backup 
file on Drive B. Never remove the Data Disk from Drive B while you're in 
Sprint; the fixed-size backup file is clucial to its operation.) 

Note: Throughout this manual, we provide notes for floppy-system users 
when there are special considerations that you need to keep in mind. 

Once you've installed Sprint with SP-SETUP, here's all you have to do to 
use it each time: 

• Turn on your computer and put your Program A Disk in Drive A and 
your Data Disk in Drive B. 

• If you see an A> prompt, type B: and press Enter to get to Drive B. 

• Type SP at the B> prompt to start Sprint. 

That's all you need to do to get Sprint going! As you use Sprint, keep these 
guidelines in mind: 

• In general, you should leave your Program A Disk in Drive A and your 
Data Disk in Drive B. As mentioned earlier, if you have a low-density 
(360K) drive, you'll be using two Program Disks (Program A and 
Program B). With the exception of two special contingencies noted below, 
Sprint will automatically tell you when to replace one with the other. Your 
Program A must be in Drive A at the following time,s: 

• when you start Sprint 
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• when you exit Sprint 
• when you want to print a file (if you're using two Program Disks and 

printing to a PostScript printer, you must remove your Program A 
Disk from Drive A and insert Program B in its place, although Sprint 
will not issue a warning prompt to this effect) 

• when you use the DOS Command on the Utilities menu to temporarily 
leave Sprint and issue DOS commands 

• when you want to sort text with the Arrange-Sort command on the 
Utilities menu 

• when you want to use the SprintMerge mailing list/form letter gener­
ation program 

• when you choose any of the commands on the Customize menu (see 
below for additional information on commands from the Customize/ 
User Interface menu) 

• If you want to choose Customize/User Interface/Load to load an 
alternate user interface, Customize/User Interface/Save to save 
user-defined and menu-created shortcuts, or Customize/User Inter­
face/Reset Shortcuts to clear all user-defined shortcuts (see Chapter 
10 for details), first insert the disk with the user interface you need to 
access in Drive A. If you installed your alternate user interfaces on a 
separate disk (see page 19 for details), insert that disk. But re­
member: Sprint will not prompt you to do this . 

• To get context-sensitive help (by pressing F1) when the help files are not 
on your Program A Disk, Sprint will prompt you to remove the Program 
A Disk from Drive A and replace it with the disk that contains the help 
files . 

• To use the online spelling checker or thesaurus when the dictionary or 
thesaurus files are not on your Program A Disk, remove the Program A 
Disk from Drive A and replace it with the disk Sprint specifies. Note: You 
cannot use Sprint's AutoSpell mode with two-floppy systems. 

Starting Sprint 

Once you've run SP-SETUP, you're ready to use Sprint. To do so: 

Two-floppy system: 
Be sure your Program A Disk is in Drive A and your Data Disk is in Drive 
B. At the B> prompt, type sp to start Sprint. 
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Hard Disk System: 
If you're not there already, change to the directory that contains your Sprint 
files (probably C: \ SPRINT) and type sp to start Sprint. 

Note: If you asked SP-SETUP to modify your AUTOEXEC.BAT file, you can 
type SP at any DOS prompt (after you reboot the system); you needn't be in 
the directory that contains your Sprint files. 
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c H A p T 

Notes for the Beginning Word 
Processor 

E R 

2 

Note: If you've used a word processor before, you can probably turn to the 
Quick Start Tutorial right now. If you're familiar with WordStar, Microsoft 
Word, or WordPerfect, take a look at your Alternative User Interfaces booklet; 
there, you'll find information about Sprint's alternative user interfaces that 
react like these programs. 

If you've used a typewriter for years, and this is your first foray into the 
computing world, you've come to the right place. If you're already dis­
couraged, take heart: These days, it's inevitable that you'd have to learn 
how to use a computer, so just be pleased to know that you've chosen one 
of the best and easiest to learn new products to get started with. And trust 
us: The very people who wrote this manual (with Sprint) were once 
dedicated typewriter typists, and now they can scarcely conceive of the 
time when they actually retyped a page of text because of an error on one 
line! 

Please read Chapter 1, "Before You Begin," before starting this chapter. We 
assume that you've copied the Sprint files to your working disk, and that 
you're using Sprint's default user interface-that is, that you haven't used 
the installation program to select one of the alternative user interfaces and 
that you're ready to roll. 

This chapter will not teach you how to use your computer, nor will it teach 
you how to type; it will only give you a very brief, very basic introduction 
to word processing with Sprint. We'll tell you how to 

• get in and out of Sprint 

• move the cursor around 
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• delete and insert characters 

• create, save, and close a file 
• get help 

• understand Sprint's menus 

The point of this chapter is for you to get your feet wet, to give you a feel 
for word processing with Sprint. When you're ready to dive in, you'll want 
to turn to the Quick Start Tutorial (Chapter 4). The tone of this chapter is an 
easygoing discussion; we aim to put you at ease in your first experience 
with the power of word processing on a personal computer. You really 
don't need to know much besides how to get your system up and running 
to understand this chapter. If you can just get the machine turned on and 
see a DOS prompt on your screen, you're in business. 

When you've completed this chapter, we suggest you also take a look at 
Appendix A, "A DOS Primer," at the back of this book. There you'll find 
information about DOS and disk directories. 

Getting In, Getting Out, and Getting Help 

Before we tell you how to do anything else, it's a good idea to know how to 
get in and out of Sprint. A lot of people get panicky when they're in a 
program-they want to know how to get out of it. Once they're out of it, 
they feel just as panicky about getting back in. To help you out while you're 
working with Sprint, Sprint has context-sensitive help; that is, you can get 
information about whatever you're doing with Sprint just by pressing F1. 

If you're using a two-floppy system, make sure your Program A Disk is in 
Drive A and your Data Disk in Drive B before you begin . 

• To get into Sprint, type SP, and then press Enter. 

• To get to the Sprint main menu, press F10. (Two-floppy system users: If 
the help files are not on your Program A Disk, Sprint will prompt you to 
remove it from Drive A and replace it with the disk that contains the files 
before you press F1). 

• To remove a Sprint menu from the screen, press Esc. 
• To get help about whatever you're doing, press F1. 

• To get out, press F10 Q (that is, press F10 and then press Q for Quit). 
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What Is Word Processing? 

You may think that word processing is little more than glorified typing. But 
this is not the case at all. Although the goal is the same-to create and print 
some kind of document-the way of reaching it is radically different. 

First of all, the computer allows you to view and correct your text on the 
monitor screen before you print it. Your typewriter may have the ability to 
correct errors by backspacing over characters using a white correction tape, 
but Sprint lets you erase characters, a line, or a whole chunk of text before 
your words ever hit the paper. It also lets you move text hither and thither 
with the flick of a keystroke. No more retyping a page just because there's 
an error, or you decide you want to rearrange something. 

Second, your computer allows you to store your documents-your letters, 
reports, or what have you-in files on special magnetic storage media called 
floppy disks, or on a fixed disk inside the computer called a hard disk. These 
files are stored on the disk like music is stored on a cassette tape. In other 
words, your disk is like the whole cassette, and each individual file is like 
one track (song) on the tape. The files are accessible at any time, and most 
importantly, you can edit them at a moment's notice. 

Getting Started with Sprint 

Sprint is remarkably easy to learn, mostly because of its menu system con­
sisting of easily understood, basic commands. Once you become familiar 
with Sprint, you'll learn quicker ways to do what you want to do than by 
using the menus. But for now, let's get into Sprint, enter some text, and 
explore some of its menus. 

We assume you're seated at your computer, that it's turned on, and that 
there's a prompt on your screen. This prompt should be a letter of the 
alphabet (either A or B if you have a floppy drive system, or C if you've got 
a hard disk), followed by a greater-than symbol (», or possibly something 
else. As long as you see the letter prompt, you're in the right place. 

You need to be able to access the disk drive that contains the Sprint file 
SP .EXE. If you've copied the file to your hard disk, you should see the C:> 
prompt. If you don't, just type C:, then press Enter. 

If you have a two-floppy system, put your Program A Disk in Drive A and 
your Data Disk in Drive B (your Data Disk must be in Drive B the entire 
time you're your working in Sprint.) 
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Now you're ready to "call up" Sprint. Type SP, then press Enter. You'll see 
Sprint's copyright message, hear your computer whirring as it finds the 
Sprint program, and then you'll see the opening Sprint screen, shown in 
Figure 2.1. 

T 2 3 4 5 6 ]L 7 
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Figure 2.1: Sprint Opening Screen 

Among other things, the ruler line at the top of the screen lets you set 
margins and tabs for your document. We won't go into how to change 
margins and set tabs right now-that's covered in the Quick Start Tutorial 
in Chapter 4-but just know that the ruler line will automatically wrap your 
sentences to the next line when you get close to the right margin. This is 
one major difference from a typewriter: You don't have to press the carriage 
return to start a new line; Sprint does it for you automatically. The only 
time you should press Enter is when you want to start a new paragraph or 
insert blank lines. 

Entering Text and Moving the Cursor 

Let's start by entering a couple paragraphs of text. Type the following two 
paragraphs of text, and separate the two paragraphs by pressing Enter 
twice. Remember, don't press Enter until you're at the end of a paragraph. 
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As you're typing, if you make a mistake that you want to correct, press the 
Backspace key; notice how it moves backward on a line-even crossing onto 
the line above--and erases the characters there. 

It's the classic Indian stereotype: the sacred cow. Jam-packed streets 
grind to a halt when a cow appears. Its placidness throws a momentary 
calm on the rush-hour. It crosses the road, and the tide of traffic 
surges again behind it. 

The cow is revered in India although the origin of its special status 
is not clear. But as long ago as 1500 Be, it appeared in holy 
hymns--the Vedas. These were composed when the ancient Persians 
(Aryans) settled in what is now the Punjab region. 

Notice the blinking light-called the cursor-that moves along as you type. 
You can think of the cursor as a place marker, something that tells you 
where you are on the screen. 

While we're on the subject of the cursor, practice moving it around on the 
screen. On the right side of your keyboard is an important set of keys called 
the numeric keypad. The keys are set up in the same pattern as a lO-key 
adding machine, but they provide more functions. There are four keys with 
arrows on them, pointing left, right, up, and down. As you might guess, 
these keys move the cursor in the direction they indicate. Try them. You 
should see the cursor moving back and forth and up and down on your 
screen. (If you're getting a series of numbers, it means your Num Lock key is 
on; to tum it off again, just press it.) Notice that when you press the Up and 
Down arrow keys, the text scrolls up and down on your screen-as if it were 
actually a big piece of paper on a scroll. If you've made a mistake some­
where that you want to correet, use the arrow keys to move to that spot in 
your text. You can delete characters with the Backspace key (to delete 
characters to the left of the cursor) or the Del key (to delete characters 
directly above the cursor). 

We'll be talking about some of the other keys on the numeric keypad 
shortly; for now, let's take a look at Sprint's menus-the real gateway to all 
its powerful functions. 

Sprint Menus and Shortcuts 

Sprint is a feature-rich software program; it provides you with lots of 
functions and ways to do things. Rather than expecting you to memorize all 
the commands and features, Sprint (like many other modern software 
programs) provides you with onscreen menus from which to choose the 
command you want. 
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Sprint's menus are called pop-up menus: They pop up on top of your text 
whenever you press a key-F10--and disappear again when you press 
another key-Esc. In other words, they're only there when you need them 
and stay out of your way when you don't. 

Sprint's menus were designed to be easy to use, even for people who've 
never touched a computer before. To sh.ow you just how easy, let's pop up 
Sprint's main menu and do a little exploring. 

Press F10, and you'll see the main menu with its assortment of commands 
(Figure 2.2). Each of the items on the main menu (except Quit) leads to 
another menu, and in some cases to another menu, and so on, in a 
branching structure. 

T 2 3 4 5 6 Sit ,..---; ~r n 1.-

'ai· !I' •• 
Edit Alt-E 

Insert Alt-I 
Typestyle Alt-T 
Style Alt-S 
Layout Alt-L 

Print Alt-P 
Window Alt-W 
Util ities Alt-U 
Customize Alt-C 

Quit Alt-Q 
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Figure 2.2: Sprint Main Menu 

To choose a command on the menu, you can do one of two things: 

• Press the Down arrow key until the choice you;re interested in is 
highlighted, then press Enter . 

• Press the letter key corresponding to the first letter in the item. For 
instance, to choose the Edit command on the menu, you would press E. 
(Lowercase e is fine.) 

Go ahead and use either of these methods to choose the Edit menu. 
Another menu pops up next to the main menu, as shown in Figure 2.3. 
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Edlt Alt-E 

Insert Alt-I 
Copy Typestyle Alt-T 
Move-Cut F5 Style Alt-S 
Insert-Paste F6 Layout Alt-L 
Erase 

Print Alt-P 
Block Select Window Alt-W 
Write Block Utilities Alt-U 

Customize Alt-C 
Search-Replace 

quit Alt-Q 
Go to Page 
Jump to Line F9 
Place Mark 

Unnamed Ins 1l:33am Ln.2 of 2 , 

Figure 2.3: Edit Menu 

There's a shortcut to the Edit menu: You can just press the shortcut Alt-E 
when there are no menus on your screen, and the Edit menu will pop up by 
itself. To try this method~ first press Shift-Esc to remove all menus from the 
screen, then press Alt-E to display the Edit menu. 

Note: Any time you want to remove a menu from your screenJ' you can 
press Esc. This will remove the last menu you opened. To remove all 
menus, either press Shift-Esc or press Esc repeatedly. 

Moving Around in Your Text 

Now, let's choose another command on the Edit menu: Jump to Line. As its 
name implies, this command lets you "jump to" different lines in your file. 
Choose this command by using the arrow keys to select it and press Enter. 
Then enter a line number when Sprint prompts you at the bottom of the 
screen. Sprint will "jump" to the line you specify. 

Notice that, when you choose a command, the menus go awayJ' and the 
command is executed-performed. 

There's another way to move around in your text like this: by pressing 
special keys and key combinations that we call shortcuts. The shortcut for 
Jump to Line is F9. To move to the top of your file, you can press Ctrl-PgUp; 
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that is, hold down the Gtrl key and press PgUp at the same time. Press Gtrl­
PgDn to move to the bottom of your text. 

All Sprint's shortcuts are listed on the Quick Reference Card. Also, many of 
Sprint's menu commands have shortcut equivalents. These equivalents are 
displayed next to the items on the Sprint menus. 

In this chapter, we will be using a few of Sprint's shortcuts. As you become 
more familiar with Sprint, you'll probably find these shortcuts are the 
quickest way to do what you want to do. 

We designed Sprint to be flexible; it will suit the needs of different people 
with different tastes and computer abilities. Some people like menus, some 
prefer to use keys. Also, most beginners prefer menus until they get to 
know their way around a program. After that, shortcut keys tend to be 
quicker. 

Beyond the Backspace Key: Deleting 

There are a number of shortcuts you can use to delete characters, words, 
and even chunks of text. Although you can always rely on the Backspace key 
to delete the character to the left of the cursor, and the Del key to delete the 
character directly above the cursor, there are other possibilities. 

For instance, to delete the word to the right of the cursor, press Gtrl-T. To 
delete an entire line, press Gtrl-Y. Gtrl-G deletes the character under the 
cursor, and Gtrl-Backspace deletes the word to the left of the cursor. 

Go ahead and practice with these keys, referring to the Quick Reference 
Card when you need to. 

Inserting Text 

After you feel comfortable with deleting text, insert some new text in your 
file. Move the cursor to a spot in the middle of your text and start typing. 
Notice how the line breaks adjust to accommodate the new text, and also 
notice that the existing text moves to the right. By default, Sprint is in Insert 
mode: Whatever you type is inserted in front of existing characters. There 
will be times when you'll want to type over (and thereby erase) existing 
text. To do that, press the Ins key. Type some more characters; this time, 
whatever you type will replace the existing text. 

To return to Insert mode, just press Ins again. Also notice the status line at 
the bottom of the screen. As you toggle from Insert to Overwrite, Sprint 
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displays Ins (for Insert) or Ovr (for Overwrite) on this line, so you'll always 
know which mode you're in. 

Getting Help 

All Sprint's menu commands are in clear, understandable English, so 
they're mostly self-explanatory. Remember, when you want to clear a menu 
from the screen, press Esc. To clear all menus, press Shift-Esc. You can 
browse through the menu structure, perusing the menus, choosing com­
mands, trying out different things-if you have trouble, refer to this 
manual. Moreover, the Sprint Reference Guide lists all menu commands in 
alphabetical order, so it's easy to find what you're looking for. 

But there's an even easier way to get information-the Sprint context­
sensitive help system. Any time you'd like to know more about a menu com­
mand, you can just choose the command and then press F1. A screen will 
pop up with information about that command. 

Note to two-floppy system users: If the help files you need to get context­
sensitive help are not on your Program A Disk, Sprint will prompt you to 
remove it from Drive A and insert the disk that contains the files. 

Files-the Basic Storage Unit 

You may not know it, but what you've been doing here is creating, editing, 
and moving around in a file. In word processing and most other software 
applications, the file is the basic storage unit for the words you type. Unlike 
a typewriter, where your words are imprinted on a single piece of paper, 
the computer 'allows you to permanently store what you type on a floppy 
or hard disk. 

As you've been typing away, Sprint has been storing your words in a 
special file called a backup (swap) file. Although files are common to all 
word processing packages, this sort of backup file is a unique feature of 
Spri~t. Whenever you stop typing for 3 seconds, Sprint saves what you've 
typed so far in the backup file, so if the power goes down in your home or 
office, you won't lose much (if any) of your file. Only if your fingers are 
bionic and never take so much as a 3-second break would Sprint fail to 
keep an automatic backup file of your work. 

When you leave Sprint (by pressing F10 Q), that backup file stays right 
where it is-safely stored on your disk. When you reenter Sprint (by typing 
SP), your file will be onscreen exactly as you left it. 
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You could go on and on like that forever, with Sprint automatically saving 
your file. But, at some point, you'll be ready to move to a new file--you've 
finished working on the letter or report, and you'd like to put it away and 
start on a new one. . 

With Sprint, you can have several files open at once--up to 24, in fact. For 
the purposes of this discussion, let's save the file you were working on, clope 
it (put it away), and then open a new file. You can read about multiple open 
files in Chapter 6 of this book. 

Call up the File menu (by pressing F10, then F). You can see that this menu 
contains the three commands just mentioned-Close, Save, and Open. 
First, press S to choose Save. Sprint will ask you for a name for the file--the 
one you've just been working on. Type in any sequence of characters (up to 
eight). What you've just typed is now stored in a separate file on your disk, 
under the file name you've typed with the letters .SPR tacked onto it (this is 
the default Sprint file extension). 

Let's suppose you're finished with this file now. Again, on the File menu, 
choose Close. The file will disappear from your screen-but it's safely 
stored on disk. To prove it, call up the File menu again and choose Open. 
Type in the name of your file; Sprint will automatically add the .SPR 
extension to the end of it. When you press Enter, the file you just worked on 
will reappear. 

If you're having trouble understanding the concept of opened and closed 
files, think of your file as a manila file folder in a file cabinet. When you 
want to look at what's in the file, you open the file cabinet and take out the 
file (in Sprint, Open the file). You then peruse what's in the file, and 
perhaps change (in Sprint, Edit) something in there. You put the file away 
(in Sprint, Save it), then close (in Sprint, Close) the file cabinet. 

Leaving Sprint 

It's time to leave Sprint. To do so, simply press F10 to pop up the main 
menu, then press Q for Quit. If you have made changes to your file since 
the last time you saved, Sprint will prompt you: 

The file filename has not been saved; save it? (Y,N,Esc) 

Since this was just a practice file, you may not care about saving changes, in 
which case you can enter N for No; if you want to save the file before 
quitting, type Y. Sprint saves the file and then quits. If you press Esc, Sprint 
will ignore the command and return you to your file. 
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Well, you've gotten your feet wet. You've gotten into Sprint, moved the 
cursor around, browsed around a couple of menus, opened and closed a 
file, and exited the program. Now you're ready to move on to the Quick 
Start Tutorial (Chapter 4). In that chapter, you'll learn more about Sprint's 
capabilities, explore the menus some more, and create and print a business 
letter and proposal. . 
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c H A p T E R 

3 

Notes for the Experienced User 

You know who you are-you're a veteran computer user, possibly a long­
time Borland customer, and you're ready to get started right now. You 
don't want to wade through a lot of verbiage, but want us to get right to the 
point. 

This chapter will point you in the right direction, so that you'll spend as 
little time as possible with your nose in these manuals. In any case, you 
should read "Before You Begin" in this book to install Sprint for your 
computer system. 

Fast Track 

Following are the basic steps for getting in and out of Sprint. In addition, 
you'll probably want to browse through the chapters on editing and 
formatting in this book and the Advanced User's Guide, skim through the 
Quick Start Tutorial in this book (Chapter 4), then move on to the 
Advanced Tutorial in the Advanced User's Guide. The Sprint Reference Guide 
is an alphabetical listing of all Sprint commands and concepts. Refer to that 
manual for quick reference. . 

1. Install Sprint for your printer using the SP-SETUP program (see 
Chapter 1, "Before You Begin"). If you want to use one of Sprint's 
alternative user interfaces (for example, those for Microsoft Word, 
WordPerfect, or WordStar users), you can choose the user interface of 
your choice with SP-SETVP. (You can also change user interfaces using 
the Sprint menus.) SP-SETUP is also used to install Sprint for the 
advanced user interface (which contains all Sprint menu selections). 
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2. Type SP at the DOS prompt to start Sprint. 

3. Press F10 for the main menu. You can browse through the menus, which 
are mostly self-explanatory, to see Sprint's functions. 

4. Press A/t-E for a shortcut to the Edit menu, A/t-S for the Style menu, and 
A/t-L for the Layout menu. 

5. Press Esc to remove a menu. To remove many menus at once, press 
Shift-Esc. 

6. Refer to the the Quick Reference Card for Sprint shortcuts (these are 
also displayed on the menus when they pop up). 

The most common formatter commands are also listed on the Quick 
Reference Card; you can find more information about them in the 
Reference Guide. 

7. To print your file, choose Go from the Print menu. 

8. Press F1 any time you need help while in Sprint. 

9. Press F10 Q to exit Sprint. 

If You Use Borland Text Editors 

If you are familiar with one of Borland's ASCII text editors-the SideKick 
Notepad, MicroStar (part of the Editor Toolbox), or the Turbo Pascali 
Basic/ C or Eureka text editor-you've got a good headstart with Sprint. 
Sprint's default user interface supports many of the same WordStar­
compatible cursor movement and editing commands. In fact, if you're so 
accustomed to the way Borland text editors work that any kind of change 
would be difficult, you might want to consider choosing Sprint's SideKick 
user interface, which behaves in almost the same way as the other Borland 
text editors. 

If you'll be working with ASCII files in Sprint (for example, if you'll be 
transmitting Sprint files over a modem), be sure to read Appendix E, 
"Working with ASCII Files." In ASCII mode (no rulers), Sprint supports 
auto-indent mode (choose Auto-Indent from the Customize/ASCII File 
Handling menu). 

Once you open your first Sprint file (by typing SF at the DOS prompt), 
you'll be able to get around onscreen with just your knowledge of Borland's 
other text editors. To get to the main menu, press F10; to get help, press F1. 

There are, however, some significant differences in how Sprint works. First 
of all, Sprint is a far more powerful product, able to do elaborate formatting 
of your documents; it can also be completely customized via the macro 
language (see the "Programming Editor Macros" section in the Advanced 
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User's Guide). There is also a very easy way to create Sprint macros "on the 
fly;" see Chapter 6 for details. If you plan to do more than basic word 
processing with Sprint, you'll want to read Chapter 8, and possibly the 
"Advanced Formatting" section in the Advanced User's Guide. 

Also, Sprint handles blocks and deleted text differently. Similar to a 
Macintosh, Sprint has a "Clipboard" where it temporarily stores blocks of 
text you have moved, copied, or deleted. See Chapter 6 for complete 
information about block handling. 

In Sprint, typestyles are not toggles. You choose the typestyle you want 
from the Typestyle menu, and Sprint enters the control codes to begin and 
end the typestyle. You don't see these control codes unless Sprint is in a 
special "Show Codes" mode. Again, see Chapter 6,"Editing: Tips, Tricks, 
and Techniques," for details. 

Sprint allows you to have up to six windows open at once, as well as 24 
open files. You can move back and forth between open windows and files, 
"cutting" and "pasting" text from one file to another, or just viewing 
different parts of your text. See Chapter 6 for information about multiple 
files and windows. 

Sprint's printing capabilities go beyond that of the other text edi­
tors-particularly with PostScript laser printers and typesetters. Sprint also 
has a complete thesaurus, spelling corrector, and hyphenation dictionary. 
Turbo Lightning users should have little difficulty using the spell checker 
or thesaurus since they work much like Turbo Lightning. 

Of course, you can also use SideKick with Sprint as you would with any 
other program. 

In fact, for those particularly addicted to SideKick, Sprint provides a 
SideKick-like interface (SIDEKICK.UI) that behaves nearly identically to 
SideKick. To load it, choose Customize/User Interface/Load, choose 
SIDEKICK frolll the list of available user interfaces, and press Enter. 

Note to two-floppy system users: In order to change user interfaces, you 
need either reinstall your default user interface with SP-SETUP or remove 
your Program A Disk from Drive A and replace it with a separate alternate 
user interface disk (created with SP-SETUP) before choosing Customize/ 
User Interface/Load). 

If You Know Another Word Processor 

First, if you are a WordStar, Microsoft Word, or WordPerfect user, you may 
want to install one of Sprint's other interfaces; see "Before You Begin" and 
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read the Alternative User Interfaces booklet. In the event that you aren't 
particularly attached to another word processor, try Borland's default 
interface (that is, don't install a special user interface, but use Sprint as is). 
It's easy to learn and has virtually all the features of any other program 
you've used. 

If you know another word processor-DisplayWrite ar MultiMate for 
example-you know the basics of word processing; after reading the 
"Before You Begin" and "Quick Start Tutorial" chapters, you can probably 
start playing with Sprint and refer to the manuals as necessary. 

There are many word processing packages on the market today, and their 
capabilities vary widely. Some, such as XYWrite, have advanced editing 
and formatting features like Sprint. If you know one of these programs 
well, you should have little trouble "migrating" to Sprint, since you already 
understand many of the concepts of a sophisticated word processing 
system. If, however, you have worked with one of the less sophisticated 
packages, you'll probably be in for a (eventually pleasant) surprise. In that 
case, you'll want to carefully read Chapter 8, "Basic Formatting," go on to 
the Advanced User's Guide, and experiment with the Sprint formatter at your 
own pace. 

If You Like to Tinker with Software 

If you want to customize the Sprint editor to make it behave in ways you 
prefer, refer to the "Programming Editor Macros" section of the Advanced 
User's Guide. If you want to make Sprint do some really fancy 
formatting-such as was done to produce this manual-see the "Advanced 
Formatting" section in the Advanced User's Guide. Of course, you should 
first familiarize yourself enough with the program to know what it is you'd 
like to change! 

If you know other programming languages, you'll find that the editor 
macro language is somewhat like C. The formatter macro language is not 
very similar to any other language. 

Don't be daunted if you've never programmed before; Sprint will provide 
you with an excellent opportunity· to learn some programming concepts 
and skills in the context of something you can make practical use of-a 
word processor. 
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c H A p T E R 

4 

Quick Start Tutorial 

This chapter explains Sprint's most commonly used functions and provides 
step-by-step instructions for creating a sample business letter and editing a 
short proposal. The purpose of this tutorial is to get you going with Sprint 
as quickly as possible and introduce you to Sprint features you're likely to 
use often. 

"Quick Start" is intended for all beginning users who want a general 
overview of Sprint's word processing functions. 

After completing this tutorial, you will know how to 

• create new files and edit existing files 
• use Sprint rulers to format text 
• make changes to text 
• use various typestyles 
• move, delete, and copy text 
• make lists 
• save and print files 
• use DOS commands without leaving Sprint 

Armed with this information, you can begin to create your own letters, re­
ports, and formatted documents. When you're ready for more information 
about Sprint's sophisticated editing and formatting capabilities, you can 
move on to the editing and formatting chapters in this manual, and from 
there to the Advanced Tutorial in the Advanced User's Guide. 

This tutorial contains the following nine lessons: 

• Lesson 1: Starting Sprint and Creating a New File 

• Lesson 2: Making Changes in a File 

Chapter 4, Quick Start Tutorial 41 



• Lesson 3: Opening and Closing a File 
• Lesson 4: Choosing Typestyles and Centering Text 

• Lesson 5: Setting and Using Tabs 
• Lesson 6: Selecting a Block and Block Commands 

• Lesson 7: Making Lists 
• Lesson 8: Printing a File 
• Lesson 9: Switching User Interfaces and Quitting Sprint 

Each lesson begins with a brief description of the subject of the lesson, lists 
typical applications for the functions and commands you'll be using, and 
explains how to perform the specific functions and commands. The Practice 
part of the lesson provides instructions for creating and editing your 
sample letter and proposal files. These instructions are always indented 
and shown in bold type. Tips are sometimes included to give you 
additional information or alternative ways to complete the task. 

Note: You should complete each lesson in order since some of the lessons 
are based on actions that you performed in previous lessons. We assume 
that you've installed Sprint using the SP-SETUP program as described in 
Chapter 1. If you want to create additional Data Disks after running 
SP-SETUP, insert a blank, formatted floppy disk in Drive B and type 
B: SPRECOVE-CREATE at the DOS prompt. Repeat for each new Data Disk you 
want to create. 

Getting Started 

For this tutorial only, you'll be using a special "tutorial" version of Sprint 
that omits some of the more advanced features of the program. Once 
you've worked through this tutorial, you'll be ready to load the basic 
version of the Sprint program. 

If you've installed one of Sprint's alternative user interfaces, these lessons 
won't apply. Please refer to the Alternative User Interfaces booklet. 

There are two basic ways to tell Sprint what you want it to do: 

• choose commands from Sprint's menus 
• press keyboard shortcuts (like Shift-Esc, Alt-R, or F6) 

In this tutorial, you'll use both methods. For example, you'll be working 
with commands on the main Sprint menu (which you get to by pressing 
F10) and the Edit menu. Although you can reach the Edit menu by choosing 
Edit from the main menu, there's a shortcut-just press Alt-E. When you 
want to learn the shortcut for a menu command, just look next to that com-
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mand on the menu display (for example, next to Edit on the main menu is 
the shortcut Alt-E). Once you've learned a shortcut for a command, you can 
use the shortcut with no menus displayed. These shortcuts are shown on 
the menus by default; if you don't see any, press F10 eM (for Customize/ 
Menu Shortctits), and make sure it reads "YES." As you work more with 
Sprint, you'll discover your preferred way of choosing commands and even 
create your own shortcuts. 

Note: When describing the menu method, we separate a menu name from 
its submenu name with a slash U). If we want you to choose, for example, 
Edit on Screen from the Ruler menu (which is on the Layout menu and is 
thus a submenu), we might tell you to do the following: 

1. Press F10 (to display the main menu). 

2. Choose the Layout/Ruler/Edit on Screen command. 

When Sprint displays a menu, you can do any of the following to choose a 
command: 

• Use the Up and Down arrow keys to highlight the item you want, then 
press Enter. 

• Press the spacebar until the desired menu item is highlighted, then press 
Enter. 

• Press the key corresponding to the first letter in the item (displayed in 
bold). For example, to choose Options from the Print menu, just press O. 
Note: Pressing Enter isn't necessary when you press the highlighted first 
letter of a menu command, so this method requires fewer keystrokes (one 
instead of two to choose a command). 

Getting Help 

Remember-any time you're having trouble with Sprint, you can press F1 
to get helpful information about whatever you're doing. If you have a two­
floppy system and the help files are not on your Program A Disk, Sprint 
will prompt you to remove your Program A Disk from Drive A and replace 
it with the one that contains the files whenever you want access to context­
sensitive help. 
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The Final Result 

Pages 45 and 46 show you the printed result of this tutorial. You will create 
the letter shown on page 45 and edit a proposal so it ends up looking like 
the proposal on page 46. 

Note: We used a PostScript typesetter to produce the letter and proposal. 
Your printed copy may look somewhat different from this, depending on 
what kind of printer you are using. 
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June 17, 1988 

Ms. Linda Silver 
498 Moonview Terrace 
Chicago, IL 60606 

Dear Ms. Silver, 

Thank you for the opportunity to provide a cost estimate on replacing your 
existing kitchen cabinets. The following estimate includes the cost of 
replacing your cabinets, a proposed time schedule, and a description of the 
work to be performed. 

We hope this proposal meets with your approval, and that we can begin 
work on your new kitchen soon. If you have any questions, please feel free 
to contact me. 

Sincerely, 

Randy "Red" Wood 
Kitchen Consultant 
Remodeling, Inc. 
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KITCHEN PROPOSAL 

TASK 

- Remove the existing cabinets and frames. 

- Construct new 3/4" face frames. 

- Build replacement cabinets, using standard 3/4" birch and 1/4" oak 
veneer facing. 

- Apply stain number 531 and satin finish. 

-Install the new cabinets. 

TIME ESTIMATE 

A job this size typically requires three to four working days. If we start on 
Monday, June 30, we should be able to complete the job by Thursday, July 
3. Our contractors will arrive at approximately 9:00 a.m. each day and will 
work until 4:00 p.m. 

COST ESTIMATE 

The cost to perform the task listed above is $6,500.00, due and payable as 
follows: 

10% $650.00 deposit due upon acceptance of this proposal. 

40% $2600.00 due at time of measurement. 

40% $2600.00 due at time of installation. 

1 00/0 $650.00 due at job completion. 

INSTRUCTIONS and RECOMMENDATIONS 

1. Remove all wall hangings and fragile objects. We are not responsible 
for damages. 

2. Plan to be without a kitchen for 5 days. 

3. Since your kitchen cannot be completely closed off from your dining 
room, cover the dining room furniture with an adequate dropcloth. This 
job will generate quite a bit of fine dust. 

4. Remove the contents of all existing cabinets and place them in another 
room. 

5. Make arrangements to be at the house on the job's starting and ending 
days. During the remaining days, you may provide instructions for entry 
in your absence. 
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Lesson 1: Starting Sprint and Creating aNew 
File 

In this lesson, you'll create a new file in Sprint. In the process, you'll 

• start Sprint and specify a new file name 
• familiarize yourself with how Sprint displays information onscreen 
• load the special user interface you need to work through this tutorial 

• enter text 

• edit the ruler line that formats your file 

• save your work 

If you haven't already installed Sprint with the SP-SETUP program, go 
back to Chapter Ion page 9 and do that now. 

Starting Sprint 

Once you start Sprint, you can create new files, edit existing files, and begin 
using Sprint's word processing functions. 

To start Sprint with a hard-disk system: 

1. Go to the directory that contains your Sprint files. For example, if you're 
at the DOS root directory and you've installed your Sprint files in a 
subdirectory called SPRINT: 

Type: CD \SPRINT 
Press: Enter 

2. Now enter the Sprint editor: 

Type: SP 
Press: Enter 

Tip: You can start Sprint from any directory by typing SP if you have set a path 
to the Sprint directory in your A UTOEXE C. BAT file. For details on how to do 
this, see page 14. 

To start Sprint with a floppy-drive system: 

1. Place your Program A Disk in Drive A and your Data Disk in Drive B. 
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2. Now start Sprint: 

Type: SP 
Press: Enter 

Sprint automatically starts on Drive B (where the SP-SETUP program 
created the fixed-size backup file). There's no need for you to specify a 
drive. 

Creating a New File 

When you start Sprint by typing SP on the DOS command line, you enter 
the editor and are presented with a new, [Unnamed] file. If you had been 
working on a file before, Sprint would come up with the file(s) opened in 
the last editing session. 

Another option is to follow the SP command with the name of a new or 
existing file. To specify that you want to open a particular file: 

Type: SP FILENAME at the DOS prompt 
Press: Enter 

If the file doesn't yet exist, Sprint will ask you if you want to create a file by 
that name: 

Create new file FILENAME.SPR? 

Press Y for "yes," N for "no." When you ,are creating file names of your 
own, follow the DOS file-naming conventions: one- to eight-character file 
names with an optional one- to three-character extension. If you're not 
familiar with these conventions, refer to Appendix A, "A DOS Primer." If 
you enter a file name with no extension, Sprint automatically adds the 
extension .SPR. 

Once the file is open, Sprint automatically displays two lines on the screen: 
a ruler line at the top of the screen and a highlighted status line at the 
bottom. 

Once you're in Sprint and working on a file, you can create a new docu­
ment by choosing New from the File menu. 

The Ruler Line 

The ruler line at the top of the file lets you set up the basic format of your 
file. You can set left and right margins and tab stops, specify how many 
columns the first line of a paragraph should be indented (if any), and 
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determine how your text should be aligned (justified, ragged-right, 
ragged-left, and centered are some of the choices). 

Figure 4.1 shows Sprint's default ruler, and the Practice part of this lesson 
explains how to adjust its various settings. 

+------------------------------------------------------------------------+ 
T 1 2 3 4 5 6]L 7 

+------------------------------------------------------------------------+ 

Figure 4.1: Default Ruler Une 

By default, the left bracket ([) sets the left margin at column 0; the right 
bracket (]) sets the right margin at column 65. This means that, when you 
type, text begins at column 0, continues to column 65, and then "wraps" to 
the next line. You do not need to (and should not) press Enter to begin a new 
line in a paragraph. Press Enter only to insert a blank line of text or to begin 
a new paragraph. 

The T near the left edge of the ruler indicates a tab stop at column 5. The L 
next to the right bracket specifies leftjustified text (text aligned at the left 
margin and "ragged" at the right margin). 

You will learn to use the remaining three codes in the Practice part of this 
lesson; they are: 

J (both) Specifies left- and right-justified margins (aligned at both 
the left and right margins). 

R (right) Specifies right-justified, ragged-left margins (aligned only 
at the right margin). 

C (center) Specifies centered text. 

The Status Line 

The status line at the bottom of the screen displays information about the 
file. It includes 

• the name of your file and file path (or [Unnamed]) 

• a message that, if present, indicates Sprint is in select mode (Sel); that is, if 
Sel is displayed, then text is being selected (marked). 

• a message telling whether Sprint is in Insert mode (Ins)-the default-or 
Overwrite mode (Ovr) 

• a message that, if present, indicates Sprint is in Column mode 

• the time of day 
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• the current cursor position (line number) 

• the total number of lines on the file 
• the current page number in the actual document (if the file has been 

paginated) 

• the current line on the page in the actual document (if the file has been 
paginated); if the file hasn't been paginated, the line number relative to 
the total lines in the document. 

• the current cursor position (column number); also, if the text at that 
cursor position is changed to a particular typestyle, then the column 
number displays in the same text attribute-bold, underlined, and so 
on-as the text) 

If you have made changes to the file but haven't saved them, Sprint also 
displays an asterisk (*) after the file name. If you have copied text to the 
Clipboard but have not moved your cursor, Sprint displays a plus (+) sign 
to signify that items moved to the Clipboard will be appended to the current 
contents. Figure 4.2 shows a sample status line for a file that is not in Sel or 
Col mode. 

File name File not Insert mode Time Line # T ctallines Column # 
& path saved 

\ \ I ~ 1 \ 
C:\SPRINT\LETTER.SPR * Ins 10:07am Ln. 440 of 500 143 

Figure 4.2: Sample Status Line 

Note: Whenever you start Sprint, as you will do for this Practice, Sprint 
automatically creates a backup file to record your work session. This 
backup file is named SP.SWP and is stored in your current directory (or, on 
a networked system, the directory you have set "home" to). If you should 
experience a power failure during a Sprint session, don't worry. All your 
entries and changes are automatically saved to this backup file every time 
you stop typing for 3 seconds, which ITleanS you have instant crash 
recovery when power resumes. "The Automatic Backup File" section in 
Chapter 7 covers this feature in greater detail. 
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Practice 

The first thing you're going to do is load the tutorial user interface and 
create the sample business letter shown on page 45. This letter serves as a 
cover letter to the proposal you modify in the next lesson. 

To create the practice file LETTER.SPR and enter text: 

1. For this tutorial, you're going to be using a special version of the Sprint 
user interface called SPTUTOR. Display the main menu and choose 
Customize/User Interface/Load: 

Press: F10 CUL 

Sprint displays a list of available user interfaces. 
Note to two-floppy system users: As long as you installed SPTUTOR as 
an alternate user interface with SP-SETUP, and you insert the disk that 
contains your alternate user interfaces, you can load the tutorial user 
interface with Customize/User Interface/Load. If you don't see 
SPTUTOR listed, you must run SP-SETUP again to reinstall your default 
user interface (choose SPTUTOR). For details on how to use SP-SETUP 
to set up a separate user interface disk, see page 19. 

2. Choose SPTUTOR from the list of user interfaces: 
Press: Down arrow to choose SPTUTOR 
Press: Enter 

3. Press F10 FN to create a new file. Sprint asks you for a name for the File 
to create: 

Type: Letter 
Press: Enter 

Tip: By default, Sprint adds the extension .SPR to your file name. If you didn't 
want an extension, type a period after the name. 

4. Type the text of the letter below the ruler line. Press Enter where 
indicated to insert one or more blank lines. 

Tip: Remember that you should only press Enter to insert blank lines or end 
paragraphs; do not use this key to start a new line in a paragraph. Sprint 
automatically wraps your text as you type past the right margin setting. 
Don't worry about fixing any typos; you'll correct those in the next 
lesson. 
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June 17, 1988 Enter 
Enter 
Enter 
Enter 
Ms. Linda Silver Enter 
498 Moonview Terrace Enter 
Chicago, IL 60606 Enter 
Enter 
Dear Ms. Silver, Enter 
Enter 
Thank you for the opportunity to provide a cost estimate on 
replacing your existing kitchen cabinets. The following estimate 
includes the cost of replacing your cabinets, a proposed time schedule, 
and a description of the work to be performed. Enter 
Enter 
We hope this proposal meets with your approval, and that we can 
begin work on your new kitchen soon. If you have any questions, 
please feel free to contact me. Enter 
Enter 
Sincerely, Enter 
Enter 
Enter 
Enter 
Randy "Red" Wood Enter 
Kitchen Consultant Enter 
Remodeling, Inc. 

Editing the Ruler 

Here's your opportunity to see how changing the ruler settings affects the 
text of the file you just typed in. You can practice editing the codes on the 
ruler and immediately see the results. 

Right now, the L on the ruler line indicates left-justified text (the default); 
Sprint will align the left margin but the right margin will be ragged, as if it 
were typed on a typewriter. By changing the ruler settings, you'll change 
the way the letter is justified. 

To change the ruler settings: 

1. Choose Layout/Ruler from the main menu: 

Press: F10 LR to choose Layout/Ruler 

2. Now, choose the Edit on Screen command: 

Press: E for Edit on Screen 

Tip: To reduce the number of keystrokes to get to this command, use the 
shortcut for Layout/Ruler/Edit on Screen, Alt-A. 
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3. The ruler line now appears highlighted, which means you can change 
its default settings by deleting codes or typing them in. You will do this 
in the practice session below. 

4. Change the format by adding the code for right- and left-justification: 

Type: J (anywhere on the ruler) 

Sprint places the J immediately after the right bracket (]) on the ruler, 
replacing the L that was there. Figure 4.3 shows how Sprint automat­
ically aligns the text of the letter at the right margin as well as the left by 
justifying the spacing between words. 

+ ----------------------------------------------------------------------------- + 
[ T 1 2 3 4 5 6 lJ 7 
+ ----------------------------------------------------------------------------- + 
June 17, 1988 

Ms. Linda Silver 
498 Moonview Terrace 
Chicago, IL 60606 

Dear Ms. Silver, 

Thank you for the opportunity to provide a cost estimate on 
replacing your existing kitchen cabinets. The following estimate 
includes the cost of replacing your cabinets, a proposed time 
schedule, and a description of the work to be performed. 

We hope this proposal meets with your approval, and that we can 
begin work on your new kitchen soon. If you have any questions, 
please feel free to contact me. 

Sincerely, 

Randy "Red" Wood 
Kitchen Consultant 
Remodeling, Inc. 

Figure 4.3: Justification of Left and Right Margins 

5. You can also see how the text looks when you center it. Type a c on the 
ruler to specify centered text: 

Press: F10 LRE (or Alt-A) 
Type: c (anywhere on the ruler) 

Sprint places the C immediately after the right bracket on the ruler; the J 
disappears. Figure 4.4 shows how Sprint centers the text. 
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+ ----------------------------------------------------------------------------- + 
[ T 1 2 3 4 5 6]C 7 
+ ----------------------------------------------------------------------------- + 

June 17, 1988 

Ms. Linda Silver 
498 Moonview Terrace 

Chicago, IL 60606 

Dear Ms. Silver, 

Thank you for the opportunity to provide a cost estimate on 
replacing your existing kitchen cabinets. The following estimate 

includes the cost of replacing your cabinets, a proposed time 
schedule, and a description of the work to be performed. 

We hope this proposal meets with your approval, and that we can 
begin work on your new kitchen soon. If you have any questions, 

please feel free to contact me. 

Sincerely, 

Randy nRedn Wood 
Kitchen Consultant 
Remodeling, Inc. 

Figure 4.4: The Letter After Centering 

6. Delete the C on the ruler (move the cursor to the C and press OeD; the 
justification code on the ruler line defaults to L (left-justified only). Type 
a J on the ruler line so the letter's margins will both be justified again, as 
in Figure 4.3. 

Note: If you type a J on a ruler without first deleting a previously 
inserted Ci they both stay on the ruler; the result of CI (the two codes 
combined) on a ruler line is text that is both left- and right-justified 
except for the last line of a paragraph or free-standing lines. 

7. Practice changing the margin settings. (The default left and right margin 
settings are fine for our letter, but experiment with them anyway.) 
Choose Layout/Ruler/Edit on Screen from the main menu: 

Press: F10, then LRE (or just Alt-A) 
Type: [(left bracket) at the desired left margin setting 
Type: ] (right bracket) at the desired right margin setting 

The text of your letter automatically adjusts itself to the new margin 
settings. When you are finished, return the left and right margins to 
their default settings (0 and 65, respectively). 

8. Try indenting the paragraphs of your letter. If you want to indent the 
first line of each paragraph, choose Layout/Ruler/Edit on Screen from 
the main menu: 

54 

Press: F10, then LRE (or Alt-A) 
Type: I on the highlighted ruler line wherever you want the 

paragraph indent to start 
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For example, if you put the I at column 5 (where the T is on the default 
ruler line), each new paragraph will start at column 5. The second and 
remaining lines of a paragraph will begin at the left margin setting 
(column 0). Don't worry about the address being reformatted; the whole 
letter will return to normal when you delete the l's from the ruler line. 

9. Try inserting new tab settings on the ruler. To set tab stops on the ruler 
line: 

Type: T on the highlighted ruler wherever you want a tab stop 

Now, each time you press the Tab key when entering text, Sprint 
automatically moves to the next tab stop indicated on the ruler line. The 
Del key is used to get rid of tab stops. 

Tip: The tab stop on the default ruler line is preset at column 5; if you continue 
to press Tab in the file, you'll get tab stops at 10, 15, and so on. If all tab stops 
are deleted from the ruler, the default is stillS, 10, 15, and so on. 

10. When you're finished experimenting, press the Up or Down arrow key to 
move off the ruler line and back into your file. The highlighting will 
disappear, and you must choose Layout/Ruler/Edit on Screen again to 
make any additional changes. 

Saving Your Changes 

Check the status line at the bottom of your screen. The asterisk (*) to the 
right of the file name means that you have made changes to the file but 
have not saved them to disk. (Even though Sprint creates a special backup 
file and saves your text to this file when you stop typing for 3 seconds or 
more, it's a good idea to occasionally save your text to disk.) 

To save the letter: 

1. Choose File/Save from the main menu: 
Press: F10, then FS 

Tip: You can also use the shortcut Ctrl-F2. 
Sprint displays the message 

Writing ... 

on the status line, indicating that it is writing your file to disk. 
Note: If you did not enter a file name when you started Sprint (that is, 
you typed SP and pressed Enter), the status line will display Unnamed 
instead of a file name. When you decide to save and press F10 FS (or 
Ctrl-F2), the status line prompts 

Save file as: 
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2. Enter the name of your file (in this lesson, LEITER): 

Type: LETTER 
Press: Enter 

Sprint writes the text to a file called LEITER.SPR on your floppy disk or 
the current directory on your hard drive . 

. Remember: Sprint automatically adds the extension .SPR to your file 
names. If you don't want this extension, follow the file name with a 
period. 

Summary of Lesson 1 

In Lesson 1, you opened a new file and typed in text. You chose a special 
user interface to work with and adjusted the ruler settings to format your 
text. 

The following table summarizes the tasks presented in Lesson 1: 

Task 

Start Sprint 

Create a new file 

Display the main menu 

Choose a command 

Choose a different user 

interface 

Change ruler settings 

Save a file 

Table 4.1: Tasks in Lesson 1 

Action 

At the DOS prompt, type SP and press Enter. 

Press F10 FN (for File/New) and enter a file 
name. 

Press F10. 

a. Use the arrow keys to highlight the command 
and press Enter or 

b. Type the first letter of the command name or 
c. Use the alternative shortcut. 

Choose Customize/User Interface/Load from 
the 
main menu. Use the arrow keys to pick the user 

interface you want, then press Enter {or press the 
first letter of the menu choice). 

Choose Layout/Ruler/Edit on Screen from the 
main menu (or press Alt-A) to change the settings 
by, ty~.ing or deIeting codes on the highlighted 
rUler nne. 

Choose File from the main menu. Press S for 
Save. You can also use the shortcut Ctrl-F2. 

This completes Lesson 1. The next lesson explains how to move the cursor 
to correct any mistakes you may have made. 
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Lesson 2: Making Changes in a File 

In this lesson, you'll edit a line of text in your sample letter. You willieam 
how to 

• move your cursor around in the file 

• correct typing mistakes 
• toggle from Insert to Overwrite mode 

Before you can change text by inserting or deleting characters, words, or 
lines, you need to move the cursor (the blinking character on your screen) to 
the text you want to change. For example, if you want to insert text at the 
bottom of your file, you first need to move the cursor to the bottom of the 
file. Likewise, when you want to add a different typestyle, such as boldface, 
you need to move the cursor to the correct spot in your file. 

There are three ways to move the cursor around in your file: 

1. use the keys on the numeric keypad 

2. use Sprint's shortcuts (which include WordStar-like commands such as 
Ctr/-C, Ctr/-R, Ctr/-E, and Ctr/-X) 

3. choose the Edit/Jump to Line command (the shortcut is F9) 

In this lesson, we use shortcuts and keys on the numeric keypad to move 
the cursor, but you can also use the Jump to Line (F9) command if you 
prefer. There is no right or wrong method; it's all a matter of personal 
preference. 

On an IBM PC, the numeric keypad is located on the right side of your 
keyboard. The following table lists the function of each of these keys, and 
three other editing keys: Esc, Tab, and Ctr/. 

A complete list of all Sprint cursor-movement commands can be found on 
the Quick Reference Card. 
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Arrow Keys 

Home 

Gtrl-Home 

End 

GtrJ-End 

PgUp 

Gtrl-PgUp 

PgDn 

Gtrl-PgDn 

Esc 

Shift-Esc 

Tab 

Glrl 

Backspace 

Table 4.2: Sprint Cursor Movement and Editing Keys 

The Up, Down, Left, and Right arrow key:s are located on the numeric 
keypad (on the right side of the keyboard). Use these keys to move 
the cursor around in any existing text: 

Up arrow Moves the cursor up one line. 

Down arrow Moves the cursor down one line. 

Right arrow Moves the cursor one column to the right. 

Gtrl-Right arrow Moves the cursor one word to the right. 

Left arrow Moves the cursor one column to the left. 

Gtrl-Left arrow Moves the cursor one word to the left. 

Moves to the beginning of a line of text. 

Moves the cursor to the top of the screen. 

Moves to the end of a line of text. 

Moves the cursor to the bottom of the screen. 

Moves the cursor up to display the previous screen of text. 

Moves the cursor to the top of the file. 

Moves the cursor down to display the next screen of text. 

Moves the cursor to the bottom of the file. 

Cancels a menu selection. Suppose you select the wrong menu 
option, or change your mind about selecting a command. Esc releases 
you from a command choice. Also, Esc removes a menu from the 
screen. See Shift-Esc to remove all menus. 

Removes all Sprint menus from the screen. Use Shift-Esc when you 
have opened several levels of Sprint menus and want to remove 
them aU at once. 

Moves the cursor forward from one tab stop to the next. 

In conjunction with another character, causes Sprint to Eerform a 
particular editing or formatting function. For example, Ctrl-PgUp 
moves the cursor to the top of the file. (If you are using the SRrint 
default user interface, you can also use Gtrl to enter WordStar-like 
commands.) 

Moves the cursor one column to the left, deleting the character that 
was already there (if y:ouare in Insert mode). It also deletes hard 
returns. Nothing will be deleted if you are in Overwrite mode. To 
change (toggle) between Insert and Overwrite mode, press Gtrl-V. 

Ctrl-Backspace Deletes one word to the left of the current cursor position. 

Ins Toggles between Insert and Overwrite mode. 

Del Deletes the character under the cursor, or, if a block is selected, 
deletes the block. 
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Practice 

In this session, you'll practice using cursor movement and editing keys to 
view your text and make some minor changes. 

Adding and Deleting Text 

To correct typos and change the date of the letter: 

1. If you find a mistake in the letter you typed, use the cursor movement 
keys to reach it and correct it: 

Press: Backspace or Del to delete the mistake 
Type: your correction 

2. Return to the top of the file, where the first line reads June 17, 1988: 

Press: Ctrl-PgUp to move the cursor to the first line in the file 
3. Change the date to today's date; first, change Insert mode to Overwrite' 

mode by pressing Ins. 
The status line message changes from Ins to Ovr. 

4. Now that Sprint's in Overwrite mode, type today's date over the exist­
ing text. When you've done this, toggle Insert mode back on by pressing 
Ins again. Make sure that Ins is displayed in the status line. 

To change the addressee's name and address: 

1. Change the name in the letter's address to your own. Move the cursor to 
line 6. Use the shortcut for Edit/Jump to line (F9) to reach that line: 

Press: F9 

Tip: Shortcuts are displayed on the menus. If you don't see any, choose 
Customize/Menu Shortcuts from the main menu and toggle to Yes. (Two­
floppy system users, make sure your Program A Disk is in Drive A when you 
choose Customize/Menu Shortcuts.) 
Sprint prompts Line number: 

Type: 6 

2. Now delete the line Mrs. Linda Silver (line 6), using Sprint's shortcut for 
deleting a line of text: 

Press: Ctrl-Y (see the table of Sprint's shortcuts at the end of this 
lesson) 

3. Insert a new blank line, using Sprint's shortcut, and type your own 
name: 
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Press: Enter to insert a new line 
Type: your name on the line inserted by Sprint 

4. Move to the next line, delete the line, insert a blank line, and type your 
address: 

Press: Down arrow to move down one line 
Press: Ctrl-Y to delete the line 498 Moonview Terrace 
Press: Enter to insert a new line 
Type: your street address 

5. Repeat the process to delete the text of line 8 and enter your own city, 
state, and zip code. 

6. Now, move your cursor to the beginning of the salutation: 

Press: Down arrow to move down two lines 
Press: Home to move the beginning of the line 

7. Use Sprint's shortcut to move your cursor one word to the right: 

Press: Ctrl-F (or Ctrl-Right arrow) to move one word to the right 

Your cursor should now be on the M in Ms. Delete the words Ms. and 
Silver using Sprint's shortcut: 

Press: Ctrl-T three times 

Sprint deletes one word to the right of the cursor each time you press 
Ctrl-T. Type your own name in the salutation. 

8. Finally, save the changes to your file by choosing File/Save from the 
main menu: 

Press: F10 FS (or use the shortcut Ctrl-F2) 

Summary of Lesson 2 

In Lesson 2, you learned how to move the cursor around in the file and 
make corrections. You also toggled Insert mode to Overwrite to type in a 
correction over existing text. 

The following table summarizes the tasks presented in Lesson 2: 

Table 4.3: Tasks in Lesson 2 

Task Action 

Move the cursor Press the cursor movement keys as shown in Table 
4.1. 

Delete a mistake Press the Backspace or Del key. 

Toggle Insert mode Press Ins. 
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Table 4.4'is a review of some of Sprint's shortcuts you've used in the first 2 
lessons. 

Key 

Ctrl-F2 
F9 
Alt-A 
Ins 
Ctrl-T 
Ctrl-Y 
Ctrl-N 
Ctrl-E 
Ctrl-X 
Ctrl-F 
Ctrl-A 

Table 4.4: Summary of Sprint Shortcuts 

Function 

Save a file 
Jump to a line 
Edit a Sprint ruler 
Toggle from Insert to Overwrite mode 
Delete one word to the right of the cursor 
Delete a line 
Insert a line 
Move the cursor up one line 
Move the cursor down one line 
Move the cursor one word to the right (same as CtrJ-Right arrow) 
Move the cursor one word to the left (same as Ctrl-Left arrow) 

Note: If you delete something by mistake using one of Sprint's shortcuts, just 
press Ctf/-U, which undoes a delete command. 

This completes Lesson 2. Go on to Lesson 3 to learn how to open an 
existing file and use DOS commands without exiting Sprint. 

Lesson 3: Opening and Closing a File 

This lesson explains how to open and close an existing file. You will also 
learn how to use DOS commands without leaving Sprint. 

As mentioned earlier, you choose Save from the File menu (or press Ctrl-F2) 
to save your file to disk. But the file remains open, even after you save it; a 
file stays open until you close it. This is useful when you are working on 
several files at once and need to move quickly from one file to another. 
When you're done working on a file, it's a good idea to close it. Otherwise, 
every file you open remains open, and you end up with a lot of open files 
that you don't really need. 

Note to two-floppy system users: Try to limit the number of files you keep 
open at anyone time, since the fixed-size backup file on your Data Disk can 
only hold a limited number of open files. 

Note: The command you use to switch between open files, normally a 
choice on the File menu (Pick File from List), is not available on the limited 
version of the user interface used for this tutorial. For information on how 
to switch between up to 24 open files (once you finish this tutorial and load 
the basic default user interface in Lesson 9), see "Moving between Open 
Files" in Chapter 7. 
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Practice 

Since you have completed a cover letter to go with your proposal, it's time 
to edit the proposal. This proposal has already been typed for you; it's in a 
file you'll open called PROPOSAL.SPR. First, you'll make sure the 
PROPOSAL.SPR is on the hard disk. If it's not, you'll use a DOS COPY 
command to put it there without leaving Sprint. Then you'll practice 
closing the file. 

Note to two-floppy system users: The file PROPOSAL.SPR is on the Data 
Disk created by SP-SETUP. If you haven't yet run SP-SETUP, go back to 
Chapter 1, page 11, and let Sprint create a Data Disk for you. 

To make sure the PROPOSAL.SPR file is present: 

1. Use the File/ Open command to check for the file LETTER.SPR: 

Press: F10 FO (or use the shortcut Ctrl-F3) 

Sprint prompts File to open: 

Press: Enter to get a list of all files with the .SPR extension in 
your current directory 

Note: The .SPR extension is Sprint's default extension, which is why you 
see a list of all files in your current directory with a .SPR extension when 
you choose File/ Open and press Enter. If you want to see a list of all files 
in the current directory, type *. * at the File to open: prompt. The 
asterisk is a DOS wildcard meaning "all;" Sprint uses DOS wildcards, so 
it will list every file name and extension combination present if you type 
* . * at the prompt. For more information on DOS wildcards, see 
Appendix A, "A DOS Primer." 

2. If you don't see PROPOSAL.SPR in the list of files with a .SPR exten­
sion, or if you get a 
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No files match II. Press Esc to continue 

message, you may not have asked SP-SETUP to copy the 
PROPOSAL.SPR file during installation. One way to remedy that (if you 
don't feel like running SP-SETUP again) is to copy that file from the 
original Sprint Thesaurus Disk. To do this: 

For a Hard-Disk System: 

a. Choose Utilities/DOS Command from the main menu: 

Press: F10 UD 
Sprint prompts DOS command: 

b. Insert the Thesaurus Disk in Drive A 
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c. Use the DOS command COpy to copy the PROPOSAL.SPR file from 
the Thesaurus Disk to your current directory: 

Type: COpy A: PROPOSAL. SPR 

Sprint copies the file to your current directory. Press any key to 
continue. 

3. Note: Utilities/DOS Command allows you to use DOS commands like 
DIR and COPY without quitting Sprint. If you want to shell out to DOS 
for more than one command, choose Utilities/DOS, don't type anything 
on the status line, and press Enter. You will exit to DOS until you want to 
return to Sprint; to get back to Sprint, just type EXIT at the DOS prompt. 

For a Two-Floppy System: 

a. The SP-SETUP program automatically puts PROPOSAL.SPR on the 
Data Disk it creates during installation! Just insert the Data Disk in 
Drive B and your Program A Disk in Drive A every time you start 
Sprint. Go back and run SP-SETUP again before continuing if you 
don't find PROPOSAL.SPR on the Data Disk. 

b. If you want to practice using the Utilities/DOS Command, check 
your Data Disk for PROPOSAL.SPR with a DOS DIR command: 

i. Make sure your Program A Disk is in Drive A. 
ii. Choose Utilities/DOS Command. 

iii. Type DrR B: PROPOSAL. SPR to check for the presence of 
PROPOSAL.SPR on your Data Disk (Drive B). 

Once you know the PROPOSAL.SPR file is present or have recopied it, you 
can open the file. 

To open the file PROPOSAL.SPR: 

1. Choose File/ Open from the main menu: 

Press: F10 FO (or use the shortcut Ctrl-F3) 
Sprint prompts File to open: 

Press: Enter to see a list of all files with the .SPR file extension 
(the Sprint default) 

2. Choose the file name PROPOSAL.SPR from the list: 

Press: Down arrow key until you reach PROPOSAL.SPR 
Press: Enter 

Sprint will open the proposal file. 
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Tip: Instead of pressing Enter at the File to open: prompt, and then choosing 
from the list, you can simply type proposal. spr over the *.SPR, so that the 
status line reads 

File to open: proposal.spr 

Then press Enter. 

Since you'll be working with the file PROPOSAL.SPR in Lesson 4, you'll 
need to open it again after learning how to close it. 

To close the proposal file: 

1. Choose the File menu from the main menu: 

Press: F10 F to choose File 
2. Choose the Close command to close the file: 

Press: C to choose Close 

Tip: You can also use the shortcut Ctrl-F4 to close a file. 

Remember: To help you learn Sprint's shortcuts, they appear next to each 
menu item. If you don't see them, choose Customize/Menu Shortcuts from 
the main menu and press Enter to toggle Menu Shortcuts from Off to On. 
Then press Shift-Esc to remove the menus. 

Note to two-floppy system users: Your Program A Disk must be in Drive A 
when you choose Customize/Menu Shortcuts. 

Summary of Lesson 3 

In Lesson 3, you learned how to use Utilities/DOS Command to copy a file 
to your current directory. You also opened an existing file and closed it at 
the end of the lesson. 
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The following table summarizes the tasks presented in Lesson 3: 

Task 

Use DOS commands 
inside Sprint 

Open an existing file 

Close a file 

Table 4.5: Tasks in Lesson 3 

Action 

Choose Utilities from the main menu, then press 
o for DOS Command. Type any DOS command 
on the status line as if you were at the DOS 
prompt, then return to Sprint when the com­
mana is completed by pressing any key. (Two­
floppy system users: Have your Program A Disk 
in Drive A when you choose Utilities/DOS 
Command.) If you want to exit to the full-screen 
DOS shell for more than one command, press 
Enter at the DOS conunand: prompt without 
entering anything. To get back to Sprint, type 
EXIT at the DOS prompt. 

Choose File/ Open, or use the shortcut Ctrl-F3. 

Choose File/Close, or use the shortcut Ctrl-F4. 

This completes Lesson 3. Go on to Lesson 4 for an overview of Sprint's var­
ious typestyles, and the commands you'll need to insert bold and under­
lined text. 

Lesson 4: Choosing Typestyles and Centering 
Text 

This lesson shows you how to choose typestyles from Sprint's Typestyle 
menu. It explains the various typestyles that Sprint supports, and lets you 
practice underlining text. 

Table 4.6 lists and explains all Sprint typestyle options available in the 
tutorial user interface (there are additional typestyles available in the basic 
and advanced user interfaces). To display the Typestyle menu, press F10 T. 
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Typestyle 

Normal 

Bold 

Italic 

Table 4.6: Sprint Typestyles 

Function 

Ends a Typestyle command by moving the cursor to the right of 
the hidden AN control code. 

Prints text in boldface type (if your printer has that capabili!y). If 
your printer cannot print bold characters, it will double-strike the 
text. 

Prints the text in an italic font (if your printer has that capabili!y). 
If your printer cannot print italic characters, it will underline tne 
text. 

Underline Underlines the text when it prints. 

Word Underline Underlines the the text when it prints, except for spaces. 

Large 

+ Superscript 
and 

-Subscript 

Prints text in large, bold type. This is very useful for headings. 

Raise and lower text (respectively) by one-half of one line. 
Sprint will also use a smaller font to print the superscripted or 
subscripted character if your printer has that capability. 

If your printer does not support vertical microspacing, Sprint will 
create a blank line above the text for a superscript or blaJik line 
below for a subscript. 

Note: When you choose a Typestyle command, Sprint changes the onscreen 
attribute of the text between the hidden control characters it inserts. It 
displays the text in a different attribute (highlighted or underlined on a 
monochrome monitor, and in a different color on a color monitor). At print 
time, Sprint prints the text between the control characters in the typestyle 
you chose, to the best of your printer's ability. 

When you' want your printed text to appear in a particular typestyle, you 
choose the typestyle you want, type the text, and then end the typestyle by 
pressing Right arrow. If you want to change the typestyle of existing text, you 
must first mark the text to be affected, and then select the desired typeface. 
This lesson explains how to select typestyles for new text. Lesson 6 explains 
how to mark text and change the typeface of existing text. 

Practice 

Since the proposal text doesn't have a title, this lesson explains how to 
insert underlined text to serve as a heading. You're going to enter the title 
KITCHEN PROPOSAL and underline it. You will also learn how to tum typestyles 
off. As a sideline to learning about typefaces, you'll also learn how to center 
a line of text by centering the underlined title. 
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Underlining Text 

You can enter text in an underlined typestyle by choosing Underline from 
the Typestyle menu and typing the text. Once you learn how to underline, 
you can choose any of the typefaces in Table 4.6 and use them the same 
way. 

To enter an underlined title for the proposal: 

1. First, open the file PROPOSAL.SPR (if it isn't already open): 

Press: Ctrl-F3 
Type: proposal (Sprint supplies the default file extension .SPR) 
Press: Enter 

2. Move to the first line of text (the line immediately following the ruler 
line) and place the cursor under the T in TASK. 

3. Insert two blank lines above the word TASK: 

Press: Enter twice to insert two lines 

4. Now move the cursor to the top of the file: 

Press Ctrl-PgUp 
5. To reach the Typestyle menu, choose Typestyle from the main menu: 

Press: F10 T 

Sprint displays the Typestyle menu. 

6. Choose the Underline command: 

Press: U to choose Underline 
7. Now enter the title: 

Type: KITCHEN PROPOSAL 

If you watch the far right corner of the status line as you type, you will 
see an underline appear beneath the column number. (On a color moni­
tor, the column number changes to the color you've selected for under­
lined text.) Sprint also displays the text you are typing in a different 
attribute (a different color on a color monitor, underlined on a 
monochrome monitor). 

8. When you've finished, turn the underlined text attribute off: 

Press: Right arrow to end the underline typestyle 

Note: Pressing Right arrow ends a typestyle because it moves the cursor to 
the right of the hidden AN control code Sprint inserts to end a typestyle 
command; everything you enter after the AN will be in the normal 
typestyle. 
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9. To see what Sprint did, press the Sprint shortcut for displaying hidden 
control codes: 

Press: Alt-Z to reveal codes 
When you chose Typestyle/Underline, Sprint inserted a AU and a AN at 
your cursor position; you then typed KITCHEN PROPOSAL between them. 
These control codes tell Sprint to underline the words when the pro­
posal is printed. 

Centering a Line of Text 

In Lesson 1, you learned how to center a whole file by changing the ruler. 
You can also center a line of text on the page by using the menu command 
Style/Center, as you'll do when you center the underlined title KITCHEN 
PROPOSAL. 

To center the underlined title on the page: 

1. Place your cursor on the line KITCHEN PROPOSAL. 

2. Choose Style/ Center from the main menu: 

Press: F10 SC 
As you can see, Sprint automatically centers the underlined title on your 
screen. 

Tip: When you choose Style/Center, your cursor doesn't have to be at the 
beginning of a line; it can be placed anywhere on that line. 

3. Insert a blank line after the underlined title: 
Press: Enter 

Summary of Lesson 4 

In Lesson 4, you learned how to create new typestyles in your file using 
commands like Underline from the Typestyle menu. You also centered a 
line that had already been entered. 
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The following table summarizes the tasks presented in Lesson 4: 

Task 

Enter underlined text 

Center existing text 

Show control codes 

Table 4.7: Tasks in Lesson 4 

Action 

Choose Typestyle/Underline from the main 
menu, type the text, and then press Right arrow 
when you want the text attribute to be turned off. 

Place your cursor on the line and choose Style/ 
Center from the main menu. 

Press Alt-l. 

This completes Lesson 4. You now know how to center a line and choose a 
typestyle when inserting new text. Changing the typestyle of existing text, 
though, requires that you first mark the text you want to change, and then 
choose the desired typestyle. You'll learn more about this in Lesson 6. 
Before you go on to Lesson 6, however, you should complete the next 
lesson. The text you'll enter in Lesson 5 is required for Lesson 6. 

Lesson 5: Setting and Using Tabs 

Sprint automatically sets a tab stop at column 5. If you tab past this first 
setting, Sprint assumes you want further tab stops at every fifth column; 
that is, at columns 10, 15, 20, and so on. If you want to set different tab 
stops, you can do so on the ruler line. Press F10, then choose Layout/ 
Ruler /Edit on Screen. The ruler now appears highlighted. Move the cursor 
to the point on the ruler where you want to set a tab and type T to set the 
tab stop. From this point on, whenever you press the Tab key, the cursor 
will move to this column of the current line. The tabs set on the ruler line 
will remain in effect until Sprint sees another ruler line with different tab 
stops. At that point, Sprint recognizes the new ruler and its new tab stops, 
and forgets the old ones. 

If you delete the T from the ruler line and don't type in any others, the tab 
stops will still default to "every 5 characters (5, 10, 15, and so on). A single 
tab stop set at any other column number on the ruler will work the same 
way; for example, if you set a tab at column 3, there will be tab stops at 
every third column (3,6, 9, and so on). 

In text, Sprint treats a tab stop like any other character; pressing Backspace 
with your cursor on the first character after a tab stop will delete that tab. 
Arrow keys will jump over it. 
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In the following practice session, you are going to insert two-column text 
beneath the COST ESTIMATE heading and introductory sentence. You will 
use tabs to produce these two columns. 

Practice 

The COST ESTIMATE heading and text is currently located at the end of the 
proposal file. This practice session explains how to enter the columnar text 
that belongs under the COST ESTIMATE heading. 

To enter the text of COST ESTIMATE in two columns: 

1. Move the cursor to the end of the file: 
Press: Ctrl-PgDn 

The text you're about to enter will appear in two columns, like this: 

10% $650.00 deposit due on acceptance of this proposal 

40% $2600.00 due at time of measurement 

40% $2600.00 due at time of installation 

10% $650.00 due at job completion 

The percenta.ge figures begin at the left margin (column 0), and the 
dollar figures and payable terms begin at column 10 (1 on the ruler line). 

2. Insert a ruler line at the current cursor position. Choose Layout/Ruler / 
Insert from the main menu: 

Press: F10 LRI (or use the shortcut Alt-R) 

Sprint automatically inserts a copy of the first ruler line at the current 
cursor position. 

Tip: You can insert additional ruler lines in your file whenever you want to 
change the format of your text. The formatting instructions on each ruler line 
remain in effect until Sprint encounters another ruler line in your file. 

3. Set a tab at column 10 (1 on the ruler line). To do this, keep your cursor 
inside the highlighted ruler you just inserted. (When you insert a ruler 
into your file, it will appear highlighted, allowing you to alter the 
default settings of the ruler.) If you've strayed off the ruler, press Alt-A to 
return to it. Move the cursor to column 10 on the ruler and insert a tab 
stop there: 
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Press: Right arrow to move the cursor to the number 10 on the 
ruler 

Type: T to insert a tab stop 
Sprint displays the T you just entered and sets a tab at this location. To 
delete the tab at column 5, move to this column and press Del. 
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4. Enter the first line of text in two columns. To do this, move your cursor 
down to the next line after the ruler. Start to type the text, using the Tab 
key to move from the first column to the second: 

Type: 10% 
Press: Tab 
Type: $650.00 deposit due upon acceptance of this proposal. 

Your line should look like this: 
10% $650.00 deposit due upon acceptance of this proposal 

5. Now insert a blank line: 

Press: Enter twice 
6. Enter the rest of the COST ESTIMATE section in two columns. Press Tab 

after each percentage figure and press Enter twice at the end of each line: 

Type: 40% 
Press: Tab 
Type: $2600.00 due at time of measurement. 
Press: Enter twice 
Type: 40% 
Press: Tab 
Type: $2600.00 due at time of installation. 
Press: Enter twice 
Type: 10% 
Press: Tab 
Type: $650.00 due at job completion. 
Press: Enter twice 

7. Now save your file to disk. Choose File/Save from the main menu: 

Press: F10 FS 
Tip: You can also use the shortcut Ctrl-F2. 

Summary of Lesson 5 

In Lesson 5, you entered text in two columns using tab stops you set on the 
ruler line. 
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The following table summarizes the tasks presented in Lesson 5: 

Task 

Insert a ruler 

Set a tab stop 

Enter two-column text 

Table 4.8: Tasks in Lesson 5 

Action 

Place your cursor just above the text you want to 
be affected by a new ruler and choose Layoutl 
Ruler I Insert from the main menu (or press Alt-R). 

Stay inside the highlighted ruler if you've just 
inserted.one (or press Alt-A if you've left the ruler 
and it's not highlighted anymore). Type a T at the 
column position on the ruIer where you want a 
tab stop. 

Set a tab stop, then type the text of the first 
column; press Tab to get to the next column, then 
type the text of the second column. 

This completes Lesson 5. Go on to Lesson 6 for an overview of Sprint's 
block operations, and the commands you'll need to move text from one 
place to another and change the typestyle of existing text. 

Lesson 6: Selecting a Block and Block 
Commands 

Some Sprint commands affect a block-an area of text-that you select. A 
block can be a single character, or any number of words, lines, sentences, or 
paragraphs, or even an entire file. Selecting a block is like using a high­
lighter pen: You draw attention to the text you want to affect so that it can 
be easily identified. Once a block is selected, you can choose from a number 
of Sprint commands. For example, you can 

• move it anywhere in the file (by selecting it, moving it to Sprint's Clip­
board, and then pasting it wherever you choose) 

• move it to another file 
• change the typestyle of the block when it prints by choosing any com­

mand on the Typestyle menu (bold, italic, underline, etc., or any combi­
nation) 

• delete it 
• copy it anywhere without moving it from its current location 
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Block Select Commands 

You can find the commands you need to select a block of text on the Edit/ 
Block Select Menu (Figure 4.5). 

r:rri!spri nt 
File Alt-F 

dit nan " •• 
< 
INSTRUCTIONS and RECOMMENDATIONS< 
< 
Remove all wall hangings and fragile objec 
responsible for damages.< 
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;f;~'U:'·;J;\\U:1II\IIPIU;JI'N·~1i'.1U; Ins 11:37am 

Figure 4.5: The Block Select Menu 

There are two ways to select a block of text: 

Insert Alt-I 
Typestyle Alt-T 
Style Alt-S 
Layout Alt-L 

Print Alt-P 
Window Alt-W 
Utilities Alt-U 
Customize Alt-C 

Quit Alt-Q 

-, .. ' 

1. Choose Edit from the main menu, then choose Block Select: 

Press: F10 fB 

o 

Then select the Word, Line, Sentence, or Paragraph commands to mark 
a particular word, line, sentence, or paragraph. Sprint will highlight the 
text you select. 

Press: W, L, 8, or P 
This method is useful for instantly marking the text you want to select 
as a block when your cursor is placed anywhere within the desired 
block. 

2. Move the cursor to the beginning or end of the desired block and then 
choose the Turn Select Mode command from the Edit/Block Select 
menu (or use the shortcut F3 when no menus are displayed). As you 
move the cursor to the opposite end of the block (using the arrow keys), 
Sprint changes the attribute of the text you are selecting; if you have a 
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monochrome monitor, the text will appear in reverse video; on a color 
monitor, it will appear in a different color. 

Once you mark a block, you can choose a block command from the Edit 
menu to affect the text. See Table 4.9 for the Edit commands that work with 
selected blocks. 

Before you start using these block commands, you should be familiar with 
the concept of Sprint's Clipboard. This is a temporary holding tank for text 
that you select and then move or copy. For instance, when you select a 
block and then choose Edit/Move-Cut, Sprint removes the block from the 
screen and places it in the Clipboard. Once you move the cursor to where 
you want this text to appear, you can choose the Insert-Paste command (or 
press F6), which copies the Clipboard text to the current cursor position. 
The block remains in the Clipboard until you replace it with new text. This 
means you can paste text from the Clipboard into a variety of files or use it 
to make many copies of the same text, but once you enter a command that 
puts text in the Clipboard (like Move-Cut or Copy), you delete what's cur­
rently there. Therefore, it's important to quickly paste text that you moved 
or copied to the Clipboard. 

Table 4.9: Block Commands on the Edit Menu 

Command Shortcut Description 

Undelete Ctrl-U 

Copy F4 

Move-Cut F5 or Del 

Insert-Paste F6 

Block Select 

Allows you to recover a block you have deleted using 
any of the deletion commands (including Move-Cut 
and the Del key), as long as nothing has subsequently 
been moved to the ClifDoard. The "undeleted" text is 
reinserted in its origina location. 

Leaves the text in its current location and also puts a 
coPy of it in Sprint's CliI'board. You can later retrieve 
thIS text by using the EClit/Insert-Paste command or 
pressing the Ins key. 

Removes the text from its current location and places it 
in Sprint's Clipboard. You can retrieve this text by 
using the Edit/Insert-Paste command or pressing the 
Ins key. 

Places the block that is currently in the Clipboard at the 
current cursor position. 

Displays the Block Select menu (see Figure 4.5). 

In addition to using these block commands once your text is selected, you 
can also choose a typestyle command (such as bold) to change the style of 
the text. 
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The following practice session explains how to select text that you want to 
move to a different place in your file. You will also select text so that you 
can change its typestyle. 

Practice 

In this practice session, you will move the COST ESTIMATE section from its 
present location (see Figure 4.6) to a new position between the TIME 
ESTIMATE section and the INSTRUCTIONS and RECOMMENDATIONS 
section. You will also select the sentence We are not responsible for damages 
and change it to a bold typestyle for emphasis. 

Moving a Block 

Figure 4.6 shows the way the file should look at this point. 
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+ ----------------------------------------------------------------------------- + 
[ T 1 2 3 4 5 6]L 7 
+ ----------------------------------------------------------------------------- + 

KITCHEN PROPOSAL 

TASK 

Remove the existing cabinets and frames. 

Construct new 3/4" face frames. 

Build replacement cabinets, using standard 3/4" birch and 1/4" 
oak veneer facing. 

Apply stain number 531 and satin finish. 

Install the new cabinets. 

TIME ESTIMATE 

A job this size typically requires three to four working days. 
If we start on Monday, June 30, we should be able to complete 
the job by Thursday, July 3. Our contractors will arrive at 
approximately 9:00 a.m. each day and will work until 4:00 p.m. 

INSTRUCTIONS and RECOMMENDATIONS 

Remove all wall hangings and fragile objects. We are not respon­
sible for damages. 

Plan to be without a kitchen for 5 days. 

Since your kitchen cannot be completely closed off from your 
dining room, cover the dining room furniture with an adequate 
dropcloth. This job will generate quite a bit of fine dust. 

Remove the contents of all existing cabinets and place them in 
another room. 

Make arrangements to be at the house on the job's starting and 
ending days. During the remaining days, you may provide instruc­
tions for entry in your absence. 

COST ESTIMATE 

The cost to perform the task listed above is $6,500.00, due and 
payable as follows: 

+ ------------... -------... _------.. ---------..;-------------------------------------- + 
[ T 2 3 4 5 6 Jt 7 
+ -------------------------------------,,;--------------------------------------- + 
10% $650.00 deposit due upon acceptance of this proposal. 

40% $2600.00 due at time of measurement. 

40% $2600.00 due at time of installation. 

10% $650.00 due at job completion. 

Figure 4.6: The COST ESTIMATE Block Before the Move 

To select the COST ESTIMATE section as a block: 

1. Place the cursor at the beginning of the block you want to select-the 
COST ESTIMATE section. You could use the arrow keys, but try using 
the shortcut for the Edit/Find command: 
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Press: F7 (the shortcut for the Find command) 

Sprint prompts Forward search: 

2. To search for the words COST ESTIMATE: 
Type: COST ESTIMATE (in either uppercase or lowercase) on the 

status line 
Press: Enter 

Sprint moves the cursor to the line containing these words. 
3. Choose Line to highlight the whole line without moving your cursor: 

Press: F10 EBL to choose Edit/Block Select/Line 
Sprint highlights the selected line; you are still in select mode and can 
continue to mark the block you want to select. 

4. Move the cursor to the end of the COST ESTIMATE section: 

Press: Ctr/-PgDn to move to the end of the file 

The entire block from the C in COST ESTIMATE to the last period after the 
word completion (including the ruler line) should now be highlighted. 

To move the COST ESTIMATE SECTION: 

You now want to move this marked section of text from its current location 
and paste it between the TIME ESTIMATE and INSTRUCTIONS and 
RECOMMENDATIONS sections. 

1. Choose Edit/Move-Cut from the main menu: 

Press: F10 EM to choose Move-Cut 

Tip: The shortcut for Edit/Move-Cut is F5 or De/. 
Sprint cuts (moves) the text from the screen. 

2. Using the arrow keys, move the cursor to the blank line above the 
INSTRUCTIONS and RECOMMENDATIONS heading. This is where 
you want to insert (paste) the text you moved. 

3. Choose Edit/Insert-Paste from the main menu: 

Press: F10 EI for Edit/Insert-Paste 

Tip: The shortcut for Edit/Insert-Paste is F6. 
Sprint pastes the COST ESTIMATE text and its ruler line (created in 
Lesson 5) into its new position in the file, as shown in Figure 4.7. 
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+ ----------------------------------------------------------------------------- + 
[ T 1 2 3 4 5 6)L 7 
+ ----------------------------------------------------------------------------- + 

KITCHEN PROPOSAL 

TASK 

Remove the existing cabinets and frames. 

Construct new 3/4" face frames. 

Build replacement cabinets, using standard 3/4" birch and 1/4" 
oak veneer facing. 

Apply stain number 531 and satin finish. 

Install the new cabinets. 

TIME ESTIMATE 

A job this size typically requires three to four working days. 
If we start on Monday, June 30, we should be able to complete 
the jot) by Thursday, July 3. Our contractors will arrive at 
approximately 9:00 a.m. each day and will work until 4:00 p.m. 

INSTRUCTIONS and RECOMMENDATIONS 

Remove all wall hangings and fragile objects. We are not respon­
sible for damages. 

Plan to be without a kitchen for 5 days. 

Since your kitchen cannot be completely closed off from your 
dining room, cover the dining room furniture with an adequate 
dropcloth. This job will generate quite a bit of fine dust. 

Remove the contents of all existing cabinets and place them in 
another room. 

Make arrangements to be at the house on the job's starting and 
ending days. During the remaining days, you may provide instruc­
tions for entry in your absence. 

Figure 4.7: The COST ESTIMATE Block After the Move 

Remember to insert a new default ruler line below the text you just 
inserted. Make sure your cursor is on the line preceding the 
INSTRUCTION and RECOMMENDATIONS heading; choose Layout/ 
Ruler /Insert from the main menu: 

Press: F10 LRI (or use the shortcut Alt-R) 

Note: If you were overzealous and pressed F6 after entering the Insert­
Paste command, you'll notice that you now have two COST ESTIMATE 
sections. Sprint retains text in its Clipboard until you put new text there, 
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so it will paste the same block over and over each time you choose 
Insert-Paste (or press F6). 

Now that you have a little experience with selecting blocks of text, you're 
going to change the typestyle of one of the proposal's sentences, We are not 
responsible for damages. Right now it appears in normal text. To draw more 
attention to it (and possibly avoid future litigation), change it to bold type. 

Using Typestyles with Block Commands 

To change the typestyle of existing text to bold: 

1. Use the Find command to move the cursor to the sentence We are not 
responsible for damages: 

Press: F9 (the shortcut for the Edit/Find command 

Sprint prompts Search forward: 

Type: We are not (you don't need to type the entire sentence) 
Press: Enter 

Sprint moves the cursor to a position right after the word not on the line 
you want to select. 

2. Choose Edit/Block Select/Sentence from the main menu: 
Press: F10 EBS 

Sprint highlights the sentence. 
3. Do not copy or paste this block of text. Instead, choose Bold from the 

Typestyle menu: 
Press: F10 TB 

Sprint either highlights or changes the color of the text that has been 
changed to bold. The column number at the bottom right comer of the 
screen also changes to indicate the new typestyle. 

4. Finally, save your file to disk by choosing File/Save from the main 
menu: 

Press: F10 FS (or use the shortcut Ctrl-F2) 

Summary of Lesson 6 

In Lesson 6, you learned how to select a block of text and then move it to a 
different place in the file. You also changed the style of text that you 
selected as a block. 

Chapter 4, Quick Start Tutorial 79 



The following table summarizes the tasks presented in Lesson 6: 

Task 

Select a block 

Move a block 

Paste a block 

Table 4.10: Tasks in Lesson 6 

Action 

a. Choose Edit/Block Select from the main 
menu, then choose Word, Line, Sentence, or 
Paragraph, or 

b. Toggle Edit/Block Select/Turn Select Mode 
On, then move the cursor to select the block 
of text you want, or 

c. Press the shortcut F3 with no menus 
displayed, then move the cursor to select the 
block of text you want. 

a. Select a block, choose Edit/Move-Cut, then 
move the cursor to where you want the 
block to be and choose Edit/Insert-Paste, or 

b. Select a block, press F5, then move the 
cursor to where you want the block to be 
and press F6. 

Choose Edit/Insert-Paste or press F6. 

Find a string of text Press F7 and type the string at the Forward 
search prompt. 

Change a block's typestyle Select the block, then choose a command from 
the Typestyle menu. 

This completes Lesson 6. Go on to Lesson 7 to learn how to format lists 
(numbered, itemized with hyphens, and others). 

Lesson 7: Making Lists 

Sometimes, for clarity, parts of a document like PROPOSAL.SPR need to be 
organized into lists: series of items that are numbered or set off from the 
left margin by symbols (such as bullets or hyphens). When you select a 
block and choose a command from the Style/Lists menu (Figure 4.8), 
Sprint formats the block into a list for you. 
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< Sprint 
INSTRUCTIONS and RECOMMENDATIONS< File Alt-F 
< Edit Alt-E 
Remove all wall hangings and fragile objects. We are not 
responsible for damages.< Insert Alt-I 
< T~estyle Alt-T 
Plan to be without a kitchen for 5 days.< Styl • I'-Styl e A It-S 
< Center Layout Alt-L 
Since your kitchen cannot be completely closed Modify 
dining room. cover the dining room furniture wi 1-----1 Print Alt-P 
dropcloth. Thts job will generate quite a bit 0 Headings Window Alt-W 
< Lists IW, • Utilities Alt-U 
Remove the contents of all existin I.m •• lii· Customize Alt-C 
another room.< Numbered 
< Multi-level 
Make arrangements to be at the hou Description 

Table 
Figure 
PostScript 

1-----1 Index ending days. During the remaining 
instructions for entry in your abs Asterisks 
< Bullets 
< Hyphens 

References 
X-Reference 

COST ESTIMATE< ~---"""Other Format 
< 
The cost to perform the task listed above is $6.500.00. due and 
payable as follows:< 

R''''N:JI;J;"!~11;'''lltp;JIIN·'''''.'p· Ins 11:37am 

Figure 4.8: The Lists Menu 

Quit Alt-Q 

..•. - o 

One big advantage to letting Sprint organize your lists is that, if you want 
to insert a new item into a list or rearrange the existing items, you never 
have to renumber the items yourself (in the case of a numbered list) or 
insert any additional symbols. Also, nesting different levels of a list is easy 
with Sprint, which automatically changes the numbering system (for a 
numbered list) or the kind of symbol used (for a bulleted-type list) to indi­
cate the different levels of the list. 

With Sprint, you can create the following five types of lists: 

1. The Outline command creates an outline with standard numbering and 
lettering. 

2. The Numbered command automatically numbers each paragraph. 

3. The Asterisks command places an asterisk (*) at the beginning of each 
paragraph. 

4. The Bullets command places a lowercase 0 at the beginning of each 
paragraph. 

5. The Hyphens command places a hyphen (-) at the beginning of each 
paragraph. 

Note: If you have installed Sprint for a printer that can print actual bullet 
symbols (for example, • and • )-like a PostScript printer-it will 
automatically use. for asterisks and • for bullets. 
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The above list of commands available from the Style/Lists menu is itself an 
example of the Numbered command format. If this list were printed in a 
Bullets format, it would look like this: 

• The Numbered command automatically numbers each paragraph. 

• The Asterisks command places an asterisk (*) at the beginning of each 
paragraph. 

• The Bullets command places a bullet at the beginning of each 
paragraph. 

• The Hyphens command places a hyphen (-) at the beginning of each 
paragraph. 

In the following practice section, you will use the Hyphens and Numbered 
commands to format two lists in your proposal file. 

Practice 

During this practice session, you will create a list itemized with hyphens 
and a numbered list. The TASK section will contain a list of tasks broken 
down into separate items,each set off from the left margin by a hyphen. 
The INSTRUCTIONS and RECOMMENDATIONS section of the sample 
proposal will become a numbered list. 

To create a list itemized with hyphens: 

1. Using one of the techniques described on page 73, select the text of the 
TASK section. For example, using the arrow keys, move the cursor to 
the R in Remove and use the shortcut for Edit/Block Select/Turn Select 
Mode On: 

Press: F3 

Move the cursor to the end of the TASK section. The entire section 
should now appear in a different attribute or color. 

2. Now that you've selected the text, you can specify the Hyphens com­
mand. From the main menu, choose Style/Lists/Hyphens: 

Press: F10 5LH 
Press: Enter 

3. Sprint places a BEGIN HYPHENS command above the selected text, 
and an END HYPHENS command at the end of the text. When you 
print this file, each item in the TASK section will be preceded by a 
hyphen (see page 46 to see the finished result). 

You can apply what you have learned about lists itemized with hyphens to 
create a numbered list in this sample proposal. 

82 Sprint User's Guide 



To create a numbered list: 

1. Select the text contained in the INSTRUCTIONS and RECOMMENDA­
TIONS section. (See Step 1 of the previous instructions for how to select 
a block of text.) 

2. From the main menu, choose Style/Lists: 
Press: F10 SL 

3. Since you want this to be a numbered list, choose the Numbered format 
command: 

Press: N for a Numbered list format 
Press: Enter 

4. Sprint places the BEGIN and END NUMBERED commands around the 
selected block of text. When you print this sample proposal in the next 
lesson, Sprint will automatically number the items between these two 
commands. 

Tip: If you have a paragraph you don't want numbered within the list, precede 
it with a tab. 
(N ote: The instructions for these practice sessions were created with 
Sprint's Numbered command format.) 

Your file should like Figure 4.9 at this point . 
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+ ----------------------------------------------------------------------------- + 
[ T 1 2 3 4 5 6]L 7 
+ ----------------------------------------------------------------------------- + 

KITCHEN PROPOSAL 

TASK 

BEGIN HYPHENS 
Remove the existing cabinets and frames. 

Construct new 3/4" face frames. 

Build replacement cabinets, using standard 3/4" birch and 1/4" 
oak veneer facing. 

Apply stain number 531 and satin finish. 

Install the new cabinets. 
END HYPHENS 

TIME ESTIMATE 

A job this size typically requires three to four working days. 
If we start on Monday, June 30, we should be able to complete 
the job by Thursday, July 3. Our contractors will arrive at 
approximately 9:00 a.m. each day and will work until 4:00 p.m. 

COST ESTIMATE 

The cost to perform the task listed above is $6,500.00, due and 
payable as follows: 

+ ----------------------------------------------------------------------------- + 
[ T 2. 3 4 5 6]L 7 
+ ----------------------------------------------------------------------------- + 
10% $650.00 deposit due upon acceptance of this proposal. 

40% $2600.00 due at time of measurement. 

40% $2600.00 due at time of installation. 

10% $650.00 due at job completion. 

+ ----------------------------------------------------------------------------- + 
[ T 1 2 3 4 5 6]L 7 
+ ----------------------------------------------------------------------------- + 

INSTRUCTIONS and RECOMMENDATIONS 

BEGIN NUMBERED 
Remove all wall hangings and fragile objects. We are not respon­
sible for damages. 

Plan to be without a kitchen for 5 days. 

Since your kitchen cannot be completely closed off from your 
dining room, cover the dining room furniture with an adequate 
dropcloth. This job will generate quite a bit of fine dust. 

Remove the contents of all existing cabinets and place them in 
another room. 

Make arrangements to be at the house on the job's starting and 
ending days. During the remaining days, you may provide instruc­
tions for entry in your absence. 
END NUMBERED 

Figure 4.9: The Proposal with List Formats Added 

5. Now save your file to disk by pressing Ctrl-F2. 
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Summary of Lesson 7 

In Lesson 7, you created two kinds of list formats in your proposal: one 
itemized with hyphens and one numbered. 

The following table summarizes the tasks presented in Lesson 7: 

Table 4.11: Tasks in Lesson 7 

Task Action 

Choose a list format Select the block you want to format as a list. 
Choose Style/LIsts from the main menu, then 
choose a list format command from those offered 
on the Lists menu. 

This is the end of Lesson 7. Go on to Lesson 8 for an overview of Sprint's 
print options and the commands you'll need to print your proposal and 
letter files. 

Lesson 8: Printing a File 

To print one copy of your file on your default printer, simply choose Go 
from the Print menu. If you want to print more than one copy, or only 
certain pages, you need to choose Options from the Print menu. If you 
want to print the file on an alternate printer, choose Current Printer from 
the Print menu; you will see a list of available printers from which to 
choose. In this tutorial, you'll be printing two copies of the letter and 
proposal files on the default printer. 

Practice 

You are now ready to preview and then print your sample proposal and 
letter files. Before you do this, make sure you have used the SP-SETUP 
program to install Sprint for use with your printer. Page 10 of Chapter 1, 
"Before You Begin," explains how to use SP-SETUP to install Sprint. 

To print the file PROPOSAL.SPR: 

1. Choose Print from the main menu. 

Press: F10 P to choose the Print menu 
Tip: The shortcut for the Print menu is Alt-P. 

2. Choose Paginate to see where Sprint is going to break the pages of the 
proposal. 
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Press: P to choose Paginate 

Tip: You can use the shortcut Ctrl-F7 for the Print/Paginate command (when no 
menu are displayed). 
Note: When you choose Print/Paginate, Sprint formats the proposal file 
as if it were going to print it on your printer. Then, instead of printing 
the file, it inserts a horizontal line in your file to tell you where each new 
page will start. 
Also Note: If you move through the proposal file, you will see only one 
bold line at the top of the file. This means your file text is going to fit on 
a single page. 

3. Remove the bold page-break line from your file by choosing Print/ 
Remove Formatter Page Breaks: 

Press: F10 PR 
Note: You don't have to choose Paginate and Remove Formatter Page 
Breaks each time you want to print a file. We use them here so you will 
be familiar with these features. 

4. Now you're ready to print. Display the Print menu again and choose 
Options: 
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Press: F10 PO to display the Options menu (Figure 4.10) 

< 
INSTRUCTIONS and RECOMMENDATIONS< 
< 
Remove all wall hangings and fragile objects. We are not 
responsible for damages.< 
< 
Plan to be without a kitchen for 5 days.< 
< 

Sprint 
File Alt-F 
Edit Alt-E 

Insert Alt-I 
Typestyle Alt-T 
Style Alt-S 
Layout Alt-L 

Since your kitchen cannot be completely closed, IO~f~f~f~rO~m~y~o~u~r~jiiiiiiil 
dining room, cover the d Print- liIIIiJ ·P •• 
dropcloth. This job will Go! Wifl{fow Alt-W 
< Destination PRINTER Utilities Alt-U 
Remove the contents of a Screen Preview Ctl-F8 Customize Alt-C 
another room.< 
< Merge Quit Alt-Q 
Make arrangements to be Paginate Ctl-F7 1--------1 
ending days. During the Remove Formatter Page Breaks 
instructions for entry i 1-------------1 

~ons iii 
., ... " •• ,. • avanced Opti ons 

Enafng Page L~ST urrent Printer [DEFAULT] I 

ptlOns 

Number of Copies 1 k listed above is $6,500.00, due and 
Pause Between Pages NO 

AL.SPR Ins 11:37am Ln.34 of 47 I 

Figure 4.10: The Print Options Menu 
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You can see from the Options menu that, by default, Sprint will print 
one copy of your formatted file, starting with page 1, and ending with 
the last page of your file. 

5. Print two copies of the proposal file by choosing Number of Copies and 
specifying 1/2" at the Number of Copies: prompt: 

Press: N to choose Number of Copies 

Sprint prompts Number of Copies: 

Type: 2 to override the "1" default 
Press: Enter 

6. Since that is the only print option you're going to choose, go back to the 
Print menu: 

Press: Esc once 

7. Now choose Go from the Print menu: 

Press: G to choose Go 

Sprint displays this message: 
Formatting PROPOSAL.SPR for PrinterName. 
PROPOSAL.SPR line 2 page 1. 

(PrinterName stands for the name of your printer.) 

If there are no formatting errors in your file, Sprint automatically begins 
printing the file. 

If Sprint finds one or more formatting errors, it displays error messages 
on the screen to indicate the problem. Formatting error messages con­
tain the name of the file in which the error occurs, the type of error, and 
the number of the line on which the error occurs. You can edit the file(s) 
listed in the message(s), fix the problem(s), and then enter your print 
command again. 

Sprint only prints a file when it no longer detects any formatting errors 
in your text. For more information on printing and errors during 
printing, refer to Chapter 9. 

If necessary, correct any errors that Sprint finds (there shouldn't be any, 
but no one's perfect) and choose Print/Go again. 

8. Look at the printed copy of the proposal. If you want to change any­
thing, go ahead and edit the file, and then reprint your proposal. 

Now let's print the letter file you created in Lesson 1. 

To print the file LEITER.SPR: 

1. Choose File/ Open from the main menu: 

Press: F10 FO to open a file (or use Ctrl-F3) 
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Sprint prompts File to open: 

2. Specify the file LETTER.SPR: 
Type: LETTER (Sprint automatically adds the default file exten­

sion .SPR) 
Press: Enter 

3. If you want to print more than one copy of the letter, choose Print/ 
Options, then choose Number of Copies and type the number of copies 
you want at the Number of Copies: prompt on the status line. 

4. You can, at this point, preview the formatted file on your screen. If you 
want to do this, choose Screen Preview from the Print menu: 

Press: F10 PS (or use the shortcut etrl-FB) 
Press any key to scroll between each page of previewed text. When 
Sprint has displayed the whole file, it will return to your original file. 
Note: If your currently selected printer supports proportional 
spacing-like a PostScript printer, for example-the output of a screen 
preview will look strange. The reason is that your screen can't display 
literally what your printer is capable of printing. With proportionally 
spaced fonts, not all characters are the same width; when Sprint tries to 
display proportionally spaced output on your screen, as if it were 
sending it to your PostScript printer, you'll see characters overwriting 
each other (they look squeezed together, and some letters seem to be 
missing). Don't worry; this won't be the case when your file is printed. 

5. If you don't want to set any more print options, choose Print/Go from 
the main menu and send the letter to the printer: 

Press: F10 PG 
If there are no formatting errors in your file, Sprint automatically begins 
printing the file. 

Summary of Lesson 8 

In Lesson 8, you previewed where Sprint was going to break the pages in 
you proposal file and removed the formatter page breaks when you found 
out that the proposal was no longer than one page. You also specified that 
you wanted to print two copies of the proposal, and then sent it to your 
printer. Finally, you printed one copy of the letter file. 
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The following table summarizes the tasks presented in Lesson 8: 

Table 4.12: Tasks in Lesson 8 

Task Action 

Choose the Print menu 

Paginate 

Press Alt-P or choose Print from the main menu. 

Press Ctrl-F7 or choose Paginate from the Print 
menu. 

Remove page breaks Choose Remove Formatter Page Breaks from the 
Print menu. 

Print multiple copies Choose Options from the Print menu. Choose 
the Number of Copies command. Respond to 
the prompt on the status line by typing the 
number of copies you want to print. 

Preview the file onscreen Choose Screen Preview from the Print menu. 

Print the file Choose Go from the Print menu. 

This completes Lesson 8. Go on to Lesson 9 for instructions on how to leave 
Sprint. 

Lesson 9: Switching User Interfaces and 
Quitting Sprint 

When you no longer want to create or edit files, you can choose Quit from 
the main menu. 

If you have made changes to any open files and not saved the changes to 
disk, Sprint will display each unsaved file on the screen and prompt: 

The file filename has not been saved; save it? (Y,N,Esc) 

If you type N, Sprint exits without saving your file. If you type Y, Sprint will 
save the file and then exit. 

Tip: If you decide you don't want to exit, press Esc to return to your file. 

Sprint automatically creates a backup file whenever you start Sprint; every 
time you open a file or make a change, Sprint records it in that backup file. 
If the power ever fails while you're working, don't worry. All the changes 
you made since the last save command (except for the last 3 seconds) are 
there in the backup file, and can be retrieved immediately when the power 
resumes and you restart Sprint. 
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If you want to have all the files you opened in the last editing session there, 
ready to work on, each time you start Sprint, be sure the Preserve Editing 
Session option on the Customize/Options menu is set to Yes (the default). 
See "The Automatic Backup File" in Chapter 7 for information on this com­
mand; it's not available in the TUTORIAL version of the user interface. 

Practice 

At this pOint, you can continue practicing with Sprint commands, or you 
can leave Sprint and return to the DOS prompt. First, however, you need to 
switch user interfaces from tutorial to basic, which is the user interface you 
will use as you work through the rest of this book. 

To switch to the basic user interface and exit to DOS: 

1. Choose Customize/User Interface/Load from the main menu: 

Press: F10 CUL 
Note to two-floppy system users: If you insert the disk that contains 
your alternate user interfaces and you see SPBASIC listed when you 
choose Customize/User Interface/Load, you can load the basic user 
interface now. If SPBASIC is not listed, you must run SP-SETUP again 
and choose the SPBASIC user interface as your default. 

2. Choose the basic user interface: 

Press: B 
Press: Enter 

This loads the basic user interface. 

3. When you are ready to leave Sprint, choose Quit from the main menu: 

Press: F10 Q to choose Quit 

If you made changes to the file after you last saved it, Sprint prompts 

The file filename has not been saved; save it? (Y,N,Esc) 

4. If you want to save the changes you've made, press Y. Sprint will save 
the file and then exit to DOS. If you want to exit without saving your 
changes, press N. Sprint returns you to the DOS prompt. 

Summary of Lesson 9 

In Lesson 9, you loaded the basic user interface that you need to work with 
in the rest of this book and quit Sprint. 
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The following table summarizes the tasks presented in Lesson 9: 

Table 4.13: Tasks in Lesson 9 

Task Action 

Switch user interfaces Choose Customize/User Interface/Load from 
the main menu and choose the interface you 
want from the list. Press Enterto load the new 
interface. (Two-floppy system users: You cannot 
use this command unless you first insert the 
disk-created with SP-SETUP-that contains the 
user interface you want to load. If the user 
interface you want is not listed when you press 
F10 CUL, you have to run SP-SETUP again and 
choose tnat user interface as your default.) 

Quit Sprint Choose Quit from the main menu or press Alt-Q. 

Summary 

Now that you're familiar with how to move around in Sprint's menus and 
how to use shortcuts and basic movement commands, go on to the rest of 
this book (and then the Advanced User's Guide) for information on some of 
the more advanced menu choices; these include powerful formatting com­
mands for customizing your documents further and useful features like 
cross-referencing, windows, and spell-checking. 

Before you go, you might like to experiment with some of the techniques 
you learned in Quick Start. Practice opening new files, entering text, 
changing the typestyles and ruler settings, and then print them out to check 
your results. Have fun! 
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c H A p T E R 

5 

Sprint Overview 

This chapter briefly explains Sprint's features and functions and introduces 
the editor and the formatter. In this chapter you'll learn about the various 
ways you can use the Sprint editor and formatter, and get an idea of how 
Sprint works to create, edit, and professionally print your files. You'll also 
find out about Sprint's standard user interface, the menus, and special 
shortcut keys. 

This chapter provides general information only. For specific details about 
Sprint's user interface and how to create, edit, format, and print files, refer 
to the remaining chapters of this manual. 

Sprint's Editor and Formatter 

Sprint is a powerful word processor that combines an easy-to-use interface 
with comprehensive formatting capabilities. With Sprint, you can quickly 
create and modify letters, memos, and reports, as well as lengthy docu­
ments and books. Sprint supports a wide variety of printers-laser, dot 
matrix, and daisy wheel-as well as several typesetters. This means you 
can get typesetquality documents when you create and print files with 
Sprint. 

Sprint is made up of two functional parts: the editor, which you use to enter 
and modify text, and the formatter, which arranges (and then prints) your 
text according to the commands you entered with the editor. 
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Figure 5.1: Sprint's Editor and Formatter 
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When you're creating files and editing them on the screen, you're using the 
editor. Sprint's editor lets you 

• Create new files. 
• Open and close existing files. 
• Insert, delete, and change text. 
• Choose editing commands that immediately affect text, and formatting 

commands that affect text when you print. 

• Mark, move, and copy text. 
• Use windows to display multiple files at once or different parts of the 

same file. 

• Check spelling, hyphenate words, and get synonyms for words. 
• Convert files created with another program to Sprint format, and write 

Sprint files to another format (for exchanging files with a different word 
processor). 

• Select, modify, and customize the way Sprint's editor displays your text 
and formatting commands. You can choose from three pre configured 
color sets (including one specifically designed for monochrome moni­
tors), and then modify / customize the one you choose. If you have a color 
monitor, you can select from over 200 alternate colors. 

Chapter 6, "Editing: Tips, Tricks and Techniques," explains many of these 
editing features. 

The editor also has a built-in crash-recovery feature, and lets you specify 
how often Sprint should save the changes and additions you make during 
an editing session. 

The formatter comes into play when you're ready to print a Sprint file. 
When you tell Sprint to print your file, the formatter reads your file, 
interprets the formatting commands you've entered with the editor, and 
then prints the formatted file. Formatting commands enhance the 
appearance and layout of your text and include such features as: 

• extensive page layout and document style commands 

• multiple-line headings and footings 
• variable fonts and typefaces 

• predefined formats 
• footnotes and endnotes 

• figures and tables 
• automatic cross-references 

• a variety of indexing commands 
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• multi-level sectioning commands that automatically create a table of 
contents 

When you're entering and viewing text on the screen, it is important to 
keep the editor/formatter distinction in mind. Many of Sprint's formatting 
functions aren't performed until you print your file. While working with 
the editor, you can set and display the basics: left and right margins, para­
graph indents, and tabs. You can also specify how your text should be 
aligned (centered or justified at the left margin, at the right margin, or at 
both margins). Sprint's real formatting power, however,lies in the formatter. 
You enter formatting commands with the editor, and Sprint will either 
display the command text or show the text affected by the command in a 
different way (for example, highlighted or in a different color). Remember, 
though, that you won't see the result of a formatting command until you 
print the file or preview your formatted text onscreen. 

Automatic Backup and Crash Recovery 

Like other word-processing packages, Sprint has a Save command that lets 
you save your text changes to disk without having to exit the file. However, 
some of us aren't as diligent about saving files as we should be. One split­
second power failure can, with some word-processing packages, mean 
hours of work lost. With Sprint, you no longer need to worry about power 
loss or computer failure. Sprint, of course, doesn't eliminate these 
situations, but it does protect your open files when failures occur. 
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Figure 5.2: Sprint's Automatic Backup 
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Sprint automatically creates a swap (backup) file called SP.SWP. The file is 
automatically updated with your changes as you edit. In the event of a 
power failure, your text is safe and can be retrieved as soon as power 
resumes. You simply restart Sprint and continue where you left off. The 
most you can lose depends on how much you typed since the last three­
second pause. In other words, not much (unless your fingers never pause). 
Chapter 7, uWorking with Files," explains the backup file in greater detail. 

Menus, Commands, and Predefined Keys 

There are a variety of ways to take advantage of Sprint's editing and 
formatting capabilities. You can 

• choose commands from Sprint's pop-up menus 
• press special ushortcut" keys to move the cursor, edit your text, or use a 

menu command without displaying any menus 

• define your own keystrokes to perform any number of wordprocessing 
functions 

Sprint's pop-up menus are an easy way to use this system. You pick the 
action you want to take from a menu displayed on the screen, and Sprint 
performs the function. 
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Shortcuts let you bypass the menu system. Many of the control keys 
emulate those you may have used with other word processors. For 
example, with Sprint's standard user interface, Ctrl-Y deletes a line, Ctrl-T 
deletes a word, and Ctrl-L searches for the next occurrence of a search string. 
Sprint's function keys are designed to provide quick access to file- and 
window-related commands, and also provide single keystroke access to a 
variety of menus used to format text. 

A quick reference to all shortcuts can be found on the Quick Reference 
Card. If you're using one of the alternative user interfaces, see the 
Alternative User Interfaces booklet for details on the shortcuts that apply to 
you. 

Although some shortcuts are predefined, you can always change them. If 
you're accustomed to a key performing a particular function, and that key 
doesn't work the same way with Sprint, you can redefine the key to have 
the meaning it had before. For example, you might want Ctrl-B to print your 
text in bold type rather than refresh the screen. See Chapter 6, "Editing: 
Tips, Tricks and Techniques," for details. 

Sprint's User Interface 

A user interface is the way a program responds to the commands you give it, 
and how it acts when performing its various functions. Sprint's user 
interface is based on an extensive set of pop-up menus that allow you to 
perform all Sprint's editing and formatting functions. 

Sprint supports several user interfaces: 

1. Its standard interface (tutorial, basic, and advanced versions), which 
includes many editing features and commands that are similar to 
WordStar. If you know Borland's SideKick or Turbo Pascal editor, you 
won't have any trouble with Sprint's basic editing commands. The 
tutorial user interface (SPTUTOR.UI) is designed to be used when you 
are first learning Sprint, in conjunction with the Quick Start Tutorial in 
this manual. Other than in the Quick Start Tutorial, we assume 
throughout the Sprint documentation that you are using either the basic 
or advanced user interface. The basic user interface (SPBASIC. UI) is a 
subset of the advanced interface. The main difference between them is 
that the advanced user interface (SPADV.UI) offers more formatting 
commands and functions, and provides access to Sprint's macro 
language. 

2. A SideKick-like interface (SIDEKICK.UI), which behaves nearly identi­
cally to Borland's SideKick. 
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3. A Microsoft V\brd-type interface (MSWORD.UI), which works like many 
Microsoft Word editing features and commands. 

4. A WordPerfect-type interface (WORDPERF.UI), which works like many 
WordPerfect editing features and commands. 

5. A V\brdStar-type (Professional Release 4.0) interface (WORDSTAR.UI), 
which works like many WordStar editing features and commands. 

When you installed Sprint using the SP-SETUP program (described in 
Chapter 1, "Before You Begin"), you chose the user interface you wanted to 
use. You can, however, select a different user interface at any time, or even 
create your own interface with Sprint's macro functions. 

Note to two-floppy system users: Make sure you insert the disk that 
contains the user interface you want to load before you choose Customize/ 
User Interface/Load command. Unless see the user interface you want 
listed when you choose Customize/User Interface/Load command, you 
must run SP~SETUP again to choose a different user interface as your 
default. 

For the most part, this manual explains the functions and features of 
Sprint's standard user interface. The Alternative User Interfaces booklet 
discusses Sprint's different user interfaces and provides a quick-reference 
comparison of Sprint commands and those used by other word-processing 
packages. 

Status Line 

Once you start Sprint, you will see a highlighted line of text at the bottom 
of your screen. This is called the status line, and displays information about 
the file you are editing. Figure 5.3 shows a sample status line. 

Chapter 5, Sprint Overview 101 



File name & path Select mode Insert mode Line # T <tal lines 

C:\DIRECTORY\filename.ext * Sel Ins Col 10:07am Ln. 13 of 59 Pg.1 Ln.13 143 

File not saved Column mode Time Page Line on page Column # 

Figure 5.3: Status Line 

The status line contains the following information: 

• the name of your file and file path (or [Unnamed]) 

• a message that, if present, indicates Sprint is in select mode (Sel); that is, if 
Sel is displayed, then the text is being selected (marked) 

• a message telling whether Sprint is in Insert mode (Ins)-the default-or 
Overwrite mode (Ovr) 

• a message that, if present, indicates Sprint is in Column mode 

• the time of day 
• the current cursor position (line number) 

• the total number of lines on the file 
• the current page number in the actual document (if the file has been 

paginated) 

• the current line on the page in the actual document (if the file has been 
paginated); if the file hasn't been paginated, the line number relative to 
the total lines in the document 

• the current cursor position (column number); also, if the text at that 
cursor position is changed to a particular typestyle, then the column 
number displays in the same text attribute-bold, underlined, and so 
on-as the text 

If you have made changes to the file but haven't saved them, Sprint also 
displays an asterisk (*) after the file name. If you have copied text to the 
Clipboard but have not moved your cursor, Sprint displays a plus (+) sign 
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to signify that items moved to the Clipboard will be appended to the current 
contents. 

Sprint also displays prompts and error messages on the status line. When 
you enter a command that requires additional information, Sprint removes 
the file-related information from the status line, and displays its prompt. 
For example, Sprint displays the following prompt when you choose the 
Write As command: 

Write file as: 

Once you enter the required information, Sprint removes the prompt and 
displays the file information described above. 

Pop-Up Menus 

Pop-up menus are an easy way to access Sprint's editing and formatting 
functions. Once you type sp to start Sprint, you can press function key F10 
to display Sprint's main menu. This menu, illustrated in Figure 5.4, displays 
a list of Sprint's major functions. 

Pop-up menus are an easy way to access Sprint's editing and a Sprint 
fonnatting functions. Once you type SP to start Sprint, you c '0 rtI' 
press function ke~ to display Sprfnt's main menu. This me EOlt Alt-E 
illustrated in Fi9trei:lli"ijilJl,diifljj, displays a hst of Sprintl------I 
major functions.< Insert Alt-I 
Just press F10.< Typestyle Alt-T 
< Style Alt-S 

< 

Layout Alt-L 

Print Alt-P 
Window Alt-W 
Utilities Alt-U 
Customize Alt-C 

The following section explains how to choose a conmand from tl------I 
and other Sprint menus.< 
< 
SECTION Chooslng a Menu Option 
< 
< 
There are three ways to choose a menu option:< 
< 

Quit Alt-Q 

1:, •• ,11"1"1-4< 
Press the @ Up} and @k{Down arrow} keys to move the cursor from 
o tion to 0 tion. Each time ou move to an 0 tion, S rint 

• • • • • • 

Figure 5.4: Main Menu 
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The following section explains how to choose a command from this and 
other Sprint menus. 

Choosing a Menu Option 

There are three ways to choose a menu option: 

• Press the Up and Down arrow keys to move the cursor from option to 
option. Each time you move to an option, Sprint highlights it. When 
Sprint highlights the option you want to choose, press Enter. 

• Press the Spacebar or Backspace key until Sprint highlights the desired 
option, and then press Enter. 

• Press the key corresponding to the highlighted first letter in the desired 
option (for example,press F for Files). 

Once you choose an option from the main menu, Sprint displays a second, 
more specific menu (sometimes called a submenu). For example, choosing 
File from the main menu causes Sprint to display the File menu. The File 
menu lists Sprint's file-related options. 
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Figure 5.5: File Menu 
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The only exception to this rule is the Quit command, which doesn't display 
a menu of options. Quit lets you leave Sprint and return to DOS. 

To choose a command from any of Sprint's menus, use one of the methods 
listed previously (either highlight and choose the option or press the key 
corresponding to the highlighted letter in the desired option). 

Some menu options are commands that tell Sprint to perform a particular 
function. For example, Save is a command listed on the File menu. When 
you choose this command, Sprint saves the current file to disk. 

Other menu options cause Sprint to prompt you for additional information. 
Still other menu options are commands that toggle a particular function 
(turn it off and on, or change it from one setting to another). Press Enter to 
perform the toggle, and then press Esc or Shift-Esc to exit the menus. For 
example, the Menu Shortcuts command, reached via the Customize menu 
(Figure 5.6), lets you toggle between displaying and not displaying menu 
shortcuts. 

Note to two-floppy system users: Your Program A Disk must be in Drive A 
when you choose Customize/Menu Shortcuts. 

Sprint print·the·file·or·preview·your·formatted·text·onscreen.< 
< File Alt-F 
SECTION-Automatlc-Backup-and-Crash-Recovery Edit Alt-E 
Like·other·word-processing·packages.·Sprint·has·a·Save·conunanl-------I 
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saving·files·as·we·should·be.·One·split-second·power·failure· Style Alt-S 
with·some·word-processing·packages.·mean·hours·of·work·lost.· Layout Alt-L 
Sprint.·you·no·longer·need·to·worry·about·power·loss·or·compul-------I 
failure.·Sprint.·of·course.·doesn't·eliminate·these·situation Print Alt-P 
but·it·does·protect·your·open·files·when·failures·occur.< Window Alt-W 
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ustomiz 
User Interface 
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retrieved·as·soon·as·power·resumes.·You· 
cont1nue·where·you·left·off.·The·most·yo 
much·you·typed·since·the·last·three-seco 
not'much'(unless'your'fingers'never'paus 
"Working'with' Fi lest "'explai ns ·the·backu Options 
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Colors 
Screen 

Quit 
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Menu Shortcuts YES s,' 

1.< 
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There·are·a·variety·of·ways·to·take·advantage·of·Sprint's'editing' 
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Figure 5.6: The Customize Menu 

Refer to the pull-out menu tree at the start of the Reference Guide for an 
overview of Sprint menus. 
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Getting Help 

Anytime you· need help with Sprint, just press F1 for information about 
whatever you're doing. Sprint will display a window explaining the menu 
item or function you're currently using. 

Note to two-floppy system users: If the help files are not on your Program 
A Disk, Sprint will prompt you to remove it and insert the disk that 
contains the files in its place. 

Responding to Sprint Prompts 

Some menu options cause Sprint to prompt you for additional information. 
Sprint displays these prompts on the status line at the bottom of the screen. 
For example, choosing Open from the File menu causes Sprint to display 
the prompt: 

File to open: 

With any Sprint prompt, once you enter the required information and press 
Enter, Sprint completes the command. If you choose this command again, 
Sprint repeats the prompt and also displays your last response (if appli­
cable). 

• If you want to repeat your previous response, press Enter. 
• If you want to change the response, use the Left and Right arrow keys to 

move the cursor to the desired location and then edit the response. 

• If you want to enter a completely different response, start typing. You'll 
notice that Sprint automatically erases your previous response as soon as 
you begin typing your new response. 

When Sprint prompts for a file name (as it does with the Open command), 
you can include the DOS wildcard characters (* and ?) in your file name. 
Sprint then displays a list of files from which to choose. This is especially 
useful when you can't remember the exact name of a file. For example, 

File to open: s*.txt 

tells Sprint to display all file names that begin with the letter s and end with 
the .TXT extension. Using the Up and Down arrow keys, choose the desired file 
from the list of files matching your search criteria, and press Enter to open 
that file. 

Note: Sprint allows you more extensive use of wildcards than DOS. You 
can use wildcards in cases such as * s .1 tr or * st * . ?bo in Sprint, even though 
such file searches would be illegal in DOS. 
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Changing Your Mind ("Un-Choosing" a Menu) 

If you choose the wrong menu option, or change your mind about choosing 
a command, you can do one of two things: 

• Press Esc to cancel the current selection. This releases you from the 
current command/menu selection but leaves any previous menus dis­
played on the screen. For example, if you display the main menu, and 
then the File menu, press Esc to leave the File menu. You can now make 
another selection from the main menu . 

• Press Shift-Esc to remove all displayed menus from the screen. Now you 
can start over. 

Both keystrokes release you from a command choice, no matter where you 
are in the command process (even when you are responding to a prompt 
on the status line). 

Multiple Files 

Sprint allows you to have up to 24 files open at one time. This means that 
you can be working on one file and open up to 23 additional files 
(anywhere on the disk), and work on them as well. As you open each file, 
Sprint copies the file's text and formatting commands to the swap file. 

@illrEID 

1 Select previous file 

I£lilllfID 
Select next file ! 

I£lilllEID Pick from a list of open files 

As you open new files, Sprint puts them on a 
"ring" in the order in which they were opened. 

Figure 5.7: Multiple Open Files 
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This also means you don't have to exit Sprint to access multiple files-as 
you open files, Sprint puts them on a sort of "ring" and lets you cycle 
through them with Ctrl-F5 (go to previous file), Ctrl-F6 (go to next file), and 
Ctrl-F9 (pick from list of files). This feature is especially useful for creating 
large documents like this manual. Each chapter can be contained in its own 
file, and you can work on several chapters at once. For example, you can 
move text from one file to another, or copy text from one file into another. 
When you have opened 24 files, or find it too clumsy to switch between 
many files, you simply close one or more of the open files. If you forget to 
save an open file to disk after you have made changes to it, Sprint auto­
matically prompts you to save the file before it acts on your Close com­
mand. For more information about opening, closing, editing, and saving 
files, see Chapter 7, "Working with Files." 

Note to two-floppy system users: Because the backup file (SP.SWP) on 
your Data Disk is a fixed-size one, it's a good idea to limit the number of 
files you keep open at anyone time. 

Multiple Windows 

Windows let you display either different parts of the same file or more than 
one file at a time. With Sprint, a single screen can contain up to six 
windows. 

When you open a window, Sprint splits the screen and shows your file in 
both windows. If you were editing a management report, for example, you 
might want to look at your findings and conclusions in one window, while 
working on the executive summary portion in another window. If you 
open another window, Sprint splits the current window (the one containing 
the cursor) in half, so you can scroll through the file and see three different 
parts of the same file. 

You can also use Sprint's windows to display more than one file on the 
screen at once. This is useful when you are working on large documents 
that are made up of more than one file. All you have to do is enter the com­
mand to open a file, and Sprint will place that file in the current ("active") 
window. Move the cursor to a different window, open another file, and 
Sprint displays that file in the current window. You can mark text in one 
window and move it to a file in another window, or copy information from 
one file to another. 

Sprint separates windows with a highlighted status line. You can always 
tell which window is "active" by looking for the window that contains the 
blinking cursor. Also, the active window's status line has full information 
(like time and line number), while the status lines of inactive windows have 
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the file name only. Figure S.S illustrates three windows, each containing a 
different file, with the bottommost window being the active one. 

features. Once you've installed Sprint for your computer syst Sprint 
there are a few guidelines you'll need to keep in mind from n 'II I Flle Alt-F 
on. These guidelines are listed shortly; you'll get more Ealt Alt-E 
information about the items listed as you work with Sprint an 1------1 
refer to this manual.< 
< 
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Insert Alt-I 
Typestyle Alt-T 
Style Alt-S 
Layout Alt-L 
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< 
< SPRECOVE-CREATE.< 
< 
... \RASPBERR USERGYD CHl.UG 

Print Alt-P 
Window Alt-W 
Utilities Alt-U 
Customize Alt-C 
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Figure 5.8: Three-Window Display 

Sprint always "keeps your place" in any window or file. That is, when you 
move between open windows and files, Sprint always returns you to where 
you were the last time you worked on that file. 

Printing Files 

Sprint supports a variety of printers and printer types, which means you 
can print your files on many kinds of dot-matrix, daisywheel, and laser 
printers, as well as several typesetters. Using Sprint's SP-SETUP program, 
you can select the printer or printers you will be using. 

As you create and edit documents, you can embellish them with the fancy 
fonts and typestyles supported by your final-copy printer. While you're 
producing draft copies on a less-capable printer, Sprint warns you when 
the printer can't print a certain font but prints the file anyway, to the best of 
your alternate printer's ability. 

Sprint's Print menu has a variety of options that allow you to 
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• print to the screen so you can preview the formatted text, or print to a 
disk file that can be printed later 

• print either the formatted or unformatted version of the file 

• print on an alternate printer 
• print form letters "merged" with a database of names, addresses, and 

other variable information 

• display where the page breaks will occur when a file is printed 

• remove those page break displays 
• choose several other options that let you print multiple copies, only 

certain pages, just the table of contents, and so forth 

Chapter 9 describes each of Sprint's print options. 
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c H A p T 

Editing: Tips, Tricks, and 
TechnIques 

E R 

6 

This chapter provides information about word processing with the Sprint 
editor. As mentioned elsewhere in this manual, Sprint really consists of two 
parts: the editor, which you use to enter and manipulate text on your 
screen, and the formatter, which you use to design and print your final 
pages. 

We talk about this distinction frequently in this manual because we want to 
be sure you look in the right place for the information you need. Just keep 
these rules of thumb in mind: 

• If you want to know how to open, close, or save files; move the cursor 
around; insert and delete text; manipulate blocks; and generally do 
things with files and the text on your screen, refer to the sections of this 
manual that deal with the editor . 

• If you want to know how to influence how your text is printed, or if you 
want to do more elaborate things like multiple columns or page headings 
and footings, refer to the sections of this manual (and the Advanced User's 
Guide) that deal with the formatter. 

This chapter focuses on the Edit menu and other Sprint editing features. 

For information about working with files in Sprint, see Chapter 7, 
"Working with Files." 

We will not go through each menu and each item in order; rather, we'll pick 
and choose items from the menus as they are needed for an integrated 
discussion of particular concepts and techniques. If you need information 
about a specific menu item not discussed in this chapter, you can look it up 
in the Reference Guide. 
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A note on alternative user interfaces: This chapter assumes you are using 
the default version of Sprint (either the basic or advanced version) and are 
not using one of Sprint's alternative user interfaces (for example, those that 
perform like Microsoft Word, WordStar, or WordPerfect). To switch to a 
different user interface, choose Customize/User Interface/Load, pick the 
user interface you want from the list Sprint displays, and press Enter. If you 
are using one of those, please refer to the Alternative User Interfaces booklet 
for information before reading further. 

Note to two-floppy system users: Make sure you insert the disk that 
contains the user interface you want to load before you choose Customize/ 
User Interface/Load. Unless you see the alternative user interface you want 
listed when you choose Customize/User Interface/Load, you must run the 
SP-SETUP program again and specify the user interface you want as your 
default (see Chapter 10 for details). 

If you've been using WordStar, SideKick, or one of Borland's other text 
editors, you'll find Sprint's standard user interface very easy to use, since 
many of the default cursor movement and editing keys are the same. 

How to Use This Chapter 

Before diving into this chapter, we recommend that you read through the 
first part of this manual, "Getting Started." We assume that you've 
successfully installed Sprint on your computer (according to Chapter 1, 
"Before You Begin"), that you've worked through the Quick Start Tutorial, 
and, if you're a beginner, that you've read Chapter 2, "Notes for the Begin­
ning Word Processor." We also assume that you know how to move the 
cursor around, and that you know the difference between Insert and 
Overwrite modes. 

This chapter is not a tutorial per se; if you're looking for step-by-step 
lessons, see the Quick Start Tutorial. This chapter provides general 
information about the editor, with an emphasis on handy techniques and 
common pitfalls. 

If you were to read through this chapter in its entirety, you'd learn quite a 
lot about the Sprint editor. However, we don't recommend that you do so. 
We suggest that you read the first ten pages or so of this chapter and get 
started right away with your own documents. As with most things, the best 
way to learn about Sprint is to use it for something practical. When you 
have trouble, you can refer back to this chapter for specific "how-to" infor­
mation, and to the Reference Guide for quick-and-dirty facts once you're 
more familiar with Sprint. And, of course, the Quick Reference Card will 
come in handy anytime. 
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And don't forget: You may seldom have to refer to this manual if you take 
advantage of Sprint's context-sensitive help screens. Anytime you're 
having trouble while you're in Sprint, just press F1 to get useful 
information about whatever you're currently doing. 

Note to two-floppy system users: If the help files are not on your Program 
A Disk, you must remove it from Drive A and replace it with the disk 
containing the files in order to use context-sensitive help. 

Menus and Shortcuts 

You could think of the Sprint editor as the window into all the program's 
powerful functions. With the editor, you'll create, manipulate, and save 
your text. You'll also use it to enter formatter commands (the subject of 
Chapter 8, "Basic Formatting") that will affect how your final text is 
printed. 

There are several ways to use the editor, and which way you choose is 
mostly a matter of taste and, to a lesser extent, your experience with the 
program. The easiest way to learn Sprint is via the menu system-the 
branching structure of screens that pop up when you press F10 (for the 
main menu) or Alt-E (for the Edit menu). Every Sprint function can be found 
on these menus. To choose an item on a menu, either move the cursor to the 
item of your choice, then press Enter, or press the key corresponding to the 
first letter in the item. For instance, to choose the File menu for access to 
some of the commands discussed in this chapter, you can just press F. 

There are faster ways to do what you want to do, though. Sprint offers a 
number of predefined shortcuts that let you quickly access the function of 
your choice. In other words, they do the same thing as choosing a menu 
item, but save you the step of choosing the menu. These special keys 
include the function keys on the left side or top of your keyboard, as well as 
some control-key and shift-key combinations (for example, Ctrl-F2 to save a 
file instead of choosing Save from the File menu, and Shift-F3 to open a 
window). 

Note: By default, Sprint displays the shortcut for each menu command on 
the same line as the name of the command (to the right). You can turn off 
this display if you wish by toggling Customize/Menu Shortcuts to No. 

The Quick Reference Card that came with your Sprint package lists the 
Sprint functions assigned to each shortcut, as well as the menu equivalents 
for each key (where applicable). However, if you're using one of Sprint's 
alternative user interfaces, these keys will not apply; see the Alternative User 
Interfaces booklet for more information. 
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You can also generate a reference card that includes shortcuts you have 
defined yourself (see "Defining Your Own Shortcuts" on page 114 for 
details on how to do this). Choose Utilities/QuickCard. After a few 
moments, Sprint will create a file called QCARD.TXT, which you can print 
out for a reference of shortcuts. 

If you are used to WordStar-like commands (which are used in many 
Borland products, like SideKick), you'll be happy to know that there are 
also many familiar shortcuts in Sprint, including those starting with Ctr/-O, 
Ctr/-I<, and Ctr/-Q. 

Defining Your Own Shortcuts 

You can define your own shortcuts to the menu functions. It's a fast and 
easy way to customize Sprint without getting into a lot of fancy 
programming. 

You'll probably want to start defining shortcuts after you've worked with 
Sprint for a while and start discovering which menu functions you're using 
the most. For instance, let's say you find that you often want to select blocks 
and write them to a new file. On the Edit menu is a command called Write 
Block. To create a shortcut to Write Block, you would take the following 
steps: 

1. Choose Write Block from the Edit menu by pressing F10 EW. 

2. Press Ctr/-Enter-that is, hold down Ctr/ and press Enter at the same time. 
3. At the prompt Shortcut for menu item:, press the key you want to per­

form the Write Block command-perhaps] Ctr/-W. 

That's all there is to it. From now on, whenever you press Ctr/-W (or 
whatever), you will automatically get the Name of file to write block to: 
prompt. You can then enter the name of the file to which you want Sprint to 
write the block. 

When defining your own shortcuts, be sure to choose keys you won't be 
likely to use for anything else. For instance, it wouldn't be a good idea to 
assign, say, Shift-8 as a shortcut, since you're likely to want to insert a capital 
B in your text and won't be able to if you redefine the key! Also, you 
probably don't want to use key combinations that are already used by 
Sprint for something else. Check the Quick Reference Card for a list of all 
predefined shortcuts. 

Note: If you want to get rid of all your key redefinitions, choose 
Customize/User Interface/Reset Shortcuts. All keys will be returned to 
their original meanings. 
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Also Note: Your special key definitions will disappear if you switch to a 
different user interface or if you ever reload all the Sprint files from your 
distribution disk. If you find that you are redefining a lot of keys, there is a 
way to permanently save your key settings in a special user interface file; 
see Chapter 10 for details. Also see that chapter for information about other 
ways to define shortcuts. 

Cursor Movement and Editing Keys 

Certain keys on your keyboard act as cursor movement and editing keys . 

• Cursor movement refers to moving the cursor (the blinking underline 
character on your screen) so that Sprint knows where to perform the 
commands you choose. Sprint invokes commands at the current cursor 
position . 

• Editing refers to functions such as inserting, deleting, moving, copying, 
and replacing text. 

You can perform most cursor movement and editing functions from the 
menus, but you can also use the keys on the keyboard's numeric pad and 
the Backspace, Tab, Gtrl, and Alt keys to move the cursor and edit text. 

Again, the Sprint Quick Reference Card summarizes Sprint's default 
editing commands. 

Using a Mouse 

You can use a standard two- or three-button mouse to move your cursor 
around the screen. If you move the mouse pointer to the top two lines of 
the screen, Sprint will scroll the document up; if you move the mouse 
pointer to the bottom two lines, Sprint will scroll down. Moving the mouse 
out of the two-line region stops the scrolling. 

You can also select text, choose menu commands, and change windows, 
using the following techniques: 

When a Menu Is Visible 

Left Button 

Right Button 

Makes a menu choice. 

Cancels the menu (same as Esc). 

When a Menu Is Not Visible 

Left Button Toggles text selection (same as F3). You can press the 
button and drag across the text to select it (the Edit menu 
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Right Button 

appears when you quit dragging), or you can click once 
and then call up the Edit menu (click the right button) to 
extend the block. 

Mouse text selection also works in Column mode. 

Clicking the left button in an area to the right of the 
onscreen margin (that is, where there is no text) affects 
the current window. (If you have the right margin set to 
column 65, this non-text zone is 15 characters wide. If you 
have a file with no ruler, the non-text zone is any position 
that's to the right of a hard return paragraph mark.) 
Clicking in the upper quarter of the non-text zone 
switches to the previous window. Clicking in the lower 
quarter of the non-text zone switches to the next window. 
Clicking in the middle part of the non-text zone zooms or 
unzooms the current window. 

Displays the Mouse menu if you have moved the mouse 
without selecting text; displays the Edit menu if there is 
text selected; displays the main menu if you have not 
moved the mouse and have not selected text. 

Middle Button If your mouse has a middle button, you can drag to select 
text by lines instead of by characters. Double-clicking the 
middle button allows you select text by paragraphs. 

Clicking the middle button in an area to the right of the 
right onscreen margin (that is, where there is no text) 
affects the current file. Clicking in the upper quarter of 
the non-text zone switches to the previous file. Clicking in 
the lower quarter of the non-text zone switches to the next 
file. Clicking in the middle part of the non-text zone calls 
the File/Pick from List command. 

Double-clicking Double-clicking the left button selects the word the cursor . 
is in. Double-clicking the middle button allows you to 
select text by paragraphs. Double-clicking the right 
button has no special effect. 

Subsequent double-clicks extend the selection. 
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The Mouse menu consists of the following commands: 

Copy Same as F1 0 /Edit/ Copy 
Move-Cut Same as F10/Edit/Move-Cut 
Paste Same as F10/Edit/Insert-Paste 
Erase Same as F10/Edit/Erase 
Write Block Same as F10/Edit/Write Block 
Select BLOCK/ COLUMN Same as F10/Edit/Block Select/ Column Mode 
Typestyle Same as F10/Typestyle 
Index-Word Same as F10/Style/Index/Word 
Cancel Same as Esc 

The Ruler Line 

Sprint automatically inserts a ruler line at the top of each new file. This 
ruler line sets up the following format for text in your file: 

Left margin Column 0 (text will have a l-inch left margin when 
it prints) 

Right margin Column 65 (sets line length to 6.5 inches) 

Paragraph indent Column 0 (paragraphs will not be indented) 

Justification Left only (right margin is "ragged") 

Tabs Tabs set every 5 characters 

If this format works well for your document, you won't need to change any 
of the default settings. If your text requires a different format, you'll need to 
change the ruler line settings accordingly by choosing Layout/Ruler/Edit 
on Screen (or pressing Alt-A). If Sprint's default ruler works well for one part 
of your file, but not for another, you'll need to insert a second ruler and 
modify its settings. Complete information about the ruler line, tabs, and 
formatting your text can be found in Chapter 8, "Basic Formatting." 

Suppressing the Ruler Line 

If you'll be working exclusively with pure ASCII files (for example, if 
you're writing computer programs), you can have Sprint automatically 
suppress rulers each time you use it. 

To do so, move your cursor to a blank place in any file. Press F3 (the 
shortcut for Edit/Block/Turn Select Mode On), but don't move the cursor. 
Now choose Utilities/ Glossary /Define. When Sprint prompts for a name, 
type AUTOEXEC. Sprint then asks if you want to save this item to 
STANDARD.SPG; press Y for Yes. 
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Now, each time you start Sprint, it will ask 

Use your default settings? 

Press Y to answer Yes whenever you want to open a blank file with no ruler 
line. 

Customizing the Default Ruler 

If you want to have different ruler settings (and any other settings) come 
up as the default every time you open a new Sprint document, you can do 
this by following these steps: 

1. Modify the ruler in any way (including any setting from the Layout/ 
Ruler /Precise Settings menu). 

2. Enter any text that you want to be automatically present (for example, 
the To:, From,:, and Re: of a memo). 

3. Select all the text and the ruler (press F3 and use the arrow keys). 

4. Define a glossary entry by choosing Utilities/ Glossary /Define. When 
prompted, call the entry AUTOEXEC. 

Now, every time you create a new document, Sprint prompts you: 

Use your default settings? 

If you type Y for Yes, Sprint inserts your customized ruler and text (if any) 
at the top of the new document. If you type N for No, Sprint opens the new 
file with the regular ruler line at the top. 

For more information about the Sprint Glossary, see Chapter 11. 

General Editing Techniques 

This section covers many of the functions on the Edit menu (see Figure 6.1), 
which you can easily get to by pressing Alt-E. 
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Figure 6.1: The Edit Menu 

The Edit menu contains basic text-editing functions. Many-though not 
all-of these functions can also be performed with Sprint shortcuts (see the 
Quick Reference Card). 

• Undelete-retrieves the last text you deleted, placing it back where it 
originally was. 

• Copy-lets you copy a block of text to a new place without removing it 
from its old spot. 

• Move-Cut-moves a block of text from one place in your file to another . 
• Insert-Paste-pastes in a block of text that has been moved to the 

Clipboard by a Copy or Move-Cut command. 

• Erase-deletes a selected block of text without putting it in the 
Clipboard. 

• Block Select-selects a block of text for changing the text style or 
performing a text-editing command. 

• Write Block-saves a selected block under a specified file name. 

• Search-Replace-lets you search for and, optionally, replace text. 

• Go to Page-jumps to the page number you specify. 

• Jump to Line-jumps to the line number you specify. 
• Place Mark-lets you set up to 10 hidden markers anywhere in your text 

(even in multiple open files), to which you can quickly return. 
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Entering Text 

When you want to create a new file in Sprint, choose New from the File 
menu; a default ruler line is inserted automatically at the top of the file, 
with a left margin of 0, right margin of 65, and a tab at column 5 (unless 
you've defined an AUTOEXEC glossary item that contains a customized 
ruler). Sprint will automatically wrap (carry over to the next line) your text 
as you type; you don't need to press the Enter key. You need to press Enter 
only when you want to end a paragraph, enter a blank line intentionally, or 
break up a line of text. 

If you have set Sprint to show paragraph marks on the screen (choose 
Customize/Screen/Paragraph Marks and toggle to On), you'll notice that, 
when you press Enter, Sprint enters a paragraph mark character at the end 
of the line. This character signifies that the line ends with a "hard" return; 
that is, Sprint will not disturb the line ending when it reformats your text. 
Hard returns are never added, deleted, or moved around when Sprint 
formats your text for the ruler. Lines not ending with a hard return 
character are moved around when you add or delete text; Sprint 
automatically adjusts "soft" carriage returns to make the margins more 
even. 

The hard return character is just like any other character; you can delete it if 
you wish to join paragraphs or lines. 

By default, Sprint is in Insert mode; this means that you can move the cursor 
anywhere in your text and insert characters, without deleting existing text. 
If you want to type over existing text, you can change Sprint's mode to 
Overwrite by pressing the Ins key. Pressing Ins repeatedly toggles between 
the two modes. You can tell which mode you're in by checking the status 
line; if Ins is displayed, you're in Insert mode; if Ovr is displayed, you're in 
Overwrite mode. 

Deleting and Retrieving Text 

You use the Del and Backspace keys to delete single characters. Del deletes the 
character above the cursor, and Backspace deletes the character to the left of 
the cursor. Pressing etr/-Backspace deletes the word to the left of the cursor. 
To delete larger areas of text, you can use any of the deletion shortcuts 
listed on your Quick Reference Card. You can also mark a block of text and 
then delete it; we describe how to do that beginning on page 125. 

Also, the Del key is a handy shortcut for deleting blocks of text; simply 
select the text you want to delete, then press Del. Note also that the text you 
delete is not lost, but is temporarily saved in the Clipboard, described in 
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the next section. This means that you can easily retrieve text you delete by 
pressing F6. 

The Clipboard 

Sprint has a special feature that allows you to retrieve text you have 
deleted. Sprint temporarily keeps deleted text in a special holding area in 
your computer's internal memory-the Clipboard. Each time you delete text, 
it goes to the Clipboard and replaces whatever was in there previously (if 
anything). So if you delete something, then change your mind before you 
delete anything else, you can either choose Undelete or Insert-Paste (shortcut 
F6) from the Edit menu to retrieve what you deleted. 

Note that Undelete and Insert-Paste work somewhat differently. Undelete 
puts the contents of the Clipboard back where they originally were, while 
Insert-Paste inserts them at the cursor position. 

Sprint also stores blocks of text you have moved or copied in the Clipboard. 
The important thing to remember is that the Clipboard holds only one thing 
at a time. Thus, each time you delete some text, or move or copy a block 
(described in the next section), you put that text in the Clipboard and delete 
whatever was there before. 

There is an exception to this rule. If you want to append text to the 
Clipboard, you can do so by pressing etrl-T (to delete a word) or etrl-Y (to 
delete a line) repeatedly as long as you don't move the cursor. All the deleted 
text can be retrieved when you press F6 or choose Undelete from the Edit 
menu. 
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• Use Move-Cut or Copy to move text to the 
Clipboard 

• Retrieve text from the Clipboard with 
Undelete or Insert-Paste 

• Caution: If you Move-Cut or 
Copy a different block of text, 
any text currently in the 
Clipboard will be deleted . 

[ 2nd bl~ck 1 
~.......w........u.t.v.......J.JAIaIJ 

Figure 6.2: How the Clipboard Works 

The Revert to Saved Command 

Suppose you've made some changes to your file, then decide you don't 
want them. As long as you don't save the file with the changes you've 
made, you can discard the changes and get the original file back by 
choosing the Revert to Saved command from the File menu. Sprint asks 

Discard changes? (Y,N,Esc) 

Answer Y and Sprint will read in your file from disk and discard any 
changes you've made since the last time the file was saved. 

Working with Blocks of Text 

If there's one thing that really sets computerized word processing apart 
from typewriter work, it's the ability to easily manipulate chunks of text. 
Sprint allows you to select a portion of text-a block-that you can then 
affect in one or more of the following ways: 
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• Move or copy it to another spot in any open file or window. 

• Copy it to a new (unopened) file. 

• Delete it. 
• Change its typeface or style. 
• Tell the Sprint formatter to format the block in a special way. 

To do anything with a block, you must first select it. There are two ways to 
do this: 

• choose commands from the Edit/Block Select menu (shown in Figure 
6.3) 

• press F3 

< r:::-Spri nt 
INSTRUCTIONS and RECOMMENDATIONS< I ~ Alt-F 
< Ed i t-----, Edlt Alt-E 
Remove all wall hangings and fragile objec Undelete 
responsible for damages.< 1-------1 Insert Alt-I 
< Copy Typestyle Alt-T 
Plan to be without a kitchen for 5 days.< Move-Cut F5 Style Alt-S 
< Insert-Paste F6 Layout Alt-L 
Since your kitchen cannot be completely cl Erase 
dining room. cover the dining room furnitul-;;;;;;;;;;;;;;;;;;;;;;;;;;;IPrint Alt-P 
dropcloth. This lock Select . 1:1.&:11111 Window Alt-W 
< WritesfoCit Utilities Alt-U 
Remove the cont Line 1-------ICustomize Alt-C 
another room.< Sentence Search-Replace 
< Paragraph 
Make arrangemen Re-Select Block Alt-B Go to Page 
ending days. Dul----------IJump to Line 
instructions fo Turn Select Mode ON F3 Place Mark 

F9 

< 
< 

Column Mode OFF 1 ______ --" 

COST ESTIMATE< 
< 
The cost to perform the task listed above is $6.500.00. due and 
payable as follows:< 

3i~'P:JI;';"1~1'Bd··'"P9·'P·~1i'.'P· Ins 11:37am 

Figure 6.3: The Block Select Menu 

Quit Alt-Q 

., .. - o 

The F3 key is a shortcut to the Tum Select Mode On/Off command on the 
Edit/Block Select menu: it begins selecting a block. To continue selecting a 
block, just press the appropriate arrow key until all the text you want to 
affect is highlighted. Also, pressing any character key automatically 
extends the selection to the next occurrence of that character. (Therefore, 
pressing the Spacebar extends the selection one word at a time.) If you 
change your mind and want to "unselect" the block, press F3 again. Notice 
how the status line reflects when Select mode is on or off (by displaying 
Sel). 
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The ReSelect Block command lets you instantly reselect the last block of text 
you selected. This can be a valuable timesaver if, for example, you want to 
use two different typestyles in a block; you can select the block and choose 
one command from the Typestyle menu, then use ReSelect Block to mark 
the same block again and choose another command from the Typestyle 
menu (see "Changing the Typestyle of a Block" on page 126 for more 
information about typestyle commands). Another time to use ReSelect 
Block is when you select and move a block of text and then change your 
mind about where you inserted it; j_lst press Alt-8 (the shortcut for ReSelect 
Block) and you're ready to use an Edit command to move it somewhere 
else. 

You'll see a command called Column Mode on the Block Select menu. This 
command lets you select columns of text as a block instead of rows (the 
default way). 

Moving and Copying Blocks 

You can make a copy of a marked block and then place it in some other file 
or window (or elsewhere in the same file), or you can remove it from its 
current location and place it elsewhere. 

In brief, when you want to move or copy a block somewhere, you do the 
following: 

1. Begin selecting the block by pressing F3, then move the cursor until the 
block is fully marked. You can move the cursor up or down and to the 
right or left to mark parts of a line. 

2. Move or copy the block to the Clipboard by pressing F5 (or De/) or F4, 
respectively. 

3. Move the cursor to where you want to insert the block-either in the 
same file, another window, or another open file-and press F6. 

Say you want to move a paragraph from one open file to another. (Multiple 
files and windows are fully discussed in Chapter 7, "Working with Files.") 
First, select the block as explained in the previous section. Then, either 
press F5 or Dei or choose Move.;.Cut from the Edit menu. The block dis­
appears. (If you had decided to copy the block, it would stay where it was 
and a copy of the block would also go to the Clipboard.) 

Now, open a window by pressing Shift-F3. In that window, load the file you 
want to move the block to by either opening the file or choosing Pick from 
List from the File menu if the file is already open (the shortcut for Pick from 
List is Ctrl-F9). The cursor will be in the file you just opened, so move it to 
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where you want to insert the block, then press F6 or choose Insert-Paste 
from the Edit menu. 

A word of caution: As mentioned in the section on deleting text (page 120), 
the Clipboard holds not only blocks that you have marked and copied, but 
also any text you have deleted (except single characters deleted with the Del 
or Backspace key). It can only hold one thing at a time, which means that if 
you delete text after you've moved a block to the Clipboard, the block will 
be lost. Develop the habit of immediately inserting the block from the 
Clipboard-don't get distracted and start deleting lines of text in between, 
or you'll be in for an unpleasant surprise when you go to paste from the 
Clipboard. 

As long as you don't delete any text or move a new block, your original 
block will stay in the Clipboard until you cut or copy something else. So if 
you change your mind and decide you want to put it back where it was, 
you can simply choose Undelete from the Edit menu or move the cursor to 
where you want it and press F6. 

Writing a Block to a New File 

Sometimes you may want to put a marked block in a separate, unopened 
file. To do that, choose Write Block from the Edit menu. At the prompt, 
enter a file name to hold the block. Sprint will leave your block where it is, 
and make a copy of it in the file you specify. 

Note that the block will not go to the Clipboard; it will only be written to 
the new file. 

Deleting a Block 

The easiest way to delete a marked block is to press F5 or Del. You can also 
choose Move-Cut from the Edit menu. The marked text will disappear from 
the screen. It will be in the Clip board, however, until you delete more text 
or move another block there, so if you change your mind before deleting any 
text or moving a block to the Clipboard, you can press F6 to retrieve the deleted 
block. 

If you want to delete a block and not place it in the Clipboard, choose Erase 
from the Edit menu. 

Note: The Erase command is only available if you are using the advanced 
user interface. See Chapter 10, "Customizing Sprint," for information about 
switching interfaces. 
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Changing the Typestyle of a Block 

Once you've marked a block of text, you can change its typestyle via the 
Typestyle menu; see Figure 6.4 for the commands it offers. 
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Figure 6.4: The Typestyle Menu 

Just choose the typestyle of your choice from the menu. The entire block 
changes attribute (for example, if you choose Underline on a monochrome 
monitor, the text is underlined onscreen; on a color monitor, the text 
appears in a different color). 

If you change the typeface of a block that is already in another typestyle 
(other than normal text), Sprint will try to use both typestyles (if your 
printer supports them). For instance, if you have some text that is marked 
as bold, then select the text and choose Italic, your printed text will be bold 
italic. 

You can also use this method of selecting text and choosing styles from the 
Typestyle menu to return text to plain text. Simply choose Normal from the 
Typestyle menu after you've selected the text. 

If you've used a number of different typestyles, or if you're looking at a file 
created by someone else, it may not be immediately obvious what typestyle 
some text is in, especially if you have a monochrome monitor (which has a 
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limited number of ways it can change the appearance of text on your 
screen). 

To see what typestyle your text is in, move the cursor to the text in question 
and look at the status line at the bottom of your screen after you have 
displayed the Typestyle menu; Sprint displays the name of the typestyle 
there. 

For more information about typestyles and fonts in Sprint, see Chapter 8, 
"Basic Formatting." 

Control Characters in Text 

When you choose a typestyle from the Typestyle menu, Sprint changes the 
way your text looks on the screen. To make the text look the way it does, 
Sprint uses embedded control characters. For instance, underlined text 
begins with a AU and ends with AN. Unless you have toggled Codes On 
(using the Codes command on the Customize/Screen menu, shown in 
Figure 6.5), you don't see these control codes. 

Note to two-floppy system users: You must have your Program A Disk in 
Drive A to use the commands on the Customize/Screen menu. 
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Figure 6.5: The Customize/Screen Menu 
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Normally, you don't need to worry about these hidden control codes; 
they're used internally by Sprint when it prints your file, and you can't 
inadvertently delete them by backspacing over them. There are a few times, 
though, that you'll need to be concerned with them: 

• when you want to search for text that's in a particular typestyle 
• when you want to insert text before or after a typestyle change 

• when you change or get rid of a typestyle command 

The section on searches (page 135) tells you how to search for (and option­
ally replace) embedded control characters in your text. The other two 
instances are explained here. 

Let's say you want to add some text to the end of an existing underlined 
sentence. To illustrate this example, choose Underline from the Typestyle 
menu, then type a sentence. After you're finished with the sentence, press 
the Right arrow key. This moves the cursor past the (hidden) control code that 
turns the typestyle off. Now type another character. As you can see, this 
character is not displayed in the underline attribute. Why? Because you 
moved the cursor past the AN that ends the typestyle. To insert the 
character in front of the AN, you'll have to press the left arrow key until 
you are on the left side of the AN character. 

This sounds obvious, but it's not always clear where the cursor is, since the 
AN is invisible to you (unless you toggle Codes On). To understand this, 
press the Left arrow key twice. The first time you press it, the cursor moves 
left one character. The second time, however, it appears to go nowhere. In 
fact, you have actually moved past the hidden AN. Now type a character. 
This time,' it should appear in the underline attribute (underlined on a 
monochrome screen, in a different color on a color screen). If you pay 
attention to the column number at the far right of the status line, you can 
see the underline come and go as you cross over the invisible control code. 

To see what's actually happening here, toggle Customize/Screen/Codes 
On or press Alt-I. (Two-floppy system users, make sure your Program A 
Disk is in Drive A when you choose Customize/Screen/Codes.) Follow the 
the same series of steps you just performed. In this case, you can see that 
when you turn underlining on, Sprint inserts control characters for both 
starting (AU) and ending (AN) the typestyle. You can also see how the 
arrow keys move the cursor past the AN, something you can't actually see 
when Codes is Off. Your underlined sentence should resemble the one in 
Figure 6.6. 
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AUlf this fonmat works well for your document, you won't need to 
change any of the default settings.AN< 
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Figure 6.6: Underlined Sentence with Codes On 

While you have Codes set to On, consider the other case when you need to 
think about control codes: when you want to change or get rid of a 
typestyle command. 

As a safeguard, Sprint doesn't allow you to delete embedded control 
characters accidentally by backspacing over them. You can, however, delete 
single control characters when Codes is set to On-that is, when you can 
see what you're doing. (You can delete entire words or sentences containing 
control codes when Codes is set to Off; Sprint simply guards against your 
deleting individual control codes with the Backspace key. This is useful if 
you misspell a word and want to backspace over it to correct it without 
disturbing the typestyle.) 

Suppose you want to change the typestyle of your sentence from under­
lined to bold. You could delete the whole sentence and start over, but it 
would be easier to simply change the control code that begins underlining 
(I\U) to the one that begins boldface (I\B). The I\N character always ends a 
typestyle (or a formatter command), so that stays the same. 

To change the control character, move to the I\U at the beginning of the 
sentence. Since Codes is set to On, you can delete the I\U by backspacing 
over it. Now you want to insert a I\B. 

To do this, you can't just press etr/-B; Sprint will think you are trying to give 
it a command to do something (in this case, reformat your text). Many 
control character sequences do tell Sprint to do something, like move the 
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cursor. To actually insert a control character in your text, you need to 
display the Insert menu (see Figure 6.7) and then choose the Control Char­
acter command. Sprint prompts you for the character you want to insert. 
Press B. Sprint inserts a hidden "B in your text and changes the sentence 
typestyle from underlined to bold. To see the results, toggle Codes Off. 
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Figure 6.7: The Insert Menu 

Note: Although an embedded control character looks like the caret (") sym­
bol (shifted 6), it is not the same. That is, if you press Shift-6, you will get the 
caret symbol, which is not the same as an embedded control character. 

Also Note: When Codes is set to On, your text will not wrap according to 
your ruler lines, but will keep going off the right margin. Turning Codes 
Offagain will automatically reformat the text. 

Searches 

Sprint can hunt very quickly through your files for words and phrases. You 
can have Sprint automatically replace words it finds, search forward and 
backward through the file, ignore or pay attention to capitalization, and 
more. All Sprint's search functions can be found on the Edit/Search-
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Replace menu (see Figure 6.8); you can also use the following shortcuts for 
search functions: 
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Figure 6.8: The Search-Replace Menu 

To search for a sequence of characters (the search string): 

1. From the Search-Replace menu, choose Direction and press Enter to 
toggle between Forward (to search forward in the file from the cursor 
position) and Backward (to search backward from the cursor position). 

2. Type the search string at the prompt and press Enter. 

Sprint searches through your file for the string. To find the next occurrence 
of the search string, press Ctr/-L or choose Next Occurrence from the 
Search-Replace menu. 

By default, Sprint will ignore the "case" (capitalization) of the search string. 
That is, if you ask Sprint to find the word spring, it will also find Spring, 
SPRING, or any combination of upper and lowercase letters that make up 

Chapter 6, Editing: Tips, Tricks, and Techniques 131 



the word. Also by default, it will find the character string spring in the word 
wellspring. These defaults can be changed by switching the Search-Replace 
menu toggles for Case Sensitive and Match Words Only from No-the 
default-to Yes. 

Search and Replace 

If you want to search for some string and replace it with something else, 
choose Search-Replace/Search & Replace from the Edit menu, or press 
Ctrl-QA. When Sprint finds the string, it will ask you whether you want to 
replace this occurrence (Yes), skip it (No), or replace all occurrences of the 
search string (And the Rest). To stop the search-and-replace operation, 
press Esc. If you choose And the Rest, Sprint will display the number of 
replacements being performed as it replaces your search string. When 
Sprint has finished searching and replacing, the message XX Replaced is 
displayed on the status line (where XX is the total number of replace­
ments). 

Note: Use caution when choosing And the Rest; be absolutely sure that you 
aren't overlooking any cases where you wouldn't want to replace the text. 

Wildcards in Searches 

As long as you don't include an asterisk (*), question mark (?), left bracket 
([), or backslash (\) in your search string, Sprint will search and replace the 
words or phrases exactly as you typed them. The asterisk, question mark, 
left bracket, and backslash are Sprint wildcard characters and perform 
different tasks when placed in a search or replacement string (explained 
shortly). Sprint will search for any letters, numbers, punctuation marks, or 
foreign characters and match them exactly; however, capitalization (case) 
will be ignored unless you toggle Case Sensitive to Yes. 

Note: If you don't plan on using wildcards and want to be able to easily 
search for asterisks, question marks, left brackets, and backslashes, you 
should turn off wildcards by choosing Edit/Search-Replace/Use Wildcards 
and toggling it to No. If you think you'd like the power of using wildcards 
in search strings, keep the command set to Yes. 

The wildcards have the following functions: 

* 
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all letters, foreign characters, the numbers 0 to 9, underscore, 
dollar sign, and the percent sign. 
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Use an asterisk to match the ends of words. For instance, 
searching for xer* will find words that start with xer, such as 
Xerographic. Searching for k*k will find all words (if Match 
Words Only is set to On) with two k's in them; searching for 
do* will find all words starting with do, such as do, doesn't and 
don't. 

If you put an asterisk in a replacement string, and if the 
search string also contains an asterisk, the text matched by the 
search string's asterisk is inserted at the same location in the 
replacement. For example, replacing *ing with *s turns 
shouting into shouts. 

? Matches any single character; all characters except space, tab, 
and soft and hard returns are matched. 

A question mark can be used to find unknown letters. For 
instance, searching for A? will find all two-letter combinations 
starting with an A. Searching for do? will find dot, do9, Do#, 
and the first three letters of don't, but won't find do (unless 
Match Words Only is set to No). 

To illustrate the difference between the question mark and the 
asterisk, searching for do* would find dot, do9, Do#, all of the 
word don't, and the word do. 

In addition to the two wildcards just mentioned, there are some other 
special techniques you can use for searching your files: 

<space> A space matches any non-printing character (spaces, tabs, 
returns). 

You can use a space to locate sequential words, even if they 
are on separate lines. For instance, if you enter alpha beta as 
the search string, Sprint will search for the words alpha and 
beta, even if there is a line break rather than a space between 
them. 

A space in a replacement string, if there is a space in the 
search string, will replace the matched whitespace character. 

You can include a space at the start and end of a search string; 
this lets you search for, for example, rote, without finding 
wrote or protection. This is the same as setting Match Words 
Only to Yes. 

[<set>] Square brackets let you search for a set of characters in a 
specified range. Anyone of the characters between the square 
brackets will match the search. You can specify the range of 
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characters in the set by separating two characters with a dash; 
for example, [a-z] or [a-Z]. For instance, if you type A[O-9], 
Sprint will search for A followed by any digit. You can also 
specify a single wildcard character by using [*]. 

[<set>]+ A set wildcard can be followed by a plus sign to match any 
sequence (1 or more) of characters in the set. That is, it's a 
"repeating" set. For example, if you type A[O-9]+, Sprint will 
search for A followed by any sequence of numbers (single or 
multiple digits). 

\c Matches the character c exactly, even if it is a wildcard, for 
example, *, [, and ? For instance, to search for an asterisk, you 
would type \ *. This includes the backslash itself; that is, \ \. 

[A ••• ] A caret (") symbol used as the first character in a set causes 
Sprint to match any characters that are not in the set. For 
example, n[o,u]t matches nut and not, while n["o,u]t matches 
any character between nand t except 0 and u (nut and not 
would not match). You can search for the caret symbol itself in 
a set, as long as it's not the first character in the set. 

Note that Sprint takes more time to search for words that start with a 
wildcard than it does when it searches for words that start with a normal 
character or a backslash. 

Wildcards in Replacement Strings 

You can put wildcards in replacement strings (the sequence of characters 
you want instead of the first sequence of characters) if there 
are corresponding wildcards in the search string. 

If there are several corresponding wildcards in a search string, each is used 
in turn. For instance, if you enter ?x? as the search string, and ?y? as the 
replacement string, Sprint will replace each x with a y but leave the 
surrounding characters unchanged. 

If there are extra wildcards in the replacement string, or if the replacement 
string consists of wildcards and no other characters, the wildcard 
characters are inserted exactly. For instance, if the search string is too and 
the replacement string is ?, Sprint will replace too with a question mark. 

The behavior of wildcards in replacement strings is as follows: 

* 
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? Inserts the character matched by the next? or [set] wild card 
in the search string. 

<space> Inserts the character matched by the next space in the search 
string. 

Case in Replacement Strings 

Although you can enter text in a replacement string in either upper or 
lowercase, Sprint changes the case (whether a character is upper or 
lowercase) of a replacement string according to the following rules: 

• If the first letter in the search string (the, string that is being replaced) is 
lowercase, the replacement string is left with its case unchanged. 

• If the first letter of the search string is uppercase, the replacement's first 
letter is changed to uppercase. 

• If the first two letters in the search string are uppercase, all the letters in 
the replacement are changed to uppercase. 

If you want characters in the replacement string to be inserted exactly as 
you type them, you can precede them with a backslash. For instance, \a 
always inserts a lowercase a, no matter what the case of the search string is. 

Typestyles and Control Characters in Searches 

If your search string is coded as a special typestyle (bold, underline, italic, 
and so on), or if it contains control characters, you will sometimes need to 
press Ctrl-Q before typing the control characters in order for Sprint to find 
them. In most cases, however, you'll be able to simple press the Ctrl key and 
then the character when specifying a search or replacement string. 

As mentioned in the section on control characters (page 127), many Sprint 
formatter commands-for example, those for typestyles and special 
formats-are surrounded by control codes. Unless you have toggled Codes 
to On, you won't see these codes; instead, the text affected by the com­
mands will be in a different attribute. The codes are there, though, and if 
you need to search for, say, only boldfaced words, you'll have to search for 
the control codes for bold-A B and AN. 

Let's say you want to search for all AB commands and replace them with 
AU commands. Choose the Search-Replace/Search & Replace command, 
and Sprint displays the Search for: prompt. Press Ctrl-B to tell Sprint you 
want to search for a hidden AB control code. 
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Press Enter to display the Replace with: prompt. Since the replacement text 
is also a control code, press Ctrl-U, then Enter. Sprint then begins the Replace 
command. 

In the few cases where Sprint won't accept a control code entered during a 
search and replace operation by pressing Ctrl and then the character, just 
press Ctrl-Q and then the character. 

Setting and Using Place Markers in Your Document 

When dealing with long documents, it is often desirable to be able to define 
a location so you can later go back to that spot quickly and easily. The Place 
Mark command on the Edit menu allows you to set and jump to up to 10 
specific spots in any or all open files (numbered 0 to 9). 

To insert an invisible mark at the cursor location, choose Place Mark/Set 
from the Edit menu (you can also use the shortcut Alt-M). Sprint prompts 
you for a marker number from 0 to 9; type a number and press Enter. 

To quickly go back to that spot, choose Edit/Place Mark/ Go To (or use the 
shortcut Alt-G). When prompted, enter the same number. Immediately 
Sprint places the cursor at the invisible marker location. 

You don't have to delete a mark to set a new one. If you've already used 1 
as a mark, you can use it again by resetting it at a new spot. 

Note that place marks can be set in different open files. Sprint automatically 
makes a file the current one if you choose a mark in that file. 

Summary 

Editing in Sprint is easy yet powerful. We've shown you a number of basic 
techniques-like cursor movements-that you'll use every day, as well as 
some more powerful (yet equally useful) features like searching with 
wildcards. For more information about editing, refer to the functional index 
and alphabetical lookup of the Reference Guide. 
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c H A p T E R 

7 

Working with Files 

This chapter covers Sprint file operations-how to: 

• open a file 
• close a file 
• save a file 
• work with multiple files 

For information about working with ASCII files, see Appendix E. 

If you need information on importing files created with another word 
processor and converting them to Sprint format, or exporting Sprint files to 
another format, refer to Appendix C, "Converting Files to and from Other 
Word Processors./I 

Opening a File 

In the "Getting Started" section of this manual, you learned how to start 
Sprint and open, close, and save a file. In this section, we'll talk in a little 
more detail about the concepts of open and closed files. 

To open a file, you choose New (to create a new file) or Open (to open an 
existing file) from the File menu (Figure 7.1). 

Chapter 7, Working with Files 137 



T 2 

Flle to create: 

3 4 5 
Fil 

"~n 

6 r==Sprint 
III I' 
rcnt Alt-E 

Ctl-F3 
Close Ctl-F4 Insert Alt-! 
Insert Typestyle Alt-T 

1--------1 Styl e Alt-S 
Save 
Write As 
Revert to Saved 

Ctl-F2 Layout Alt-L 

Print Alt-P 
1--------IWindow Alt-W 

Translate 
File Manager 

Utilities Alt-U 
Customize Alt-C 

Pick from List Ctl-F9 1------1 
L...----------'Quit Al t-Q 

Figure 7.1: The File Menu 

At the prompt, enter a file name. If you don't include a file name extension, 
Sprint assumes an extension of .SPR. If the file has no extension, enter the 
file name followed by a period. (If you want to create a file with no 
extension, you have to add a period after the name.) 

Anytime Sprint prompts for a file name, you have several options. You can 

1. Type the exact name of the file (including the full directory path if you 
want to work with a file in a different directory) and press Enter. 

2. Type a name that includes wildcards (see page 148) and choose the file 
from the list Sprint displays. 

3. Press Enter and Sprint will display a list of relevant files with the .SPR 
extension. 

Working with Several Open Files 

As you've probably already learned, Sprint allows you to work with up to 
24 files at one time. Until you've had a chance to really try out this feature, 
you may not appreciate its power and convenience. 

At any point while you're editing one file, you can open another one by the 
same method (choose New or Open from the File menu). Although the first 
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file will disappear from your screen, it's still there in the background, ready 
to be accessed again. You could think of all your open files as a sheaf of 
papers stacked on top of each other; all you have to do is reshuffle the stack 
to get to the open file you want (Figure 7.2). 
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Figure 7.2: Multiple Open Files 

Why might you want to use this feature? Suppose you're working on a 
business report. As you work, you begin to get a brainstorm of ideas. You 
could open up a new file, jot down your ideas, then bounce back and forth 
between the two files. 

Or say your report has several, distinct sections. Rather than putting all the 
sections into one long file, you could open separate files to contain each 
section, then go back and forth between them as you get ideas. The power 
of multiple files is that, if you suddenly think of something you want to 
add or simply refer to in a specific file, you can quickly jump to the file, do 
what you want to do there, and get back to whatever you were doing in 
another file. You can also move chunks of text between open files; see page 
124. 
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Moving between Open Files 

Once you've opened several files, the easiest way to move back and forth 
between them is to choose Pick from List on the File menu (or press Ctrl-F9). 
When you do so, you'll get a list of the currently open files. To choose one, 
just move the cursor to the one you want and press Enter. Note that you can 
open files on any disk or directory, including "virtual" drives and 
directories if you are working on a networked system. Figure 7.3 shows a 
sample list of open files. Note that files which have been changed but not 
yet saved have an asterisk (*) next to them. 
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Figure 7.3: Sample List of Open Files 

You can quickly move between open files by pressing Ctrl-F5 (to move to the 
last file you opened) or Ctrl-F6 (to move to the next file in the sequence); files 
become active in the order they were originally opened. (The active file is 
the one that the cursor is currently in.) 

As you move between files, Sprint will return you to the place in each file 
where you left off. 

Note to two-floppy system users: It's a good idea to be cautious about the 
number of files you have open at anyone time, since the size of your 
backup file is limited. (The SP-SETUPprogram creates a fixed-size backup 
file on your Data Disk in Drive B; this backup file is crucial, so never 
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remove your Data Disk from Drive B when you're in Sprint. See page 22 for 
information on how to create additional Data Disks.} 

Using Windows to View Several Open Files 

Moving back and forth between open files works fine, but there is one 
disadvantage: You can't look at the files at the same time. To do that, you 
can open up to six windows to contain different open files or parts of the 
same file. 

For instance, suppose you have several files that make up a business report. 
As you're working on one file, you realize there's a chunk of text in another 
file that you need to insert in this file. Or suppose you need to constantly 
refer to another file in order to get information, and it would be more 
convenient to view both files at once. 

Open (window) command To open a window, choose Open from the 
Window menu, shown in Figure 7.4. 

have some text that is marked as bold. then select the text a 
choose Italic. your printed text will be bold 1ta11c.< 
< 
You can also use this method of selecting text and choosing 
styles from the Typestyle menu to return text to plain text. 
Simply choose Normal from the Typestyle menu after you've 
selected the text.< 
< 

Sprint 
File Alt-F 
Edit Alt-E 

Insert Alt-I 
Typestyle Alt-T 
Style Alt-S 
Layout Alt-L 

If you've used a number of different typestyles. or if you'rel-------I 
looking at a file created by someone else. it may not be Print Alt-P 
inmediately obvious what typestyle some text indo 11m rtI 11 
you have a monochrome monitor (which has a 1 I!)'@ 'MU Utnlties Alt-U 
_j,.,U:JI;UmJO,!dMlhIlGl,le Close Sh-F4 Customize Alt-C 
Styles from tile Typestyle menu to return tex Shut All Sh-F9 1------1 

Wlndow Alt-W 

Simply choose Normal from the Typestyle menu Quit Alt-Q 
selected the text.< Zoom Sh-F5 1--------1 
< Resize Sh-F2 
If you've used a number of different typestyl------I 
looking at a file created by someone else. i Next Sh-F6 
inmediately obvious what typestyle some text Previous if 
you have a monochrome monitor (which has a 1 L..--------Iys 
it can change the appearance of text on your screen).< 
< 
To see what t estyle your text is in. move the cursor to the 

f' ,: II • I ~ • .' • 

Figure 7.4: The Window Menu 

Sprint will split your screen. You'll notice that an identical copy of the 
current open file appears in both windows, with the cursor in the bottom 
window. You can now enter or edit text. Only one window is active at a 
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given time-that is, you can only make changes in the window that 
contains the cursor (and the cursor can't be in more than one place at 
once!). Any menu choices you make will apply only to the active window. 

You'll notice that the status line of the active file contains complete 
information about that file (line and column number, and so on) while the 
inactive file shows only the file name. 
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Figure 7.5: Two Windows, One Active File 

If you want to look at a different file, just choose Open from the File menu 
as you normally would to open a closed file, press Ctrl-F5 or Ctrl-F6 to cycle 
through the list of open files in opposite directions, or choose Pick from List 
from the File menu to load an already-open file. Sprint will load the file into 
the active window. To move between windows, press Shift-F6 or choose the 
Next or Previous command from the Window menu. As with files, win­
dows become active in the order they were opened. 

You can also move text from one window to the other, or from one open file 
to another, using the Clipboard, described on page 121 in the "Editing: Tips, 
Tricks, and Techniques" chapter. 

142 Sprint User's Guide 



Shrinking and Expanding a Window 

Two items on the Window menu allow you to change the size of windows: 
Zoom and Resize. 

Zoom lets you expand the active window to fill the screen. When you're 
ready to return the window to its original size, you can choose Unzoom 
from the menu. (Unzoom appears only when a window has been previ­
ously "zoomed.") The shortcut for Zoom/Unzoom is Shift-F5. 

The Resize command allows you to make fine adjustments in the size of the 
current window. When you choose Resize, you then press the plus (+) key 
on the numeric keypad on the right side of your keyboard to expand the 
current window, and the minus (-) key to shrink it. Press Esc or Enter when 
you've finished adjusting the size of the window. The shortcut for Resize is 
Shift-F2. 

Closing a File or Window 

Once you've opened several files and windows, you may find after a while 
that there are too many open; it may become cumbersome to move between 
them or see enough text. So close some! Both the File and Window menus 
have a command called Close, although they work differently. 

When you close a file, you are actually removing it from Sprint's backup 
(swap) file (described in the next section). It will no longer appear in the list 
of open files when you choose Pick from List. Note that closing is not the 
same as saving. When you close a file, you are simply removing it from the 
swap file. When you save a file, you are saving your changed file to disk. 

If you want to close a file that you've made changes to since the last time 
you saved it, Sprint asks you 

The file Filename has not been saved; save it? (Y,N,Esc) 

Unless you don't want to save the changes, answer Yes by pressing Y. Sprint 
will then save the file before closing it. (Esc will cancel the command, and 
pressing N will close the file without saving.) 

When you close a window, that's all you're doing: You're removing one of 
the windows from the screen, but the file that was in the closed window 
remains open; it will still be available in the list of open files when you 
choose Pick from List. 
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Merging Files 

You can combine two or more files by inserting one file inside of another. To 
do this, move the cursor to the point in a file where you want to insert 
another file, then choose Insert from the File menu. At the 

Name of file to insert: 

prompt, type the name of the file, then press Enter. 

Note: As with all Sprint file operations, you can use DOS wildcards to see a 
list of files from which you can then pick a file to insert. See page 148 for 
more information. 

The Automatic Backup (SP.SWP) File 

You may already have noticed that when you start Sprint, the files you 
worked on last are miraculously already open. This is the result of Sprint's 
auto-backup system. 

In addition to the files you've saved on disk, Sprint automatically creates its 
own file, called SP .SWP. This file stores your entire Sprint work 
session-that is, all open files-on your disk. Each time you open a file, 
Sprint reads your file on disk, places the file contents on the screen, and 
also inserts it in its backup file. In effect, Sprint makes its own copy of the 
file you opened. When you make changes to a file, your changes are not 
reflected in the original file until you explicitly choose Save from the File 
menu (or press Ctrl-F2). Your changes are automatically saved to the backup 
file, however, whenever you pause in your typing for at least 3 seconds. 
(You can change this 3-second default by choosing Customize/Options/ 
Background Save Period and entering any value up to 60 seconds.) This 
one backup file contains as many separate files as you have open. 
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Sprint saves your file 
(MYFILE.SPR) to disk 

when you select File/Save 
(or press lliill~) 

Sprint saves all open files to the 
backup file (SP.SWP) when you 
stop typing for three seconds or 
more or when there is a power 

~ failure or other system "crash." 

Figure 7.6: The Backup File vs. Your Named Files 

It is important to realize that when you are creating new files and editing 
existing files, you are not working with your files on disk until you choose 
Save; you are working with the copies of those files in the backup file. 
During a Sprint work session, your files on disk are not changed until you 
choose the Save command from the File menu or the Go command from 
the Print menu. Therefore, for each file you edit, you always have a backup 
(the original file on disk). 

The backup file has several beneficial effects: 

• If the power should fail while you are working, or if your computer 
system "crashes," you'll be able to recover the new text and changes you 
were entering, even though you hadn't yet explicitly saved the text. Since 
Sprint automatically saves your changes to the backup file when you 
pause typing for three seconds, the most you will probably lose is a few 
seconds worth of typing! 

• If you turn off your computer or run another program and then return to 
Sprint, you'll still be working on the same file you last worked on, 
without having to open the file again. 

• If your disk is full when you try to save a file, you'll still have the copy in 
the backup file, so you can delete some files on your disk to make room 
(via the File/File Manager menu), then save the file. 
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The Preserve Editing Session Command 

The Preserve Editing Session command on the Customize/ Options menu 
determines whether Sprint keeps the backup file or erases it when you 
leave Sprint. 

If Preserve Editing Session is Yes (the default), Sprint keeps the contents of 
the backup file on your disk when you choose the Quit command. When 
you restart Sprint, you automatically open this file again. Any files that 
were open when you quit are automatically open again when you restart, 
along with any other files you open in this editing session. This is useful if 
you typically work on the same files and the same computer every day. 

If Preserve Editing Session is set to No, Sprint removes the backup file from 
your disk when you choose the Quit command. When you restart Sprint, a 
new, empty backup is created. This option is particularly useful if you use 
more than one computer (or are on a local area network) to edit your Sprint 
files. 

Note to two-floppy system users: Be sure your Program A Disk is in Drive 
A when you choose commands on the Customize/Options menu. 

Why You Should Leave Preserve Editing Session Set to Yes 

Here's an example of why you should usually leave Preserve Editing 
Session set to Yes: 

Let's say you never use any other computer than your own, and you 
constantly update the same files during the course of your workday. In this 
instance, you probably want to set Preserve Editing Session to Yes. That 
way, whenever you start Sprint, these files are automatically open and 
accessible to you. 

In short, if you use more than one machine to edit Sprint files, you should 
set Preserve Editing Session to No on all machines. If you are the only 
person using your computer, and you work on the same files quite often, 
you probably want to set Preserve Editing Session to Yes. You can check 
this setting by choosing Customize from the main menu, and then choosing 
Options. If you want to change the setting, choose Preserve Editing Session 
and press Enter to toggle between Yes and No. 
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When to Set Preserve Editing Session to No 

There are a couple of instances when you'll want to set Preserve Editing 
Session to No: 

• When you'll be editing your files on more than one computer . 

• When you work with confidential files. 

Let's consider the first case. Let's say that Preserve Editing Session is Yes on 
your machine. You open a file named REPORT.SPR on your machine, make 
some changes, save the changes to disk, and then quit Sprint. Since you 
didn't close the REPORT.SPR file, it's still open in the backup file on your 
machine. 

Now you bring the disk containing your file to someone else's computer; 
let's say that this machine is connected to the printer you want to use to 
print the final version of your file. You print the file, notice some changes 
you want to make, and then use this computer (rather than your own) to 
edit your file. You print the file again, and then quit Sprint (when you print, 
Sprint automatically saves your file to disk). 

The next time you start Sprint on your machine, your REPORT.SPR file will 
already be open, since you didn't close it last time. Ordinarily, this is a great 
feature, except that the version in your backup file doesn't reflect the changes 
you made on the other computer. You might think that Sprint didn't save your 
changes, when in fact it did, but you're looking at the backup file version, 
not the version you saved to disk. If this ever happens, don't panic! Simply 
close the file (this removes it from the backup file), and then open it again. 
(You could also choose Revert to Saved from the File menu.) Remember, 
when you open a file, Sprint automatically puts the contents from your disk 
file on the screen and in the backup file. 

Another time when you might be confused about which version of a file 
you're working on is this: If you type sp filename at the DOS prompt, Sprint 
might display this message before opening the file: 

File already open; read over it? 

What this means is that a file by that name is already open in the backup 
file. Sprint doesn't know whether you want to edit the one in the backup 
file or the one saved on disk. Remember, the file on disk is the last saved 
version. If you answer Y to this question, Sprint will open the file on disk 
and get rid of the one already in the backup file. If you answer N, Sprint 
will just reopen the file in the backup file-not the one you've saved on 
disk. If you then save the file, you will overwrite the existing file on disk. 

N ow, to the second case. If you work on confidential files and need to 
protect your data from intruders, it's worth noting that the backup file can 
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still exist on your disk even if your other files do not. For example, say 
you've written a confidential memo. You print it out, then remove the file 
from your disk. However, your backup file that contains the confidential 
memo is still on disk. Some prying person could open that file and read 
your memo. 

To avoid such a scenario, do one of the following: 

• Close all files when you exit Sprint . 
• Set Preserve Editing Session to No. 

Of course, this may be somewhat inconvenient, but if confidentiality is an 
issue you'll want to be sure the backup file is empty or nonexistent when 
you leave your computer. 

Note: In cases where tight security is called for, you will have to use a 
utility that "wipes" the file from disk. The steps outlined here should be 
good enough unless you're trying to keep files from the prying eyes of a 
real hacker. 

Using Wildcards in File Operations 

One of Sprint's most useful features is its support of DOS wildcards. Any 
time Sprint asks you for the name of a file, you can type any combination of 
characters and wildcards. You are probably familiar with this concept if 
you've had some experience with DOS. 

A DOS wildcard is either of two characters: a question mark (?) or an 
asterisk (*). A question mark represents any single character, and an 
asterisk represents any sequence of characters. Think of them like jokers in 
a deck of cards: Anything goes. 

When you want to open or look at a list of files in Sprint, you can use 
wildcards instead of typing the full names for the files you're interested in. 
In the File menu, this use of wildcards applies to the New, Open, Insert, 
and File Manager commands. 

Note: By default, Sprint assumes the .SPR file name extension if you don't 
include one. For instance, if you type CHAP1 in response to the File to 
open: prompt, Sprint will assume you want to open a file called 
CHAP1.SPR. To open a file called CHAP1 with no extension, type a period 
after CHAP1. 

For example, say you want to open a file that begins with the characters 
DOC; you can't quite remember the exact file name. You could choose 
Open from the File menu, then type DOC* • *. Sprint will display a list of all 
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files that begin with the characters DOC; you can choose the one you want 
by moving the selection bar to it, then pressing Enter. 

If you wanted to search for file names that were chapters less than 10, you 
could type CHAP? • DOC. This would find CHAP1.DOC, CHAP2.DOC, etc., but 
not CHAP10.DOC, CHAP11.DOC, etc. 

Similarly, suppose you want to look at a list of files on your disk, but you 
only want to see the ones that have the .DOC extension. Choose File/ Open, 
then type *. DOC. Again, Sprint displays a list of all files with the .DOC 
extension. 

By the way, you can look at a list of files in some other directory, too. 
Choose List Directory from the File Manager menu, then enter the disk and 
full path name of the directory. For instance, to look at the files with the 
.DOC extension in a directory on Drive C called FILES, you'd type the 
following: 

C: \FILES\* .DOC 

You can also use wildcards when you load Sprint from the DOS command 
line. For instance, say you want to open a file with the .TXT extension. You 
could simply type 

SP *. TXT 

Sprint will load, then display a menu of files with the .TXT extension. To 
choose a file from this list, move the selection bar to the one you want, then 
press Enter. 

You will see that Sprint usually remembers the last wildcard file name you 
entered on the status line. For example, if the last time you opened a file 
you entered *. DOC, the next time you ask Sprint to do something with a 
file-open, insert, or look at a directory list-* . DOC will appear on the status 
line. Rather than retyping the name of the file or mask you want, you can 
simply edit what's on the status line by moving the cursor and inserting or 
deleting characters. 

For example, suppose you now wanted to look at files with the extension 
.TXT. You could simply move the cursor to * . DOC, and replace .DOC with 
• TXT. Of course, you can always type over what's there if you want to type 
something completely different; just start typing, and the previous entry 
will disappear. 

You can also use wildcards with the commands in the File Manager menu, 
as described in the next section. 

Note: Any time Sprint prompts for a file name (except the File/New com­
mand), you can simply press Enter to see a list of all relevant files with the 
.SPR extension (or .SPG for glossary files). 
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The File Manager 

Sprint allows you to perform a number of file-related functions with its File 
Manager menu (Figure 7.7). With the choices on this menu, you can copy, 
rename, or erase files on any disk and directory without leaving your 
Sprint editing session. You can also change to a different disk directory. 
This can come in handy when, for instance, you need to copy a file onto a 
floppy disk for someone else, or when you want to view and open some 
files in another disk or directory. (If you want to work with files in a 
different directory, you can also enter the full directory path when 
prompted for a file name.) 
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Figure 7.7: File Manager Menu 

You can choose files to copy, erase, or rename in one of three ways: 

• by typing the name of the file on the Sprint status line 
• by typing a combination of characters and wildcards, then choosing the 

file you want from a resulting list 

• by choosing the List Directory command, choosing the file you want 
from the list, and then choosing the desired command from the File 
Manager menu 
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If you've used the DOS commands COPY, ERASE (or DEL), and REN, 
you'll find that Sprint's corresponding commands work much the same 
way. For instance, to copy a file named DOC.SPR, choose Duplicate-Copy 
from the File Manager menu. At the prompt 

File to copy: 

type DOC. SPR, then press Enter. At the next prompt 

Copy DOC.SPR to: 

type the name of the file you want to hold the copy of DOC.SPR. If you 
want to copy the file to a different disk or directory, include the full path 
name for the file. For instance, to copy the file to a directory called FILES 
with the file name NEWDOC.SPR, you would type 

\FILES\NEWDOC.SPR 

You can also use DOS wildcards (introduced in the previous section) when 
copying a file. For instance, suppose you want to copy a file from the FILES 
directory, but you can't quite remember what the name of the file is. At the 

File to copy: 

prompt, you can just type 

\FILES\*. * 

Sprint will give you a list of all the files in the FILES directory. Choose the 
file you want with the arrow keys, then press Enter. 

You can also see a list of files in the current (logged) directory by choosing 
the List Directory command. Sprint will present a list of all files in the 
directory. To choose a file, move the cursor to the file you want, then press 
Enter. You can then choose the Duplicate-Copy command and follow the 
same steps outlined above. The file you chose from the list will auto­
matically be placed at the File to copy: prompt. 

The Erase and Rename-Move commands work in much the same way. You 
can either choose the command, then type the name of the file you want to 
erase or rename, or use DOS wildcards or the List Directory command to 
see a list of files from which you can choose the file you want. 
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What to Do if Your Disk Fills Up 

Here's a good example of how the File Manager can come in handy for you. 
Suppose your disk is too full to hold your file after you've added text to it. 
When you attempt to save the file, Sprint will tell you 

Disk full. Writing <filename> Press ESC to continue. 

Don't panic-there's a way out of this! 

1. Choose File Manager and choose the List Directory command. 

2. Make a note of files you can delete from the directory. 

3. Choose Erase to delete the files noted in Step 2. 

You should now have enough disk space to save your Sprint file. 

You could also "save the day" by choosing Write As from the File menu to 
write the file to another disk. (You can use the Write As command 
whenever you want to save a file under a different name.) 

You may also get a swap file full error when opening a file if you don't 
have enough disk space in your backup file to hold the file being opened. 
The same procedure just outlined will work in this case, too. Or, you could 
try closing some open files and then open the file you want again, since the 
space formerly occupied in the backup file by those files will be freed. 

Working with Files in a New Directory 

There may be times when you want to open, copy, rename, or erase files in 
another disk or directory. Particularly if you find yourself wanting to open 
several files, you'll probably find it most convenient to switch to a new 
directory using the Change Directory command on the File Manager menu. 
The current disk/directory is the one that Sprint automatically looks in 
when you enter the name of a file to open. 

For example, suppose you're working on files in a directory called SPRINT. 
During your editing session, you find that you need to edit some files in a 
directory called FILES. If you don't change the directory, each time you 
want to open a file in the FILES directory, you'll have to enter the full path 
name of the file, including the name of the new directory. To save typing 
time, you can use the Change Directory command to change the directory 
where Sprint looks for files, so you won't have to enter the full path name 
each time you want to open a file in a different directory. 

When you choose Change Directory, Sprint prompts you with 
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Change Directory to: 

Enter the drive letter and full path name of the directory you want to 
change to. For example, to change to the FILES directory on your hard disk 
(C:), type 

C: \FILES 

Now, when you open a file, you can simply enter the name of the file 
without the path name. 

Note: Any files you've opened that are not in the current directory will be 
saved to the directory where you found them. In other words, even though 
you've changed to a new directory, the files will still be saved where they 
should be-not in the new directory. 

Working with ASCII (Plain Text) Files 

See the full discussion on dealing with ASCII files in Appendix E. 
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c H A p T E R 

8 

Basic Formatting 

Formatting is the process of arranging text so it looks the way you want it to 
on the printed page. As you learned in Chapter 6, you create, edit, and 
manipulate Sprint files with the editor. The formatter comes into play when 
you want to format your text. For example, you might want to emphasize a 
word with bold type, change the margins, or add a page heading and 
footing. 

This chapter introduces basic formatting. It begins with Figure 8.1, which 
shows you how Sprint automatically formats each page of a file. This basic 
layout doesn't require any special formatting commands. Sprint automat­
ically provides left, right, top, and bottom margins, centers the page 
number near the bottom of each page, and begins a new page when nec­
essary. 

Table 8.1 lists the dimensions of the default layout. It explains each of the 
built-in values Sprint uses to format each page of a document. 

The sections following Table 8.1 explain how you can change and enhance 
the default layout with different margins, indented and out dented text, 
tabs, various typestyles and fonts, and headers and footers on the printed 
page. You'll find most of the commands you'll need on the Layout menu. 

We try to cover most common formatting situations in this chapter. For 
information about printing your formatted files, see Chapter 9. Also, don't 
forget that many of your formatting choices depend on what printer you 
installed when you set up Sprint with the SP-SETUP program. If you need 
more information about the formatting commands and menus introduced 
here, refer to the Reference Guide. If you're interested in more advanced for­
matting functions or desktop publishing applications, see the II Advanced 
Formatting" section in the Advanced User's Guide. 
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Figure 8.1: Default Page Layout 
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Top Margin 

Bottom Margin 

Left Margin 

Right Margin 

Header 

Table 8.1: Page Layout Defaults 

1 inch from the top of the page. 

1 inch from the bottom of the page. 

1 inch from the left edge of the page. 

1 inch from the right edge of the page . 

.5 inches from the top of the page. 

Footer .5 inches from the bottom of the page. 

Paragraph Indent The default setting is 0, which means the first line of 
each paragraph is not indented from the left margin. 

Tabs A tab is preset (on the ruler line) at column five, which 
also sets tabs at every fifth column (column 5, 10, 15,20, 
and so on). 

Justification Left; text is automatically aligned at the left margin. The 
right margin is ragged. 

Spacing Single; the printer used determines the default spacing 
between liries. Normally, printers print six (single­
spaced) lines per inch. 

Font All text prints in the default font (the font selected when 
the printer was installed with the SP-SETUP program). 

Paper Size The default setting is 8.5 by 11 inches. 

If you want to change: 

Left or Right Margins, see page 158 or 159, respectively. 

Paragraph Indent, see page 159. 

Tabs, see page 159, and the "Tabs" section beginning on page 162. 

Justification, see page 159. To center text, see page 164. 

Font, see the "Fonts" section beginning on page 171. 

Spacing, see the "Spacing and Page Breaks" section beginning on page 178. 

Top or Bottom Margins, see page 164. 

Header and Footer Margins, see pages 173 and 176, respectively. 

Paper Size, see page 165. 
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The Ruler Line 

Sprint automatically Inserts a ruler line at the top of each file. This ruler line 
sets up the left margin at column 0 (text will have a 1/1 left margin when it 
prints), and the right margin at column 65 (sets a 6-1/2" line length), with 
no paragraph indent, left justification, and tabs every five columns. For 
information on how to change these default settings, see the "Document­
Wide Margins" section on page 164. 

If this format works well for your document, you won't need to change any 
of the default settings. If your text requires a different format, you can 
change the ruler line settings. To do this, you need a command on the 
Layout/Ruler menu (see Figure 8.2), Edit on Screen. 

< 
Just choose the typestyle of your choice from the menu. The 
entire block changes attribute (for example, if you choose 
Underline on a monochrome monitor, the text is underlined 
onscreen; on a color monitor, the text appears in a different 
color) .< 
[. 1· 2· 3· 4· 5· 6 

< 

Sprint 
File Alt-F 
Edit Alt-E 

Insert Alt»I 
Typestyle Alt-T 
St~le Alt-S 
'I .lii d' •• 

Quit Alt-Q 

If you've used a number of different typestyles, or if you're 
looking at a file created by someone else, it may not be 
inmediately obvious what typestyle some text is in, especially if 
you have a monochrome monitor (which has a limited number of ways 
it can change the appearance of text on your screen).< 
_;h"1p:J'Uml~1'311· •• ".Il: .-t.iJ!!I.M-n.~iR:dl"."'. I'3IIMllitIOl9mt:-""iij!ll1O 

Figure 8.2: The Ruler Menu 

Choose Layout/Ruler/Edit on Screen (or press Aft-A); Sprint moves the 
cursor to the ruler line. Make your change(s) as follows: 

To change the left margin: 
Use the arrow keys to move the cursor and then type a left bracket (D 
where you want the left margin to be. 
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To change the right margin: 
Use the arrow keys to move the cursor and then type a right bracket (]) 
where you want the right margin to be. 

To change the paragraph (first line) indent: 
Use the arrow keys to move the cursor and then type an I where you want 
the indent. If you just want to get rid of the current indent, move the cursor 
to the I on the ruler and press Del. (Note: I is shown only if the setting is 
different from the left margin.) 

To change the justification: 
Type an L for left-justified, an R for right-justified, a J for both sides 
justified, or a C for centered text. You can type the character anywhere on 
the ruler line; you needn't type it at the right margin. 

Note: When you type a J on a ruler that already has a C, they both stay on the 
ruler; the result of C] on a ruler line is text that is both left- and right­
justified except for the last line of a paragraph or free-standing lines. If you 
delete the C, an L automatically replaces both C and]. Another variation of 
these ruler codes is R]i that combination results in text that is left- and 
right-justified except for the last line of a paragraph or freestanding lines, 
which will be flush with the right margin. 

To change tab settings: 
Type a T where you want the tab stop to be. To delete existing tab settings, 
move to the T on the ruler and press Del. Pressing T repeatedly when the 
cursor is on the same spot on the ruler will toggle the tab setting On and 
Off. 

If Sprint's default ruler works well for one part of your file, but not for 
another, you can insert a second default ruler by choosing Insert from the 
Layout/Ruler menu, and then modify its settings. 

There is no limit to the number of rulers you can use in your files. Each 
ruler line sets up the basic format for text following the ruler, until Sprint 
sees another ruler with different settings. To delete a ruler, just move to the 
line it's on and press Ctrl-Y, Sprint's shortcut for deleting a line. 

Note that the ruler line lets you create a format for your file based on screen 
character widths. This is not a very precise way of formatting, however, 
especially if your printer supports proportionally spaced fonts. For this 
reason, you may want to use the commands on the Layout/Ruler/Precise 
Settings menu (Figure 8.3). 
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< Precise Settings 
Font Just choose the typestyle of your choice from th • 

entire block changes attribute (for example. if Size 
Underline on a monochrome monitor. the text is U�------------� 
onscreen; on a color monitor. the text appears i Initial (first line) Indent 
color).< Left Indent 
[ • 1 • 2 • 3 • 4 • Right Indent 
< I-----~------I 

NOT SET If you change the typeface of a block that is al Tab Stops 
typestyle (other than nonnal text). Sprint will '------------.... 
typestyles (if your printer supports them). For instance. if you 
have some text that is marked as bold. then select the text and 
choose Italic. your printed text will be bold italic.< 
< 
You can also use this method of selecting text and choosing 
styles from the Typestyle menu to return text to plain text. 
Simply choose Nonnal from the Typestyle menu after you've 
selected the text.< 
< 
If you've used a number of different typestyles. or if you're 
looking at a file created by someone else. it may not be 
immediately obvious what typestyle some text is in. especially if 
you have a monochrome monitor (which has a limited number of ways 
it can Chang~e~arance of text on your screen).< 
_;,*'-,p:J!~!\lIl5IIDlB_ _.m.:IIi.-M-.. -:r.+1r.'1·.,-• .,.-..t~;G1fr.l: --AIAIO 

Figure 8.3: The Precise Settings Menu 

The "Advanced Formatting" section in the Advanced User's Guide explains 
these commands. 

Indenting and Outdenting 

As mentioned in the last section, you can set an automatic paragraph (first 
line) indent simply by typing an I on the ruler line where you want the 
indent to be. You can also outdent paragraphs using the same technique. 

Note: When you set a paragraph indent, Sprint indents the first line of each 
paragraph. If you want all lines indented, you need to reset the left margin 
on the ruler. 

Figure 8.4 shows an example of an outdented paragraph; text "hangs" in 
the left margin to set it apart from the main body of the text. 
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< 
or • [ • 2 • 3 • 4 • 5 • 6 ]L 7 • 
< 
Apples Large green or red fruit< 
< 
Oranges Large orange fruft< 
< 

G:\TEST\APPLES.SPR * Ovr 1:30p Ln.2 of 8 Col 

Figure 8.4: Outdented Text 

As shown, the left margin indicated on the ruler is actually further to the 
right than the indent (in this case, really an outdent) on the ruler line; to 
Sprint, the actual left margin is where the left square bracket is on the ruler. 
To get to that margin, however, you press Tab. 

We entered the word Apples by simply typing Apples at the far left of the 
screen. Then we pressed Tab to move to the left margin. We then typed as 
we normally would, and Sprint adjusted the text so that it was flush against 
the left margin (set at 10 characters). When we were ready to outdent the 
word Oranges, we pressed Enter, then just typed Oranges at the far left 
margin. We then pressed Tab again to enter the column of descriptive text to 
the right of Oranges, and so on. 

This method works well for two columns of text; for more than two 
columns, or for more complex formatting, you'll want to set tabs. If you 
want to indent an existing block of text that begins and ends with a hard 
carriage return (that is, a paragraph), press Shift-Tab with your cursor placed 
anywhere in that block; Sprint will instantly indent the entire block to the 
first tab set on the previous ruler line. To change the column number of the 
indent, choose Layout/Ruler/Edit on Screen and change the column 
number of the first tab stop on the previous ruler. If you want to begin 
entering an indented paragraph, press Shift-Tab and begin typing; the text 
will wrap around at the same left margin until you press Enter to end the 
paragraph. 
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Tabs 

Tabs are another way to offset text from the margins. Choose Layout/ 
Ruler /Edit on Screen (or press Alt-A) and type a T wherever you want to set 
a tab. For example, to set a tab 15 columns from the left margin, move to 
column 15 on the ruler and type a T. When you want text to begin at this 
tab stop, press Tab and type the text. To remove a tab stop from the ruler 
line, choose Layout/Ruler/Edit on Screen (or press Alt-A), move to the tab 
stop, and press Delor T. 

If you want to change a tab stop, press Alt-A, delete the existing tab, and type 
a T at the desired column on the ruler. Sprint will automatically move the 
text from the old tab stop to the new one. 

If you set only one tab, Sprint will automatically space tabs at intervals of 
the tab you set, although only one T will appear on the ruler line. For 
instance, if you set one tab at 6, each time you press the Tab key, the cursor 
will move six characters.to the right-6, 12, 18, and so on. This might be 
useful if you're setting up a table (such as the one in Figure 8.5) where you 
want evenly spaced columns. 

< 
°T 1 0 2 0 3 0 4 0 5 0 6 L 7 0 

< 
< 
10% $65 45 49 430 DUE< 
< 
40% $260 83 24 49 IN< 
< 
40% $260 94 102 650 DUE< 
< 
10% $65 61 780 68 DUE< 

G:\TEST TABLBS.SPR * Ins 1:39p Ln.4 of 12 Call 

Figure 8.5: Setting One Tab for a Table 
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In the example, we've set only one tab at column 7; Sprint has evenly 
spaced the tab columns every seven characters. 

If you set tabs at uneven increments, the distance between the last two tabs 
becomes the default tab interval once you tab beyond the last tab set. For 
example, if you set tabs at 5, 12, 20, 24, and 28, the next tab after 28 will be 
32, followed by 36, and so forth (because the distance between 24 and 28 is 
4). 

Note: You can completely change the tab settings for a different part of 
your document by inserting a new ruler line and setting new tabs. Tab 
settings will affect any text after that ruler line and before the next ruler line, 
as illustrated in Figure 8.6. 

< 
°T 1 0 2 0 3 0 4 0 5 0 6 L 7 0 

< 
< 
10% $65 45 49 430 DUE< 
< 
40% $260 83 24 49 IN< 
< 
40% $260 94 102 650 DUE< 
< 
10% $65 61 780 68 DUE< 
< 

°T lOT 2 0 3 T 0 4 0 5 0 6 L 7 0 

Day Month Year 
< 
24 May 87 
11 June 88 
8 January 35 

Century< 

20th< 
18th< 
20th 

G: TEST\TABLES.SPR * Ins 1:41p Ln.18 of 18 Col 

Figure 8.6: Two Rulers with Two Sets of Tabs 

Precise Tabs 

7 

If you want to set tabs at a precise dimension (for example, 1.25 inches) 
rather than a position measured in number of characters, you can use the 
Layout/Ruler /Precise Settings/Tab Stops command. This is particularly 
useful if your printer supports proportionally spaced fonts. Please see the 

Chapter 8, Basic Formaffing 163 



II Advanced Formatting: Tips, Tricks, and Techniques" chapter in the 
Advanced User's Guide for details on this command. 

Centering Text 

The Style/ Center command cente.rs a line or region of text between the left 
and right margins set on the ruler line. Select the block of text you want 
centered, or, to center a single line, just place the cursor anywhere on that 
line; then choose Style/Center. If you selected a block of text, Sprint will 
insert BEGIN and END CENTER commands above and below it. If you 
placed your cursor on a line of text and chose Center, Sprint inserts a 
hidden AF control code at the beginning and end of the line, centering it 
onscreen and at print time. 

You can also center text by choosing Layout/Ruler/Edit on Screen and 
typing a c on the ruler line above the text to be centered; Sprint will auto­
matically center each line between the left and right margins. 

Document-Wide Margins 

If you lik~, you can change the default margins for your entire document. 
Choose Layout and press D to display the Document-Wide menu (Figure 
8.7). 
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1:45p Ln.774 of 1238 Call 

Figure 8.7: The Document-Wide Menu 

By choosing Left Margin, Right Margin, Top Margin, or Bottom Margin 
from the Document-Wide menu, you can change the default left, right, top, 
or bottom margins. You can use inches, centimeters, points, picas, lines, or 
characters as the dimensions. Sprint will use these default settings as its 
starting point. Any subsequent rulers you insert will be relative to the 
defaults you set with the Document-Wide menu. 

If you want to change the default paper size from 8.5 by 11 inches, you can 
use the Document-Wide/Paper Size command to choose from a menu of 
standard paper sizes or specify any unusual dimensions. 
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Typestyles and Fonts 

< 
Just choose the typestyle of your choice from 
entire block changes attribute (for example. 
Underline on a monochrome monitor. the text i 
onscreen; on a color monitor. the text appear 
color) .< 
[. 2 3 4 
< 

S . t r---; prln~-
the menu. The File Alt-F 

i f you choose 
s underlined 

Edit Alt-,E 

s in a different Insert Alt-I 
-~estile- 1t.1ftI1I.~.1 1M, :' Sty e A t-S 

Layout Alt-L 
Bold 
Ital ic Print Alt-P 
Underline Window Alt-W 
Word Underline Utilities Alt-U 

Customize Alt-C 

If you change the typeface of a block that is 
typestyle (other than normal text). Sprint wi 
typestyles (if your printer supports them). F 
have some text that is marked as bold. then s 
choose Italic. your printed text will be bold 
< --

Large 

You can also use this method of selecting tex 
styles from the Typestyle menu to return text 
Simply choose Normal from the Typestyle menu 
selected the text.< 
< 

+ Superscript 
- Subscript 
Strikethrough 

Font 
Character Size 
Hidden 

Quit Alt-Q 

if 

If you·ve used a number of different typestyl 
looking at a file created by someone else. it 
immediately obvious what typestyle some text 
you have a monochrome monitor (which has a limited number of ways 
it can change thea earance of text on our screen).< 

Figure 8.8: Typestyle Menu 

Typestyle commands let you define how characters print. Typestyles such 
as bold, underline, and italics can enhance the appearance of your text. 

Aside from standard typestyles, the Font command lets you choose from a 
list of font types supported by your printer. If you're using a basic dot­
matrix printer, this list may contain only one or two fonts, like Pica and 
Elite. If you're using a production-quality printer, like a LaserJet or 
LaserWriter, the list is extensive. 

To specify a different character size for text in your document, choose the 
Character Size command from the Typestyle menu. You can enter the size 
you want in any dimension supported by your printer. 

Your printer's capabilities determine which of these commands you can 
use. For example, a LaserJet or LaserWriter supports a wide variety of 
fonts, type sizes, and typestyles, while other, less capable printers may be 
limited to a single font and minimal typestyles. 

In addition to these typestyle commands, Sprint has a variety of Heading 
commands that automatically change the size, typestyle, and font of 
heading text. The "Advanced Formatting: Tips, Tricks, and Techniques" 
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chapter in the Advanced User's Guide explains how to create headings, 
subheadings, chapter titles, and a number of other document divisions. 

Typestyles 

Table 8.2 lists the Typestyle commands you can choose, explains the effect 
of each command, and includes the hidden control code Sprint inserts 
when you choose the command. Check to make sure that you're in Insert 
mode, not Overwrite mode, before choosing a Typestyle menu command; 
otherwise, they won't work correctly. For an explanation of control codes in 
Typestyle commands, refer to page 170. 

On monochrome monitors, Sprint automatically displays different 
typestyles in a different attribute (reverse video, bold, or underlined); on 
color monitors, Sprint displays typestyles in different colors. See the 
"Choosing and Customizing a Color Set" section in Chapter 10, "Cus­
tomizing Sprint," for information about changing these attributes or colors. 
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Control 
Typestyle Code 

Normal I\N 

Bold I\B 

Italic I\E 

Underline I\U 

Word Underline I\W 

Large I\A 

+ Superscript I\S 
and 

- Subscript I\Q 

Strikethrough 1\ X 

Table 8.2: Typestyle Commands 

Function 

Turns off the previous !}'pestyle, and can be used 
with any of tlie typestyles listed in this table. 
Inserting a hard return also turns off a previous 
typestyle. See page 170 for an explanation of how 
this works. 

Prints text in boldface type, if your printer has 
that capability. If your printer cannot print bold 
characters, it will double-strike the text. 

Prints text in an italic font, if your printer has that 
capability. If your printer cannot print italic char­
acters, it will underline the text. 

Underlines all text affected by the command, 
including spaces. 

Underlines all text affected by the command 
except for spaces and punctuation. 

Prints text in large, bold type, if your printer has 
that capability; if not, attempts to print double 
width. This is useful when creating headings or 
divisions in a document. 

Raises and lowers text (respectively) by one­
half of one line. Sprint will also use a smaller 
font size to print the superscript or subscript 
character, if your printer has tnat capability. 

If your printer does not support vertical 
mIcrospacing, Sprint will create a blank line 
above the text for a superscript or blank line 
below for a subscript. 

Prints text with dashes (-) through it, which is 
useful for legal documents (for example, ~ 
May 31,1987). 

Font "OFONT<font name)"N Prints text in the selected font. 
"OENDF"N 

Character "OSIZE<char size)"N Prints text in the specified size. 
size "OENDS"N 

Hidden "OBEGIN COMMENT"N Keeps selected text from printing even though it 
"OEND COMMENT"N appears onscreen. 
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Choosing and Changing Typestyles 

There are two different ways to change the typestyle of text, depending on 
whether you are inserting new text that you want to be affected or 
changing the typestyle of existing text. 

New text: 

Choose the desired typestyle from the Typestyle menu, type the text to be 
affected, and then choose the Normal command from the Typestyle menu. 
You must be in Insert mode to choose a Typestyle command and then enter 
new text in that typestyle; make sure the status line reads Ins and not Ovr 
before you start. 

You can also press the Right arrow key to end the typestyle. For example, 
choose Bold from the Typestyle menu, type the text you want in bold, and 
then press the Right arrow key. The cursor won't move, and you won't notice 
anything different, but you're actually moving the cursor past the hidden 
AN that Sprint inserted when you chose Typestyle/Bold. This AN character 
is the code to end the typestyle, so when you start typing again the new 
text will be in plain type. 

Change existing text: 

Select the block of text that you want to change, and then choose the 
desired typestyle from the Typestyle menu. Since you've marked a block, 
Sprint knows that the typestyle applies to that block, and changes the entire 
block to the selected typestyle. 

For example, if you have a block of plain text, and decide you want it to 
print in italics, select the block (press F3 and then move the cursor until the 
text is marked), then choose Italic from the Typestyle menu. Sprint auto­
matically places a hidden A E at the beginning of the block, telling the for­
matter to begin printing in italics, and a AN after the last character of the 
selected block, ending the typestyle. 

If you want to replace one Typestyle command with another, you need to 
delete the control code at the beginning of the affected text that represents 
the currently selected typestyle, and replace it with a different typestyle 
command. For example, if you have a block of text in bold, and want to 
change it to italics, you need to delete the hidden AB that begins the Bold 
command. There is a simple way to replace the Bold (AB) command: 

1. Select the block of text you want to change. 

2. Choose Normal from the Typestyle menu. 

3. Choose ReSelect Block from the Edit/Block Select menu. 

4. Now choose the new style from the same menu. 
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If you want to nest typestyles (have a block affected by more than one 
typestyle command, like bold and italics), reselect the block and choose 
another Typestyle command. For example, if you want a block of text to 
print in bold italics: 

1. Mark the block and choose the Bold command from the Typestyle 
menu. 

2. Press AIt-8 or choose ReSelect Block from the Block Select menu to 
reselect the block. 

3. Choose the Italic command from the Typestyle menu. 

Control Codes in Typestyle Commands 

Sprint's typestyle commands are not toggles; you choose one command to 
turn on a typestyle (for example, choose Bold from the Typestyle menu), 
and choose a different command (Normal, also on the Typestyle menu) to 
turn the typestyle off. Whenever you choose a Typestyle command, Sprint 
inserts a control code to tell the formatter what to do when it sees the text. 
For example, Sprint inserts a "U when you choose Underline, a "B when 
you choose Bold, and a "S when you choose superscript (+). It also inserts a 
"N, which ends the typestyle. There are two ways to view these hidden 
control codes: 

• Press Alt-Z, which acts as a toggle between show codes and hide codes, or 

• Press F10, and then choose Customize/Screen/Codes. 

When you choose Codes, Sprint automatically toggles between Off (hide 
the codes) and On (show the codes). If you want to see the codes, press 
Shift-Esc when the command displays Codes ON. Normally, you don't need 
to see these codes, but there are a few cases when you need to. See 
Chapter 6, page 127 for details. 

Typestyles and Hard Returns 

If you choose a Typestyle command, begin entering text, and then insert a 
hard return (by pressing Enter), the typestyle will be turned off; that is, the 
hidden "N control code in front of your cursor will be deleted. To 
compensate for this, Sprint will automatically insert a hidden ''begin new 
typestyle" control code (for example "B for bold or "E for italics) after 
every hard return; that way, as you continue to type and even insert more 
hard returns, you won't have to keep re-choosing the same typestyle after 
every hard return. (Sprint does not do this, however, if you're working 
with control codes revealed.) 
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It's important to be aware that a hard return deletes the "N that "closes off" 
a typestyle and immediately inserts a new "begin" typestyle code ("B, "E, 
"T, and so on), because typestyles behave differently after you insert a hard 
return. One difference is that, if you choose Typestyle/Normal or press 
Right arrow to end a typestyle, as you normally would when you finish 
entering text in a different typestyle, it won't work. Don't panic about not 
being able to turn off a typestyle when this happens, though; just insert a 
"N with the Insert/Control Character command to end the typestyle. 

Also, if you toggle Customize/Screen Codes On and notice that every 
"begin" typestyle control code at the beginning of a line doesn't have a 
corresponding "N ("end") control code, don't worry; Sprint will figure out 
that you want to continue the typestyle past a hard return until you insert a 
"N control code with Insert/Control Character. 

Fonts 

Printing in various fonts can also enhance the appearance of your text. For 
example, you may want certain documents printed in a Helvetica font, 
while others might look better in a Times font. 

There are two basic ways to specify a font change: 

1. The Typestyle/Font command lets you specify a font for a marked area 
of text. 

2. The Layout/Ruler/Precise Settings/Font command lets you select a 
font for text affected by the current ruler line. 

The fonts you can use depend on the printer(s) you've installed (with the 
SP-SETUP program) to print your Sprint files. When you choose Font, 
Sprint displays the fonts available for your currently selected printer. 
Figure 8.9 illustrates Font displays for the Apple LaserWriter and a daisy 
wheel printer. 
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Figure 8.9: Sample Font Displays 

Unless you specify otherwise (with either of the Font commands), the for­
matter will print your document with the default font. The default font is the 
font you specified when you installed the printer. 
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If you want to change the font for an individual word or a selected block of 
text, select the text and then choose Typestyle/Font. Sprint displays a list of 
fonts for the current printer. Choose the desired font, and the formatter will 
automatically print the selected text in the specified font. 

You can also specify a font for text that follows a particular ruler line. 
Position the cursor below the ruler you want to affect, and then choose 
Layout/Ruler/Precise Settings/Font. Choose the desired font, and Sprint 
will add a font parameter to the ruler line. For example, if you choose 
Helvetica and then press Alt-Z, you'll see the parameter font Helvetica added 
to the ruler line's control codes. All text below this ruler line will print in 
the Helvetica font. To return to your previous font, insert another ruler and 
choose your default font from the list of fonts. 

If you have only one ruler line in your file, the entire document will print in 
the font you specified. If you have more than one ruler, only the text 
appearing below the current ruler and above the next ruler line will print in 
the selected font. 

If you want to print an entire document with a font other than the default 
font, you need to use the Layout/Ruler/Precise Settings/Font command 
on the first ruler in the file, which will change the font of the entire file. 

Remember, when you choose the Font command, Sprint displays the fonts 
supported by your currently selected printer. To view the fonts supported by 
another printer, you need to choose Print/ Current Printer, choose the 
desired printer, and then choose the Font command. Changing the printer, 
however, does not change the fonts selected. If the new printer has a font of 
the same name, it will be used. If not, you will get a warning message when 
you print. (You'll also get a warning message at print time if, when you 
choose the Typestyle/ Character Size command, you specify a character 
size your printer doesn't support.) The file will print anyway, using a font 
and character size supported by the current printer. 

Page Headers 

A page heading (or "header") is one or more lines of text that appear in the 
top margin of the page. Sprint supports multiple-line headers, and lets you 
specify how text should be formatted in the heading. You can place heading 
text at the left margin, aligned at the right margin, or centered between the 
left and right margins. Headings can also alternate; for example, you can 
have one page heading for odd-numbered pages and another for even­
numbered pages. Header commands can appear anywhere in your docu­
ment. The text of the page heading will appear on all pages following the 
command. 
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When you choose Header from the Layout menu, Sprint displays a pop-up 
menu (see Figure 8.10). 
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Figure 8.10: The Header Menu 

If you want the same header to appear on all pages except the first, choose 
All Pages. Sprint then inserts two commands-BEGIN and END 
HEADER-with a blank line between them. You type the page heading text 
between the two lines. For example, to print the text User's Manual at the 
top of every page except the first, choose Layout/Header/All Pages, and 
type User's Manual. This text will appear in the heading margin (.5 inch 
from the top of the page) and will begin printing at the left margin. 

If you want the header text aligned at the right margin rather than at the 
left, choose Layout/Header, then choose Insert/Wide Space (Spring) before 
you type the text of the header. The Wide Space command tells the format­
ter to push text over to the right margin. (You can also insert a ruler line 
within the header to set justification, margins, and centering.) 

Let's say you want text to print at the left and right margins, and in the 
center of the header line. For example, the header text might be: 

User's Manual January 10,1989 First Draft 

To do this, choose Layout/Header/All Pages, type User's Manual, choose 
Insert/Wide Space (Spring), and then type January 10, 1989. You'll notice 
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that the Wide Space command pushes the date over to the right margin. 
Now choose Wide Space again, and type First Draft. The date moves to the 
center of the line, and the words First Draft appear at the right margin. 

You can set up alternating headers so that one header line appears on odd­
numbered pages and another, different header line appears on even­
numbered pages. To define headers for even pages, choose Layout/ 
Header /Even Pages and type the heading text for even-numbered pages. 
Likewise, to define headers for odd pages, choose Layout/Header/Odd 
Pages and type the heading text for odd-numbered pages. 

Use the Position command to specify exactly what distance from the top of 
the page you want the header to print. The default is 0.5 inch from the top 
of the page. 

To create multiple-line headers, simply press Enter at the end of each header 
line and type the next line of header text. The formatter will print all header 
lines that appear between the BEGIN and END HEADER commands. For 
example, 

BEGIN HEADER 

END HEADER 

Annual Report 
March 15, 1989 

For internal review only! 

If you want to stop page headings from appearing at some point in your 
document, choose a new Header command, but don't enter any text 
between the BEGIN and END HEADER commands. This tells the formatter 
to leave your header lines blank. 

If you want to include a page number in a header, choose Insert/Variable/ 
Page anywhere in the header text. Sprint prompts you to pick a template for 
the way the page number will print from a template menu (just highlight 
any of the choices-for instance arabic-and press Enter). 

If you want to adjust the vertical header placement, choose Position from 
the Header menu. You can then enter any dimension by which you want to 
offset the header from the top of the page (the default is .5 inches from the 
top margin). For example, if you want less space between the top of the 
page and the header, you could enter .25. The header would appear .25 
inches above the text area (and .75 inches from the top of the page, 
assuming the top margin remains at the default of one inch). 

Also, a single document can have more than one header. Simply create a 
new header at the spot in your document where you want it to change. The 
next printed page will have the new header. 
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You can also use a ruler line to format your header. Just be sure to insert the 
ruler immediately after the BEGIN HEADER command. This ruler will 
affect only the header at print time, but you should still insert another 
default ruler after the END HEADER command; that way, any text 
following the header will be shown onscreen according to the default ruler, 
not the ruler you used to format the header. 

If you want a title page for your document, choose Title Page from the 
Layout menu. Then enter a title (multiple lines are fine). At print time, 
Sprint will create a title page with your text centered in the middle of the 
page. To put a header on the title page, choose Layout/Header/Title Page 
and type text for the header (to appear only on the title page). 

Page Footers 

A page footing (a "footer") is one or more lines of text that appear in the 
bottom margin of the page. By default, Sprint automatically centers the 
current page number in the footing line of each printed page (except page 
1). You can change the text of a footer, as well as the format and placement 
of footer text, by using commands from the Layout/Footer menu (Figure 
8.11). This menu works the same way as the Header menu (see the previous 
section). 
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Figure 8.11: The Footer Menu 

As with page headers, Sprint supports multiple-line footers, and lets you 
specify how text should be formatted in the footer. 

You can use the Position command to specify the exact place on the page 
where you want the footer to print. The default is 0.5 inch from the bottom 
of the page. 

Footer commands can appear anywhere in your document. The text of the 
page footer will appear on all pages following the command. If you don't 
insert a page footer, Sprint will automatically center the page number in the 
footer line. 

Note: Once you enter a Footer command, Sprint will no longer print the 
page number at the foot of the page. If you want to include the page 
·number as part of the footing text, choose Insert/Variable/Page at the place 
you want the page number to print. This tells the formatter to fill in the 
value of the current page number when it formats your file. For more infor­
mation about variables (such as page number), please see the "Advanced 
Formatting" section in the Advanced User's Guide. 
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Spacing and Page Breaks 

To change the spacing of lines in a document (sometimes called leading), 
choose Layout/Ruler/Line Spacing. To make other spacing and page break 
settings, choose Layout and press P to display the Page Breaks menu 
(Figure 8.12). 
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Figure 8.12: The Page Breaks Menu 

Alt-Q 

Sprint's spacing commands let you determine the amount of space between 
each printed line, the space between paragraphs, and the maximum 
amount of space between words on a line. You can also keep an area of text 
together on a page, reserve an area of blank space on a page, and prevent 
the formatter from leaving an "orphaned" line at the top or a "widowed" 
line at the bottom of a page. 

Line Spacing 

With most word processors, you can specify single or double spacing; some 
allow 1.5 and triple spacing. Sprint supports these spacing commands, and 
also provides the flexibility required for desktop publishing applications; it 
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allows you to enter custom spacing dimensions in points, inches, lines, or 
any other dimension with the Layout/Line Spacing menu (Figure 8.13). 
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Figure 8.13: The Line Spacing Menu 

A normal-sized line equals approximately 12 points; an inch equals 
approximately 72 points. This means that, if your printer supports vertical 
microspacing (as most laser printers do), your line spacing can be quite 
precise. 

Unless you select a Line Spacing command, Sprint automatically single 
spaces your printed text. Single-spacing means the spacing equals the points 
size. 

If you do need to change the default spacing, you can make it be just about 
anything you like. The Line Spacing menu lists Single, 1.5, Double, and 
Other, as explained in Table 8.3. 
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Single 

1.5 

Double 

Other 

Table 8.3: Spacing Commands 

Selects single spacing, which prints approximately six lines per vertical 
inch. Choosing this commana inserts spacing 1 on the current ruler 
line. 

Selects one and one-half line spacing, which widens the gap between 
lines. Instead of the typical six lines per inch, Sprint prints only four 
lines per inch. Choosing this command inserts spacing 1. 5 on the 
current ruler line. 

Selects double spacing, which prints approximately three lines per 
vertical inch. This means there is the equivalent of two blank lines 
between every printed line. Choosing this command inserts spacing 2 
on the current ruler line. 

Lets you specify spacing in any measurement (points, picas, centi­
meters, or inches) if your printer has that capability. This is useful when 
laying out documents for printing on a tlpesetter or printer that uses 
the PostScript language. Let's say you re creatin~ a brochure and 
single-spacing looks too crowded, but 1.5 spaCIng creates more 
whitespace than you really want. Here's a perfect application for Other. 
You can customize your lme spacing quite easily. Smce Single specifies 
12 points between lines and 1.5 specifies 18 pomts between lines, you 
could choose Other and specify 15 points. 

The Line Spacing command works on the current ruler. (In fact, the com­
mand is embedded in the ruler, as you can see if you press Alt-Z to reveal the 
control codes of the ruler.) You won't see the effect of the command on the 
screen, but when you print your file, the formatter will read the spacing 
codes on the ruler line and format your text with the desired line spacing. 

If you want to change the spacing of just a certain part of your file, you can 
insert a ruler above and below the text you want to be spaced differently, 
move the cursor within that region, and then choose the Line Spacing com­
mand. 

Spacing between Paragraphs 

As far as Sprint is concerned, a paragraph is one or more lines of text 
preceded and followed by a blank line (two hard carriage return characters 
created by pressing Enter twice). By default, the formatter inserts a single 
blank line between each paragraph of text. 

To vary the amount of space between paragraphs, choose Layout/ 
Document-Wide/lnter-Paragraph Spread. Sprint prompts 

Spread to use between paragraphs: 

Enter the amount of space you want between each paragraph in the 
document. If you type 2, for example, the formatter will insert two blank 
lines between each printed paragraph; if you type .5, there will be one-half 
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line between paragraphs. You can use dimensions other than lines in your 
response to the prompt. For example, you can set the spacing between 
paragraphs to 36 points or .25 inches. 

Spacing between Words 

If you want text justified at both the left and right margins, Sprint will need 
to insert extra spaces between words to get the text to line up correctly. The 
Layout/Document-Wide/Word Spacing command lets you decide the 
maximum number of spaces Sprint can insert when trying to justify a line. 
Choose Word Spacing and type in the appropriate value. For example, you 
could type 2 (two extra spaces may be inserted) or 1 pica or .25 inch. If 
Sprint needs additional space to align the text, it will expand the space 
between characters. 

Reserving Blank Space 

If you want the formatter to leave part of the page blank (to paste in a 
figure, for example), choose the Layout/Page Breaks/Reserve Space com­
mand. Sprint prompts for the amount of blank space you want reserved on 
the page. You can type a specific number of lines (for example, type 12 to 
reserve 12 blank lines), or use dimensions such as inches, points, or centi­
meters. 

When the formatter sees this command during formatting, it looks at the 
amount of space remaining on the current page. If the current page doesn't 
have enough space for the reserved blank area, the formatter breaks the 
page and puts the reserved blank space at the top of the next page. 

Note: The Reserve Space command is used to reserve vertical blankspace. If 
you want a fixed amount of blank space on a line, use the Insert/Wide 
Space (Spring) or Insert/Non-Breaking Space command. Wide Space acts 
like a "spring," in that it pushes text to the right to align it at the right 
margin or between tab stops. The Non-Breaking Space command inserts a 
single space that will not be altered during formatting (that is, the formatter 
won't add additional spaces at this location when trying to justify the line). 

To insert a blank page in your document, choose Blank Page(s) from the 
Layout/Page Breaks menu. 
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Keeping Text Together on a Page 

When you want to keep an area of text together on a page (for example, a 
list, or a closing paragraph in a letter), there are several commands on the 
Layout/Page Breaks menu that will come in handy. 

The Group Together on Page command keeps the specified text together on 
a page. If there is not enough space on the page for the whole block of text, 
Sprint will print the block on the next page. To use this command, you can 
either select an existing block as usual, then choose the command, or 
choose the command first and then enter the text you want to "group." 
Sprint inserts a BEGIN and END GROUP on either side of the block. 

The Keep with Following Text command prevents Sprint from breaking the 
page after the specified line. Use this command to keep a particular line of 
text with what follows. 

The Layout/Page Breaks/Conditional Page Break command tells Sprint to 
insert a conditional page break in a location where it normally would not. 
For example, you might want to allow Sprint to break a page after the first 
line in a paragraph (normally not allowed). 

In general, you will probably want to avoid inserting an unconditional page 
break in a document (with the Page Breaks/Insert (Unconditional) com­
mand). This command will insert a page break regardless of how the text 
falls on the page. If you delete some text in your document, you may find 
the page being broken after only a few lines. 

Orphan and Widow Lines 

Unless you choose a command such as Conditional Page Break, Group 
Together on Page, or Reserve Space, the formatter prints as much text as 
possible on a page and then begins printing the following page. This means 
the first line of a paragraph could appear by itself at the end of the page (a 
widow), and the following page would contain the remainder of the 
paragraph. Similarly, the formatter might print all but the last line of a 
paragraph at the end of a page, and print the single, remaining line (an 
orphan) at the start of the next page. 

If you want to prevent widow and orphan lines, choose Layout/Page 
Breaks/Widow-Orphan Control. Sprint prompts for a setting, which is the 
minimum number of lines you want to appear together at the end and 
beginning of a page. For example, if you type 3, the formatter will print at 
least three lines of a paragraph at the end of a page; it won't leave the first 
two lines of the paragraph "orphaned" at the bottom of the page. If there 
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isn't enough room on the current page to print the first three lines of a para­
graph, the formatter will break the page and begin the paragraph on the 
following page. Likewise, if the formatter can print all but the last two lines 
of a paragraph, but you've set Widow-Orphan Control to 3, Sprint will 
break the page so it prints the last three lines of the paragraph at the top of 
the next page. 

For information on how to insert a conditional line break, see the "!" entry 
in Chapter 2 of the Reference Guide. 

Hyphenation 

Formal, professional-looking documents often require full justification 
(aligned at both margins). If you're creating documents that are fully 
justified, you should usually choose to hyphenate the file for the best­
looking output. 

When the editor justifies text at both margins on the screen, it inserts spaces 
between words to align text at the right margin. If a particularly long word 
falls near the end of the line, but won't fit on the current line, the word will 
print on the next line and the editor adds blank space between words on 
the current line so the text is justified. 

You can avoid this extra blank space during printing if you conditionally 
hyphenate text. By conditional we mean that you allow Sprint to break a 
word over two lines when necessary; otherwise, the word prints together on 
the line, without printing a hyphen. 

The Utilities/Hyphenation menu lists commands that let you conditionally 
hyphenate a single word, a selected block of text, or an entire file. When 
you choose one of these Hyphenation commands, Sprint displays, in the 
status line, how it will automatically hyphenate the text when necessary. If 
you wish, you can override the default hyphenation points. 

Which words Sprint hyphenates depends on two other Hyphenation com­
mands: Minimum Word Length and Space Allowable. The Minimum Word 
Length command tells Sprint the minimum number of characters required 
before Sprint can hyphenate a word. The default is 8, which means that 
only words of eight characters or more will be affected by the Hyphenation 
command you choose. 

The Space Allowable command specifies the maximum number of extra 
blank spaces that can appear in a line that's justified. The default is 4, which 
means that, if the editor inserted more than four extra spaces when 
justifying the text on the screen, then the formatter will try to bring the first 
word in the next line up to the current line, and hyphenate it appropriately. 
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In this way, the formatter can fill up some of the extra blank space when 
justifying text at the right margin. The larger the value of Space Allowable, 
the less hyphenation will be attempted during formatting. 

Note to two-floppy system users: If the dictionary files that you need to 
hyphenate files are not on your Program A Disk, Sprint will prompt you to 
remove it from Drive A and replace it with the disk containing the files in 
order to use the commands on the Hyphenation menu. 

Lists 

Sprint provides several different list formats: Outline, Numbered, Multi­
level, Description, Asterisks, Bullets, and Hyphens. To use them in your 
documents, choose the commands from the Style/Lists menu (see Figure 
8.14). 
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Figure 8.14: The Usts Menu 

Although you can create lists manually, the Outline format will use classic 
outline numbering and lettering, the Numbered and Multilevel formats 
will automatically number the items (paragraphs), Hyphens will automat­
ically insert a hyphen to the left of each item (paragraph), and Description 
will create two-column lists. This way, if you insert a new item in, for 
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example, a numbered list, you don't have to renumber the items yourself; 
Sprint does it for you. Remember, though, you won't see the effect of these 
formats until you print. 

Outlines 

The Outline command lets you create an outline, automatically lettered and 
numbered in classic outline style. 

For example, you can use this command to create the following outline: 

I. Composers 

A.German 

1. Bach 

a. Johann Sebastian 

i. Sacred work 

ii. Secular work 

b. Johann Christian 

2. Beethoven 

3. Schubert 

4. Wagner 

B. Russian 

1. Rimsky-Korsakov 

2. Tchaikovsky 

3. Stravinsky 

a. pre-exile work 

b. post-exile work 

To create the outline, choose Outline from the Style/Lists menu and press 
B to begin the format; Sprint inserts a BEGIN OUTLINE command. Type 
the outline; when you want to indent a subheading, insert a new BEGIN 
OUTLINE command. When you come to the end of a level (for example, 
after the last German composer listed), choose Style/Lists/Outline again 
and press E to end the format. Be sure that every BEGIN command in your 
outline has a corresponding END command nested at the appropriate place. 
Nested means that each subheading level within the outline has its own 
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BEGIN and END format commands, and that each END format command 
occurs in reverse order of the BEGIN format commands. For example, if 
you created an Outline format and then decided to re-select the same block 
and choose Layout/Page Breaks/Group Together on Page to prevent a 
page break in the middle of your Outline format, this is how the BEGIN 
and END OUTLINE commands would appear nested within the BEGIN 
and END GROUP commands onscreen: 

BEGIN GROUP 
BEGIN OUTLINE 
Catherine II (the Great) 

Paul I 

Alexander I 

Nicholas I 
END OUTLINE 
END GROUP 
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This how the example previous outline, with nested format commands, 
appears onscreen: 

BEGIN OUTLINE 
Composers 

BEGIN OUTLINE 
German 

BEGIN OUTLINE 
Bach 

BEGIN OUTLINE 
Johann Sebastian 

BEGIN OUTLINE 
Sacred work 

Secular work 
END OUTLINE 

Johann Christian 
END OUTLINE 

Beethoven 

Schubert 

Wagner 
END OUTLINE 

Russian 

BEGIN OUTLINE 
Rimsky-Korsakov 

Tchaikovsky 

Stravinsky 

BEGIN OUTLINE 
pre-exile work 

post-exile work 
END OUTLINE 
END OUTLINE 
END OUTLINE 
END OUTLINE 

Note: Each outline item must be preceded by a blank line. If you want to 
print a single-spaced outline, consult the "Advanced Formatting" section of 
the Advanced User's Guide. 
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~u~beredLists 

The Numbered command tells the formatter to precede each paragraph 
with a number, followed by a period and one-quarter inch of space, like 
this: 

1. Here's the text of the first paragraph. 
2. Here's the next item. Each item that you want numbered must be 

preceded by a blank line. 
If the item contains more than one paragraph, begin the paragraph 
by pressing Tab, and then type the additonal paragraphs. That way, 
Sprint won't give the paragraph a number. 

3. Notice how the text is automatically aligned. You don't have to space 
over or manually align text. 

To create a numbered list, choose Style/Lists/Numbered. Press B to begin 
the format. Sprint inserts a BEGIN NUMBERED command. Type the text of 
the list, and make sure the paragraphs (the line items in the list) are 
separated by a blank line. At the end of your list choose Style/Lists/ 
Numbered and press E to end the format region. 

The following example lists the steps involved in making a peanut butter 
and jelly sandwich. The Numbered command automatically numbers each 
paragraph (step) for you. (If the steps are "nested," Sprint switches from 
numbers to letters.) 

1. Remove two pieces of bread from the bread bag. 
2. Get a jar of peanut butter and another jar of jelly from the refrig­

erator, and open each jar. 
3. Dip a knife (or other suitable spreader) into the peanut butter, and 

then spread the peanut butter on one piece of bread. 
4. Remove any leftover peanut butter from the knife. 

Note: There are three ways to do this: 

a. Wash or wipe the knife so that it's clean. 
b. Use your finger (if it's your sandwich). 

c. Move the knife across the other piece of bread. Be careful if you're 
using junk-white bread; it tears easily. 

5. Dip the knife into the jelly jar, and then spread the jelly on the other 
piece of bread. 
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6. Some people like to add sliced bananas to their peanut butter and 
jelly sandwiches. If you're one of these people, remove any leftover 
jelly from the knife, slice a firm banana, and then place the slices on 
the bread that you spread with peanut butter. 

7. Put the two pieces of bread together, sticky sides to the middle. If 
you've added bananas, put the "jelly" piece on top of the peanut 
butter /banana piece. 

To create this printed example, choose Style/Lists/Numbered and press B. 
After the BEGIN NUMBERED command, type the text of the list but don't 
enter the numbers or letters that you see at the beginning of each 
paragraph. Begin each paragraph (in this case, each step) at the left margin, 
and separate each paragraph with a blank line. When you get to the 
paragraph that begins with "Note:", begin the paragraph with a Tab, and 
then type the text. This tells the formatter you want to start a new 
paragraph but don't want it numbered. At the end of the list, choose Style/ 
Lists/Numbered again and press E to end the format region. 

To create the list of ways to remove extra peanut butter (the text preceded 
with a., b., and c.), you need to nest another Numbered format within the 
main Numbered format. Mark the text that explains how to remove extra 
peanut butter, and then choose Style/Lists/Numbered again. 
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The example text should look like this onscreen: 

BEGIN NUMBERED 
Remove two pieces of bread from the bread bag. 

Get a jar of peanut butter and another jar of jelly from the refrigerator, and 
open each jar. 

Dip a knife (or other suitable spreader) into the peanut butter, and then spread 
the peanut butter on one piece of bread. 

Remove any leftover peanut butter from the knife. 

Note: There are three ways to do this: 

BEGIN NUMBERED 
Wash or wipe the knife so that it's clean. 

Use your finger (if it's your sandwich). 

Move the knife across the other piece of bread. Be careful if you're using 
junk-white bread; it tears easily. 
END NUMBERED 

Dip the knife into the jelly jar, and then spread the jelly on the other piece 
of bread. 

Some people like to add sliced bananas to their peanut butter and jelly 
sandwiches. If you're one of these people, remove any leftover jelly from the 
knife, slice a firm banana, and then place the slices on the bread that has the 
peanut butter on it. 

Put the two pieces of bread together, sticky sides to the middle. If you've 
added bananas, put the "jelly" piece on top of the peanut butter/banana piece. 
END NUMBERED 

If the items to be included in the list are already present in the text, you can 
format them with any of the commands on the Lists menu by selecting 
them as a block with F3, choosing a list format from the Style/Lists menu, 
and then pressing Enter. Sprint will automatically insert BEGIN and END 
commands above and below the selected block of text. 

Remember: Each numbered item must be preceded by a blank line! If you 
want a list to print single-spaced, you need to modify the Numbered format. 
This is an advanced formatting function, however, and is discussed in the 
section "Advanced Formatting" in the Advanced User's Guide. 

Unnumbered Lists 

If you want line items/paragraphs in a list to begin with a hyphen (-), you 
can use the Hyphens format. It works in the same way as the Numbered 
format, without numbering the paragraphs. 
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The following example shows an unnumbered list of ingredients for choco­
late truffle cake. The Hyphens command automatically begins each 
paragraph with a hyphen. 

- 1 pound chocolate (any of the following types): 

* Sweetened dark 
* Semisweet 
* Bittersweet 

- 5 ounces butter 

- 5 eggs, separated 

- 3 cups whipping cream 
- Sugar (about 1/2 cup to sweeten the cream) 
- Sweet dark chocolate for shavings 

To create this printed example, choose Style/Lists/Hyphens and press B to 
begin the format region. Sprint inserts a BEGIN HYPHENS command, and 
places the cursor on the blank line after it. Type the text shown above, but 
don't type the ''bullets'' at the left; when you print this example, the format­
ter will automatically print a hyphen before each major ingredient and an 
asterisk before each type of chocolate. Begin each paragraph (in this 
example, begin each line) at the left margin, and separate each paragraph 
with a blank line. When you're done with the list, choose Style/Lists/ 
Hyphens and press E to end the format region. 

Note that this example actually contains two unnumbered lists. The main 
ingredients comprise one list (the main list), and the types of chocolate are 
a sub list within the main list. The items in the sublist are indented from the 
main list and preceded by a different type of bullet. This is called nesting 
formats-including one format within another. To create this effect, mark 
the sub list ("types of chocolate" paragraphs) and choose Lists/Hyphens 
again. The screen text looks like this: 
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BEGIN HYPHENS 
1 pound chocolate (any of the following types) : 

BEGIN HYPHENS 
Sweetened dark 

Semisweet 

Bittersweet 
END HYPHENS 

5 ounces butter 

5 eggs, separated 

3 cups whipping cream 

Sugar (about 1/2 cup to sweeten the cream) 

Sweet dark chocolate for shavings 
END HYPHENS 

If you don't want a hyphen to appear in front of a particular paragraph, 
press Tab before beginning the paragraph. 

Each item/paragraph must be preceded by a blank line! If you want a list 
to print single-spaced, you need to modify the Hyphens format. This is an 
advanced formatting function, however, and is discussed in the II Advanced 
Formatting" section in the Advanced User's Guide. 

Two-Column Lists 

The Description command is typically used when defining a list of terms, 
concepts, or ideas. For example: 

Computer 

Eraser 

Pencil 

An object that lets you run the Sprint word processing 
program. 

A tool for removing things that you write. It has a ten­
dency to get lost, and leaves messy rubber shavings all 
over your desk. 

A tool for writing, which also has a tendency to get lost. 
It also rolls off your desk when you're not looking, and 
has to be sharpened all the time. 

The pencil ha,s been replaced with another tool, called 
word processing. 

To create this list, choose Description from the Style/Lists menu and press 
B to begin the format. Sprint inserts a BEGIN DESCRIPTION command. 
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Type the text to be "outdented" (the text in the left column), press Tab to 
begin the second column, and continue typing the rest of the paragraph. 
Insert a blank line between each paragraph. If you don't want a paragraph 
to be "outdented" (see the last paragraph in this example), press Tab before 
you type the text. The screen text looks like this: 

BEGIN DESCRIPTION 
Computer An object that lets you run the Sprint word processing program. 

Eraser A tool for removing things that you write. It has a tendency to get 
lost, and leaves messy rubber shavings allover your desk. 

Pencil A tool for writing, which also has a tendency to get lost. It also 
rolls off 'your desk when you're not looking, and has to be sharpened all the 
time. 

The pencil has been replaced with another tool, called word processing. 
END DESCRIPTION 

When the formatter sees the Tab character, it automatically moves over 
one-quarter of the line length, and then prints the text following the Tab. 

Be sure to insert a blank line between each paragraph. In doing so, you tell 
the formatter to start a new entry in the list. 

When you are done with the list, choose Description from the Style/Lists 
menu and press E to end. the format region. Sprint inserts an END 
DESCRIPTION command. 

Note: Another way to create a two-column list like this is to set a ruler line 
so that the left margin (set by typing a left bracket ([) on the ruler line) is 
about 1 inch to the right of the first-line indent (set by typing an I on the 
ruler line). Now you can type in your list and see it formatted onscreen as it 
will print. The only difference from the Description format is that the items 
in the leftmost column will not be boldfaced. 

This concludes the discussion of basic formatting techniques and com­
mands. For information on more advanced formatting functions, or to learn 
about desktop publishing with Sprint, please see the II Advanced For­
matting" section in the Advanced User's Guide. 
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c H A P T E R 

9 

Printing 

This chapter tells you how to print your Sprint files. We discuss the 
printing options available to you on the Print menu (Figure 9.1), as well as 
how to resolve formatter errors that may occur when you print your files. 
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Figure 9.1 : The Print Menu 

It is assumed that you have used the SP-SETUP program (described in 
Chapter I, "Before You Begin") to install Sprint for your printer(s). If you 
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haven't yet done so, please go back and do that now. We also assume you 
have read and understood Chapter 8. 

Note to users with two-floppy systems: Your Program A Disk must be in 
Drive A in order to print. If you have 360K drives and want to print to a 
PostScript printer, you should install your PostScript printer as an alternate 
with the SP-SETUP program-simply insert your Program B Disk when 
SP-SETUP prompts for a disk during alternate printer installation. When it 
comes time to print to a PostScript printer, Sprint won't prompt you to 
insert Program B Disk; as long as you've previously copied the PostScript 
printer driver file to Program B Disk, just go ahead and insert it before you 
choose Print/ Go. 

There are two ways you can format and print a Sprint document. Normally, 
you'll want to print from within the editor. If you are not currently using 
Sprint and simply want to print a file, you can print from the DOS com­
mand line with the command SPFMT. The last part of this chapter, beginning 
on page 204, describes how to print from DOS. 

Printing from the Editor 

The fastest way to print a Sprint document is to print it while you're editing 
it: just choose Go from the Print menu. Sprint will format and print your 
document on your printer using the default printing options. By default, 
Sprint prints 

• one copy 

• the whole file 
• without stopping between pages 
• on your default printer (instead of to a file or the screen) 

• using all your formatting commands 

You can change these defaults via the Print/Options menu and the Print/ 
Advanced Options menu. The options on these menus are described 
starting on page 198. 

If you are satisfied with the default print option settings, you can send your 
file directly to the printer by pressing the printing shortcut-Ctrl-KP. If you 
want to change the options (for example, say you want to print two copies), 
you'll first need to choose Options from the Print menu and make your 
adjustments. You can then choose Go from the Print menu, or press Ctrl-KP. 

When you tell Sprint to print your file, it usually goes through two passes 
(depending on the setting of Number of Passes in the Advanced Options 
menu): a formatting pass and a printing pass. During the formatting pass, 
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Sprint formats your file according to formatting commands you have 
entered. If Sprint finds any formatting errors (usually commands you've 
entered incorrectly), it will list those errors and the lines they're on, tell you 
the total number of errors, and won't proceed to the printing pass. You'll 
need to go back into the file and correct the errors, then ask Sprint to print 
your file again. See page 200 for information about formatting errors and 
how to correct them. 

Once Sprint has printed (or attempted to print) your file, you'll return to 
the editor (you'll have to press any key to continue if Sprint encounters 
errors in your file). 

Previewing Output on the Screen 

Sending output to the screen is useful when you want to check the format 
of a document before printing it. The formatter will interpret all the format­
ting commands,. but will display the formatted document on the screen 
instead of sending it to the printer. There is also a Paginate command on 
the Print menu that allows you to see where your page breaks will be; see 
the next section for information. 

To view your formatted file onscreen, choose Print/Screen Preview from 
the main menu (or use the shortcut etrl-F8). 

Note: If you have installed Sprint for a printer with proportionally spaced 
fonts (such as an HP LaserJet), what you see on the preview screen might 
not look right; the characters might be bunched together and the text 
unreadable. This is because Sprint has no way to display proportionally 
spaced fonts on your screen, so it can only approximate. However, you'll be 
able to get an idea of where lines will break and how your text will be for­
matted. 

There is another way to view sample output on the screen: press Ctrl-F8. 

Viewing Page Breaks 

Sometimes, you may need to know where the page breaks will be in your 
file. You can ask Sprint to format and paginate your file by choosing 
Paginate from the Print menu, or by pressing Ctrl-F7. Sprint will go through 
its normal formatting pass; if there are any errors, it will display them 
along with the page breaks (shown as solid lines across the screen). If there 
are no errors, Sprint will display your file with the page breaks only. 

When your file includes page breaks, Sprint adds the current page number 
to the status line. 
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You can remove the page breaks by choosing choosing Remove Formatter 
Page Breaks from the Print menu. Note that only formatter page breaks are 
removed. Any page 'i:>reaks you have inserted via the Layout/Page Breaks 
menu will remain. ..- .- -

The Print Options Menu 

The Options menu (Figure 9.2) tells Sprint which pages of your document 
to print, how many copies of the document to print, and whether to pause 
between pages. 
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Figure 9.2: The Options Menu 

Printing Multiple Copies 

It's easy to print more than one copy of your document; just choose 
Number of Copies from the Options menu and press Enter. Enter the 
number of copies you want printed and press Enter again. 

If you want to change other print parameters, do so now. To start printing, 
choose Go from the Print menu, then press Enter. 
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Printing a Portion of Your Document 

If you want to print only a portion of your document, you can tell Sprint by 
setting the Starting Page and Ending Page parameters. 

To change the starting page, choose Starting Page from the Options menu. 
Enter the page number from which to start printing (all preceding pages 
will be skipped). To enter the last page to print, move the selection bar to 
Ending Page, and enter the page number of the last page you want printed. 

You don't have to enter both the starting page and the ending page. If you 
enter only the starting page, Sprint will automatically print through the last 
page (as well as the Table of Contents and Index); if you enter only the 
ending page, Sprint will start printing with the first page. 

If you want to print only the Table of Contents, enter 0 as the starting page. 

If you want to print only the Index, enter the first page of the index 
(approximate if you have to) as your starting page. 

If you want to print just one page, set the starting page and ending page to 
be the same in the Options menu. 

Log Error Messages to a File 

When you tell Sprint to format and print your files (via the Print menu or 
the DOS command line), there will sometimes be formatting errors 
(mistakes in how you entered formatting commands) that you will need to 
correct before Sprint will actually print your file. 

If the formatter discovers an error while formatting your document, it will 
display an error message along with the number of the line containing the 
error. Unless you don't expect to have many formatting errors (for example, 
in a short file with few formatting commands), you'll want to save those 
messages to a file so that you can easily correct the errors. To send the 
message(s) to a file, choose Log Errors to File from the Print/Advanced 
Options menu (Figure 9.3). 
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Figure 9.3: The Advanced Options Menu 

Colt 

When Sprint formats your file, it will create a file with the same name as 
the file you are trying to print, and will add the extension . LOG. For 
example, if you are trying to print a file called DOC.SPR, Sprint will create 
a file called DOC.LOG to contain any error messages. 

Using the Editor to Correct Formatter Errors 

To correct the errors in the .LOG file, you can open two Sprint 
windows-one containing the file with the errors and one containing the 
.LOG file-and correct the errors while you review the file. 

Assuming that there are some formatting errors in your file, once Sprint has 
finished its formatting pass, you can open up the .LOG file in its own 
window, above or below the file you want to correct. You can then move 
back and forth between the windows, determining what the errors are, and 
then correcting them. Because Sprint tells you the line number of each 
error, you can jump quickly to the error using the Jump to Line command 
on the Edit menu. 
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Formatter Warning and Error Messages 

This section describes some of the more common error and warning 
messages you might encounter while formatting your document (for a 
complete list, see the "Error Messages" Appendix in the Sprint Reference 
Guide). 

There is a difference between warning messages and error messages. 
Warning messages simply tell you that there's a problem with a formatting 
command, but Sprint will print the file anyway. Common warnings are 
unassigned cross reference tags or too many tab characters. Error messages 
indicate more serious formatter command problems; Sprint will not print 
your file if there are errors. 

When trying to correct an error, first look at the line number indicated in 
the error message onscreen (or in the .LOG file if you've turned Log Errors 
to File On). If you can't find the error on the indicated line, look back a few 
lines; some errors aren't detected by Sprint immediately. 

Some common warnings and errors: 

Error: Missing end to begin 
Starting at the line number listed, look forward in the file until you find the 
place where you should have inserted an END formatter command. 

Warning: Group too big for page 
If you've used the Group Together on Page command, or some other 
formatter command that attempts to keep a block of text together on a 
page, Sprint may not be able to fit the whole thing on the page. 

Warning: Printer does not have font 
You've asked Sprint to print in a font that your printer doesn't have. 

Quick Printing and Error Checking 

Sprint normally performs two passes on your document file as it is format­
ting and preparing to print. During the first pass, Sprint scans the format­
ting commands you've entered, checking for any errors, and locating 
cross-reference tags. This first pass takes time. You can save time by 
printing on the first pass (by choosing Advanced Options/Number of 
Passes/l) without checking for errors and without filling in the cross­
references. When printing during the first pass, Sprint will stop it if 
encounters an error. 

If you want Sprint to check your file for formatter command errors but not 
print the document, choose Paginate from the Print menu. Sprint will go 
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through its formatting pass, tell you where the page breaks will be, and 
display any errors it has found. Error messages are displayed next to the 
page break line Sprint inserts in your file. 

Printing Complex Documents 

For extremely long and complex documents (like this manua!), in which 
there are many cross-references, font changes, indexing commands, and so 
on, you should tell the formatter to go through three passes (choose 
Advanced Options/Number of Passes/3). On the first two passes, Sprint 
finalizes tags and index terms, and on the third pass, it prints your file. 

Unformatted Printing 

Sprint will normally format your document before printing it (that is, it will 
interpret all formatter commands and fit the document into the defined-or 
default-page format). You' must tell Sprint if you're printing a non­
document or a program; otherwise, it will format the file. 

To print a file without formatting, choose Formatted Print from the 
Advanced Options menu and press Enter to toggle to No. 

Your file will be paginated and each page will have a header consisting of 
the name of the document, the date and time printed, and the page number. 
The formatter will not recognize formatter commands, open/close 
delimiters (for example, the boldface delimiters will be printed as A Band 
AN), or ruler lines (they will printed as AK). The formatter will recognize 
tabs and form feeds. 

If you want Sprint to print your file without checking for errors and without 
filling in the cross-reference variables, choose Number of Passes from the 
Advanced Options menu and press Enter until 1 is displayed. 

Printing on Cut Sheets or Continuous Paper 

When you first installed Sprint' for your printer using the SP-SETUP 
program, you indicated whether you would be using cut sheets of paper. If 
you answered No to the Cut Sheets prompt in the SP-SETUP program 
(because you're using continuous-form computer paper or because your 
printer self-feeds), you can temporarily override that decision. 

Choose Pause Between Pages from the Options menu and press Enter to 
toggle to Yes to have Sprint pause before printing each page (for single 
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sheets). If you want Sprint to return to automatically feeding each page, set 
the option to No. 

If you want to change other print parameters, do so now. To start printing, 
choose Go, then press Enter. 

Printing to a File 

Sending output to a file is useful if you later want to print the document on 
another printer that isn't attached to your computer (like a PostScript 
typesetter) or send a formatted document over a modem. In addition to the 
text in the document, the file will contain all of the commands necessary to 
print the document on the specified printer. If you want the file to include 
commands for a different type of printer, you must choose Current Printer 
from the Print menu; see the next section. 

Note: If you want Sprint to always send printer output to a file, you can 
reinstall Sprint to do so using the SP-SETUP program. 

To send your formatted document to a file, choose Destination from the 
Print menu and press Enter to toggle to FILE. Choose Go. Sprint prompts 
you for a file name to print to (defaulting to FILENAME.PRN). Press Enter 
to accept the default or type in a different name. 

Printing on an Alternate Printer 

When you first installed Sprint with the SP-SETUP program, you installed 
it for a specific printer (the default printer). If you plan to print your Sprint 
files on more than one printer, you'll also want to install it for those 
printers. If you haven't already done so, you should run the SP-SETUP 
program and install any alternate printer; see Chapter 1, "Before You 
Begin," for instructions. 

To use an alternate printer, choose Current Printer from the Print menu and 
press Enter. Sprint will present a list of printers to choose from. Choose the 
name you gave your alternate printer when you ran the SP-SETUP 
program. 

If you want to change other print parameters, do so now. To start printing, 
choose Go from the Print menu, then press Enter. 
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Printing ASCII Files 

See Appendix E for some special considerations and menu options when 
printing ASCII files. 

Printing from DOS 

If you want to format and print a document without running the editor 
(from DOS), you simply type SPFMT at the DOS prompt, followed by the 
name of the file you want to print. 

As when you print from within the editor, Sprint will list any formatting 
errors it finds, and won't proceed to print your file until you correct the 
errors (explained on page 200). 

If you're satisfied with the default print options, that's all there is to 
printing a file. If you want to change some options, you'll need to enter one 
or more printing switches after the SPFMT command and before the file 
name. (These switches are described in detail starting in the next section.) 
Each switch is preceded by a hyphen, with a space between each switch. 
For example, if you want to print only pages 3 through 5, this is what the 
command looks like: 

SPFMT -start=3 -stop=5 filename. ext 

SPFMT from the command line is designed to be run from batch files. It is 
entirely generic; that is, it only uses legal DOS calls. It will not draw a 
screen display, and you must type a I\C to stop it in process. 

Menus vs. DOS 

The Sprint print options are all accessible from the DOS command line. The 
following table shows both the menu choice and command line option 
version. 
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Table 9.1: Sprint Print Options 

Menu command Command line switch 

Screen Preview 
Destination FILE 
Number of Copies 
Starting Page 
Ending Page 
Pause Between Pages 
Formatted Print (on Advanced Options menu) 
Current Printer 
Wordwrap ASCII Files (on Advanced Options menu) 
Log Errors to File (on Advanced Options menu) 
Quick Print 
Tab Expansion (on ASCII File Handling menu) 

-v 
-o=name 
-# 
-start=N 
-stop=N 
-pause 
-p 
-p=name 
-f 
-l=name 
-p# 
-t=# 

There are a few advanced options that can only be set from the DOS com­
mand line; there are no menu equivalents: 

Define variable 'name' 
Use alternate font 
Print single page 

Print to alternate screen 

-d <name>{ =string} 
-f=<name> 
-page=# (same as 
-start# -stoP#) 
-s=<name> 

Most of the DOS versions are self-explanatory, but the following notes 
should be helpful: 

Printing multiple copies: 

SPFMT -# FILENAME 

where # is the number of copies you want to print (for example, type -2 for 
two copies). 

Printing a portion of your document: 

SPFMT -start=x -stop=y FILENAME 

where x is the number of the first page you want to print, and y is the 
number of the last. 

If you want to print only a single page, specify the -page=x parameter, 
where x is the number of the page you want to print. 
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Printing without formatting: 

SPFMT -p# FILENAME 

where # is a number from 0 to 3. (0 = print to screen, 1 = print without 
error-checking and formatting, 2 = print with two passes, and 3 = print 
after three passes.) 

Printing on an alternate printer: 

SPFMT -p=NAME FILENAME 

where NAME is the name of the alternate printer and where the file name 
NAME.SPP exists. 

Changing tab size: 

SPFMT -t=N FILENAME 

where N is the size of the tab character. (All tabs will be the same size.) 
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c H A p T E R 

10 

Customizing Sprint 

While you're in the editor, the Customize menu (Figure 10.1) allows you to 
change or customize the way Sprint does a number of things. You can 

• reassign the functions of specific keys 
• load a different user interface 

• customize the colors used to display screen elements 
• display or not display particular screen elements 
• make some settings to determine how ASCII files are handled 

• display or not display shortcuts next to the menu command name 
• reset (clear) or save all shortcuts you have defined 

• change miscellaneous editor defaults 

Note to users with two-floppy systems: Your Program A Disk must be in 
Drive A when you use any of the commands on the Customize menu. As 
for the Customize/User Interface/Save, Load, and Reset Shortcuts com­
mands, there are special circumstances you need to be aware of: 

• If you have a high-density drive and you see the user interface you want 
listed when you choose Customize/User Interface/Load to switch user 
interfaces (or Reset Shortcuts to discard your shortcuts), go ahead and 
choose the command. 

• If you have a low-density drive, or you don't see the user interface you 
want listed, you must insert a disk that contains the appropriate user 
interface in Drive A before you choose Customize/User Interface/Load 
or Reset Shortcuts. If you install~d your user interfaces on a separate user 
interface disk with SP-SETUP, you must insert that disk in Drive A. 
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• If you didn't install the user interface you want to access on a separate 
disk when you ran SP-SETUP, or you don't see the user interface you 
want listed when you choose Customize/User Interface/Save, Reset 
Shortcuts, Load, you'll need to run SP-SETUP again to install that user 
interface (see page 19) . 

• When saving shortcuts with Customize/User Interface/Save, be sure to 
save them to the disk that contains that user interface. If the user 
interface you want to save changes to is on a separate disk, insert that 
disk before you choose Customize/User Interface/Save. 

With a two-floppy system, the important thing to remember-if you don't 
have all your user interfaces installed on your Program A Disk-is always 
to insert the disk that contains the user interface you want to access before 
you choose Customize/User Interface/Load, Save, or Reset Shortcuts. 

< Sprint 
Just choose the typestyle of your choice from the menu. The File Alt-F 
entire block changes attribute (for example. if you choose Edit Alt-E 
Underline on a monochrome monitor. the text is underlined 
onscreen; on a color monitor. the text appears in a different Insert Alt-I 
color).< Typestyle Alt-T 
[. 2 3 4 5 6 Style Alt-S 
< Layout Alt-L 
If you change the typeface of a block that is already in anotl-------I 
typestyle (other than normal text). Sprint will try to use bo 
typestyles (if your printer supports them). For instance. i 
have some text that is marked as bold. then select the text a 

Print Alt-P 
Window Alt-W 
Utiliti es Alt-U 

choose Italic. your printed text will bell~~~uDstlolimaiZ ••• I==~==:~:=1 
< ""iiMmM, .. · 
You can also use this method of selectin Corors Quit Alt-Q 

Customlze Alt-C 

styles from the Typestyle menu to return Screen 
Simply choose Normal from the Typestyle Ascii File Handling 
selected the text.< Menu Shortcuts YES 
< 
If you've used a number of different typ Options 
looking at a file created by someone els'---------' 
immediately obvious what typestyle some text is in. especially if 
you have a monochrome monitor (which has a limited number of ways 
it can chan e the a earance of text on our screen .< . . . . 

Figure 10.1: The Customize Menu 

Reassigning Function Keys 

You can use the Customize/User Interface/Function Keys command to 
rearrange or swap meanings of keys. 
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For example, suppose you want the File/Open command to be assigned to 
Ctr/-O. By default, Ctr/-F3 opens a file in Sprint. To assign this function to 
Ctr/-O also, choose Function Keys. At the prompt, press Ctr/-O. Sprint will 
then ask you what key is already assigned to this function. Press Ctr/-F3. Now 
both Ctr/-F3 and Ctr/-O will display the File to open: prompt. You can, of 
course, reassign the meaning of Ctr/-F3 to some other function, or leave it as 
is. 

When reassigning the meaning of function keys, type carefully! If you want 
to reassign F4 to A/t-Z (for example) but accidentally press A/t-O, you will 
have to press A/t-Q again to prevent Sprint from reassigning it. 

Note: You cannot reassign the following keys: 

.F10 

• Tab 
• Esc 

• Enter 

• AJ 
.AM 
• Esc 

• any regular printing character (a-z, A-Z, and so on) 

You can also use 'the Ctr/-Enter method (described on page 114) to assign 
shortcuts to menu items. 

Note: If you change your mind about your key assignments, you can clear 
them all and return keys to their previous meanings by choosing 
Customize/User Interface/Reset Shortcuts. (Two-floppy system users: If 
you're working with low-density drives, you must insert your Program B 
Disk (or the disk containing the appropriate user interface) in Drive A 
before you choose Customize/User Interface/Reset Shortcuts.) 

Reset Shortcuts 

This command clears all keyboard shortcuts you have defined and returns 
the keys to their original (Borland default) meanings. Note that all user­
defined shortcuts are cleared: those you have defined with Ctr/-Enter, the 
Potpourri menu, the Utilities/Glossary/Assign to Key command, and the 
Customize/User Interface/Function Keys command. 

You'll want to use this command if you have accidentally redefined keys 
you didn't mean to and can't undo your mistakes. To permanently save 
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shortcuts that you can retrieve at any time, use the Customize/User 
Interface/Save command. 

Note to two-floppy system users: If you have a low-density (360K) drive, 
there's only room on your Program A Disk for one version of a user 
interface-the current one. Therefore, before you can use the Customize/ 
User Interface/Reset Shortcuts command to revert to an earlier version of 
your current user interface (removing any shortcuts you've defined), you 
must first insert the disk that contains the previous version of your user 
interface in Drive A. 

Saving Your Shortcuts 

You can permanently save any shortcuts you've assigned in your own user 
interface file by choosing the Customize/User Interface/Save command. 
Any shortcuts you've defined with Customize/User Interface/Function 
Keys, etrl-Enter, or the Potpourri menu will be saved. Sprint prompts you for 
a file name. You can reload this file at any time using the Customize/User 
Interface/Load command (see the next section). So even if you reset your 
shortcuts later with the Customize/User Interface/Reset Shortcuts com­
mand, you can always retrieve your saved shortcuts by loading that file. 

Note to two-floppy system users: If you have a low-density (360K) drive, 
or the user interface you're saving changes to is not on your Program A 
Disk, you must put the disk containing the appropriate user interface in 
Drive A before choosing Customize/User Interface/Save. 

Changing User Interfaces 

A user interface is a set of internal settings that define the way a program 
interacts with you. On the Customize menu, there is a command called 
User Interface/Load (Figure 10.2). (You can also press Shift-Aft-U as a 
shortcut.) 
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Figure 10.2: The User Interface/Load Menu 

This command allows you to load a different user interface. For example, if 
you used the SP-SETUP program to install Sprint's basic user interface, and 
are ready to switch to the advanced version, choose SP ADV from the User 
Interface/Load menu. The new user interface immediately replaces the one 
you were using. The new user interface will remain in effect until you 
switch to another user interface. 

You can also change the user interface by running the SP-SETUP program. 

Note to two-floppy system users: One way to switch user interfaces is to 
run SP-SETUP again and install a new default. However, if you want to use 
Customize/User Interface/Load to change user interfaces without leaving 
Sprint, there are two things to keep in mind: 

• whether you're using low-density or high-density drives 

• where you installed your alternate user interfaces when you ran 
SP-SETUP . 

If you have a low-density (360K) drive, and you used SP-SETUP to install 
an alternate user interface on your Program B Disk (there's only room for 
one), you can now insert your Program B Disk in Drive A and use 
Customize/User Interface/Load to switch to that alternate user interface. If 
you used SP-SETUP to install alternate user interfaces on a separate disk 
(see page 19 of the "Before You Begin" for details), then you can switch to 
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any of the alternate user interfaces on that disk; just insert it in Drive A, 
choose Customize/User Interface/Load, and Sprint will list them as 
available. 

If you have a 720K drive, and you installed an alternate user interface on 
your Program A Disk when you ran SP-SETUP, you can use Customize/ 
User Interfaces/Load to load it; just make sure your Program A Disk is in 
Drive A and press F10 CUt. With a 720K drive, there's only room for one 
alternate user interface on your Program A Disk, but you can use 
SP-SETUP to copy alternate user interfaces to a separate disk and then 
insert that disk in Drive A whenever you want to load a new user interface. 

If you have 1.2M drives, you can install more than one alternate user 
interface on your Program A Disk with SP-SETUP; when you want to 
switch user interfaces, just put your Program A Disk in Drive A, choose 
Customize/User Interface/Load, and pick a user interface from the list. 

The advanced user interface gives you access to commands affecting 
variables, cross-references, index commands, PostScript output, conditional 
page breaks, word and paragraph spacing, style sheets, advanced printing 
options, macros, and a few customization options. 

Complete information about using different user interfaces can be found in 
the Alternative User Interfaces booklet. 

Choosing and Customizing a Color Set 

Depending on what kind of monitor and video card you have installed in 
your computer, you will have a particular palette of colors to choose from 
in designing the look of Sprint on your screen. 

If you have a monochrome monitor, you also have some flexibility in 
determining the attributes in which Sprint displays various things on the 
screen. 

To change colors or attributes, choose Colors from the Customize menu. 
Figure 10.3 shows you what your options are. 
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Figure 10.3: Color Set Menu 

Monochrome Monitors 

If you have a monochrome monitor, choose Monochrome Set. If you decide 
to choose Modify, you can explicitly change the onscreen attributes of 
different typestyles, highlighted text, menus, error messages, indexing, 
format commands, rulers, page breaks, crossreferences, and more. 

For example, by default, Sprint displays underlined text with an under­
score. Suppose you instead want underlined text to appear in reverse 
video. To change it, choose Modify, then choose Typestyle, then Underline. 
Sprint will present you with the monochrome "palette" shown in Figure 
10.4. Move the cursor until it is on the x that is in reverse video, then press 
Enter. If that's all you want to change, you can press Esc twice and Sprint 
will save your changes. 
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Figure 10.4: Monochrome Palette 

If you change your mind about the changes you've made, choose Undo to 
return to the original display. 

Color Monitors 

If you have a color monitor, you can choose between two predesigned color 
sets, or you can customize the colors to be any way you want them. 

Take a look at the two alternate sets, Color Set 1 (the default) and Color Set 
2, on the Customize/Colors menu. If you like Color Set 2 better than the 
default, choose it and press Enter, and Sprint will save the new color set for 
you. If you want to play around a little and design your own color 
combinations, choose Modify. You can then choose the colors for any of 18 
different screen elements. 

Move the cursor to the x that is the color you want, and press Enter. You can 
do this for as many screen elements as you wish. When you're finished, 
press Esc until you exit from all the menus. Sprint saves your new settings 
when you quit Sprint. If you change your mind about anything you've 
done, just choose Undo to get back to the screen colors you started with. 
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The Screen Menu 

When you choose Screen from the Customize menu, Sprint displays a 
menu of items that you can choose to display or hide. Figure 10.5 shows the 
default settings for these items. 
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Figure 10.5: The Screen Menu 

All the items on the Screen menu can be represented by special characters 
on the screen (see Figure 10.6). To change an item's setting, move to it with 
the Up or Down arrow keys, and press Enter to toggle between On and Off. 
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Sprint's Special Screen Characters 

With Screen With Screen 
Codes Off Codes On 

Paragraph mark (hard return): ~ ~ 

Space character: 

Non-breaking space: .... 1\\ 

Wide space (spring): .. I\F 

Tab: ~ 1\1 

Indent mark: -+ I\G 

Figure 10.6: Special Characters in Sprint 

For instance, to see the control codes for typefaces and formats, toggle 
Codes to Yes (see page 127 for more information about these codes). 
Generally speaking, you will only want Codes to be Yes when you need to 
do something with a control character; see page 127 for more information. 
Likewise, if you want to see tab characters, toggle Tabs to Yes. 

It's entirely a matter of personal preference whether you choose to see a 
symbolic representation of certain Sprint features on your screen; some 
people like to see spaces, for example, so that they can easily tell exactly 
how many times they have pressed the spacebar and to avoid a "spaced 
out" look to the text. The same holds for tab and paragraph (carriage 
return) characters. 

ASCII File Handling 

See Appendix E, "Working with ASCII Files," for information on handling 
ASCII files. 

Displaying Menu Shortcuts 

By default, you can have Sprint display the keyboard shortcut associated 
with each menu item, next to the menu item. For instance, to display the 
Typestyle menu, instead of pressing F10 T, you can simply press A It-T. 
Particularly when you're first learning Sprint, it's convenient to see the 
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shortcut displayed right next to the menu item. Once you've learned these 
shortcuts, you may want to toggle Menu Shortcuts to No. 

The Options Menu 

The Options menu (Figure 10.7) contains some miscellaneous Sprint 
functions that you can change. 
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Figure 10.7: The Options Menu 

Preserve Editing Session 

Alt-Q 

Colt 

The Preserve Editing Session option determines whether Sprint deletes the 
backup (SP.SWP) file when you exit Sprint, or whether it keeps it for your 
next work session. See page 144 for information about the backup file. 

Background Save Period 

You use this menu to change how long Sprint waits before writing your 
changes to the backup (swap) file on disk; the default is 3 seconds, 
maximum is 60 seconds. Just remember that, the shorter the time you allow, 

Chapter 70, Customizing Sprint 217 



the less likely you are to lose changes should there be a power failure. 
Floppy-disk users might find it more convenient to set the the delay period 
higher to reduce disk-access times. 

Menu Display Delay 

Use this menu to change how long Sprint waits before displaying a menu 
once you've pressed a key. 

Once you become familiar with Sprint, you may prefer not to see the pop­
up menus at all; you know what you want to do and don't need to see the 
menus. You can delay the display of the menus by increasing the number of 
this setting; Sprint interprets numbers you enter as tenths of a second. 
Enter 0 for a setting of no delay. 

Insert mode 

By default, Sprint is in Insert mode; that is, Sprint inserts the characters you 
type in front of existing characters, without erasing anything. If you want 
Sprint to default to Overwrite mode so you can type over existing 
characters, toggle this setting to Overwrite. (You can toggle between Insert 
and Overwrite modes at any time by pressing Ins.) 

Tone 

You can change the tone and duration of the ''beep'' your computer makes 
when Sprint is checking the spelling on your file or when you make an 
error. 

To change the tone of the beep, choose Tone from the Options menu. You 
can then play around with both the frequency (tone) and the length of the 
beep. Use the Up and Down arrow keys to change the frequency of the tone, 
and the Right and Left arrow keys to change its duration. Each time you press 
one of these keys, Sprint will change the frequency of the tone or its length. 
To hear a sample beep, press any other key while in this menu. 
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c H A p T E R 

11 

Sprint Utilities 

This chapter discusses the features available on Sprint's Utilities menu, 
shown in Figure 11.1. 
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Figure 11. 1: The Utilities Menu 
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These utilities include the following: 

• Spelling corrector 
• Hyphenation (see the "Advanced Formatting" section in the Advanced 

User's Guide) 

• Thesaurus 

• Glossary (for creating typing shortcuts) 

• Arrange-Sort (for alphabetizing words) 

• Line Drawing (for drawing horizontal and vertical lines) 

• Potpourri (for assigning special functions' to the keys of your choice) 

• QuickCard (lists all Sprint's shortcuts, including those built-in and those 
defined by you) 

• Macros (for loading and running macros) (see the Advanced User's Guide) 

• DOS Command (to allow you to enter DOS commands from within 
Sprint) 

Note: Sprint's form letter/mailing list utility is on the Print/SprintMerge 
menu. 

This chapter covers everything on the Utilities menu except hyphenation 
and macros. For information about hyphenating with Sprint, see the "Basic 
Formatting" chapter in this manual. For information about how to load and 
run Sprint macros, see the "Programming Editor Macros " section in the 
Advanced User's Guide. 

Checking Spelling 

Sprint's spelling dictionary contains 100,000 English words, as well as all 
the Sprint formatter commands. You can correct misspellings in your Sprint 
files in two ways: 

• as you type ("on-the-fly") 

• a word, block, or an entire file at a time 

In either case, in order to use the spelling dictionary, be sure that the files 
SPELLER. ENG, AMERICAN .LEX, and USER.DIC are on one of your 
floppy drives or on your hard disk in the directory where you store your 
Sprint files. 

Note: You can use the SP-SETUP program (described in Chapter 1,"Before 
You Begin") to copy the speller files to your floppy or hard disk. 

When you choose Spelling from the Utilities menu, you see the Spelling 
menu (Figure 11.2). 
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Figure 11.2: The Spelling Menu 

As a shortcut, you can also reach the Spelling menu by pressing Shift-F1. 

Note: Sprint supports foreign-language and specialized dictionaries (the 
default is American English). Contact the Borland Customer Service 
department for more information. 

Automatic Spell Checking 

You can have Sprint check your spelling as you type by toggling AutoSpell 
On. When you type a word that Sprint thinks is misspelled, it beeps to 
warn you. You don't need to stop typing immediately; in AutoSpell mode, 
Sprint keeps track of all the misspelled words you type. (You're limited 
only by the available disk space.) When you're ready, you can tell Sprint to 
correct either the last misspelled word, by choosing Last Bad Word from 
the Spelling menu, or all misspelled words, by choosing Every Bad Word. 
(You can also press Ctrl-F1 to choose Every Bad Word.) 

When you choose either Last Bad Word or Every Bad Word, you'll see the 
menu in Figure 11.3. 
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Figure 11.3: The Replacement Words Menu 

You now have a choice: 

• If the word is not misspelled, but is just a word that Sprint doesn't have 
in its spelling dictionary, you can choose Add to Dictionary to increase 
Sprint's vocabulary. 

• If the word is misspelled, you can either tell Sprint what the correct word 
is by choosing Replace With or choose Lookup and then choose a word 
from the list of replacements Sprint displays. 

• You can tell Sprint to ignore this misspelled word by choosing Skip Once. 

If you choose Replace With, you can type the word you want to replace on 
Sprint's status line; Sprint will automatically replace the misspelled word 
with the word you type, and return the cursor to where you were when 
you started. 

It's a matter of personal preference whether you choose to correct your 
spelling as you type or later on. Generally, if you are an accurate typist or a 
good speller, you might like AutoSpell mode. In AutoSpell mode, your 
computer will beep when Sprint thinks you've made a spelling error. If you 
don't make a lot of errors, you might like being alerted when you do. If 
your typing or spelling is less accurate, you might want to keep AutoSpell 
mode Off (the default) and wait until later to correct your spelling so as not 
to be distracted by the beeping. 
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Another factor in deciding which mode you like is the content of what 
you're typing. If you're typing straightforward business letters with a lot of 
common words, AutoSpell might be useful. If you're typing a computer 
program with a lot of strange variable names, you'll probably want to turn 
AutoSpell Off since Sprint won't recognize many of the words you type. 
You can add words to Sprint's vocabulary, though (see the next section). 

Note to two-floppy system users: You cannot use AutoSpell mode; you 
should toggle AutoSpell Off and leave it set to Off. When you want to use 
the spelling dictionary but the dictionary files are not on your Program A 
Disk, Sprint will prompt you to remove it from Drive A and replace it with 
the disk containing the files. When you're finished, put your Program A 
Disk back in Drive A. 

Spell Checking a Word, Block, or File 

At any time, you can ask Sprint to check the spelling of a word, a block, or 
the entire file. 

• To check the spelling of a word, move the cursor onto the word and 
choose Word from the Spelling menu. 

• To check the spelling of a block, select the block, then choose Block from 
the Spelling menu. 

• To check the file, choose File from the Spelling menu. Choosing this com­
mand checks the spelling of the entire file. To check a file from the cursor 
position to the end of the file, choose Rest of File from the Spelling menu. 
When you reach the bottom of the file, Sprint will ask if you want to 
continue from the top of the file. Answer Y or N. If you type Y for Yes, 
Sprint continues its spelling check from the top of your document down 
to the cursor position. 

Sprint will check the spelling of the text you've specified. When Sprint 
finds a word it thinks is misspelled, it will stop and ask you whether you 
want to add it to the dictionary (Add to Dictionary), replace it with a word 
you type (Replace With), ignore the word and move on to the next one 
(Skip Once), or choose a replacement from a list Sprint displays (Lookup). 

You can interrupt Sprint's spell checking any time by pressing Esc. 

Thesaurus 

To use the thesaurus, be sure the files THESAUR.LEX and THESAUR.ENG 
are on your disk. Use the SP-SETUP program (described in Chapter 1, 
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"Before You Begin") to copy the thesaurus files to your floppy or hard disk. 
Then press F10 and choose Utilities/Thesaurus (or press Alt-F1). You can ask 
Sprint to find a synonym for the word of your choice. To do so, move the 
cursor to the word, then choose Thesaurus. Sprint will display a list of 
synonyms for the word, as shown in Figure 11.4. Just as you would with 
the spelling dictionary, choose a replacement from the list, or choose Pass if 
you don't want to use one of the synonyms Sprint suggests. 
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Figure 11.4: The Alternative Words Menu 

If Sprint has no synonyms for the word, no list will be displayed and Sprint 
will display the message Not in thesaurus. 

Note to two-floppy system users: If you want to use the commands on the 
Thesaurus menu but the thesaurus files are not on your Program A Disk, 
Sprint will prompt you to replace your Program A Disk in Drive A with the 
file that contains the thesaurus files. When you're finished with the 
thesaurus, swap the disks again. . 

Arrange-Sort 

The Arrange-Sort command lets you alphabetize a block of text in ascend­
ing (A to Z) or descending (Z to A) order. To use it, you should first select a 
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block of text as you normally would: Either press F3 and move the cursor 
until the block is selected, or choose Block Select from the Edit menu and 
select the area of text. If you want to sort columns separately, first choose 
Column Mode from the Block Select menu, then select the columns. Once 
the block is selected, choose Utilities/Arrange-Sort. Sprint will ask if you 
want to sort in ascending or descending order, then will alphabetize the 
text according to the order you choose. Be aware that Sprint sorts according 
to strict ASCII order; that is: 

• all uppercase letters before all lowercase 

• % and & before numbers 

• > and = after numbers 

Note to two-floppy system users: You must have your Program A Disk in 
Drive A in order to use the Arrange-Sort command. 

For a complete list of all ASCII characters, see the "ASCII Character Set" 
Appendix in the Reference Guide. 

Line Drawing 

The Line Drawing command lets you draw vertical and horizontal lines in 
several styles: 

• single • degree 
• double • period 
• asterisks • shade 
• block 

See Figure 11.5 for the different line styles you can draw with the Line 
Drawing command. 
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Line Drawing Characters 

Single 
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Asterisk * * * * * * * * * * * * * * * * * * 
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Shade 

* 
* 
* 
* 
* 
* 
* 
* 
* 

Figure 11 .5: Line Styles 

Use the keys on the numeri<; keypad to move the cursor and choose line 
styles; look at the status line for information about which keys do what. 
Press 0 to begin drawing, the arrow keys to draw the line, and numbers 1-7 
to select line styles. Press 0 again to stop drawing; if you wish, you can 
move the cursor to a different spot and then press 0 again to resume 
drawing. To erase part or all of a line, press 8 and move the cursor along 
the line. Press Esc when you've finished drawing. 

If you're using a mouse, press the left button to begin drawing. To draw the 
line, move the cursor as you normally would with the mouse. Press the 
right button to stop drawing. 

Note: You should only use this method of line drawing with a fixed-width 
font; otherwise (for proportional-width fonts) try the Style/Graphics/ 
Draw Box command. 

The Glossary Menu 

Sprint allows you to create your own list of abbreviations for words, 
keystrokes, and macros you use often with the Glossary menu (Figure 
11.6). 
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Figure 11.6: The Glossary Menu 

For example, let's say you often type the words Borland International. 
Rather than typing this long sequence of characters (and risking a 
misspelling) every time, you can simply type an abbreviation for the words, 
then tell Sprint to fill in the words for you. 

To assign a commonly used word or phrase to an abbreviation, first type 
the text (which can be any length and can contain control codes, formatting, 
macros, rulers, and so on), then mark it as you would for any block 
operation (press F3, then move the cursor until the word or phrase is 
marked). Now press F10 UG to display the Glossary menu. Choose Define 
from the menu. Sprint will ask you to 

Enter the name for this item: 

Type an abbreviation-for example, BI for Borland Intemationaland press 
Enter. The next time you need to use the phrase, you can call up the 
Glossary menu and choose Recall (or just press F2), then type BI when 
Sprint prompts you for the name. Sprint will insert Borland International in 
your text at the cursor position. Or, you can type BI in the text, then press 
F2. Sprint will look up the word to the left of the cursor. If the abbreviation 
is in the Glossary, it will replace it (in this example, with Borland Inter­
national). If the abbreviation is not in the Glossary, Sprint will prompt you 
to enter another abbreviation. 
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If you wish, you can assign the abbreviation to the key of your choice by 
choosing Assign to Key from the Glossary menu. Sprint will ask you 

To which key should the glossary item be assigned? 

Press the key to which you want to assign the abbreviation. Sprint will then 
present a list of the abbreviations you've created so far. Choose the one you 
want to assign to the key. 

You can create as many abbreviations as you like. You can also delete an 
abbreviation from the Glossary by choosing Erase. Sprint will prompt you 
for the name of the abbreviation you want to delete. 

Note that your abbreviations are saved in memory only. When you quit 
Sprint or change glossaries, Sprint will ask you if you want to save the 
Glossary you've been working with. Enter a file name; Sprint automatically 
adds the .SPG extension. 

If a glossary entry starts with a percent sign (%), Sprint assumes the entry is 
a list of macro commands and not straight text and will execute the macros 
(rather than inserting text). 

Note to floppy disk users: If your .SPG files are not on your Program A 
Disk, Sprint will prompt you to insert the disk that contains them in Drive 
A in order to load a glossary file. 

To see a list of all the items in your glossary, choose Glossary/List. Sprint 
will create a text file and display it as an open file with your glossary's file 
name and the extension .TXT (you can print out this file like any other). 

Defining Default Settings 

If you want to have a set of ruler settings (and any other settings) come up 
as the default every time you open a new Sprint document, you can do this 
by following these steps: 

1. Edit a ruler in any way you like (including any settings from the 
Layout/Ruler /Precise Settings menu). 

2. Enter any text that you want to be automatically present (for example, 
the To:, From:, and Re: of a memo). 

3. Select all the text and the ruler (press F3 and use the arrow keys). 

4. Define a glossary entry by choosing Define from the Glossary menu. 
When Sprint prompts you to name the entry, call it AUTOEXEC. (Sprint 
will save the file as AUTOEXEC.SPG.) 
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Now, every time you create a new document, Sprint prompts 

Use your default settings? 

If you type Y for Yes, Sprint inserts your customized ruler and text (if any) 
at the top of the new document. If you type N for No, Sprint opens the new 
file with the regular ruler line at the top. 

Keyboard Record Mode 

You can also tell Sprint to record any sequence of keystrokes (up to 1024) 
you type in a glossary item. To do this, choose Keyboard Record from the 
Glossary menu, then just start typing. You can choose menu items, press 
shortcut keys, type straight text-in short, any keystrokes will be recorded 
as you type. When you're finished, press Esc and Sprint will prompt you 
for a name for this glossary item and an optional description. (If you made 
a mistake and don't want to save the keystrokes, just press Esc.) As with 
other glossary items, when you want Sprint to perform this sequence of 
keystrokes, choose Recall Entry and enter the name of the glossary item. 

Potpourri: Assigning Special Functions to 
Keys 

The Potpourri option lets you assign a specific command to a key or 
execute it on the spot. When you choose Potpourri, Sprint displays a list of 
40-some commands to choose from (see Figure 11.7 for the menu of com­
mands you can assign). (Use the arrow keys to see more of the list.) To 
assign a command to a key, press the keystroke you want to assign it to. 
From then on Sprint will perform that command when you press that key. 
For example, suppose you want Alt-T to transpose two characters. You 
would choose TransposeChars from the list, then press Alt-T when Sprint 
prompts you. 

Note: You cannot reassign the following keys: 

.AM 

.F10 

• Tab 
• Enter 
.AJ 

• Esc 
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If you change your mind about your key assignments, you can clear them 
all and return keys to their previous meanings by choosing Customize/ 
User Interface/Reset Shortcuts. 

Note to two-floppy system users: If you have a low-density (360K) drive, 
you must insert your Program B Disk (or the disk containing the 
appropriate user interface) in Drive A before you choose Customize/User 
Interface/Reset Shortcuts command. 
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For an explanation of each of these commands, see "Potpourri" in the 
Reference Guide. 

QuickCard 

This command displays a quick reference list of all the Alt, etrl, Shift, and 
function keys defined for your user interface. If you have reassigned any 
shortcuts yourself, these will also appear on the quick reference card. 

When you choose QuickCard, Sprint displays the message 
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After a few seconds, you'll see the quick reference card. Once displayed, 
the quick reference becomes an oll-en file on your screen called 
QCARD.TXT. You can close it when you've finished looking at it, or print it 
like any other file. 

Each time you choose QuickCard, Sprint will rebuild and display the quick 
reference card, based on whatever keys are currently defined. So, if you 
change any key definitions, these changes will be reflected the next time 
you choose QuickCard. 

Entering DOS Commands 

Sprint allows you to enter DOS commands or even run another program 
without permanently leaving Sprint itself. This comes in handy when you 
need to exit to DOS to do something, but intend to get right back to Sprint 
when you're done. 

To enter a DOS command, choose DOS Command from the Utilities menu. 
Sprint will prompt you: 

DOS command: 

You can either enter a DOS command-for example, DIR to see a directory 
listing-or simply press Enter (press Backspace first if another command is 
already there) to exit to the full-screen DOS "shell." If you enter a com­
mand on the status line, DOS will execute the command. You'll then see the 
prompt 

[Press any key to continue.] 

Press any key, and you'll be back to Sprint, exactly where you were when 
you left. 

If you want to do a few things while in DOS-for instance, look at a 
directory, then run another program (such as a communications program to 
check your electronic mail)-you'll want to just press Enter after choosing 
DOS Command. Sprint will disappear from the screen, and you'll see a 
message telling you to type EXIT to return to Sprint, and giving the version 
of DOS you're running. For example: 

---Type EXIT to return to Sprint--­
The IBM Personal Computer DOS 
Version 3.10 (C) Copyright International Business Machines Corp 1981, 1985 

(C) Copyright Microsoft Corp 1981, 1985 

You'll be at the same DOS prompt as you were when you loaded Sprint. 
You can go ahead and do whatever you want to do, but remember that 
Sprint is in the background, ready to be used again when you're ready. To 
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get back into Sprint, though, don't type SP as you normally would; type 
exit at the DOS prompt. 

Note: If you change directories while in the DOS shell, when you return to 
Sprint, the current directory will be the last directory you were in before 
you returned to Sprint. For example, say you loaded Sprint from a 
directory called C:\SPRINT. While in the DOS shell, you changed to a 
directory called C: \ SYSTEM, then typed exit to return to Sprint. If you then 
enter a file name to open, Sprint will assume that the file is in the C: \ 
SYSTEM directory-not the C: \ SPRINT directory. If you wish, you can use 
the File Manager to switch the logged directory back to C:\SPRINT. 
Choose File Manager from the File menu, then choose Change Directory 
and enter C: \SPRINT. 

Note to two-floppy system users: Your Program A Disk must be in Drive A 
in order to choose Utilities/DOS Command. 
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N T R o D u c T o N 

Most of you have received personalized junk mail, probably the most 
familiar use of merge-mail programs. These programs take specific 
information from one file-a mailing list or collection of records-and 
insert the information into a second file, usually a form letter. You can use 
these programs for a variety of purposes-to bill customers, solicit 
contributions, send form letters, or personalize newsletters. 

This section of the manual introduces SprintMerge, Sprint's merge 
program. You can reach SprintMerge commands through Sprint's Insert 
and Print/Merge menus. 

Sprint 
File 
Edit 

Insert 
Typestyle 
Style 
Layout 

File I 
Edit 

'Qsprint--, 

...-----IPri nt,----~!ijijii.~__._.~Insert IiM#i I Go! Window Variable Typestyle 
...-----Merge-----,Destination PRINTER Utilities Define Text Variable Style 

Go! Screen Preview Customizel--------ILayout 
Screen Preview I-----------I----~ 

Merge Quit Template for Data Print 
Letter File Paginate 1----1--------IWindow 
Record File DEFAULT.REC Remove Formatter Page Breaks Special Hyphen Utilities 

Non-Breaking Space Customize 
Data Format STANDARD Options Wide Space (Spring) 
Initial Record 1 Advanced Options 
Ending Record LAST Current Printer [DEFAULT] Repeating Character 
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Order 
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Figure Intro.l: The Insert and Print/Merge Menus 

Quit 

You can also run SprintMerge from the DOS command line by typing 
SPMERGE and any of the options described in this section. We encourage you 
to use the menu method, so we don't cover the command line option very 
much here. Check "Command Line Options" in Chapter 15 for the com­
mand line version of most commands. 
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This Section's Structure 

This section is divided into five chapters: 

Chapter 12, "Your Template, Records, and Letter File," describes how you 
prepare your information for merging purposes. It explains command lines, 
record files, templates, and form letters. 

Chapter 13, "Merging and Printing Your Files," takes you through the 
different print options available for Sprint, Reflex, Paradox, and dBASE 
records. 

Chapter 14, ''The SprintMerge Tutorial," begins with an overview and then 
walks you through several different uses of SprintMerge, including 

• merging letters with simple merge fields 
• merging letters with Sprint formatting commands 
• adding optional variables and paragraphs to a form letter 

• sorting and selecting records 

• creating mailing labels 
• using BASIC-type files 

Each example has step-by-step instructions and example files that we 
provide on the distribution disks. You can rename these files and customize 
them to fit your needs. 

Note to users with two-floppy disk drives: When you ran SP-SETUP to 
copy files to the Data Disk, Sprint copied the example files to that disk. Be 
sure the Data Disk is in Drive B. 

You should be familiar with Sprint before you begin the tutorial. 

Chapter 15, "The SprintMerge Reference," describes each element of the 
SprintMerge program in detail. The elements are listed alphabetically. 

Chapter 16, "SprintMerge Troubleshooting and Error Messages," offers two 
checklists: causes of common problems and SprintMerge's error messages. 

You'll get a much clearer idea of SprintMerge's capabilities in the next 
chapter, so let's begin. 

236 Sprint User's Guide 



c H A p T E R 

12 

Ypur Template, Records, and Letter 
File 

Say you're a professional who sends periodic reminders to clients, based on 
the date of their last appointments. Or you work for an organization that 
sends different letters to contributors, depending on the size of their 
contributions. Or you mail out subscription renewals and print up labels, in 
zip-code order, for your newsletter. In the old days, you'd probably farm 
out these jobs to a secretarial service and a mailing house. Now you can do 
them yourself. You just create your letter, your records, and a template 
using the Sprint editor, and SprintMerge does the rest. 

In this chapter, we explore SprintMerge's main tools: the template and 
records in the record file, and the letter file. We show you how to merge 
these elements. The next chapter then explains how to print your merged 
form letters and mailing lists. 

If you're curious about aspects of SprintMerge touched upon here, refer to 
that specific item in Chapter 15. 

Note to two-floppy system users: Your Program A Disk must be in Drive A 
to use the SprintMerge program. 
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The SprintMerge Concept 

The SprintMerge program requires three elements: 

• a template, usually at the top of the record file, that defines the format of 
the information 

• a record file that holds the actual information (names, addresses, and so 
on) 

• a letter file that contains the form letter, with blanks (fields) to be filled in 
with information from the record file 

Here's how it works: 

1. Using the Sprint editor, choose Insert/Template for Data to create a 
template describing all the fields your information has. This command 
automatically displays @Template { } and @Data. 

2. In this same file, you create and maintain your records, using the Sprint 
editor and the @Data command and following the format defined in the 
template. 

3. With the Sprint editor, set up your form letter, using Insert/Merge Field 
to indicate blank fields that SprintMerge will fill in with the actual 
values. 

4. Choose Record File from the Print/Merge menu and enter the name of 
the appropriate record file with the template and your records. Then 
choose Go. 

5. The SprintMerge program, guided by the template, reads information 
from the first record of the record file and plugs that information into 
the appropriate blank fields in the letter file. 

6. It then moves on to the next record and inserts that record's information 
into a second copy of the form letter, and so on. 

7. The SprintMerge program sends the outfile to the Sprint formatter, 
which formats and prints the merged form letters. You can specify 
special print options, described in Chapter 1 of the Sprint Reference 
Guide. 

The following figures show sample record and letter fJes. We explain them 
in detail in the next sections; for now, just look over the entries. The angle 
brackets and semicolons in the template and records are the field delimiters 
and field separators, respectively. The boldface text in the letter represents 
the blank fields entered with the Merge Field command. 
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@TEMPLATE{<honorific> <firstname> <lastname> 
<address -multiline>; 
<city>; <state>; <zip -num>i 
<price -default $15>} 

@DATA 
Ms. Melissa Clarke 
The Willows 
2000 Anita Lanei 
WacoiTexasi75000i 

Mr. Victor Ordonez 
87-B Prince Roadi 
WacoiTexasi75001i 

Ms. Melanie Rekieta 
Chaucer Mansi9n 
1 Meadow Lanei 
WacoiTexasi75000i 

Figure 12.1: The Record File 

HONORIFIC FIRSTNAME LASTNAME 
ADDRESS 
CITY STATE ZIP 

Dear HONORIFIC LASTNAME, 

The Albinoni Memorial Quartet will be playing in CITY next month. 
This is the group's first visit to STATE, fresh from their wildly 
lauded recitals in Bahrain, Indonesia, and Columbia. 

The quartet's eclectic program comprises both 400-year-old and 
modern compositions. Because of the time you have donated so 
generously to this organization, we would like to offer you the 
chance to purchase recital tickets at the discount price of 
PRICE. 

Please call our Volunteers Liaison, Imelda Pascual, if you are 
interested. 

Yours sincerely, 

Floyd M. Pinkus 
President 

Figure 12.2: The Letter File 
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You can also tell the SprintMerge program to select only specific records or 
sort them in a particular order. It holds sorted records in an intermediate 
file called a sortfile (default SPM.S$$). After sorting or selecting, 
SprintMerge places the records into an outfile (default SPM.O$$). 

Note: SprintMerge isn't case sensitive. @Template, @template, and 
@TeMpLaTe are all the same command. 

The Record File 

The record file is where you store the pieces of information that 
SprintMerge inserts into a form letter. It is also where you store the 
template-the empty form these pieces must fit into. 

The pieces of information you might store in this file include names, 
addresses, donation amounts, and accounts outstanding. 'itEach piece of 
information is called a field. Each complete set of fields is called a record. At 
least one blank line separates one record from the next. The following 
figure shows how a record's fields might be inserted into a form letter. 

TEMPLATE 

<Han> <Firstname> <Lastname> 
<Address -multiline>; 
<City>;<State>;<Zip -num> 

RECORD 

Mr. Felix Jones 
789 Main Street; 
Boise; Idaho ;83700 

LETTER FILE 

Dear HON LASTNAME, 

The Albinoni Memorial Quartet will 

be playing in CITY next month. 

This is their first visit to STATE. 

We have a special offer on tickets. 

Figure 12.3: A Record's Fields in a Form Letter 

The record file also includes a template, which you create to show all the 
fields in each record, just as a doctor uses the blanks in a medical chart to 
insert details about your health. 
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At a minimum, the. record file contains two commands, @Template (Insert/ 
Template for Data) and @Data. @Template describes each record by giving 
each field a name. @Data tells SprintMerge that what follows are the 
records. The following table lists these and other formatting commands you 
can use in the record file. 

Table 12.1: Record-File Commands 

Menu Command @-Command Equivalent 

Insert/Template for Data 
Insert/Merge Field 
None 
Print/Merge/Order* 
Print/Merge/ Criteria* 
Print/Merge/Initial Record 
Print/Merge/Ending Record 
None 
None 
Print/ Options 
Typestyle/Hidden 
Print/Merge/Data Format 

@Template(sl!.ecifications) 
@Value(specification) 
@Include(jile name) 
@Sort(specifications) 
@5elect(specifications) 
@Startrec(number) 
@Endrec(number) 
@Sortfile«(ile name) 
OOutfile(Jile name) 
@Print(print options) 
@Comment(notes) 
@Remditto 

*1£ the command string is too long for the command line, use the @-form of 
the command in the file. 

Template for Data, Hidden, @Data, and @Include can only be used in your 
record file. You can specify all other SprintMerge formatting commands 
either in the template file or on the command line if you are running 
SprintMerge from DOS. You can find these commands on the Print/Merge 
menu; they include 

• Screen Preview 
• Data Format (Standard or Basic) 

• Initial Record 
• Ending Record 
• Order (Sort order) 
• Criteria (Record selection criteria) 

Note: Commands in the command line override commands in a record file. 

Chapter 12, Your Temp/ate, Records, and Letter File 241 



The Template for Data Command 

To create a template, choose Insert/Template for Data. Here's what appears 
on the screen: 

[ T 1 
@TEMPLATE{ }< 
@DATA< 

2 3 4 5 6 ]L 7 

... \USERGYD\MERGSCRN\TEST1.SPR * Ins 1:12pm Ln.2 of 2 Col 

Figure 12.4: The Template for Data Screen 

10 

The command @Template{ } appears at the beginning of the file, with the 
cursor between the curly braces, ready for you to start typing in your 
template. The command @Data follows it, telling SprintMerge that your 
records follow. Get accustomed to always deleting the ruler at the top of 
the file: Move the cursor to it and press De/. 

The Template for Data command is how you specify the different catego­
ries or fields in the template. A delimiter encloses the template and another 
delimiter encloses each field in it. (You can use any of the Sprint delimiters, 
described on page 296; you can't use BEGIN and END commands.) Field 
separators separate one field from another. They follow each closing deli­
miter and can be visible or nonprinting (a space, for example). 

In the following example, the template is enclosed in curly braces ({ I). The 
angle brackets « » are the field delimiters, and the forward slashes are the 
field separators. 

Note: Field names cannot have more than 15 characters. 
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For example, the template 

@Template{ 
<Firstname>/<Lastname>/ 
<Address>/ 
<City>/<State>/<Zip>} 

describes the record 

as 

Robin/Jones/ 
123 45th Street/ 
New York/NY/10001 

Field Name 
<Firstname> 
<Last name> 
<Address> 
<City> 
<State> 
<Zip> 

Value 
Robin 
Jones 
123 45th Street 
New York 
NY 
10001 

By meticulously setting up your fields, you can make your records and 
templates versatile enough for extremely varied tasks. 

Your Records 

Your record files are where you keep the pieces of information on each 
person, company, or entry. When you enter your records, you must follow 
your template layout exactly. You must enter the template's field separators in 
your actual records in exactly the same manner. It's easy to do this by 
opening two windows in Sprint: Leave the template showing in the top 
window and work on your records in the lower one. 

The only exception to the rule of following your template exactly is when 
you have declared a multiline field in your template. The multiline option 
allows you to extend your information over several lines before ending that 
field. So your actual record may have three lines of information in the 
multiline field, while the template, of course, shows only one line. But you 
must end your multiline field with the correct visible field separator, as 
indicated in your template. The SprintMerge program won't know it's at 
the end of the multiline field until it comes across the field separator. 

You can chain any number of record files together with the @Include com­
mand. Just type @Include Filename after the template. The record files you 
include should not contain templates at the top of the files. 

Chapter 72, Your Template, Records, and Letter File 243 



Field Separators 

A field separator is any character that follows the closing delimiter of a 
field. Field separators tell SprintMerge where one field ends and another 
begins. It can be a printing (visible) character such as a punctuation mark, 
or it can be a nonprinting (invisible) character, such as a space, tab space, or 
hard return. 

Note: A hard return character is sent to the computer when you press Enter, 
telling it to move the cursor to the beginning of the next line. Most pro­
grams signify a hard return character by a symbol on the screen; Sprint, for 
example, displays a left-pointing arrow. You won't see this symbol in your 
printout, however. 

You insert field separators in both the template and the actual records. You 
shouldn't insert the delimiters (in our examples, the angle brackets) in the 
records. 

Make sure a field never contains its own field separator. If it does, 
SprintMerge can't tell where the field really ends. For example, if your 
Lastname field entry contains a hyphen (as in Piggott-Smythe), don't use a 
hyphen as a field separator after Lastname. 

Don't put a field separator after the last field in a template. 

Let's examine the following template example: 

@Template{ 
<Honorific> <Firstname> <Lastname> 
<Address -Multiline>; 
<City>;<State>;<Zip5 -Num>;<Zip4 -Num>; 
<Product>} 

• <Honorific> <Firstname> <Lastname> are separated by blank spaces. 
• <Lastname> and <Address -Multiline> are separated by a hard-return 

character. 

• <Address -Multiline> and <City> are separated by a semicolon and a hard 
return. In this case, only the first character, the semicolon, is the field 
separator. (A semicolon is used instead of a slash because semicolons 
aren't likely to occur in addresses.) The SprintMerge program ignores the 
second separator (the hard return) . 

• <City>;<State>;<ZipS -Num>;<Zip4 -Num>; are separated by semicolons. A 
visible separator also follows the field <City> so that the SprintMerge 
program doesn't read the address St. Paul, MN as the city of St. and the 
state of Paul. As most people don't use four-digit zip code extensions and 
that field will usually be empty, a visible separator after the zip code field 
clearly marks the end of that field. 
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• <Product>, the last field in the template, shouldn't have a field separator. 
The closing delimiter for the template command is sufficient. 

Later, when you're more familiar with templates, you can use more familiar 
separators, like a comma between the City and State fields and a hyphen 
between the two parts of the zip code. 

Use visible field separators when 

• You designate a field as a multiline field. 

• You designate a field as having a default value. 

• A particular field could sometimes be empty. 
• The information in a field may contain a blank space. 
• You have doubts about the information that a field will contain. 

It's safe to use an invisible field separator when the field will always be 
filled in and the information in the field is fairly standard. 

Remember, don't put a field separator after the last field in a template. Be 
sure, however, to leave a blank line between records to separate them. 

Field Declarations 

You can declare a field as containing only a certain type of data (alphabetical, 
ASCII, or numerical) and as multiline. The first three types-alpha, ASCII, 
and num-are useful when you sort and select. Multiline is handy when 
you want to accommodate information of varying length. You can also 
declare a different default value for a field when the field is empty. 

-Alpha @Template{<Name -alpha>} 
The default field type: If you don't declare a field type, the SprintMerge 
program assumes the field is alphabetical. SprintMerge sorts and selects 
alpha fields alphabetically with no regard for case. Alpha fields can contain 
nonalphabetical characters: The SprintMerge program just compares the 
numbers and punctuation improperly. For example, it considers 5 greater 
than 128 because 5 comes after 1. 

-ASCII @Template{<Name-ASCII>} 
Tells the SprintMerge program to treat the field's contents as strings of 
ASCII characters; SprintMerge sorts according to ASCII order. Check your 
ASCII table, such as the one SideKick Plus supplies, to look up a specific 
precedence (indicated by the decimal numbers). In ASCII, any uppercase 
letter has precedence over the same letter's lowercase; that is, any 
uppercase letter sorts before all lowercase letters. 
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-Num @Template{<Zip -num>} 
Tells the SprintMerge program to treat the field's contents as numbers. 
SprintMerge compares any data that looks like a number; it ignores non­
numeric data. 

-Multiline @Template{<Address -ASCII -multiline>;} 
Tells the SprintMerge program that the field can contain more than one 
line. You can combine this field declaration with any of the above types, in 
any order. To use this type effectively, end a multiline field with a visible 
separator unless it is the last field in the template. 

-Default @Template{<State -default Maine>} 
Specifies a default value for a field. If you enter Maine as the default value 
for the State field in your template and leave this field empty in a record, 
SprintMerge substitutes Maine as the value of the empty field. To use this 
type effectively, end a default text field with a visible separator unless it's 
the last field in the template. 

The Letter File 

The letter file (Print/Merge/Letter File) is your form letter. The template in 
the record file defines the merge fields-that is, it names each field. These 
field names are what you enter into the letter file with Insert/Merge Field. 
SprintMerge takes the field values from the record file and places them into 
the appropriate blank fields in the form letter. 

In the following example, we show SprintMerge variables in boldface. The 
SprintMerge program stops at these blanks and inserts the appropriate 
values. Here's the template (DOLPHINS.REC on the Data Disk): 

@Template{<Honorific> <Firstnarne> <Lastname> 
<Address -multiline>/ 
<City>/<Country>/<Zip -nurn>/ 
<Donation -default $lOO>} 

Here are the records: 

@Data 
Mr. Roger Lobo 
567 rue de Seine/ 
Paris/France// 

Dona Consuelo Ruiz 
Cas a Ruiz 
5 Avenida del Mar/ 
Barcelona/Spain// 

246 Sprint User's Guide 



Ms. Oina Honggala 
555 Kuvela/ 
Tornio/Finland// 

Note the two linespaces between each record. One represents the Donation 
field, and the other separates the records. 

Here's the letter file (DOLPHINS.SPR on the Data Disk). Again, Sprint­
Merge fields are shown in boldface type. 

HONORIFIC FIRSTNAME LASTNAME 
ADDRESS 
CITY COUNTRY 

Dear HONORIFIC LASTNAME, 

We are in the process of forming an international society to 
study the migratory habits of dolphins, including the beaked 
dolphin, the killer whale, and the pilot whale. We understand you 
are actively involved in studying these fascinating mammals in 
your country. 

We are asking activists like you to donate the amount of 
DONATION. This will go toward setting up a head office, which we 
expect to locate in London. We'd appreciate any suggestions on 
this. 

Thanking you in advance, 

Bernice Liu 

The printed letter for the first record would look this this: 

Mr. Roger Lobo 
567 rue de Seine 
Paris, France 

Dear Mr. Lobo, 

We are in the process of forming an international society to 
study the migratory habits of dolphins, including the beaked 
dolphin, the killer whale, and the pilot whale. We understand you 
are actively involved in studying these fascinating mammals in 
your country. 

We are asking activists like you to donate the amount of $100. 
This will go toward setting up a head office, which we expect to 
locate in London. We'd appreciate any suggestions on this. 

Thanking you in advance, 

Bernice Liu 

You now know how to set up a template, your records, and a letter file. It's 
time to merge these elements together and print out the form letters. The 
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next chapter shows you how to merge and print your Sprint, Reflex: the 
Analyst, Paradox, and dBASE records. 
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13 

Merging and Printing Your Files 

This chapter shows you how to merge and print your form letters. It also 
discusses running SprintMerge from the DOS command line, and using 
Reflex, Paradox, and dBASE records. Let's begin by going through the 
options on the SprintMerge nlenu. 

The SprintMerge Menu 

Once you've set up your template and records, you can call up SprintMerge 
by choosing Print/Merge, which displays the SprintMerge menu. 
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T 2 3 4 5 6 Sprint 
File Alt-F 
Edit Alt-E 

Insert Alt-I 
Typestyle Alt-T 
Style Alt-S 
Layout Alt-L ,- ¥t'O-
Window Alt-W 

r------:Print,------,~~--M~I I Gol 
r------I'IMerge-o -------, esti nat i on PRINTER Utilities Alt-U • Go! creen Preview Ctl-F8 Customize Alt-C 

Screen Preview 

Letter File TESTl.SPR :ii~ate Ctl-F7 Quit 
Alt-Q 

Record File DEFAULT.REC emove Formatter Page Breaks 

Data Format STANDARD ptions 
Initial Record 1 dvanced Options 
Ending Record LAST urrent Printer 

Order 
Criteria 

[DEFAULT] 

SPR Ins 1: 14pm Ln.2 of 2 Call 

Figure 13.1: The SprintMerge Menu 

If you choose Go, SprintMerge merges the record and letter files and sends 
the merged output to the printer. If you choose Screen Preview, 
SprintMerge merges the files and sends the output to the screen. 

The SprintMerge program automatically enters (defaults to) whatever file 
you have open as the Letter File. If it isn't the right file, choose Letter File 
and enter the correct file name. 

Record File displays DEFAUL T.REC when you first open the menu. You 
can change this by choosing Record File and typing in the correct file name. 

Data Format can be either Standard or Basic. The latter is for files that use 
quotation marks as delimiters around information fields, usually from 
BASIC programs. 

Initial Record and Ending Record tell SprintMerge what records you want 
sorted or printed. The defaults are 1 and Last. 

Order is where you specify the sort order, if any-ascending or descending 
in alphabetical, numerical, or ASCII order-and what field to sort on. 

Criteria is the record selection criteria, when you want the SprintMerge 
program to work on only some records. You can specify logical operators 
(and, or, and not) and relational operators <equal, greater than, less than, 
and not equal). 
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The Formatting and Printing Process 

Once you've set up your template, records, and form letters, you can call 
up the SprintMerge program by choosing Print/Merge. Check the name of 
your letter file and the name of your record file, then choose Go. After 
SprintMerge substitutes information from your records into the blanks in 
your form letter, it passes the whole project over to the Sprint formatter. 

Sprint's first pass through your file interprets any remaining formatting 
commands and checks for coding errors. You can override some formatting 
commands by selecting print options, such as multiple copies or a range of 
pages, from the Print/ Options menu. If you have any formatting errors in 
your file, Sprint displays error messages and, when done with the first 
pass, stops without printing. This gives you a chance to go into the file and 
correct the errors. 

If you want, you can set Print/Advanced Options/Log Errors to File to On. 
Sprint then copies any formatting errors to a .LOG file, so that you can 
check and correct your file at your leisure. Note: This doesn't include the 
SprintMerge errors that occur before the merged file is passed to the for­
matter. 

To stop formatting a file before the Sprint formatter has finished (for 
example, there are several warnings indicating too many tab settings and 
you want to fix the file before going on), press Ctrl-C or Esc. 

Here's how you would use the SprintMerge menu: 

1. Choose Print/Merge. 
2. Choose Letter File and enter the name of your form letter. 

3. Choose Record File and enter the name of your record file. 

4. Choose Screen Preview to check your merged letters onscreen, if you 
like. 

5. Choose Go to send your merged letters to the printer. 

Running SprintMerge from DOS 

To run the SprintMerge program from the DOS command line, type 

SPMERGE LETTER.SPR -R RECORD.REC OPTIONS -OUT FILENAME -PRINT OPTIONS 

and press Enter. The items from LETTER to FILENAME all have to do with 
SprintMerge. After that, -PRINT OPTIONS is where you list the commands 
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that show up in the Print/Options or Advanced Options menus: Starting 
Page, Number of Copies, and Number of Passes, for example. 

Here's what the entries in the command line mean: 

• SPMERGE starts the SprintMerge program. 
• LETTER. SPR specifies the letter file containing your form letter. If you don't 

specify a letter file name, the SprintMerge program looks for the file 
DEFAULT.SPR. 

• -R tells the SprintMerge program to expect a record file next. 

• RECORD.REC specifies your record file. If you don't specify a template file 
name, the SprintMerge program looks for the file DEFAULT.REC. 

• OPTIONS specify actions that should be performed in addition to filling in 
your form letters: 

-SELECT filters out certain records based on your specifications. 

-SORT arranges your records according to a specified field. 

-SORTFILE specifies a temporary outfile other than the default sort output 
file SPM.S$$. 

-STARTREC and -ENOREC specify the record to begin and end with in a par­
ticular file. 

-REMOITTO removes the double quotation marks commonly found in 
BASIC-type database files. 

• -OUT or -0 creates an intermediate output file with the file name that you 
specify. If you don't specify a file name with this command, the 
SprintMerge program uses the default output file SPM.O$$. 

• -PRINT indicates that you want to use Sprint's print options, which you 
should enter after this switch. The options are listed in the Print/Options 
and Advanced Options menus. 

In order to allow any combination of print options, SprintMerge sends the 
rest of the command line from -Print on to the Sprint formatter. So, if you 
use -Print, it ~ust be the last option in the command line. 

You may be wondering about the default output files SPM.O$$ and 
SPM.S$$. Unless you specify a file name, SprintMerge holds any sorted or 
printed records in these files. Here's how they work: 

1. When you begin merging, SprintMerge always sends the information to 
SPM.O$$ on its first pass, when it reads and selects records. 

2. If you've included a sort command, SprintMerge reads and sorts 
SPM.O$$ into SPM.S$$. This file is meant for the program, so you can't 
decipher it easily. 
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3. If you've specified -Out to save the output to a file that you can look at 
and sorting has occurred, SPM.S$$ is copied back into SPM.O$$. (If 
sorting hasn't occurred, the file is, of course, still in SPM.O$$.) 

Any commands in the command line override any corresponding com­
mands in your record. To display the usage and options list on your screen, 
type SPMERGE. Here's what you'll see: 

Main Options 
-select selspec 
-sort sortspec 

Output Options 
-out filename 
-0 filename 
-print options 
-p options 

Other Options 
-startrec n 
-endrec n 
-remditto 

-record filename 
-r filename 
-sort file filename 

Operate on only a subset of the records. 
Process the records in a specified order. 

Send a copy of output to a file. 
Same as -out. 
Specify more print options at end of command line. 
Same as -print. 

Ignore the first n-1 records. 
Ignore all records after record n. 
Remove quotation marks from input fields. 

Specify name of record file. 
Same as -record. 
Specify name of temporary sort file. 

Command lines cannot have more than 128 characters. If your command 
line exceeds 128. characters, delete some commands and insert them into 
the file. 

Note: To stop the SprintMerge program at any time, press Ctrl-C. 

Now, for those of you who have existing records or use a different database 
program,let's use Reflex, Paradox, and dBASE files with SprintMerge. 

Using Files Created with Reflex: The Analyst 

You can merge the records already entered in your Reflex database with 
letters written in Sprint. First, let's use the Reflex Report view to create a 
sample SprintMerge template that you can use with the following form 
letter. Note: When using your own database, be sure to switch to the field 
names in your Reflex file. 
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CENTERPAGE<.5 page> 
DAr.!<July 25, 1988> 

I'LUSBLEF! 
HON I'IRSTNAME LASmAN! 
ADDRESS 
CITY, S!Ar.! ZIP 
COtJN1rRY 

Dear BON LASTNAME, 

The pamphlet "Circumambage and Tautology in Late 20th-Century 
Technical Writing" is finally available for reprint. Kindly 
contact our Permissions Editor, Mr. Dante Anderson, for more 
details. 

Sincerely, 

Ford Prefect II 

Follow these steps to create the template: 

1. Load Reflex2 and select Report from the title screen. 

2. Press /Print Retrieve File (fPR) to retrieve your file. 

3. Press F3 to choose the When Printed row, then press F10 and choose 
Introduction from the Choices list. 

4. Press Esc to put the cursor in the Report design area. 

5. Use Up to move to the Introduction row. 

6. Enter ' @template {<Hon>, <Firstname>, <Lastname>, on the first line of the 
report. 

7. Press Down to move to the second row of the Report design and type 
<Address>, . 

8. Continue entering the field names, enclosed in angle brackets « » with 
a trailing comma. 

9. After you enter the last field, set the Wide As Needed attribute. Do not 
type an ending comma delimiter. Enter a right curly brace } to complete 
the template. 

Now, let's set up some records to match the template: 

1. Leave one blank line after the template and enter' @Data on the next line. 

2. Press Down to go to the next row, then press F3 to choose the When 
Printed row. 

3. Press F10 and choose Body from the Choices list. 
4. Press Esc to put the cursor in the Report design area again, then press 

F10 and choose H0n from the Choices list. 
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5. Press Right twice, press F10, and choose Firstname. Continue entering 
field names in the same order as the template you created in the 
Introduction area. 

6. Leave one blank line after all your fields have been entered. 

7. Press / Attributes Export U AE), choose each of the field names, and 
press F10. Choose Commas to delimit the fields with commas. 

8. Press / Attributes Variable Width U AV) and set each of the fields to be 
Wide As Needed. 

Your report design should look like the following figure: 

Attributes 

E i rstNaMe \..-- Last NaMe '--

llm.,~1 __ 7i .. c 
~,,-I __ _ fuA .. __ _ 

Figure 13.2: The Reflex Report Design Screen 

Let's assign the template'S print settings and save them to disk: 

1. Press /Print Change Printer Settings (/PC) to open the Print Settings 
tool. 
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C:\s rint\letter.rec 

PRINT SETTINGS 

Output: o To Printer ~ To Disk Fi Ie File NaMe 1.1~llhl~11 
Margins: Left OJ Right [E[] 

Top OJ BottOM OJ 
Page Length [J[] Setup String I 
Paper Feed: ~ Cont inuous o Single sheet 

Print With Page Breaks o Yes ~ No 

Pr int FroM Page D To~ 

I Print I I Put Away I Cancel 

Row: 11 FrOM Col: 1 through Co I : 1 ~ 

Figure 13.3: The Reflex Print Settings Tool 

2. Change Output to the To Disk File option, and enter the directory where 
your Sprint files are located and the name of your record file. 

3. Change the Left, Top, and Bottom margins to 0; the Right margin to 240. 
4. Change Print with Page Breaks to No. 

5. Select Print to print the records to disk. 

You are now ready to use your Reflex records with the SprintMerge pro­
gram. 

Using Files Created with Paradox 

You can merge the records already entered in your Paradox database table 
with letters written in Sprint. These following steps create a template in the 
Paradox Report design to use with the letter on page 254. When using your 
own database, be sure to switch to the field names in your Paradox table. 

1. Load Paradox and choose Report/Design from the main menu. 
2. Choose the first unused report. 

3. Enter the name of your Paradox table. 
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4. Enter a description for your report, such as SprintMerge. 

5. Choose the Free Form Design option. 

6. Go to the Report Header section of the report and press Insert to switch 
to insert mode. 

7. Enter ' @Template{ <Hon>, <FirstName>, <LastName>, on the first line of the 
Report header band. 

8. Press Down to go to the second row of the Report header band. 

9. Enter <Address>, on the second row. 

10. Continue entering field names enclosed in angle brackets « » with a 
trailing comma. 

11. After you enter the last field, do not type a comma. Type } to complete 
the template. 

12. Leave a blank line in the Report header after the closing delimiter ( } ) 
and enter @Data on the following line. 

13. Move the cursor down to the Form Band section. 

14. Press etrl-Y to delete the fields that Paradox automatically placed in the 
Form band. 

15. Move the cursor to the Page Header band and press etrl-Y to delete the 
line with MM/YY /DD. 

16. Go to the first line of the Form band and press F10/Field/Place/ 
Regular. Choose the Hon field. 

17. Press Enter twice to enter the field name, then go to the end of the Hon 
field and enter a comma. 

18. Continue entering all your field names in the same manner, following 
the order of the template you created in the Report header band. 

19. Press F10/Setting/RemoveBlanks/LineSqueeze/Yes to remove 
blankspaces between the field entry and the comma delimiter. 

Your report design should look like the following figure: 
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Designing report Rl for Address table 
Form Band 

Report Ins 1/1 

.... + ... 10 .... + ... 20 .... + ... 30 .... + .. .40 .... + .. .50 .... + ... 60 .... + ... 70 .... + ... 8* 
@template{<Hon>,<FirstName>,<Lastname>, 
<Address>, 
<City> ,<State> ,<Zip> 
} 
@data 

- page 
-furm-----------------------------------------------
AAA,AAAAAAAAAAAAAAA,AAAAAAAAAAAAAAA, 
AAAAAAAAAAAAAAAAAAAAAAAAA 
AAAAAAAAAA,AA,AAAAA 

- form -----------------------------------------------

-page-----------------------------------------------

Figure 13.4: The Paradox Report Design 

Now, to print your database records to disk, press F10/Report/Output/ 
<YourReportName>/File. Type a name for your Sprint record file, such as 

. ADDRESS.REC. 

You can now use your Paradox records with Sprint's SprintMerge program. 

Using Files Created with dBASE 

The following steps create a dBASE program that generates a file compat­
ible with the SprintMerge program. 

1. Go to the dBASE III dot prompt. 
2. Enter the following code: 

modify command <ProgramName> 

3. Enter the following program, substituting the field names in your data­
base file: 
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set talk off 
set echo off 
set alternate to address.rec 
set alternate on 

"@Template{" 
"<Hon>,<FirstName>,<LastName>, 
"<Address>, 
"<City>, <State>, <Zip>} 

@Data 

use address 
DO WHILE .NOT. EOF() 
? Hon+", "+TRIM(FirstName) +", "+TRIM(LastName) +", " 
? TRIM(Address)+"," 
? City+","+State+","+Zip 

SKIP 
ENDDO 
set alternate off 
close alternate 
close databases 
return 

4. Press Gtrl-W to save the program. 

5. Do <ProgramName> at the dot prompt. 

These steps create the file ADDRESS. REe, which you can use to merge 
your dBASE records with the Sprint form letter. 

Let's go to the tutorial, which will give you a broader view of the different 
ways you can use SprintMerge. 
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c H A p T E R 

14 

A Tutorial on Merging 

This hands-on tutorial acquaints you with different aspects of SprintMerge. 
It leads you through progressively more sophisticated uses of the program, 
from the simplest unformatted form letter to using variable paragraphs to 
printing only selected records. 

When you ran the SP-SETUP program, Sprint copied the example files to 
your hard disk (or to your Data Disk; if you have a two-floppy system, 
your Data Disk should be in Drive B). You can open them or enter them 
into your computer as we go along. After completing each tutorial, you can 
play with the example format (substituting your own file name) and gen­
erate customized versions of the template and letter. 

Before starting this tutorial, you should know how to enter a SprintMerge 
field from the Insert menu. You use this command from within your letter 
file. When you choose Insert/Merge Field, the field name you enter at the 
prompt is displayed in your letter, surrounded by special codes that tell 
SprintMerge "this is a field; substitute the correct value from the record file 
when merging." Here's how you do it: 

1. Press F10and choose Insert/Merge Field. 
2. Sprint prompts you for the field you want it to reference when merging. 

Enter the field name and press Enter. 

You should see the field name in your letter as a highlighted item. Let's say 
you entered the field name State. When SprintMerge gets to that word in 
the letter, it goes to the first record and substitute whatever is in the State 
field, say, Hawaii. It does the same for the second record, and so on. 
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Incidentally, you can merge your letters from the DOS command line. We 
show you how in one or two examples. See page 290 for how to run Sprint­
Merge commands from DOS. 

A Simple Form Letter 

The simplest use of SprintMerge is with a form letter where only the names 
and addresses change. There are four basic steps: 

1. Create the template. 
2. Enter or include the record file(s). 
3. Write the form letter. 
4. Merge the form letter and record file(s), and print or screen preview the 

merged file. 

Let's go through them one by one. 

Create the Template 

First, think carefully about the precise categories of information you want 
to create. Which categories will you need for future form letters? For 
sorting and selecting addresses? If you spend the time to plan your 
template correctly, you can create a template (and therefore a record file) 
that can be used for several different tasks. 

Chapter 15 contains the technical specifications and limitations of creating 
your template. Here's a quick summary: 

.15 characters maximum in a field name. 

• Field names must be alphanumeric characters-no spaces, tabs, or hard 
returns . 

• 31 characters maximum in a default field value. 

• Default values can't have spaces, tabs, hard returns, line feeds, or form 
feeds . 

• 16 fields maximum in a template. 

• Delimiters do not nest. 

Now, choose File/Open and open a file called GENERIC.REC. Choose 
Insert/Template for Data. A Sprint window opens with @Template{ } and 
@Data displayed. Move the cursor to the ruler at the top of the file and 
press Del to remove it. Enter the following template between the curly 
braces: 
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<hon>/<firstname>/<mi>/<lastname>/<title>/ 
<address -multiline>/ 
<city>/<state>/<zip5 -num>/<zip4 -num>/ 
<country>/ 
<petname> 

Make sure you've put in all the field separators and delimiters. 

Note: @Data doesn't need delimiters surrounding the records. 

Now, you want to enter your records following the template layout exactly. 
With GENERIC.REC still open and the template showing in the top half of 
the screen, choose Window/Open to open a second window. Sprint dis­
plays another version of GENERIC.REC in the second window. 

Enter the Records 

In this second window, create the record files: Enter the following honor­
ifics, names, addresses, and titles. Remember to follow the template exactly; 
check yourself by comparing the records against the template in the first 
window regularly. 

Chapter 14, A Tutorial on Merging 263 



@Data 
Mr./Wright//Kingsley/President/ 
unicorns & Dragons, Inc. 
777 Fifth Street/ 
Cambridge/MA/02140/-0020/ 
/ 
Grendel 

Dr./Emilio//Lazzaro// 
1117 Big John Road/ 
Belmont/MA/02178// 
/ 
Ginger 

Ms./Dagny/M./Doherty/Proprietor/ 
Children's Hour Bookshop 
22 Schmaltz Street/ 
Cambridge/MAl / / 
/ 

Mr./Art//Pavonine/Executive Director/ 
Mime Theatre 
1024 Laguna St./ 
Boston/MA/02113// 
/ 
Nicholas 

Ms./Cecilia//Montoya/Operations Manager/ 
Delightful Doodahs Corporation 
26 Terrigal/ 
Turramurra/NSW/2074// 
Australia/ 

Mr./Fernando//DuBois// 
Matching Items, Inc. 
33 Forgotten Place 
Suite 405/ 
Boston/MA/02213// 
/ 

~ the Country field separator 

~ one blank line as a record separator 

~ the Country field separator 

~ one blank line as a record separator 

~ the Country field separator 
~ The Petname field 

~ one blank line as a record separator 

~ the Country field separator 

~ one blank line as a record separator 

~ the Petname field 
~ one blank line as a record separator 

f- the Country field separator 
~ the Petname field 

~ file ends on this line 

Now, check your screen: Did you follow each record with at least one blank 
line as the record separator? Did you insert the field separators (slashes and 
hard returns) for empty fields? 

264 Sprint User's Guide 



Write the Form Letter 

Using the Sprint editor, enter the following form letter under the file name 
BIRDS.SPR. Use Insert/Merge Field to enter the field names shown in 
boldface. 

Before you begin typing in the letter, let's make sure you don't get page 
numbers or footers in the letters. You will need to change the default 
document-footer setting, which automatically put page numbers at the 
bottom of the page. To do this, press F10 to call up the main menu, then 
choose Layout/Footer/All Pages. Sprint automatically inserts the com­
mands BEGIN and END FOOTER into your file. Don't type anything in, 
and move the cursor down to the first blank line. 

BEGIN FOOTER 

END FOOTER 
October 24, 1988 

BON FIRSTNAME LASTNAME, TITLE 
ADDRESS 
CITY, STATE ZIPS ZIP4 
COUNTRY 

Dear HON LASTNAME, 

Welcome to the Society for the Preservation of Parrots. We were 
pleased to see you and your pet at the last meeting. Our next 
session will be on the first Monday of next month, at 8:00 p.m. 

Yours truly, 

Max Cox 

Check the letter. Whether you include punctuation after a field depends on 
the records in your record file. The comma after Lastname in the salutation, 
for example, is not part of the merge field. There isn't a period between Hon 
and Firstname because the honorific itself will contain a period when 
necessary. However, there should be a comma between City and State, 
because the city name won't include one. 

When you're satisfied, go to the top of the file and delete the ruler. 

Run SprintMerge 

Now that you have your template, records, and form letter in place, you 
need to tell SprintMerge what you want done with them. Let's preview the 
merged letters onscreen. 
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1. From within Sprint, press F10 and choose Print/Merge. 
2. Choose Letter File and change it to BIRDS.SPR if necessary. 

3. Choose Record File and change it to GENERIC.REC if necessary. 
4. Choose Screen Preview and press Enter. Sprint begins merging the 

record and letter files. If it doesn't find any errors, it displays the 
merged letters onscreen. 

5. If you're satisfied with the letter, choose Go to print them. 

As mentioned at the beginning, you can run SprintMerge from the DOS 
command line rather than from the menus. Choose Quit to leave Sprint and 
type the following at the DOS prompt: 

SPMERGE BIRDS.SPR -R GENERIC.REC Enter 

Sprint begins merging the letter and record files and, if no errors are found, 
sends the merged letters to the printer. Note: You can stop SprintMerge by 
pressing Gtrl-G. 

You should end up with a merged form letter for each of the six records 
you entered. Here's what the first merged letter should look like: 

October 24, 1988 

Mr. Wright Kingsley, President 
Unicorns & Dragons, Inc. 
777 Fifth Street 
Cambridge, MA 02142-0021 

Dear Mr. Kingsley, 

Welcome to the Society for the Preservation of Parrots. We were 
pleased to see you and your pet at the last meeting. Our next 
session will be on the first Monday of next month, at 8:00 p.m. 

Yours truly, 

Max Cox 

A Formatted Form Letter 

You can use Sprint formatting commands to customize your merged letters. 
This example builds on the first one by including some formatting com­
mands in the form letter. We'll use the same template, GENERIC.REC, as in 
the previous example. 
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Write the Form Letter 

Open a file called DOGS.SPR and enter the following letter. Use the 
@Centerpage command to center the one-page business letter between the 
tcp and bottom margins of the page. We'll then use @Address to move the 
date and mailing address to the middle margin. 

Let's add some date variables from the Insert menu, so that the program 
will insert whatever date your computer clock is set to. To do so, choose 
Insert/Variable/Monthname. When Sprint displays the Pick Template for 
Monthname menu, choose None. Do the same for the Day and Year var­
iables. Sprint only puts in the last two numbers of the year, so type 19 
before inserting the variable. 

Remember to insert the fields shown in boldface with Insert/Merge Field. 
Note that there isn't a period between Hon and Firstname, but there is a 
comma between City and State. This is because the honorifics themselves, in 
the record file, contain the periods, as do the middle initials. 

Change the default footer setting, as in the first example, by choosing 
Layout/Footer / All Pages and leaving a blank line between the BEGIN and 
END commands. 
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BEGIN FOOTER 

END FOOTER 
@CENTERPAGE[.5 page] 
@ADDRESS[MONTHNAME DAY, 19YEAR] 

@ADDRESS [BON FIRSTNAME HI LASTNAME 
ADDRESS 
CITY, STATE ZIPS 
COUNTRY] 

Dear BON LASTNAME, 

We invite you and your pet to enter the 25th annual Borzoi Best of Breed 
event. While we .look for the elegance of line that Borzoi are famous for, 
we consider intelligence, strength, agility, and poise just as important. 
If you are interested, please contact us for a brochure listing the 
rules and dates. 

Thank you, 

Gordon Sumner 

Run SprintMerge 

As you did for BIRDS.SPR, run SprintMerge by choosing Print/Merge. 
When the Merge menu comes up, enter the names of your letter and record 
files, DOGS.SPR and GENERIC.REC, respectively. Then choose Go to print 
the merged letters out or Screen Preview to view them on your screen. 

If you want to run SprintMerge from DOS, enter the following command 
line: 

SPMERGE DOGS.SPR -R GENERIC.REC -PRINT -V Enter 

The -V print option command at the end tells SprintMerge to send the 
merged letters to the screen, so that you can view them. Here's how the first 
letter should look: 

268 Sprint User's Guide 



Dear Mr. Kingsley, 

August 8, 1988 

Mr. Wright Kingsley 
Unicorns & Dragons, Inc. 
777 Fifth Street 
Cambridge, MA 02140 

We invite you and your pet to enter the 25th annual Borzoi Best of Breed 
event. While we look for the elegance of line that Borzoi are famous for, 
we consider intelligence, strength, agility, and poise just as important. 
If you are interested, please contact us for a brochure listing the 
rules and dates. 

Thank you, 

Gordon Sumner 

Adding Optional Variables to a Form Letter 

Let's set up a new form letter that can be personalized with optional 
nicknames. We'll need two new fields, a Yes/No field and a Nickname field. 

We'll also use Sprint's @Case command. (If you're not familiar with this 
command, refer to the Reference Guide.) 

Create the Template 

First, let's copy our existing template into a new file. 

1. Choose File/ Open and open GENERIC.REC. 

2. Choose File/Write As and call the copy GENERIC2.REC. 
3. Sprint automatically closes GENERIC.REC and opens GENERIC2.REC. 
4. Move the cursor to the end of the first line and press Enter to insert a 

blank line. Type 
<nickname>/<hasnname>/ 

The Hasnname field is a Yes/No field, and Nickname contains the name. 
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Add Fields to the Records 

We need to add the nickname, if any, to the second line of each record. 

1. Move to the cursor to the end of the first line of the first record (after the 
slash) and press Enter. 

2. In the new blank line, type 

Bob/yes/ 

3. Insert a blank line after the name line of the second record and type 

/no/ 

4. Do the same for all the record, entering a nickname, a slash, Yes, and 
another slash for those records with nicknames. For those without 
nicknames, enter a slash, No, and another slash. We'll leave the names 
to you. 

Write the Form Letter 

This letter includes variations of an @Case statement. When you enter the 
@Case statement, be sure to enter Nickname and Firstname with Insert/ 
Merge Field. Also, to match the @Case statement, be sure to put quotes 
around the merge field reference after you've entered it. (The quotes go 
outside the 1\ V and 1\ N command characters around the fields.) 

Choose Insert/Merge Field to insert the variables that create the form 
letter's "blanks." @Address tells Sprint to start printing the enclosed text 
halfway between the left and right margins. Note that Hasnname isn't a 
merge field. We want to reference the field itself, not insert the field's value 
into the letter. 

OK, open a file called P ARTY.SPR and enter this letter. Don't forget to 
delete the ruler at the top of the file after you've entered it. 
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@ADDRESS<October 24, 1988> 
@BLANKSPACE<3 LINES> 
RON FIRS'mAME LAS'mAME 
ADDRESS 
CITY, STATE ZIPS 

Dear @CASE {HASNNAME, YES "NICKNAME ", NO "FIRS'mAME II } , 

Our records indicate that you are a user of our product, Turbo Party 
Planner. We're pleased to announce the latest extension to that product, 
Turbo Party Planner Toolbox. 

The Toolbox works with the Party Planner to help you do what you, 
@CASE{HASNNAME, YES, "NICRNAME", NO IFIRS'mAME"}, have only dreamed of: 
Customize your fete to satisfy each guest! Fill in the Favorite Dance Step, 
Composer of Choice, Food Allergies, and Favorite Games categories, 
and you have an instantly accessible record of that person's 
preferences. 

Feel free to call me, @CASE{HASNNAME, YES "NICKNAME", NO IFIRS'l'NAME"}, 
if you would like more information. I'll be happy to answer any 
questions. 

Sincerely, 

Allegra Rhumba 

Run SprintMerge 

Choose Print/Merge and enter the names of your letter and record 
files-P ARTY.SPR and GENERIC2.REC respectively. 

If you want to, include a print option. Press Esc to go back to the Print 
menu and choose Options. Then, choose Pause Between Pages and toggle it 
to Yes. 

This option causes the printer to pause between pages, so that you can feed 
in single sheets. Sprint will display a message on your screen at regular 
intervals, asking you to insert a new sheet into the printer. 
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Here's how the first letter should look: 

Mr. Wright Kingsley 
Unicorns & Dragons, Inc. 
777 Fifth Street 
Cambridge, MA 02140 

Dear Bob, 

October 24, 1988 

Our records indicate that you are a happy user of our product, Tu%bo Party 
Planner. We're pleased to announce the latest extension to that product, 
Turbo Party Planner Toolbox. 

The Toolbox works with the Party Planner to help you do what you, Bob, 
have only dreamed of: Customize your fete to satisfy each guest! 
Fill in the Favorite Dance Step, Composer of Choice, Food Allergies, 
and Favorite Games fields, and you have an instantly accessible 
record of that person's preferences. 

Feel free to call me, Bob, if you would like more information. 
I'll be happy to answer any questions. 

Sincerely, 

Allegra Rhumba 

Using Variable Paragraphs 

You can create letters that include or exclude a paragraph depending on the 
the contents of certain fields, using Yes/No fields. If there are distinct 
variables (such as an account age of 60, 90, or 120 days) and minor changes 
in the letter, you can selectively print by using an @Case statement within 
your form letter. In this example, we'll use Sprint's @Case and @String com­
mands, and create a field that uses a default field declaration. 

Create the Template 

To create an effective template for this example, think about the content of 
your variable paragraph. What is the single characteristic that determines 
whether you want the addressee to see that paragraph? Once you have 
determined the single criterion, create a new field in which to note whether 
each person has that characteristic. 
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In this example, the variable paragraph is included only if the addressees 
have children. We created a variable field called Havekids. We also have a 
second field that lists the names of the addressees' children, with a default 
declaration, Kids, for when we don't know or can't remember the names of 
the addressees' children. A visible separator follows this field. 

Open a new file, KIDS.REC, and delete the ruler at the top of the file. 
Choose Insert/Template for Data, and enter this template between the 
curly braces: 

<firstname> <lastname>/<partner> 
<kids -default kids>/<havekids> 
<address -multiline>/ 
<phone>/<birthmonth> <date> 

Enter the Record 

OK, let's enter some new records. Note that when you come to the Kids and 
Havekids fields, you'll enter either the children's names followed by the field 
separator or just the field separator. You'll type either Yes or No and the field 
separator in the Havekids field. 

In this case, we're using invisible field separators-hard returns-after 
some fields. Pay attention to where they go. 
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@Data 
Christine Roxas/Richard 
/no 
55 Bloomfield Road 
Townsville, CT 33333/ 
576-2760/April 1 

Anna Schreppel/Harrison 
Brian and Robbie/yes 
234 56th Road 
Chicago, 1L 55555/ 
253-6809/November 22 

Elizabeth Bowen/Ramon 
/yes 
706 Wayne Avenue 
East Cupcake, KY 23456/ 
999-2345/July 23 

Write the Form Letter 

Again, we'll use Case and String statements in this letter. Open a file called 
KIDS.SPR and enter the following letter: 

@ADDRESS<MONTHNAME DAY, 19YEAR> 

Dear FIRSTNAME and PARTNER: 

Hi! This month brings us to the successful completion of Sarah's Ph.D. 
She is deciding among several posts offered on the East Coast and a very 
attractive two-year post-doc at the University of Paris. 
@CASE<HAVEK1DS, YES "We're really interested in hearing all about your 
KIDS and how they are growing. 

Our Martha has become quite interested in cars. Joey spends his time in 
the water--swimming in the pool, dawdling in the bathtub, and even 
occasionally trying to stand in the sink.", ELSE .11. 
> 
We'll be very sad to leave this area, after all the good times we have had 
in town and on campus. Write soon. 

Don't neglect to enter the greater than symbol ( > ) near the end of the 
letter. It makes sure that there aren't two blank lines before the last 
paragraph, in cases where the optional paragraph isn't inserted. 
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Run SprintMerge 

Choose Print/Merge and enter the Letter File and Record File names. Since 
you toggled Print/Options/Pause Between Pages to Yes in the last 
example, toggle it back to No. Now, choose Print/Merge/Go to print or 
Print/Merge/Screen Preview to check the letters onscreen. 

Here's how the second merged letter should look: 

Anna Schreppel 
234 56th Road 
Chicago, IL 55555 

Dear Anna and Harrison, 

October 24, 1988 

Hi! This month brings us to the successful completion of Sarah's Ph.D. 
She is deciding among several posts offered on the East Coast and a very 
attractive two-year post-doc at the University of Paris. 

We're really interested in hearing all about your Brian and Robbie 
and how they are growing. 

Our Martha has become quite interested in cars. Joey spends his time in 
the water--swimming in the pool, dawdling in the bathtub, and even 
occasionally standing in the sink. 

We'll be very sad to leave this area, after all the good times we have had 
in town and on campus. Write soon. 

Merging Selected Records 

SprintMerge lets you select records from old mailing lists and transfer them 
into a temporary outfile. (You can also reorganize existing lists by sorting 
them, explained in the next section.) If you want to specify an outfile to 
hold the selected records, use the command line to merge. 

Let's take a minute to look at the command-line options. From the DOS 
prompt, type SPMERGE and look at the options displayed. Use -Select to 
specify your selection criteria. Use the -Out or -0 switch without the -Print 
switch to tell SprintMerge to send the selected records to a plain text file, 
with all the fields and field delimiters intact. You can then type @Include 
<outfile> after your template to use the records in a merge operation. 

In this example, you'll select records from GENERIC.REC. 

Chapter 74, A Tutorial on Merging 275 



Select the Template 

Choose Print/Merge/Record File and type GENERIC.REC. Next, you need to 
tell SprintMerge what records to include. 

Specify the Record Criteria 

To enter your record specifications, use Print/Merge/Criteria. The 
equivalent command line command.is -Select. 

You specify records to select with relational and logical operators. Simply 
choose Print/Merge/Criteria and enter the selection string. Selection 
criteria are explained in detail in Chapter 15, but here's a table listing them: 

Logical Operators 

* and 
or 

Table 14.1: The Selection Criteria Operators 

not (as in != for not equal to) 

Relational Operators 

} 
{ 

equal to, same size characters in alphabetical fields 
greater than 

}= =} 
{= ={ 
!= {} } { 

fess than 
greater than or equal to 
fess than or equaf to 
not equal to 

For example, you'd type City=Boston*State=MA in the Criteria prompt to 
select records that have Boston and MA in their City and State fields. 

In the following case, we select records that contain the honorific for 
women. After previewing the selection onscreen, we'll print an outfile 
called WOMEN from the command line. 

1. Choose Print/Merge/Criteria. Make sure you have GENERIC.REC in 
Record File and, say, BIRDS.SPR in Letter File. 

2. A prompt appears. Type hon=Ms. (don't forget the period) and press 
Enter. 

3. Choose Screen Preview. 

4. The merge begins. You should see the two entries with Ms. in their 
honorific fields on your screen. 
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Now that you've seen the selected records merged into the letter, let's send 
the records to an outfile: 

1. Press Esc to return to the record file, then choose Utilities/DOS Com­
mand. A prompt appears. 

2. Type SPMERGE BIRDS.SPR -R GENERIC.REC -SELECT HON=MS. -0 WOMEN. Press 
Enter. 

3. SprintMerge sends the selected records to the file Women. Use the DOS 
command TYPE WOMEN to view this file. 

Sorting Records 

When you create your template, you can designate certain fields as being of 
a specific type-numerical, alphabetical, or ASCII. When you sort, you use 
these type designations to arrange your records in ascending or descending 
alphabetical, numerical, or ASCII order. When merging, you specify sort 
orders with Print/Merge/Order. 

You can also specify Sort options in the command line. If you use the 
-Sortfile <file name> switch, SprintMerge will send the sorted records to a 
file, in a printable format. 

Sorting specifications are thoroughly explained in Chapter 15, but here's a 
summary. The characters in normal typeface are what you'd specify in the 
template fields: 

Table 14.2: The Sort Order Specifications 

field name 
-!field name 
fi~ld name -num 
-!field name -num 
fii?ld name -ASCII 
-!field name -ASCII 
field name1,field name2 

field name1,!field name2 

ascending alJ?habetical order 
descending alphabetical order 
ascending numerical order 
descending numerical order 
ascending ASCII order 
descending ASCII order 
field 1 in ascending order, then field 2 in 
ascending order 
field 1 in ascending order, then field 2 in 
descending order 

As you can see, the Sort operation sorts in ascending or descending order 
according to the type of field you've specified (alphabetical, numerical, or 
ASCII). 

In the following example, we want to sort the Lastname field in descending 
alphabetical order. 
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1. Choose Print/Merge/Order. Make sure you have GENERIC.REC in the 
Record File and, say, DOGS.SPR in the Letter File. 

2. A prompt appears. Type ! Lastnarne, which means you want to sort the 
Lastname field in descending alphabetical order. 

3. Choose Screen Preview to view the sorted records. 

Note: If SprintMerge displays error messages while formatting, check that 
the last field in your template doesn't have a visible delimiter. It should be 
followed only by a hard return. 

Selecting Records for Varying Letters 

The example on page 272 works when you want to send the same letter to 
selected records in one record file. The @Case statement adds or leaves out 
variable paragraphs depending on the contents of a field. 

@Case isn't appropriate, however, when you have letters with distinct 
tones for different field values. You could have a harsh letter for accounts 
unpaid over 120 days and a gentle reminder for accounts only 60 days late. 
Neither can you use @Case when the selected field values (such as an 
Amountdue field) aren't distinct. And, if the field covers a wide range of 
values (such as State), using @Case would be very cumbersome. 

In this example, we'll send three different letters to three groups of selected 
recipients from one record file. We have an account age field in the 
template and will create three letter files. We'll use Print/Merge/Criteria to 
separate out the records. 

Note: You don't have to include the selection variable in the letter itself for 
selecting to work. The example after this demonstrates how such selecting 
works. 

Create the Template and Records 

1. Choose File/ Open and open GENERIC.REC. 
2. Choose File/Write As and write the records to a new file called 

OVERDUE.REC. 

3. Delete the Petname field from the OVERDUE.REC template and the pet 
names from the records. 

4. Add the Acctage and Amountdue fields to the end of the template, so it 
looks like this: 
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@Template{<hon>/<firstname>/<mi>/<lastname>/<title>/ 
<address -multiline>/ 
<city>/<state>/<zip5 -num>/<zip4 -num>/ 
<country>/ 
<acctage>/<amountdue -num>} 

The Amountdue field is numerical so that you can select by a precise 
numerical amount. 

Now, following that template, enter these values to the ends of each record 
in succession: 

120/44558.92 
60/2000.53 
90/503.89 
30/450.98 
120/8965.99 
60/1893.21 

Write the Form Letters 

The letter for 60-day overdue accounts (60DAYS.SPR) is a gentle reminder. 
For 90-day overdue accounts, the letter (90DAYS.SPR) has a darker tone. 
And the letter (120DAYS.SPR) for long overdue accounts pulls no punches. 

Open a file called 60DAYS.SPR and enter the following 60-day letter (feel 
free to amend it). Don't forget to enter the field names with Insert/Merge 
Field. 
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Dear BON LASTNAME: 

We know that you have been buried in paperwork these past two months. 
We know that you don't mean to be overdue on your account by sixty days. 

Prove us right: When you have a moment, locate your checkbook and a pen 
and make out a check to The Flaming Flamingo, Inc., in the amount of AMOUN!DOE. 
Then dispose of the whole matter by mailing it immediately! 

Yours sincerely, 

Obi wan Kenobe, 
Accounts Payable 

Now enter the 90-day letter in a file called 90DAYS.SPR: 

BON LAS'l'NAME: 

Have you overlooked our gentle reminder among your letters? Did you 
purposely throw the reminder away? Do you enjoy courting disaster? 

Here's one more chance to make amends with us, The Flaming Flamingo, Inc. 
Make your check out to us for the amount of AMOUN!DOE and mail it today! 

Yours sincerely, 

Obiwan Kenobe, 
Accounts Payable 

Next, enter the 120-day letter in 120DAYS.SPR: 

LAS'l'NAME : 

You have blown it completely. Your karma is irredeemably befouled. 
Our lawyer should be at your office door shortly after you open this 
letter--we aren't called The Flaming Flamingo for nothing! We strongly 
suggest that you have the AMOONTDUE you owe us in hand. 

Fitfully yours, 

Bart Fader, 
Collections 

Run SprintMerge 

Now, choose Print/Merge/Criteria and enter the appropriate account age 
criteria for each letter: 

60DAYS.SPR 
90DAYS.SPR 
120DAYS.SPR 

ACCTAGE=60 
ACCTAGE=90 
ACCTAGE=120 

Choose Print/Merge/Record File and specify OVERDUE.REC. Then 
choose Letter File and enter the appropriate letter file for each criterion: 
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When Criteria is 60, the Letter File should be 60DAYS.SPR, and so on. 
Choose Screen Preview to view each set of letters. 

Another Example Using Varying Letters 

Remember we said in the previous example that you don't need to include 
the selection variable in the letter for selection to work. Let's test this. 

Suppose you're the director of a nonprofit organization, and you want to 
send customized appeal letters out. The type of letter sent depends on the 
level of support previously received from that person. 

Create the Template 

Let's take our OVERDVE.REC template, write it as CONTRIBS.REC, and 
modify it to look like this: 

@Template{<hon>/<firstname>/<mi>/<lastname>/<title>/ 
<address -multiline>/ 
<city>/<state>/<zip5 -num>/<zip4 -num>/ 
<country>/ 
<date>/<totalamt -num> 

The Date field logs the date of the person's last donation. The Totalamt field 
contains the total amount donated for the year. 

In the records, substitute the following date and donation amounts in place 
of the Acctage and Amountdue fields. 

3.88/0 
8.88/200 
8.88/25 
10.88/1500 
6.88/300 
2.88/125 

Create the Form Letters 

We want to encourage the low givers and noncontributors, and to thank 
high givers and inspire them to continue helping. 

Enter this noncontributol; letter (save it as NOGIVR.SPR): 

Chapter 74, A Tutorial on Merging 281 



Dear FIRSTNAME LASTNAME: 

Thank you for your continued interest and moral support. We are sorry that 
circumstances have prevented you from contributing to our pressing 
financial needs, but hope that this year will be better for you. 

If you wish to remain on our mailing list, please let us know by returning 
the enclosed postpaid card. If you'd like to send a check now, please make it 
payable to Friends of the Swamplands. A receipt will be sent to you promptly. 

Now, enter the low-giver letter (save it as LOGIVR.SPR): 

Dear FIRSTNAME LASTNAME: 

Thank you for your donation in the amount of $!oT~ this past year. 
It helps defray the cost of our mailing list. We hope you continue 
to be a part of the Friends of the Swamplands. 

Here's the moderate-giver letter (save it as MODGIVR.SPR): 

Dear FIRSTNAME LASTNAME: 

Thank you for your generous donation of $TOT~ this past year. You and 
others like you make our work possible. We'd like to remind you of our 
supporting patron program. Information on this Friends of the Swamplands program 
is enclosed. 

Finally, enter the high-giver letter (save it as HIGIVR.SPR): 

Dear FIRSTNAME LASTNAME: 

Your very generous support of Friends of the Swamplands, totaling $!OTALAHr, 
makes you one of our key members. Without the kind of support you have 
provided, we would be unable to inspect forests around the world. 

We'd like to let you know about a new program: In return for a contribution 
of $20,000 and over, we invite you to accompany us on one of our inspection 
expeditions during the next year. For more information, call Rhonda Starr. 

Run SprintMerge 

Enter the appropriate Letter File with each selection Criteria you enter in 
the Letter File. To print letters to nongivers, low, moderate, and high givers, 
type these values: 

Letter File NOGIVR.SPR Letter File LOGIVR.SPR 
Record File OVERDUE. REC Record File OVERDUE. REC 
Criteria TOTALAMT=O Criteria TOTALAMT}O*TOTALAMT{lOO 

Letter File MODGIVR.SPR Letter File HIGIVR.SPR 
Record File OVERDUE. REC Record File OVERDUE. SPR 
Criteria TOTALAMT}=lOO*TOTALAMT{lOOO Criteria TOTALAMT}=lOOO 
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Choose Print/Merge/Screen Preview to see whether the letters merged 
correctly. 

Creating Mailing Labels and Inventory 
Stickers 

With Sprint and SprintMerge, you can produce address labels of varying 
sizes. We do this by tricking SprintMerge into thinking it's merging a very 
short document on a very narrow page. SprintMerge doesn't actually 
understand that it's printing mailing labels, so it can't automatically 
generate the 4-across format, for example. 

We'll use the Sprint @Style command to create a new printer definition that 
specifies a label as a page. 

Select the Template 

For this example, let's create a simple template and some records. Choose 
File/Open and open a file called LABELS.REC. Choose Insert/Template 
for Data and type 

@Template{<Hon> <Firstname> <Lastname> 
<Address>/ 
<City> <State> <Zip -num> 
<Birthday> 

@Data 
Mr. Jeffrey Kell 
13245 Office Park/ 
Chattanooga TN 37402 
November 15 

Ms. Cora Aquino 
970 South Newton St./ 
Boston MA 02101 
June 12 

Ms. Kelly Tyler 
123 Brabant Avenue/ 
Buran, SC 23156 
October 10 
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Create the Label Format 

We need to open a letter file that contains the label format and the fields we 
want to include on the label. Choose File/Open and open a file called 
LABELS.SPR. 

At the top of the letter file, enter an @Macro command to eliminate page 
headings and footings in the Sprint formatter: 

@Macro (Pageinit="") 

Next, create a Style command that specifies the size of the labels. This 
example uses 1 x 4-inch labels and an elite print wheel (12 characters per 
inch). Before we show you the Style command, here's the process we 
followed to arrive at our dimensions: 

IC 
IR Mary Jean Maceri 
I-~ 100 Camino Real A 

Sevilla, Spain 

Greg Wasson 
396 Vista Linda 
Madrid, Spain 

Lolita Montilla 
900 Avenida Ruiz 
Madrid, Spain 

A Page Length 
B Left Margin 
C Top Margin 

Figure 14.1: Measuring a Typical Label 

• Measure the length from the top of the first label to the top edge of the 
next label. (This can be different from the length of the top to the bottom 
of that same label, depending on the type of label roll you use.) 

• Measure the left margin from the edge of the paper that backs the label 
(or from the perforations on the left edge if you are using form-feed 
paper) . 

• Measure the top margin from the top perforated edge (or the top of the 
label). Experiment with this measurement for the best results. 

• Set the bottom margin to zero; this means your standard address will fit 
on the label in the vertical direction. 

The following Style command gives Sprint the measurement information it 
needs to print properly. (To use different labels, postcards, or a pica printer 
(10 characters per inch), adjust the command's parameters.) Enter this after 
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the @Macro command at the beginning of your letter file. Remember to 
enter the boldfaced words with Insert/Merge Field. 

@STYLE[PAPER 1 INCH, LEFT INDENT 5 CHARS, FILL NO, TOPMARGIN 1 LINE, 
BOTTOMMARGIN 0, FORMFEED NO] 
BON FIRSTNAME LASTNAME 
ADDRESS 
CITY, STAf.E ZIP 

Fill No tells Sprint not to fill a line with characters to the right margin, while 
Formfeed No tells it not to advance the printer to the next line. 

Run SprintMerge 

Before you print a large run of mailing labels, it's always a good idea to test 
your printer definition by printing a record file that contains just a few 
records. Our record file contains only three records, so we can safely forge 
ahead. 

We want to have an outfile containing the records, so we need to print this 
set of files from the command line. We'll call the outfile LIST.REC. Type 

SPMERGE LABELS.SPR -R LABELS.REC -0 LIST.REC -P 

SprintMerge will merge the letter and record files, then pass the records to 
the formatter to be printed as LIST.REC. After printing is finished, you'll be 
returned to the Sprint editor. Meanwhile, your printer should be generating 
the labels specified. 

Note: You can stop SprintMerge at any time by typing CtrJ-C. 

Printing from a Specific Label Number 

If you have to abort a print run with Ctrl-C and then want to continue where 
you left off, you can use Print/Merge/Initial Record (or -Startrec n from 
the OOS command line). This lets you specify the record number to start 
printing at. 

You determine the record number by counting the number of labels already 
printed successfully. Then substitute that number into the Initial Record 
command. 

If you have chained a series of record files together by using multiple 
Include commands in your file, you can still keep track of record numbers. 
SprintMerge counts records sequentially. It starts with the first record in the 
first record file through to the last record in the last record file. You don't 
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need to know how many records each record file contains in order to 
restart your mailing label run. 

Using BASIC-Type Files 

BASIC-type database files use commas as field separators and double 
quotation marks as field delimiters within a record. They do not contain 
hard returns within fields. Here's an example: 

"Ms. ", II Gwen II , "COX", 

"564 Louisburg Square", 
"Boston", liMA II , "02354" 

You can convert this type of database into SprintMerge records by using the 
Remditto (for remove ditto) command. It removes the quotation marks. Type 
@Remditto after the template and before @Data. 

BASIC-type database files allow commas between the double quotation 
marks~uMuffins and Beer, Inc."-but they also use commas as field 
separators. If SprintMerge comes across a record that has a field containing 
its own field separator while processing your records, it may misalign your 
fields. SprintMerge does not display an error message to flag your 
attention, because it has no way of knowing that a misalignment has 
occurred. You'll learn how to check for commas on page 287. 

Create the Template 

If you want to use a BASIC-type database file with SprintMerge, you need 
to create a template that matches it. Due to BASIC's characteristics, you 
don't need to use a multiline field declaration (your database file won't 
contain them), and you should use commas as your field separators. Open 
a file called BASIC.REC, choose Insert/Template for Data, and enter the 
following template so the screen looks like this: 

@Ternplate{<hon>,<firstname>,<lastnarne>, 
<address>, 
<city>, <state>, <zip>} 
@Rernditto 
@Data 

We suggest you always place the Remditto command between the template 
and @Data. Alternatively, you can change Print/Merge/Data Format from 
Standard to Basic and Sprint will remove the quotation marks auto­
matically. Or, you can leave the command out of your template file and 
include it as -Remditto in the DOS command line. 
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Now, enter the following BASIC files according to the template. 

"Mr.", "John", "Fowles", 
"234 First Street", 
"Cambridge", "MA", "02354" 

"Ms.", "Virginia", "Woolf", 
"564 Louisburg Square", 
"Boston", "MA", "02354" 

"", "K.A.", "Porter", 
"422 Ringgold Street", 
"Newton", "MA", "02135" 

"", "J.B.", "Dohire" 
"Muffins and Beer, Inc.", 
"Cambridge", "MA", "02135" 

"Mrs.", "Elizabeth", "Barrett-Browning", 
"354 Fulton Street", 
"Arlington", "MA", "02174" 

"Mr.", "T.H.", "White", 
"356 Fulton Street", 
"Arlington", "MA", "02174" 

Write the Form Letter 

Choose File/ Open and open a file called STICKER.SPR. Enter the following 
form letter: 

BON FIRS'mAME LAS'mAME 
ADDRESS 
CIn STATE ZIP 

Dear BON LAS'mAME: 

Now that you have your precious little one, won't you feel safer with our 
deluxe, day-glo Baby on Board sticker on your rear windshield? This sign 
alerts all drivers that they should be much more careful around your car 
than if only you, BON LAS'mAME, or any other mere adult were in it. 

Isn't $21.95 a small price to pay for peace of mind? 

Sincerely, 

Checking for Commas 

Before printing labels or letters, check your database file for fields that 
contain commas. An easy way to do this is to use the -Outfile command 
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from the DOS command line. First, check that Print/Merge/Letter File says 
STICKER.SPR and Record File says BASIC.REC. Then go to Utilities on the 
main menu and choose DOS Command. At the DOS prompt, type 

SPMERGE STICKER.SPR -R BASIC.REC -REMDITTO -0 FILEl 

Once SprintMerge has finished processing your records, choose File/Open 
and look at the outfile FILEI. Search for all occurrences of double quotation 
marks. If Sprint finds any, the record contains a comma somewhere within 
a field and needs to be corrected. You can either correct this file (FILEI), or 
you can note the line numbers and correct BASIC.REC. 

Try it. You'll see that you need to correct the address of J.B. Dohire, of 
Muffins and Beer, Inc. Go back to BASIC.REC and make the correction, 
then run it ~gain. 

You can use Remditto with other print options, such as sort and select. 

Summary 

Congratulations, you've completed the SprintMerge tutorial. You should 
now be able to create and format templates and form letters, as well as add 
optional values and fields. You've only scratched SprintMerge's surface, so 
do study each feature's in-depth description in the following reference 
section. 
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c H A p T E R 

15 

The SprintMerge Reference 

This chapter is a general reference that describes each component of the 
SprintMerge program (templates, records, and letter files), as well as all 
commands. Except for the introductory section on the SprintMerge concept, 
the elements are alphabetically arranged. 

If you need help performing a task with SprintMerge and don't want to 
wade through theory right now, you can turn to Chapter 14 and see if one 
of the examples addresses your needs. 

For problems in running SprintMerge, such as misaligned addresses or 
fields in your letters, turn to Chapter 16. 

This chapter covers the following main topics: 

• The SprintMerge Concept 
• Commands 

• Command Delimiters 
• Fields 

• Letter Files 
• Record Files 
• Records 

• Selection Specifications 

• Sorting Specifications 
• Technical Specifications 
• Templates 
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The SprintMerge Concept 

SprintMerge uses three elements you create-a template, record file, and 
form letter-and combines them into a series of personalized materials. The 
template lays out the fields each record contains. The record file holds the 
actual information corresponding to the template fields or slots. For 
example, the record file would have Chris Jones in the Firstnam~ field, 123 
Main Street in the Address field, and so on. The letter file specifies the field 
blanks, and SprintMerge plugs the information from the record file into 
those blanks. 

Once you've set up your template, records, and form letter, you invoke 
SprintMerge by choosing Print/Merge. You enter the correct Letter File and 
Record File in those menu prompts. 

You can also sort or select records, and specify the Initial and Last Record. 
If you have special print options you want to use, choose Print/ Options or 
Advanced Options and follow the menu prompts. 

After SprintMerge substitutes information from your records into the 
blanks in your form letter, it passes the whole project over to the Sprint for­
matter. The formatter then interprets the remaining formatting commands 
in your file. (You override some formatting commands when you select 
print options-such as multiple copies or a range of pages-from the 
Print/ Options menu.) 

Sprint now begins its formatting/printing process. It first goes through the 
entire file and checks for coding errors. After an error-free formatting pass, 
it prints the file. 

If you have any formatting or SprintMerge errors in your file, Sprint dis­
plays error messages and, when done with the first pass, stops without 
printing. This gives you a chance to go into the file and correct the errors. 

If you want to stop formatting a file before the Sprint formatter has finished 
(for example, if there are several error messages and you want to fix the file 
before going on), press Ctr/-C. 

Running SprintMerge from the DOS Command Line 

To run SprintMerge from the DOS command line, type SPMERGE LETTER.SPR 
followed by the any of the following options and press Enter. (Note: To stop 
SprintMerge, press Ctr/-C.) Command lines cannot have more than 128 
characters. 

SPMERGE LETTER.SPR -R RECORDS.REC <OPTIONS> -OUT -PRINT <OPTIONS> 
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• SPMERGE starts the SprintMerge program. 
• LETTER. SPR specifies the letter file containing the form letter you want 

merged. If you don't specify a file name, SprintMerge looks for the file 
DEFAULT.SPR. 

• - R tells SprintMerge to expect a record file next. 
• RECORD. REC specifies the record file you want merged with the letter file. If 

you don't specify a file name, SprintMerge looks for the file 
DEFAVLT.REC. 

• <OPTIONAL COMMANDS> specify actions that should be performed in addition 
to filling in your form letters: -Select, -Sort, -Startrec, -Endrec, -Sortfile, 
and -Remditto. By issuing these commands in the command line, you 
override corresponding commands in the record file. 

• -OUT creates an intermediate outfile with the file name that you specify. If 
you don't specify a file name with this command, SprintMerge uses the 
default outfile SPM.O$$. If you've used a -Sortfile command without 
specifying a file name, SprintMerge copies the outfile to the default 
sortfile SPM.S$$. 

• -PRINT indicates that you want to use Sprint print options, which you can 
specify after this switch. 

Commands 

You can enter most SprintMerge commands in three ways: 

1. You can choose commands from the menus. 

2. You can enter @-commands in your record or letter file. 

3. You can enter commands on the DOS command line. 

The following table alphabetically lists all SprintMerge commands, 
showing their menu form, @ form, and command-line form. Each com­
mand is then explained, in the same order as the table (moving rightward 
down the table). 
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Table 15.1: The SprlntMerge Commands 

Menu Commands 

Criteria 
Data Format/Basic 
Ending Record 
Go 
Initial Record 
Merge Field 
Order 
Record File 
Screen Preview 
Template for Data 
Typestyle/Hidden 

Criteria 

@Commands 

@Select 
@Remditto 
@Endrec 

@Startrec 

@Sort 
@Inc1ude 

@Template 
@Comment 
@Data 
@Inc1ude 
@Sortfile 

DOS Line Commands 

-Select specs 
-Remditto 
-Endrecn 
-Print,-P 
-Startrec n 

-Sort specs 
-Record,-R 
-View 

-Sortfile filename 
-Out, -0 filename 
SPMERGE 

Specifies the criteria for selecting records. See "Selection Specifications" on 
page 302 for a list of the logical and relational operators you can use. 

When using@Select, you can place it anywhere in the record file. 

-Select in the command line overrides any ®Select commands in the record 
file. 

Data Format/Basic 

Removes the double quotation marks used as delimiters in BASIC-type files 
so that SprintMerge can use the information. Your template must separate 
fields with commas, just as BASIC does, in order to use BASIC-type record 
files with this command. 

The commands @Remditto and -Remditto are equivalent to this command. 
Always put @Remditto before @Data in a record file. 

Ending Record 

Must be followed by a number n, stops SprintMerge after the nth record in 
your record file. For example, if you enter 45 in the Ending Record prompt, 
SprintMerge stops after completing work on the 45th record in your record 
file. 
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This command is often used with Initial Record (@Startrec). 

If you've included a series of record files with the @Include command in 
your record file, SprintMerge counts the included records sequentially. It 
starts with the first record in the first included record file through to the last 
record in the last included record file. 

You can put @Endrec anywhere in the record file. -Endrec in the OOS com­
mand line overrides any @Endrec command in the record file. 

Go 

When followed by SprintMerge print options, specifies how you want to 
print your completed letter file. You can use any of Sprint's print options. 

Use this command to store the print options you usually use with 
SprintMerge. If you normally print unformatted files on a dot-matrix 
printer, for example, you could include @Print(-P=Diablo) in your record 
file. 

Initial Record 

Starts SprintMerge on the nth record in your record file. If you type 30 in 
the Initial Record prompt, for example, SprintMerge counts to the 30th 
record in your record file and begins work there. 

If you've included a series of record files by using multiple @Include com­
mands in your record file, SprintMerge counts the records sequentially. 
When restarting an interrupted print run, count the number of labels or 
letters already printed and type that number into the Initial Record prompt. 

-Startrec in the command line overrides any @Startrec commands in the 
record file. 

Merge Field 

Lets you insert the field name in the letter file to be merged with the 
corresponding record from the record file. When SprintMerge comes across 
an item entered with Insert/Merge Field, it goes to the template, checks 
where the data should be in the record, pulls the data from the record, and 
inserts it into the form letter. 
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Order 

Specifies the order you want to sort the records in. See "Sorting Speci­
ficationsll on page 304. 

You can place the @Sort command anywhere in the record file. -Sort with 
no options in the command line turns off all sorting and overrides any 
@Sort commands in the record file. 

Record File 

Must be followed by a file name, tells SprintMerge what record file to use. 
If you don't specify a file name, SprintMerge looks for the default record 
file DEFAULT.REC. 

Screen Preview 

Sends the merged outfile to the screen rather than to the printer. Just follow 
the prompts and press Esc to quit. 

Template for Data 

Puts the commands @Template{ } and @Data at the top of your file. You 
enter the template fields between the curly braces and the records after 
@Data. 

Typestyle/Hidden 

Tells Sprint to ignore whatever is between the Begin Comment and End 
Comment delimiters. 

@Data 

Tells SprintMerge that what follows this command are your records. 

@Include 

Tells SprintMerge to append the named file(s) to the record file, as if they 
were entered after @Data. Included record files should not have templates. 
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@Remditto 

See "Data Format/Basic." 

@Sortfile 

Names a temporary sortfile for SprintMerge. If you don't specify a file 
name and the sort records don't fit into memory, SprintMerge writes the 
records to disk under the default sortfile SPM.S$$. 

-Sortfile in the command line overrides any @Sortfile commands in the 
record file. 

@Startrec 

See "Initial Record." 

-Out 

Must be followed by a file name, specifies an outfile into which Sprint­
Merge puts sorted or selected records. You must give this command at the 
end of the SprintMerge command line. You cannot enter it from the file. If 
you don't use this or the @Outfile command to specify an outfile, Sprint­
Merge uses SPM.O$$ as a default file. 

This command also stops SprintMerge from passing your outfile to Sprint 
for printing. In fact, you can use the -Out command without a file name 
when you want to prevent printing but want to be able to look at the 
SPM.O$$ file. If you follow this command with the -Print command, 
SprintMerge puts your completed form letters into the outfile you specify 
and passes that outfile to Sprint to be printed. 

You can specify both an outfile and a sortfile in the command line. 

-Out in the command line overrides any @Outfile command in the record 
file. 
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SPMERGE 

The SprintMerge command on the DOS command line. Tells Sprint that 
what follows are the letter file and record file to be merged, according to 
the options set. Here's a typical SPMERGE line: 

SPMERGE LETTER.SPR -R RECORD.REC <OPTIONS> -P <PRINT OPTIONS> 

The first set of merge options comprises sorting, selecting, sending records 
to an outfile, records to start and end with, and removing double 
quotations marks from BASIC-type files. The second set comprises print 
options, such as viewing, starting and ending pages, number of copies, 
number of passes, word wrap, and logging errors to a file. 

Command Delimiters 

The commands you place in the record file are structured just like all other 
Sprint commands. SprintMerge accepts all seven single character Sprint 
delimiters: 

[] brackets 

{} braces 

< > angle brackets 

double quotes 

open and close quotes 

two close quotes 

( ) open and close parentheses 

Note: The SprintMerge program ignores the delimiters BEGIN and END. 

Fields 

Fields are the categories of information that make up the template, which 
represents one record. This main entry explains the general concept; see 
also the following sub-entries: 

• Field Declarations 

• Field Names 
• Field Separators 

• Field Types 
• Fields, Empty and Default 

• Fields, Multiline 
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Fields are enclosed by delimiters and segregated by field separators. All the 
fields in a template are enclosed by the @Template command and its 
delimiters; for example, 

@Template{<fieldl -multiline>/ 
<field2 -num>i <field3>i <field4> 
<fieldS -default Text>= 
<field6 -alpha>} 

You can set default values. SprintMerge will use this value for records that 
don't supply a value for the field. 

You declare a multiline field when the information will be of varying 
lengths. In the Address field, for instance, you may have some records that 
show a company name, a building name, and a street address, while others 
have only one line-the street address. 

Field Declarations 

After typing afield's name, you can specify the field as one of the following 
types: alphabetical, ASCII, or numerical. You can also specify that it is a 
multiline field or contains a default value. If you type -Default in the com­
mand line, it precedes any default value for an empty field. If you don't 
specify a field type, SprintMerge assumes ASCII. 

Field Names 

A field name consists of one word, with up to 15 alphanumeric characters 
with no spaces, enclosed by any of the six types of single character Sprint 
delimiters (see page 296). (Note: The delimiters BEGIN and END do not 
work with SprintMerge.) 

You can follow a field name with a field declaration, which specifies the 
field's data type as alphabetical, ASCII, or numerical. 

Field Separators 

The character that immediately follows the closing field delimiter is called a 
field separator. This can be a printing or nonprinting (invisible) character. If 
you press Enter after typing a field's delimiter, for example, the hard return 
character is the field separator. 

Don't put a field separator after the last field in a template. Follow it with 
the closing delimiter. 

Chapter 75, The SprintMerge Reference 297 



Normally, it doesn't matter what your field separator looks like. You should 
use a printing character and carefully consider what character to use as a 
field separator when 

• Your field data might contain a blank space. 

• Your field data in your record file might be empty. 

• You have specified a default value. 

• You have declared the field as multiline. 
• Your field may, at some point, contain that field separator character as 

part of the data. For example, don't use a slash ( / ) if the Address field 
contains "c/o." This also means you should never use a letter as a field 
separator. 

The following two templates, for instance, will cause problems: 

@Template{<Aaa -multiline> 
<Bbb>, <Ccc>} 

@Template{<Aaa -multiline> 
<City> <Ccc>} 

The multiline field isn't defined well enough to satisfy either template. Its 
ending field separator is a hard-return character, and the multiline 
declaration specifically allows for hard returns in the data. So,SprintMerge 
has no way of knowing where the multiline field ends and the next one 
begins. In addition, look at the City field in the right-hand example: The 
field separator between City and Ccc is a nonprinting space, which will 
cause problems for cities with spaces in their names-Rio de Janeiro, Walla 
Walla, Des Moines, and so on. 

The solution is to mark these fields with a visible field separator, such as an 
equal sign: 

@Template{<Aaa ~multiline>= 
<Bbb>=<Ccc>} 

Field Types 

@Template{<Aaa -multiline>= 
<City>=<Ccc>} 

The type of field determines how Sprint performs the relational operations 
when sorting and selecting. There are three types: 

-Alpha @Template{<Name -Alpha>} 
Assumed when no type is given after the field name. Tells SprintMerge to 
treat the field's contents as strings of alphabetical characters, causing 
SprintMerge to sort alphabetically with no regard to case (AaBb ... YyZy). 
Fields can contain non-alphabetical characters; numbers will compare 
"improperly" -that is, 5 will--be--eonsidered greater than 128 because it's a 
single character and 5 is greater than 1. 
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-ASCII @Template{<Name -ASCII>} 
Tells SprintMerge to treat the field's contents as strings of ASCII characters, 
so SprintMerge sorts in ASCII order. All uppercase letters are sorted before 
the lowercase letters (AB ... YZab ... yz). 

-Num @Template{<Zip -Num>} 
Tells SprintMerge to treat the field's contents as a number. Any data that 
looks like a number will be compared as a number. Dollar signs, commas, 
and trailing zeros after a decimal point are ignored, as are all characters 
other than numbers. Leading or trailing minus signs (-) or a number 
enclosed in parentheses indicate a negative number. The maximum value of 
a number in SprintMerge is 20,000,000, and SprintMerge only works with 
up to two decimal places. 

Here are two examples of equivalent numbers: 

5326 = 05,326 = $5326.000 
-41.1 = 41.10- = (41.1) 

Sorting and selecting by numerical fields is slower than by alphabetical or 
ASCII fields. For more information on selecting and sorting numbers, see 
"Selection Specifications" on page 302. 

Fields, Empty and Default 

You can declare a default field value in your template. The SprintMerge 
program will automatically fill in that value whenever you leave that field 
empty in your record. Your default value should not contain any spaces, 
hard returns, or tabs. It can be up to 31 characters long. 

<CITY>, <STATE -DEFAULT Ohio> 

If you leave the state field blank in a record, SprintMerge will insert the 
default value Ohio for that field. 

Fields, Multiline 

You can include a message or information across several lines in a single 
field by declaring a multiline field. The multiline declaration lets you 
accommodate addresses of varying lengths in a single template. 

Be sure to follow a multiline field with a visible field separator, that is, a 
separator other than a tab, space, or hard return. Also, use a separator that 
doesn't appear within the message or the address. The last field in the 
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template, however, should not be followed by anything but the template's 
closing delimiter, even if it is a multiline field. 

In the following example, note the double blank lines separating the first 
record from the second. This is due to the last field, an empty multiline 
field that isn't followed by a visible separator. 

@Template{<hon> <firstname> <lastname> 
<address -Multiline>; 
<message -Multiline>} 

@Data 
Ms. Michelle Novik 
125 Charles Street 
New York, New York 33333; 

Mr. Ronnie Davis 
Union of Concerned Philatelists 
117 Marlborough Street 
Sandwich, TX 56738; 
How's the fund-raising? When will you have enough to buy the collection 
for the museum? 

Ms. Melissa Clarke 
Boogie Till You Drop, Inc. 
Route 24 
Box 5 
Outthere, ID 88897; 
I sent in my SPP membership dues for 1988 two months ago and still haven't 
received my card. Would you look into this problem? 

Remember that the file ends on the blank line following the last record. 

Letter Files 

You create ''blanks'' in your form letter in this way: Choose Insert/Merge 
Field and enter the field name you want to reference, wherever you want 
information to be filled in from records corresponding to the fields in your 
template. When you choose Insert/Merge Field, the prompt Name of 
variable to reference: appears. Enter the field name, and it shows up in 
your text onscreen, highlighted. 

SprintMerge searches your letter file for Merge fields. (If you set 
Customize/Screen/Codes to On, you'll see the control characters AVand 
AN around each merge field.) When SprintMerge finds a merge field, it 
looks for the corresponding information in the current record. SprintMerge 
then places the information into the "blank" in your form letter, then moves 
to the next merge field. 
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You can use @Case and @String commands with fields defined by the 
template. 

If a record's field is empty and you have specified a default value in the 
template for that field, SprintMerge prints that default value. If the field is 
empty and you haven't specified a default value, SprintMerge ignores that 
Merge Field command and moves on to the next one. 

If you reference a field that doesn't exist in the template, SprintMerge 
makes no substitution and skips that merge field. 

Record Files 

The record file contains the template and records. It has at least two com­
mands: @Template and @Data. If you want to include additional records 
other than the ones in the record file you have open, use @Include. 

You can specify which record file you want to use through the menus or in 
the DOS command line. With the appropriate letter file open, choose Print/ 
Merge/Record File. Enter the file name of your record file and press Enter. 

You can put most SprintMerge commands either in the record file or in the 
DOS command line. You must, however, include the @Template and @Data 
commands in the record file; otherwise, SprintMerge won't work. 

SprintMerge recognizes multiple @Include and @Comment commands in 
your record file. However, SprintMerge recognizes only the first instance of 
other SprintMerge commands, including @Data. 

Records 

A record is a complete set of information, such as one person's name, 
address, and phone number. The record file contains many records. When 
you enter information in your record file, you must follow the format 
prescribed by the template. SprintMerge overlays the template over your 
record and substitutes the value of the field wherever the field name 
appears. For example, in the Firstname field, it will substitute whatever the 
record shows in that space-Katherine, David, Denise, and so on. 

You separate each record from the next by at least one blank line. Here's an 
example of a template and some records: 
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@Template{<Firstname> <Lastname>; <Anotherfield> 
<field -Multiline>/ 
<field -Num> 
<field -Alpha>; 
<field -Default Text>} 

@Data 
Thomas Jefferson; Delegate 
that among these are 
Life, Liberty, and the Pursuit 
of Happiness/ 
1776 
Declaration of Independence; 
Self-Evident 

Wolfgang Mozart; Composer 
The Magic Flute/ 
1791 

f-field is empty, separator remains 
f-this blank line represents an empty field 

If any record's field (except the last one specified in your template) could be 
empty, be sure to construct the template with a visible separator for that 
field. If you don't, your values may get placed into the wrong fields. For 
more information on using visible field separators, see page 297. 

Selection Specifications 

You can select certain records, such as those with California in the State field, 
from a record file or mailing list by using relational and logical operators. 
Choose Print/Merge/Criteria and you'll be prompted for the selection 
criteria. 

Note: When using -Select in the command line, omit all spaces between 
relational and logical operators and selection criteria. For example, 
state=CA is correct, but state = CA is not. 

Logical Operators 

* and 
or (logical or) 
not; as in "not equal to 0=)" 

SprintMerge evaluates relational operators before logical operators and 
treats relational operators equally. It evaluates logical operators from left to 
right. 
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You can use character strings in two different ways. If you put quotation 
marks around a word-for example, "string"-SprintMerge interprets that 
character string literally. It selects only those records in which the specified 
field equals the word string. If you use the word string without quotation 
marks-that is, string-SprintMerge first interprets that word as a field 
name, and then, if it can't find a field with that name, as a string within a 
word. 

Let's say you have this template and record: 

@Template{<Firstname> <Lastname> 
<address> 
<city> <state> <zip> 
<bill> 
<month> <year>} 

Bill Johnson 
800 Washington Street 
San Francisco CA 94117 
345.62 
May 88 

If you specify month=May*year=1988 when you choose Print/Merge/Criteria, 
SprintMerge will include this record when it selects. If you type 
month!=May*year=1988, the record won't be included, because you have told 
SprintMerge to select records that don't have May in the Month field. 

There are two things to note in the preceding example. First, there are no 
spaces in the selection criteria description. Second, there may be instances 
when the same word is both a field name and a record value. In these cases, 
you must enclose the value with quotations marks. For example, you have 
a Bill field in your template, which is where you assign the amounts 
customers are billed. The record's Firstname field value is Bill, so if you 
enter as your selection criteria all customers whose first names are Bill, type 
Firstname="Bill" . 

Relational Operators 

SprintMerge provides the following symbols so that you can compare 
records and select only those that relate to fields in a certain way. It doesn't 
use the usual relational symbols - <, >, I, and & - since DOS has 
reserved them for redirecting, piping, and future parallel processing. 
Instead, it uses similar-looking symbols. 

= --
} 
{ 
}= =} 
{= ={ 
!= {} }{ 

equal, same size 
greater than 
less than 
greater than or equal to 
less than or equal to 
not equal 

There are no spaces between selection criteria. 
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If you specify month=May*year=86-year=88 in your selection criteria, for 
example, SprintMerge will select records with May 86 or May 88 recorded 
with their addresses. 

The command -Select in the command line turns off any selection criteria 
within files. 

Sorting Specifications 

Sorting arranges your records in a specified order. You can give a sorting 
command in your record file by choosing Print/Merge/ Order. You can also 
give sort specifications in the command line, such as SPMERGE LETTER. SPR -R 
RECORD. REC -SORT SPECS. You can sort in alphabetical, numerical, or ASCII 
order, depending on the field's type declaration. 

Here are some sort specifications: 

-SORT NAME Sorts in ascending alphabetical order. SprintMerge 
assumes all undeclared fields to be alphabetical for 
sorting purposes. 

-SORT ! NAME Sorts in descending alphabetical order. 

-SORT ZIP Sorts in ascending numerical order. For this command to 
work, you should declare the Zip field numerical in your 
record file, for example, @Template{<zip -num>}. 

-SORT! ZIP Sorts in descending numeric order. For this command to 
work, you should declare the Zip field numerical in your 
record file, for example, @Template{<zip-num>}. 

-SORT SERIALNO Sorts in ascending ASCII order. For this command to 
work, you should declare the Serialno field as ASCII in 
your record file, for example, @Template{<serialno 
-ASCII>}. 

-SORT ! SERIALNO Sorts in descending ASCII order. For this command to 
work, you should declare the Serialno field as ASCII in 
your template file, for example, @Template{<serialno 
-ASCII>}. 

-SORT Turns sorting off. Any SORT commands found in the 
record file are ignored. 
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You can specify two fields for sorting. To do so, separate the field names in 
your command line with commas. Here are some examples: 

-SORT FIELDl, FIELD2 Sorts in ascending order on FIELDl, then on FIELD2. 
There are no blanks between the specifications in 
the command line. 

-SORT (!FIELDl, FIELD2) Sorts in descending order on FIELDl, then in 
ascending order on FIELD2. 

-SORT FIELD1, !FIELD2 Sorts in ascending order on FIELDl, then in 
descending order on FIELD2. 

-SORT ( ! FIELDl, ! FIELD2) Sorts in descending order first on FIELDl, then on 
FIELD2. 

Technical Specifications and Limitations 

Following is a quick look at SprintMerge's specifications. You may need to 
refer to it when you first set up your templates and records. 

TEMPLATE 

• Up to 15 characters in a field name. 
• Only alphanumerical characters in field names; no spaces, tabs, or hard 

returns. 

• Up to 31 characters in a field default value. 
• Default values cannot contain spaces, tabs, hard returns, line feeds, or 

form feeds. 

• Up to 16 fields in a template. 

• Delimiters do not nest. 

RECORDS 

512 characters maximum record length. 

COMMAND LINE 

128 characters maximum in a command line. (This is a DOS limitation.) 

DEFAULT FILE NAMES 

Letter File DEFAULT.SPR 
Record File DEFAULT.REC 
OutFile SPM.O$$ 
SortFile SPM.S$$ 
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CASE 

SprintMerge ignores uppercase and lowercase except in the records them-
selves. . 

Templates 

The template is the pattern you set up to categorize the information (fields) 
in your records. The template describes how the information is organized 
and specifies the names of these fields. The command Insert/Template for 
Data produces the command @Template, its delimiters, and @Data in a file. 
When setting up a template, try to anticipate all the possible fields you will 
need to keep separate. 

The fields within a template are set apart by field delimiters. They are 
segregated from each other with field separators, which can be printing or 
nonprinting. 

Here's a template, with field types and separators: 

@Template{<fieldl> <field2>;<field3> 
<field4 -multiline>/ 
<fieldS -num> 
<field6 -default Text>= 
<field7 -alpha>} 
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c H A p T E R 

16 

SprintMerge Troubleshooting and 
Error Messages 

This chapters deals with the errors you can make when merging docu­
ments and the messages SprintMerge displays. The first section, "A 
Troubleshooting Checklist," lists common mistakes people make when 
using SprintMerge and suggests solutions. "Error Messages," the second 
section, explains what each SprintMerge error message means and what 
you should do to correct it. Finally, "Other Messages" discusses all other 
SprintMerge messages that you might come across. 

See ''Technical Specifications and Limitations" on page 305 for a quick look 
at the limitations of the template and command line. 

A Troubleshooting Checklist 

Command Line 

• Are you overriding any similar commands that might be in your tem­
plate file? If so, do you want to override these commands? 

• Does your command line have more than 128 characters? If so, you must 
shorten it; put some commands into your template file instead. See 
"Running SprintMerge from the DOS Command Line" on page 290 for 
how to do this. 
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Letter File 

• Have you used the correct field names in your merge fields? 

Record Files 

• Have you used the correct record file names with your @Include com­
mand? 

• Do you have more than one of each formatter command in your template 
file? Except for @Include and @Comment, SprintMerge recognizes only 
the first instance of each command. 

• Have you . mismatched any delimiters? Are you missing any delimiters? 
• Have you tried to nest your delimiters in your template? You cannot nest 

delimiters in SprintMerge. 

• Have you ended all multiline fields with a visible field separator? If the 
last field in your template is a multiline field, have you made sure that 
only the template's closing delimiter follows it (that is, there is no field 
separator)? 

• Do you have more than 16 fields in your template? If so, you must delete 
or combine some fields. 

• Do you have a blank line inside your @Template command? If so, delete 
it. Use blank lines only to separate records and commands, not fields. 

• Do any of your field names contain a space? A tab? A formfeed or line­
feed command? A hard return? If so, change the field name, for example, 
from Last Name to Lastname. 

• Do any of your field names run over 15 characters? If so, shorten the field 
name. 

• Have you ended all potentially empty fields with visible separators? If 
such a field is the last field in the template, it doesn't need a field 
separator and should be followed only by the template's closing delim­
iter. 

• Have you ended all fields with default values with visible separators? If 
the field is the last field in the template, it shouldn't have a field 
separator and should be followed only by the template'S closing 
delimiter. 

• Is the last field in your template followed by a field separator? The last 
field in a template only needs to be followed by the template command's 
closing delimiter. 
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• Do you have an empty field that isn't the last field specified in the 
template and doesn't end with a visible separator? If so, add a visible 
separator to your record file. 

• Do you have an empty field that is the last field specified-in the template 
and the only field on the line? If so, make sure that you have entered one 
blank line for that empty field and another blank line as a record 
separator. 

Sorting and Selecting 

• Have you used the correct field names? 
• Did you enter spaces between the selection criteria? If so, delete them. 

Error Messages 

If Sprint finds many errors as it formats your merged document, you can 
do one of three things: 

• Temporarily suspend formatting to write down the offending record or 
line numbers. To suspend formatting, press etr/-S. When you want to 
continue, press any key. 

• Redirect the error messages to a file by choosing Print/Advanced 
Options/Log Errors to File. 

• Use the switch -L <filename> in the DOS command line to log errors to a 
file. 

The last two options create a file with the extension .LOG, containing any 
errors found in the document. After SprintMerge has processed the re­
cords, you can look at the error file and correct the errors at your leisure. 

You can also redirect the error messages to a file with the OOS command 
>ERRFILE. Use it with the -Out command: 

SPMERGE LETTER.SPR -R RECORD.REC -0 NUL >ERRFILE 

This routes your error messages to the file ERRFILE and discards rather 
than prints any SprintMerge output. 

The Error Messages 

@Template command was either missing or incorrect. 
SprintMerge halts if no template is specified. 
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'C' is not an opening delimiter. 
You didn't use a valid opening delimiter after a command. Also, verify that 
you have put a closing delimiter after the @Template command. 

Cannot create output file 'XXX'. 
SprintMerge can't create the intermediate file SPM.O$$ or, if you gave the 
-Out command, the outfile XXX. 

Cannot open input file lXXX' - skipped. 
SprintMerge can't open a record file you included with @Inc1ude. Check 
your record file names and directories to see whether the file is present and 
you have spelled the name correctly. 

Cannot open letter file lXXX' - program stopped. 
SprintMerge can't open your letter file. Check if you have used the correct 
file name, if the file already exists as a directory in your path, or if you have 
specified its location incorrectly (such as wrong disk drive). Also, check 
whether you have mistakenly put spaces in your selection expression. 

Cannot open output file 'XXX' for input - merge not done. 
Your disk is full or has an error. Check your disk for space; refer to your 
operating system reference manual for help with disk errors. 

Can't chain to 'XXX'; program not found. 
A chaining error, which normally shouldn't happen. If it does, check your 
disk to make sure that both the Sprint formatter and SprintMerge programs 
are on the same disk. If not, you can use the -Out option to copy the 
resulting output file onto the disk that contains the formatter, for later 
printing. 

Cannot open sort file 'XXX' for output - merge not done. 
SprintMerge can't open the temporary sortfile SPM.O$$. 

Cannot open record file 'XXX,' program stopped. 
SprintMerge can't find DEFAULT.REC or any other record file. Check 
whether you've created one. 

Cannot read letter file 'XXX'. 
Disk error. Refer to your operating system reference manual for help with 
disk errors. 

Cannot rename output file to be IXXX'-output left in 'YYY.' 
Sorting occurred and the output file couldn't be renamed (because of a bad 
file, full disk, or some such reason), so SprintMerge left the sortfile where it 
was. 

Cannot reopen sort and output files for copy-output left in 'YYY.' 
Sorting occurred and the sort and output files couldn't be reopened for 
copying. SprintMerge left the output file where it was. 
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Cannot write to output file. Disk full? 
Check your disk space. 

Cannot write to sort file. Disk full? 
Check your disk space. 

Error in selection criteria for 'X'. 
Check your selection statement in the command line or, if you are not using 
-Select, the @Select or Print/Merge/ Criteria command in your record file. 

Error in selection criteria, missing X in 'XXX'. 
Check your selection statement in the command line or, if you aren't using 
-Select, the @Select or Print/Merge/Criteria command in your record file. 
SprintMerge suggests what might be missing from your command. 

Missing argument to 'X' option. 
You haven't told SprintMerge the field names or variables to use after a 
command in the command line. 

Missing logical operator in selection criteria 'X'. 
Check your selection command in the command line or record file. 

Missing relational operator in selection criteria 'X'. 
Check your selection command in the command line or record file. 

More than one @Template command was encountered. 
The second @Template command is ignored. 

Not enough memory - requires 128K system, program stopped. 
SprintMerge requires at least 128K of memory. 

Output file has too many records - too big to merge. 
You are using too many records. Break up your record file into several 
parts, then run SprintMerge several times. 

Output file write error - disk full? 
Check your disk space. 

Record file name 'XXX' doesn't fit - ignored. 
Are you using too many @Include files in your record file? You can use up 
to 1024 characters in the included file names (Include<A> Include<B>, for 
example, uses only 2 characters out of the possible 1024). 

Selection expression 'X' is too complicated - selection not done. 
You specified more than 20 selection operations. Break up your selection 
expression into parts; that is, run SprintMerge twice with simpler selection 
expressions. Try an initial selection using the -Out command and no letter 
file, then a second run using the letter file and the file that you specified 
with the -Out command. 
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Unknown command IX' in record file - ignored. 
You have an illegal or unknown command in the record file that 
SprintMerge is ignoring. 

Unknown field name in sort expression IX'. 
Check the field names in your record file to verify that you entered the 
correct one. 

Unknown option IX' - ignored. 
You used an illegal or unknown Field or option after a command in the 
command line. 

Write error on output file. 
Disk error. Refer to your operating system reference manual for help with 
disk errors. 

Write error on sort file. 
Disk error. Refer to your operating system reference manual for help with 
disk errors. 

Other SprintMerge Messages 

Beginning merge, # chunks. 
For your information. This is an indicator to let you know that sorting is in 
progress. 

Missing data before line # of input file IX' - record not merged. 
For your information. The record preceding line # of your record file X is 
incomplete; in order to continue without misinterpreting the remaining 
records, SprintMerge has discarded that record. You might see this message 
if a field in your record mistakenly contains its field separator, for example, 
<ADDRESS>/ and c/o Joe Smith. 

Sorting by {reverse} xxxx, then by {reverse} xxxx. 
For your information. 

# records output. 
For your information. This is the number of records SprintMerge selected 
using your selection criteria. 

# records processed. 
For your information. This message appears immediately after you have 
typed in the command line, indicating the total number of complete records 
in all your record files. 
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A 

A DOS Primer 

If you are new to computers or to DOS, you may have trouble under­
standing certain terms used in this manual. This appendix provides you 
with a brief overview of the following DOS concepts and functions: 

• what DOS is and does 
• the proper way to load a program 
• directories, subdirectories, and the path command 

• using AUTOEXEC.BAT files 

This information is by no means a complete explanation of the DOS operat­
ing system. If you need more details, please refer to the MS-DOS or PC­
DOS user's manual that came with your computer system. 

Sprint runs under the MS-DOS or PC-DOS operating system, version 2.0 or 
later. 

Note: You can use any DOS commands while in Sprint by choosing DOS 
Command from the Utilities menu, and then entering the command. 

Note to two-floppy system users: To use Utilities/DOS Command, you 
must have you Program A Disk in Drive A. 

What Is DOS? 

DOS is shorthand for Disk Operating System. MS-DOS is Microsoft's 
version of DOS, while PC-DOS is IBM's rendition. DOS is the traffic 
coordinator, manager, and operator for the transactions that occur between 
the parts of the computer system and the computer system and you. DOS 
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operates in the background, taking care of may of the menial computer 
tasks you wouldn't want to have to think about-for instance, the flow of 
characters between your keyboard and the computer, between the 
computer and your printer, and between your disk(s) and internal memory 
(RAM). 

Other transactions are ones that you initiate by entering commands on the 
DOS command line; in other words, immediately after the DOS prompt. 
Your DOS prompt looks like one of the following: 

A> 
B> 
c> 

The capital letter refers to the active disk drive (the one DOS and you are 
using right now). For instance, if the prompt is A>, it means you are 
working with the files on Drive A, and that commands you give DOS will 
refer to this drive. When you want to switch to another disk, making it the 
active disk, all you do is type the letter of the disk, followed by a colon and 
Enter. For instance, to switch to Drive B, just type B: Enter. 

There are a few commands that you will use often with DOS, if you haven't 
already, such as 

DEL or ERASE 

DIR 

COPY 

SP 

to erase a file 

to see a list of files on the logged disk 

to copy files from one disk to another 

to load Sprint 

DOS doesn't care whether you type in uppercase or lowercase letters, or a 
combination of both, so you can enter your commands however you like. 

We'll assume you know how to use the first three commands listed; if you 
don't, refer to your DOS manual. Next, we will explain the proper way to 
load a program like Sprint, and that involves the last command-SP. 

How to Load a Program 

On your distribution disk, you'll find the main Sprint program, under the 
file name SP.EXE. This program file is necessary for all functions, so you 
always need it when you first start the program. A file name with the 11ast 
name" or extension .COM or .EXE means a program file that you can load 
and run (use) by typing only its Ufirst name" on the DOS command line. So, 
to invoke Sprint, you simply type SP and press Enter, and Sprint will be 
loaded into your computer's memory. 
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There's one thing you need to remember about loading Sprint and other 
similar programs: You must be currently accessing the disk and directory where 
the program is located in order to load it; unless you have set up a DOS path 
(described shortly), DOS won't know where to find the program. 

For instance, if the disk with the SP.EXE program is in Drive A but the 
prompt you see on your screen is B>, DOS won't know what you're talking 
about if you type SP and press Enter, and will give you the message Bad com­
mand or file name. 

It's as if you were shuffling through the "School Records" file in your file 
cabinet looking for information about your home finances. You're in the 
wrong place. So if you happen to get that DOS message, simply switch to 
Drive A by typing A: and then press Enter. Then type SP and press Enter to 
load Sprint. 

You can set up a "path" to the Sprint files so that DOS can find them, by 
using the DOS PATH command. See the section on the AUTOEXEC.BAT 
file for more information. 

Directories 

A directory is a convenient way to organize your floppy or hard disk files. 
Directories allow you to subdivide your disk into sections, much the way 
you might put groups of manila file folders into separate file boxes. For 
instance, you might want to put all your file folders having to do with 
finance-a bank statement file, an income tax file, or the like-into a box 
labeled "Finances." 

On your computer, it would be convenient to make a directory to hold all 
your Sprint files, another for your SideKick files, another for your letters, 
and so on. That way, when you type DIR on the DOS command line, you 
don't have to wade through hundreds of file names looking for the file you 
want. You'll get a listing of only the files on the directory you're currently 
logged onto. 

Although you can make directories on either floppy or hard disks, they are 
used most often on hard disks. This is because hard disks can hold a greater 
volume of data, so there is a greater need for organization and compart­
mentalization. 

When you're at the DOS level, you can tell DOS to create directories, move 
files around between directories, and display which files are in a particular 
directory. 
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In the examples that follow, we assume you are using a hard disk system, 
and that you are logged on to the hard disk so that the prompt you see on 
your screen is C>. If you want to create directories on your floppy disks, just 
substitute A or B for C in the example. 

To make a directory for your Sprint files, do the following: 

1. At the C> prompt, type MD SPRINT and press Enter. The MD command tells 
DOS to make a directory called SPRINT. 

2. Type CD SPRINT and press Enter. The CD command tells DOS to move 
you into the Sprint directory. 

3. Now, put the Sprint disk you want to copy from into one of your floppy 
drives-let's say A for this example-and type COpy A: * . * Enter. (The 
asterisks are wildcards that stand for all files.) The COpy command tells 
DOS to copy all files on Drive A to the SPRINT directory on drive C. As 
each file on the disk is copied, you will see it listed on the screen. 

That's all there is to it. Treat a directory the same way you would a disk 
drive: To load Sprint, you must be in the SPRINT directory before typing SP 
and pressing Enter, or DOS won't be able to find the program. 

Subdirectories 

If you are someone who really likes organization, you can further subdi­
vide your directories into subdirectories. You can create as many directories 
and subdirectories as you like-just don't forget where you put your files! 

A subdirectory is created the same way as a directory. To create a sub­
directory from the SPRINT directory (for instance, for storing your letters 
and memos), do the following: 

1. Be sure you are in the SPRINT directory. 

2. Type MD LETTERS and press Enter. 
3. Type CD LETTERS and press Enter. You are now in the LETTERS 

subdirectory. 

4, Copy the letter files you want to the new subdirectory. 

Where Am I? The $p $g Prompt 

You have probably noticed that when you change directories, you still see 
the C> prompt; there is no evidence of what directory or subdirectory you 
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are in. This can be confusing, especially if you leave your computer for a 
while. It's easy to forget where you were when you left. 

DOS gives you an easy way to find out. Just type 

prompt=$p $g 

and from now on (until you tum your computer off or reboot), the prompt 
will show you exactly where you are. Try it. If you are still in the LETTERS 
subdirectory, your DOS prompt should look like 

C:\SPRINT\LETTERS > 

The AUTOEXEC.BAT File 

To avoid typing the prompt command (discussed in the previous section) 
to see "where you are" every time you tum on your computer, you can set 
up an AUTOEXEC.BAT file to do it for you each time you turn on your 
computer. 

The AUTOEXEC.BAT file is a useful tool to get your computer to do things 
automatically. There are many more things it can do, but rather than go 
into great detail here, we suggest referring to your DOS manual for more 
information. We, will show you how to create an AUTOEXEC.BAT file that 
will automatically change your prompt so you know where you are in your 
directory structure, set a path to the SPRINT directory, and then load Sprint. 

The DOS PATH command tells your computer where to look for com­
mands it doesn't recognize. DOS only recognizes programs in the current 
(logged) directory, unless there is a path to the directory containing perti­
nent programs or files. 

In the following example, we will set a path to the SPRINT directory. 

If you have an AUTOEXEC.BAT file in your root directory, your computer 
will do everything in that file when you first tum your computer on. (The 
root directory is where you see the C> or C: \ prompt, with no directory 
names following it.) 

Here's how to create an AUTOEXEC.BAT file. 

1. Type CD \ and press Enter to get to the root directory. 
2. Type COPY CON AUTOEXEC. BAT and press Enter. This tells DOS to copy 

whatever you type next into a file called AUTOEXEC.BAT. 
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3. Type 
PROMPT=$P $G Enter 
PATH=C:\SPRINT 
CHOIR SPRINT 
etrl-ZEnter 

4. The etrl-Z sequence saves your commands in the AUTOEXEC.BAT file. 
(You can use Sprint to create your AUTOEXEC.BAT file too, but make 
sure you save it as an ASCII file.) 

5. To test your new AUTOEXEC.BAT file, reboot your computer by 
holding down the etrl and Alt keys and then pressing Del. You should see 
C: \SPRINT). 

Changing Directories 

How do you get from one directory to another? It depends on where you 
want to go. The basic DOS command for changing directories is CD. Use it 
like this: 

• To move from one directory to another: For example, to change from the 
SPRINT directory to one called DOCUMENTS, enter the following from 
the SPRINT directory: 

C:\SPRINT> CO\OOCUMENTS 

Notice the backslash (\) before the directory name. Whenever you are 
moving from one directory to another unrelated directory, enter the 
name of the directory, preceded by a backslash. 

• To move from a directory to its subdirectory: For example, to move from the 
SPRINT directory to the LETTERS subdirectory, enter the following from 
the SPRINT directory: 

C:\SPRINT> CD LETTERS 

In this case, you did not need the backslash, because the LETTERS 
directory is a direct offshoot of the SPRINT directory. In fact, DOS would 
have misunderstood what you meant if you had used the backslash in 
this case. If you had included the backslash, DOS would have thought 
that LETTERS was a directory off the main (root) directory. 

• To move from a subdirectory to its parent directory: For example, to move 
from the LETTERS subdirectory to the SPRINT directory, enter the 
following from the LETTERS subdirectory: 

c: \SPRINT\LETTERS> CD .. 
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DOS will move you back to the SPRINT directory. Any time you want to 
move back to the parent directory, use a space followed by two periods 
after the CD command . 

• To move to the root directory: The root directory is the original directory. It is 
the parent (or grandparent) of all directories (and subdirectories).'When 
you are in the root directory, you see this prompt: c: \ >. 
To move to the root directory from any other directory, simply type 

CD \ 

and press Enter. The backslash without a directory name signals DOS that 
you want to return to the root directory. 

This appendix has presented only a quick look at DOS and some of its 
functions. Once you're familiar with the information given here, you may 
want to study your DOS manual and discover the many things you can do 
with your computer's operating system. There are many other DOS 
functions not mentioned here that can simplify and enhance your computer 
use. 
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Using Sprint on a Local Area 
NetworR 

x 
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This chapter tells system administrators how to configure Sprint most 
effectively for a multi-user environment. We discuss the pros and cons of 
sharing the editor and formatter, and pitfalls to watch out for in a net­
worked environment. 

Remember that Borland requires that each user have a legal copy of 
Sprint-even when sharing it on a network. If you expect up to three 
people to be using Sprint at the same time, you must buy three copies of 
Sprint. Refer to our no-nonsense license statement on page 6 for details. 

Sharing Sprint Files 

As with most programs that are to be shared on a network, you have more 
than one option in deciding how and which Sprint files are shared. The 
particular configuration of your network-that is, which resources are 
shared and whether the personal computers in the net are identical-will 
determine which Sprint files are public and which private. In general, the 
two main programs-SP.EXE and SPFMT.EXE-along with dictionaries 
and engines (.LEX and .ENG files) and .FMT files, can be shared, while 
screen and printer drivers and the backup file (SP.SWP) cannot. 

Here are some more specific guidelines: 

• Store all shared Sprint files in one disk or directory on the network 
server. Don't put multiple copies of shared files on users' local direc­
tories; put only files that will not be shared on local computers . 

• Store all non-shared Sprint files in one disk/ directory on each user's PC. 
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• Set a path in each user's AUTOEXEC.BAT file first to the local disk/ 
directory containing Sprint files, then to the public disk/ directory. This 
will ensure that Sprint will use the local files that should not be shared 
before looking to the public directory. 

• Also in each user's AUTOEXEC.BAT file, add this line: 
SET HOME=C:\SPRINT 

This ensures that the Sprint backup file and all its other specially created 
files are stored locally on each user's drive C. The backup file cannot be 
shared. This example assumes that each user has a hard disk, and that 
Sprint files are stored in a directory called SPRINT. For users with 
floppy-based systems, replace the C: part of the instruction with A:. 

Which Files to Share? 

The complete list of files on the Sprint disks can be found in Chapter 1, 
"Before You Begin." All of these files can be shared with the following 
exceptions and restrictions: 

• All users should have their own copy of the .OVL file-the overlay file 
for the Sprint user interface they are using-and there should be no copy 
on the public volume. This allows users to create their own macros and 
change editor settings and colors. Sprint saves this file to the "home" 
directory automatically if you have defined such a directory in your 
AUTOEXEC.BAT file. 

• Unless all users have identical computers, the SP.SPS file-the screen 
driver file-should not be shared. For example, if some users have color 
monitors and some monochrome, sharing the .sPS file will cause definite 
screen display problems. Sprint saves this file to the "home" directory 
automatically if you have defined such a directory in your 
AUTOEXEC.BAT file . 

• There should be a shared copy of DEFAULT.SPP (the printer driver 
created by the SP-SETUP program) for any network printer. If users also 
have local printers, they can still put the alternate printer drivers on the 
network. Users simply choose Current Printer from the Print menu to 
select the printer they need . 

• You may want to allow read-only rights to a shared copy of 
STANDARD.FMT, unless you want to allow users to modify 
STANDARD.FMT and add new formatter commands. 

• The backup file (SP.SWP) cannot be shared. As long as you follow the 
procedure mentioned above for creating a private home directory for 
each user, there should be no conflicts with the backup file. 
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Double Editing 

When two users can open and edit the same document, confusion is 
usually never far off. Happily, Sprint is smart enough to detect when this 
potentially perplexing condition is at play. A typical s~enario: 

Bruce opens a file and begins editing. Albert then opens the same file and 
begins his editing. Albert, who is a quicker worker, finishes, and saves his 
version of the file. When Bruce goes to save his version, Sprint notices that 
the file has been changed since Bruce opened it. Sprint politely tells Bruce 
he should save the file under another name to avoid ruining Albert's day. 

Troubleshooting 

If you've followed the guidelines we just outlined, you should have few 
problems with using Sprint on a network. Since there are some problems 
that can crop up when files are incorrectly shared, we'll mention these 
problems here and tell you how to solve them. 

Problem: A user types SP and Sprint appears to "hang"; sometimes the 
cursor may be able to be moved about the screen as if in a Sprint file. 

Solution: This means there is an .SPS screen-driver file in the shared 
volume or on the user's path that is not compatible with the user's 
computer. Delete the .SPS file from the shared volume. 

Problem: A user types SP and receives an error message stating that there is 
a file-sharing conflict. 

Solution: This usually means that there is another user working with Sprint 
in the shared volume, and there is a backup file (SP.SWP) in the volume. 
Follow the procedure on page 323 to force Sprint to create a separate 
backup file on each user's local volume . 

. Problem: When a user tries to format a file for a network printer, the for­
matter doesn't recognize certain commands in STANDARD.FMT. 

Solution: This probably means that Sprint is using a local copy of 
STANDARD.FMT and/or the .SPP printer driver file when it should be 
using a shared copy. The user should either call the formatter from the 
shared volume that contains a copy of STANDARD.FMT and/or the .SPP 
file, or the user's path should be set to public first, then local. 
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Converting Files to and from Sprint 

When you choose File/Translate and then Export or Import, you are 
presented with a number of file formats of other word processors that you 
can convert from or to Sprint. 

Note to two-floppy system users: Sprint may have to prompt you to insert 
the Convert Disk into Drive A before you can translate files. When you 
installed conversion utilities in SP-SETUP, you labeled the disks that con­
tained the conversion files (one per disk). Sprint will prompt you to insert 
the disk with the appropriate conversion file when you pick File/ 
Translate/Import or Export. 

Choosing the Import command lets you convert files in the following for­
mats into Sprint: 

ASCII file 
DisplayWrite 4 (DCA RFT) 
MSWord 
MultiMate 
MultiMate Advantage 
WordPerfect 4.2 
WordStar 
SideKick Plus (Outlook files only) 

Choosing the Export command from the Translate menu lets you save your 
Sprint file in any of the same formats, except SideKick Plus (Outlook). 
Sprint prompts you for the original file name (the file to be imported or 
exported) and then the new file name (the file after it is imported or 
exported). 
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Choosing SideKick Plus from the Import menu displays this prompt on the 
status line: 

Press (T) for tab indent, (0) for outline, or ESC to cancel: 

If you press 0, your Outlook outline will converted into a Sprint document 
formatted as an Outline list (that is, the Style/Lists/Outline command). If 
you press T, your Outlook outline will be converted into a Sprint 
documented that uses tabs to indent your topics and subtopics. 

For most documents, the translation process is seamless and accurate, and 
you don't have to think about how it works. On the other hand, not every 
aspect of a Sprint document can be accurately translated to, say, a WordStar 
document, ~nd not all WordStar formats can be correctly carried over into a 
Sprint file. 

The rest of this appendix documents the major differences and dangers 
when translating to and from Sprint. In general, when Sprint is translating 
a file and finds a command it can't convert, it tries to strip out the control 
codes or delimiters but preserves the command name and the rest of the 
command as regular text. In a few cases, the conversion process will re­
move the entire command if it can't translate it. 

Importing to Sprint 

When importing a file created with another word processor into Sprint, 
there are two aspects of the conversion that are important: the formats that 
import correctly, and the main formats that cannot be imported correctly. 

Formats That Import Correctly 

Typestyles 

Bold is converted correctly. 

Italic is converted correctly. 

Subscript and superscript are converted correctly. 

Underlining is converted correctly as long as a single line is used. If the 
original file used a double underline rather than a single line, Sprint 
substitutes a single line but warns you of the substitution in a log file. 
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Strikethrough is converted correctly as long as a solid line is used. If the 
original file used something other than a solid line, Sprint substitutes a 
solid line but warns you of the substitution in a log file. 

Nonprinting text (print off ... print on) is converted to BEGIN 
COMMENT ... END COMMENT. 

Changes from the default font are converted correctly by either defining a 
font in a ruler line or by defining a region of text in a Text format modified 
by the Font parameter. 

Line and Paragraph Formats 

Columns are converted to regions of text governed by the COLUMNSn 
command where n is the number of columns. If the original document used 
more than six columns, the Sprint conversion uses six and warns you of the 
substitution in a log file. Column text in Sprint has a uniform width, 
regardless of the original's. 

Hanging margins (hanging indents) are converted by adjusting Sprint's left 
margin on the ruler line. The first-line indent on the ruler line retains the 
original left margin setting. 

Leading is converted correctly by creating a ruler line with the Spacing 
parameter set accordingly. 

Justification (left-justified, right-justified, centered, or full-justified) is con­
verted correctly. 

Tab stops are converted correctly as T's on the ruler line as long as the 
original file does not use any more than eight at a time. If all the tab stops 
have the same interval (for example, 4, 8, 12, 16, and so on), only the first 
one is put on the ruler. 

Individual tab characters are converted correctly as 1\1 characters. 

Layout Formats 

Center-page formats are converted to Sprint's CENTERP AGE .5 PAGE 
command. 

Conditional end-of-page is converted to Sprint's BEGIN GROUP ... END 
GROUP command. 

A hard new page is converted to a mandatory form feed and new line (that 
is, a 1\ Land 1\ J). Note that the con version will insert a hard return 
immediately before the form feed if it isn't already there. 
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A soft page break is converted to a Sprint formatter page break (a page 
break that the formatter inserts). Note that the conversion will insert a hard 
return immediately before the form feed if it isn't already there. 

Header and footer text is converted to the appropriate header or footer 
command (for example, HEADER, HEADERG, FOOTERE, and so on). 

Footnotes and endnotes are converted to the correct Sprint command 
(FNOTE or ENOTE). Notes other than these will create warning messages 
in the conversion log file that is automatically created. Also, the format of 
the note or any command that sets the footnote number will be ignored in 
the conversion. 

Page number is converted to the Page variable in Sprint. 

Set-page-number commands are converted to SET Page=n commands. The 
next page is numbered n. 

Character Conversions 

The @-sign (@) is converted to two @-signs (@@) to prevent the formatter 
from misconstruing a single @-sign as a command prefix. 

A non-breaking space character is correctly converted to Sprint's hard space 
character. 

Hard returns and soft returns are converted correctly. 

Discretionary hyphens (soft hyphens) are converted correctly. 

Formats That Are Not Imported 

Typestyles 

Reverse image is not converted in Sprint. 

Line and Paragraph Formats 

"Hot zones" (predetermined areas of text that define where hyphenation 
should occur) are not- converted in Sprint. 
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Layout Formats 

The format of a header or footer (for example, its position and justification) 
is not converted in Sprint. 

Merged files (as used in mail merge commands) are not converted in 
Sprint. 

Variables 

The format for automatic numbering is not converted in Sprint. 

Inserting dates is not converted in Sprint. 

Inserting the time is not converted in Sprint. 

Inserting line numbers is not converted in Sprint. 

Page number formatting is not converted in Sprint. 

Setting automatic numbering (like line numbering) is not converted in 
Sprint. 

Layout Formats 

Any type of note besides footnotes or endnotes are not converted in Sprint. 

The format for notes is not converted in Sprint. 

Setting the footnote number is not converted in Sprint. 

A non-breaking hyphen is not converted in Sprint. 

Exporting from Sprint 

When exporting a file created in Sprint to another word processor, there are 
two aspects of the conversion that are important: the Sprint formats that 
export correctly, and those that don't. 
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The Sprint Fonnats That Export Correctly 

Typestyles 

Bold is converted correctly to the appropriate command. 

Italic is converted correctly. 

Subscript and superscript are converted correctly. 

Underlining is converted correctly. 

Strikethrough mode is converted correctly. 

Both types of Sprint comments are converted correctly to the appropriate 
print-on/print-off commands. One-line comments that begin with a 
semicolon (;) must begin a new line or be preceded by whitespace. 

Line and Paragraph Formats 

Two kinds of columns are correctly handled in the conversion: Columns 
generated by a Text format with the Columns parameter set to the correct 
number, and columns created with the menu command, which inserts a 
COLUMNSn command. Pressing Enter, inserting the A J control character, or 
using the @* command all convert to a hard return. 

A non-breaking space in a Sprint document exports correctly. 

Spacing in a ruler line is converted to leading in other documents. Spacing 
can be in mm, cm, inches, picas, or characters. 

Justification settings in rulers (}, L, R) are correctly converted as appro-
¢~ . 
A special hyphen is converted to a discretionary hyphen. When the special 
hyphen falls at the end of a line, it is converted to a printing hyphen. 

A flush right format (either to the margin or to a tab or decimal tab) is 
converted correctly. 

Centering text with wide spaces, with the CENTER command (off the 
menu) or with @= all convert correctly. 

Paragraph (first line) indentation or the I on a ruler line is converted 
correctly. 
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Lists 

Numbered formats convert to paragraphs with numbers preceding each. 

Hyphens formats convert to paragraphs with hyphens preceding each. 

Quotation formats convert to paragraphs indented five characters from left 
and right margins. 

Asterisks formats convert to paragraphs with asterisks (*) preceding each. 

Bullets formats convert to paragraphs with lowercase o's preceding each. 

Layout Formats 

T in a ruler line is converted to an undifferentiated tab stop. 

Tab (a 1\ I) is converted to a tab character. 

RESERVE commands will convert to the closest number of hard returns. 

An unconditional page break will convert to a hard page break. 

CENTERP AGE command converts correctly. 

GROUP commands convert to conditional page breaks. 

The Page variable converts to the appropriate page number. 

The SET P AGE=n command converts to the appropriate set page number 
command. 

All header and footer commands convert appropriately. 

Sprint Syntax 

There are three different ways a formatter command can be entered in a 
Sprint document. For every formatter command that converts correctly, all 
three forms are supported. 
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The three ways are 

@-sign version OCenter[Memo to All Employees] 

@Begin version @Begin[center] 
Memo to All employees 
@End[center] 

Menu version BEGIN CENTER 
Memo to All Employees 
END CENTER 

There are seven pairs of legal delimiters used to enter @-sign version of 
command in Sprint. All seven are correctly recognized in the conversion. 

Sprint Formats That Do Not Export Correctly 

Using the Char command with values from 0 through 31 will result in a 
space being substituted for the command. 

Only one level of lists convert correctly; nested lists may not have the 
correct bullet or number format as they have in Sprint. 

Only editor (ruler) tabs are converted. Formatter (precise) tabs are not 
converted. In other words, the TABSET command and @/ are ignored in 
the conversion process. 
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Help! 

Answers to Common Questions about Sprint 

General Questions 

Q. How much RAM do I need to run Sprint? 

A. You need at least 256K. 

Q. Why doesn't my screen look like what prints on my printer? 

A. Sprint supports many advanced formats that cannot be accurately dis­
played on a normal computer monitor. For this reason, many commands 
take effect only when you print. On the screen, these commands appear as 
highlighted text, indicating that their "magic" will only be realized when 
you print. In general, these commands are called formatter commands 
because they take effect only when your document is being formatted by 
Sprint just prior to printing. 

Q. What do I do if I get a Disk Full error? 

A. You'll need to delete some unnecessary files to free up space on your 
disk. You can do one of two things: 

1. Choose File Manager/List Directory and make note of any files you can 
delete, then choose Erase to delete those files. 

2. Choose File/Write As and write the file to another disk. 
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Backup File Confusion 

Q. How come when I close a file, another file appears in its place? 

A. You must have opened several files. When you open a second file in 
Sprint without first closing the current file, Sprint keeps both of them open 
(although only one file is visible at a time unless you have opened a 
separate window for it using the Window menu commands). Sprint allows 
you to have up to 24 files open at once. 

Q. I've made changes to a file and quit Sprint, but when I open Sprint 
again, the old version of the file is there, not my changed one. 

A. You're probably working on two different computers. When you have 
Preserve Editing Session set to Yes, Sprint saves all open files to the backup 
file and automatically brings up this backup file when you open Sprint. But 
if you have made changes to this file using another computer and then 
copied the changed file to the first computer, the backup file will not be 
current even though the file on disk is. 

In such cases, the easiest solution is to close the file in the backup file and 
then open the file again. This discards the outdated version in the backup 
file and retrieves the correct version from disk. 

The moral is: When editing the same files on several computers, set the 
Preserve Editing Session command to No or close the file when you're 
finished. 

User Interfaces 

Q. How come the menus you talk about in the Sprint manuals look differ­
ent on my screen? 

A. You must be using an alternative user interface (UI). The manuals 
assume you are using the default Sprint user interface and not an 
alternative one. For the purposes of learning what Sprint has to offer, you 
should switch to basic or advanced (see the next question for how to do 
this). For information on the user interface that you're using, refer to the 
separate booklet on alternative user interfaces. 

If, on the other hand, you seem to have a Sprint user interface, but some of 
the commands are missing from your menus, you probably forgot to switch 
from tutorial to basic or advanced. The tutorial user interface includes only 
the most fundamental commands and should not be used except as an 
introduction to "'\7ord processing and to Sprint. If you want to see all the 
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menu commands mentioned in the Sprint manuals, you must be running 
the advanced user interface. 

Q. Out of curiosity, I loaded an alternative user interface, but now I want to 
return to the basic Sprint user interface. How do I do this? 

A. You can call up the list of alternative user interfaces from any user 
interface by pressing Shift-Aft-U. Choose the one you want to load and press 
Enter. 

Note to two-floppy system users: If you have low-density (360K) drives, 
you cannot use Customize/User Interface/Load to load an alternative user 
interface or Customize/User Interface/Reset Shortcuts to recover an 
unaltered user interface after changing keyboard shortcuts unless you first 
insert the disk containing the appropriate user interface in Drive A. If you 
don't have a separate user interface disk, you must run the SP-SETUP 
program to reinstall the user interface you want as a default. If you have 
high-density (720K or more) drives, however, and the user interface you 
want to load or return to is listed when you choose Customize/User 
Interface/Load or Reset Shortcuts, then you can use those commands. 

Control Codes 

Q. Sometimes I use the arrow key but the cursor doesn't move. Pressing it 
again gets it going. 

A. Your cursor is actually "moving" over hidden control codes. Sprint 
inserts control codes to begin and end various commands (like the com­
mands in the Typestyle and Style menus). Ordinarily, there is no reason 
why you need to see these codes, so Sprint keeps them hidden. Even so, 
Sprint knows they exist and accounts for them when counting characters. 
You can see what column number your cursor is on-even if it's invis­
ible-by looking at the column indicator in the lower-right corner. The 
column indicator also changes style as you move past a typestyle control 
code. 

You can always opt to show the control codes in your documents by 
choosing Customize/Screen/Codes and setting the command to On. 

Q. Sometimes when I type next to a word that's in bold, the text I type is in 
bold too. But other times, it's not. What's up? 

A. If your cursor is placed to the left of the hidden control code that turns 
off the bold typestyle (it's a "N), text you insert there will also be in bold. 
But if your cursor is to the right of the "N character, new text will not be 
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bold. The confusion sometimes arises because ordinarily the codes are in­
visible (see the previous question for more information). 

You can choose to show the screen control codes to reduce confusion. 

Shortcuts 

Q. I assigned a shortcut to a key, but now it's gone. What happened? 

A. Sprint stores the shortcuts you assign to keystrokes in the SP .OVL file. If 
for any reason you deleted this file, your macros get zapped along with it. 
Also, if you reinstall Sprint, you'll lose your shortcuts. 

Another possibility is that you had a power outage before Sprint could save 
your shortcut to the SP.OVL file (Sprint saves the shortcuts you assign only 
when you quit Sprint). 

You will also lose your shortcuts if you choose Customize/User Interface/ 
Reset Shortcuts. 

Q. How can I quickly get to a command that's buried in several levels of 
menus? 

A. You can create your own shortcuts. Display the chain of menus that 
leads to the command you want. Use the arrow keys to choose (highlight) 
the desired command. Now press etrl-Enter. Sprint displays this prompt in 
the status line: 

Shortcut for menu item: 

Now press the desired key. For example, if you want to be able to change 
text to bold by pressing a key instead of choosing Typestyle/Bold, you 
could assign a keystroke to the menu command (like Shift-AIt-B). Then 
whenever you selected a block of text and pressed Shift-Alt-B, Sprint would 
immediately change the style of the text to bold. 

Q. What should I do if I can't remember the shortcuts I've assigned to 
menu commands? 

A. Choose QuickCard from the Utilities menu. Sprint creates a file 
containing all the defined shortcuts, including those you've defined 
yourself. You can then print out this file for reference. 
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Printing 

Q. How do I queue a number of files to print? 

A. Create a batch file (QUEUE.BAT), which contains the following: 

for %%f in (%1 %2 %3 %4) do spfmt %%f <print options> 

This batch file allows you to queue up to four files at once. To increase the 
number of files, simply add %5, %6, %7, and so on to the batch file. 

To execute the batch file, type the following at the DOS prompt: 

QUEUE <file1> <file2> <file 3> <file4> 

Q. I set up a table on the screen, but when it prints, the columns are not 
lined up. 

A. You probably used spaces to create your columns instead of tabs. Unless 
you are printing in a fixed-width typeface, the fixed-width screen 
characters will not accurately show the correct widths of your printed doc­
ument. When setting up tables to print in proportionally spaced fonts, 
always press the Tab key to move from one column to the next. This will 
keep your columns aligned regardless of the font your printer is using. 

Even if you are printing your document in a proportionally spaced font, 
you might still want to print your tables in a fixed-width font (assuming 
your printer can output both types of typefaces). To do this, you can select 
the text of your table as a block, and then choose Typestyle/Font. Sprint 
displays a menu of the fonts your printer can use. Choose a fixed-width one 
from that list (it might be called Courier, Elite, Pica, or something else). 

Q. My printer manual says I have all sorts of special symbols in its char­
acter sets. How do I print them from Sprint? 

A. You need to use the Char command. This command sends a decimal 
ASCII code to your printer, which in turn prints the character represented 
by that decimal code in your printer's font. In order to use the Char com­
mand, you need to know the decimal code for the character you want to 
print (only your printer manual can tell you that). When you know the 
code (it will be between 32 and 255), type the number, select it as a block, 
choose Style/Other Format, type Char, and then press R for Region at the 
prompt. When this document prints, the special character prints where you 
inserted the Char command. 

A more "techie" way to embed the decimal code into your Sprint document 
is to press Shift-Alt while you type the decimal number (32 or greater) from 
the numeric keypad. When you release the keys, the character will be 
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embedded at the cursor position. If your computer has a character defined 
for that number, it will appear (but that character will probably not 
correspond to the look of the character in the printer's character set). 

Rulers 

Q. How can I change the default ruler? 

A. Create a glossary entry that contains a modified ruler. Save the glossary 
under the name AUTOEXEC. Each time you open a new file, Sprint will 
use the modified ruler. 

Q. The manual says I can change the ruler by just typing on it, but when I 
do that, Sprint beeps at me. 

A. You first need to put your ruler into an "editable" state. You do this by 
pressing Aft-A or choosing Layout/Ruler/Edit on Screen. When you do this, 
your cursor jumps to the ruler above it (if it's not already on it), the ruler 
becomes highlighted, and you can type on the ruler to change its settings. 

Q. When I type, the words go right off the edge of the screen. I thought 
Sprint was supposed to automatically word wrap? 

A. It does, but you have to tell Sprint at what point to wrap the line. 
Normally, you do this with a ruler. You probably deleted the ruler from 
your file that Sprint automatically put there. Insert a ruler at the top of your 
file by choosing the Layout/Ruler/Insert command (or by pressing Aft-R). 

Or, you may have toggled Customize/Options/Codes to On and started 
typing. Sprint won't wrap lines with codes displayed, so toggle Codes Off 
to wrap lines. 

Indexing 

Q. When I index a word in my file, the word doesn't appear in the docu­
ment anymore. 

A. You chose Reference Word instead of Word from the Index menu. The 
Reference Word command indexes the word without printing it in the text. 

Q. When I index a word in my file, the word appears in my document 
twice. 

A. You chose Word instead of Reference Word. See the previous question. 
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Q. I've changed my mind about indexing a certain word. How do I un­
index it? 

A. You have to delete the usually hidden control codes surrounding the 
indexed word. Press Alt-Z to display the codes. Now you can delete the "D 
(which precedes the index item) and the "N (which goes after it) just as you 
would any other character. 

You don't have to do this to undo a typestyle change, however. In that case, 
you need only select the text and choose Normal from the Typestyle menu. 

Recovering from Mistakes 

Q. My cat just walked across the keyboard and made a mess out of my doc­
ument. How can I get back my original? 

A. You can choose File/Revert to Saved. This command discards the 
version on the screen and loads the last-saved version of the file from disk. 
Using this method, you will recover the version that existed the last time 
you chose File/Save (or pressed Ctrl-F2). 

Q. When I paste from the Clipboard, sometimes the text pasted is only the 
last thing I cut and sometimes it's the last several things I cut. Why the 
difference? 

A. You're inadvertently using the append feature of Sprint's Clipboard. 
When you make repeated cuts without moving the cursor (using, for example, 
Ctrl-Y several times in a row to delete one line after another), Sprint takes the 
last item cut and tacks it onto the end of what's currently in the Clipboard. 
If you move the cursor between cuts, however, Sprint keeps replacing 
what's in the Clipboard with the most recent cut. 

Error Messages 

Q. I get an error message "Variable Not Found" when I try to print, but I 
don't have any variables in my document. 

A. You probably tried to define a tag with one of the words reserved for 
variables (like page or month). 

Q. Sprint keeps running out of memory when it tries to print my doc­
ument. 

A. You must have a document with a lot of formatting commands. Running 
out of memory should be a rare occurrence; each of the Sprint manuals was 
printed with Sprint-without running out of memory. Nonetheless, if you 
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do run out of memory, try to free up some extra memory by looking for 
unnecessary control codes in your file. Because the codes are invisible until 
you press Alt-Z, they can pile up sometimes without your knowing it. Look 
especially for typestyle codes with nothing between them, like I\BI\BI\NI\N 
and the like. Another way of freeing up memory is to make your document 
less complicated by removing redundant or nested commands. 

Q. I keep getting an error message saying "Unknown command." What am 
I doing wrong? 

A. It's possible you have a stray @-sign in your document that's not 
followed by a space, a number, or a symbol. If you do, Sprint tries to 
interpret that @-sign as a special command. If you need to put an @-sign 
right before a letter character, you have to use two @-signs in a row (that is, 
type @@). 

Searching 

Q. When I use the Search-Replace commands, Sprint finds almost every 
word instead of just the text I entered. 

A. You probably have entered a wildcard in your search text with the Use 
Wildcards command set to Yes. When this command is set to yes, Sprint 
matches the asterisk (*) with any group of characters, the question mark (?) 
with anyone character, and the space character with any whitespace 
(including tabs). Sprint also considers brackets (] and [) as enclosing a set of 
matchable characters. If you want to use these characters as normal text, 
you either have to precede each of them with a backslash (\) or set Use 
Wildcards to No. 

Q. Sometimes searching using the F7 key is case-sensitive and sometimes 
it's not. Why the difference? 

A. The F7 search key is a shortcut to choosing Find from the Search-Replace 
menu, using the menu settings as they stand when you press F7. If you use the 
F7 shortcut, change the settings in the Search-Replace menu, and then use 
F7 again, the two F searches will operate under different settings. 
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A p p E N D 

Working with ASCII (Plain Text) 
FlIes 

x 

E 

If you plan to use only Sprint to create, edit, and print files, and don't 
intend to share files with anyone else who uses another word processor, 
you don't need to read this section. 

But please read on, however, if you plan to do one of the following: 

• write computer programs 
• edit your Sprint files with SideKick or some other ASCII text editor 

• send your files over a modem 

Note: If you will be sharing files with someone who uses WordPerfect, 
Microsoft Word, MultiMate, or WordStar, please see Appendix C. 

Note to two-floppy system users: You must have your Program A Disk in 
Drive A in order to use any of the commands on the Customize/ASCII File 
Handling menu. 

Translating Files 

There may be times when you (or someone else) will need to use an ASCII 
text editor (for example, SideKick) to edit files created with Sprint. Or, just 
the opposite: You may want to use Sprint to edit files created with a 
different word processor. 

Sprint's Translate command on the File menu displays the Translate menu 
(Figure E.1), which allows you to change Sprint files to ASCII (plain text) 
files that any word processor can understand, or take another word 
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processor's files and read them into Sprint. Every word processor has 
special internal methods for creating and saving files, and these ways of 
doing things are not necessarily compatible. 

thing that tells you where you are on the screen.< 
< 
While we're on the subject of the cursor, practice moving it 
around on the screen. On the right side of your keyboard is an 
important set of keys called the numeric keypad. The keys are set 
up in the same pattern as a lO-key addlng machlne, but they 
provide more functions. There are four keys with arrows on them, 
pointing left. right. uP. and down. As you might guess. these 
keys move the cursor in the direction they indicate. Try them. 
You should see the cursor moving back and forth and up and down 
on your screen. (If you're getting a series of numbers. it means 
your @k[Num Lock] key is on; to turn it of~,itiJriii~Mst press 
it.) Notice that when you press the mm and I,. keys. the 
text scrolls up and down on your screen--as i it were actually a 
big plece of paper on a scroll. If you've made a mistake some­
where that you want to correct. use the arrow keys to move to 
that spot in your text. You can delete characters with the 
@K[Backspace] key (to delete characters to the left of the 
cursor) or the @K[De1] key (to delete characters directly above 
the cursor).< 
< 
We'll be talking about some of the other keys on the numeric 
keypad shortly; for now. let's take a look at Sprint's menus--the 
real .. atewa~to all its powerful functions.< 
'M' '" .'1' ,*4' •• W 

Figure E.l : The Translate Menu 

tillO 

There are also several settings on the Customize/Ascii File Handling menu 
that pertain to ASCII files. First we'll discuss the Import/Export pro­
cedures, then we'll go on to talk about the settings that deal with ASCII 
files. 

Note: When you open a new file in Sprint that you intend to edit later with 
an ASCII editor, be sure to delete the ruler line before saving the file; your 
text editor won't understand the control codes in the ruler. 

Importing an ASCII File 

Let's say you want to take a file you created with Borland's SideKick and 
edit it in Sprint. The SideKick Notepad, like other ASCII text editors, puts 
hard return characters at the end of every line; Sprint does not. In order for 
your text to automatically "wrap" at the right margin, you need to get rid 
of those hard returns. First choose Customize/ASCII File Handling and 
toggle Wrap Long Lines to Yes. Sprint will ask you at what character to 
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wrap lines (65 is the default). Press Enter to accept 65 or enter another 
number. Next, choose Translate/Import from the File menu. This displays 
the Import From menu (see Figure E.2 below), a list of possible origins of 
the file you want to import to Sprint. 

thing that tells you where you are on the screen.< ~Translate-, 
< r----Import From QWno .. 
While welre on the subject of the cursor, ~iillillf Export I 
around on the screen. On the right side 0 ~l1(pl1tYWrite 4 (DCA RFT) 
important set of keys called the numeric Microsoft Word 
up in the same pattern as a 10-ke~ MultiMate 
provide more functions. There are four ke MultiMate Advantage 
pOinting left, right, up, and down. As yo Wang (IWP) 
keys move the cursor in the direction the WordPerfect 4.2 
You should see the cursor moving back and WordStar 
on your screen. (If youlre getting a seri WordStar 2000 
your @k[Num Lock] key is on; to turn it 01---------1 
it.) Notice that when you press the WI an SKPLUS Outlook 
text scrolls up and down on your screen-- ........ ----------a 
big plece of paper on a scroll. If youlve made a mistake some-
where that you want to correct, use the arrow keys to move to 

-that spot in your text. You can delete characters with the 
@K[Backspace] key (to delete characters to the left of the 
cursor) or the @K[Del] key (to delete characters directly above 
the cursor).< 
< 
Weill be talking about some of the other keys on the numeric 
keypad shortly; for now, letls take a look at Sprintls menus--the 
real;:ateway to all its powerful functions.< 
.'~'1'1I""P· -4,.."1: 

Figure E.2: The Import From Menu 

Choose ASCII File. At the prompt, enter the file name you want to read into 
Sprint. Sprint then asks you 

Enter the minimum line length to wrap: 50 

The default value of 50 means Sprint will reformat (that is, convert hard 
returns to soft) all lines in the file that are 50 characters or longer. If the lines 
in the file you are importing are generally shorter-say, 35-you can enter 
35, and Sprint will wrap all lines that are 35 characters or longer. 

Sprint converts the hard returns to soft returns only if the hard return is at 
or beyond the line-length setting and only if the line following it doesn't 
start with whitespace (another hard return, a tab, or a space character). That 
way, Sprint knows where the true end of a paragraph is (which must retain 
a hard return); it also allows you to preserve the formatting of most tables. 

Note: Be careful not to set your wrap margin at too Iowa number; if you 
do, you may format some lines in your file incorrectly. For example, if there 
are lines in your file that are particularly long (this is common in files 
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containing computer programs), you may not want Sprint to wrap those 
lines. 

When you press Enter, Sprint will convert the file, then load and display the 
converted file, ready for editing. Note that the original file with the hard 
returns is still on your disk, but the one in Sprint's backup file is the 
converted one. If you want to keep the original file, and save the one you've 
just converted, choose Write As from the File menu to save the converted 
file to a file with a new name. Sprint will save the file under the new file 
name you specify. If you don't want to keep the original file, you can just 
choose Save and write over the original. 

Exporting a Sprint File 

Now, say you want to edit a Sprint file in the SideKick Notepad. In this 
case, you've got the opposite problem; because Sprint does not use hard 
returns to end lines (only paragraphs), when you load the Sprint file into 
the Notepad (or whatever text editor you're using), each paragraph will 
consist of one long line that goes off the right side of the screen. You could, 
of course, reformat the text in SideKick, but there's an easier way: choose 
Export, then choose ASCII File from the Export To menu that Sprint 
displays (Figure E.3). 
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thing that tells you where you are on the screen.< r-Translate-, 
< I Import I 
While welre on the subject of the cursor. Export T EM' 
around on the screen. On the right side 0 ' •• 1'~"~ 
important set of keys called the numeric DisplilyWrlte 4 (DCA RFT) 
up in the same pattern as a 10-ke~ Microsoft Word 
provide more functions. There are four ke MultiMate 
pointing left. right. uP. and down. As yo MultiMate Advantage 
keys move the cursor in the direction the Wang (IWP) 
You should see the cursor moving back and WordPerfect 4.2 
on your screen. (If youlre getting a seri WordStar 
your @k[Num Lock] key is oni to turn it 0 WordStar 2000 
it.) Notice that when you press the mm anL..----------.I 
text scrolls up and down on your screen--as if it were actually a 
big plece of paper on a scroll. If youlve made a mistake some-
where that you want to correct. use the arrow keys to move to 
that spot in your text. You can delete characters with the 
@K[Backspace] key (to delete characters to the left of the 
cursor) or the @K[Del] key (to delete characters directly above 
the cursor).< 
< 
Weill be talking about some of the other keys on the numeric 
keypad shortlYi for now. let's take a look at Sprint's menus--the 
real~atewaJ to all its powerful functions.< .'!!"';'.'y- -4' •• "1: 

Figure E.3: The Export To Menu 

Sprint asks you for a file name to export. It then creates an ASCII file that is 
identical to the original Sprint file, but each line will end with a hard return 
character. The file will have the same "first name" as the original, but will 
have the extension .ASC. For instance, if you want to export a file called 
EDIT.SPR, Sprint will create an ASCII file called EDIT.ASC. Your original 
file will remain untouched. 

Editing an ASCII File with Sprint 

You may want to edit an ASCII file with Sprint that you will later want to 
use with a different program; in this case, you would use the Customize/ 
ASCII File Handling menu (Figure E.4). 
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Figure E.4: The ASCII File Handling Menu 

3 

For instance, suppose you are creating a file that you will later pass on to 
someone who is using SideKick, which is a plain ASCII text editor. You 
don't want to introduce any codes into the file that SideKick might 
misinterpret. An example of such a code is the Sprint ruler line. To see what 
we mean, choose Codes from the Customize/Screen menu and toggle to 
Yes (or press Alt-Z). As you can see, the ruler begins with a Ctrl-K (A K) 
character and contains some other information that SideKick wouldn't 
understand. 

The other issue is that ASCII text editors require that lines end with a 
"hard" return. Sprint lines end with soft returns. 

In order to edit your file without a ruler line, you will want to change the 
three settings on the Customize/ Ascii File Handling menu: Tab Expansion, 
Wrap Long Lines, and possibly Auto-Indent. You can also have Sprint 
automatically suppress rulers; see the next section. 

Note: If you want to enter Sprint formatting commands in your ASCII files, 
you will need to use the @-sign method; see the "Formatting ASCII Files" 
section for instructions.' 
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Suppressing the Ruler Line 

If you will be working exclusively with pure ASCII files (for example, if 
you're writing computer programs), you can have Sprint automatically 
suppress rulers each time you use it. 

To do so, move your cursor to a blank place in any file. Press F3 to turn 
block select mode on, but don't move the cursor. Now choose Utilities/ 
Glossary /Define. When Sprint prompts for a name, type AUTOEXEC. Sprint 
then asks if you want to save this item to STANDARD.SPG; press Y for Yes. 

Now, each time you start Sprint, it will ask 

Use your default settings? 

Press Y to answer Yes whenever you want to open a blank file with no ruler 
line. 

Tab Expansion 

The Tab Expansion setting determines tab stops for a file that has no rulers. 
(Although you could use this to set tabs even if you are using a ruler that 
has no tabs set on it, we recommend that you set tabs on the ruler itself. The 
reason is that tabs set with Tab Expansion don't show up on the ruler, and 
so are easy to forget.) The default is five spaces; that is, each time you press 
the Tab key, the cursor will move five spaces to the right. This is exactly the 
same as a ruler with a single T at column 5. To change the default, choose 
Tab Expansion and press Enter. Sprint will ask you 

Number of spaces to show tabs as: 

Type in a number for the size of your tabs and press Enter. 

If your file has a ruler in it, Sprint will encourage you with a message to use 
the ruler instead of the command to set tabs. If you're bent on setting tabs 
with the Tab Expansion command, you should delete the ruler first. A ruler 
tab causes the Tab Expansion command to be ignored. 

Caution: Be aware that when you change the Tab Expansion setting, you 
affect the display of all files that have tabs based on Ascn tab size. In other 
words, if you have a file in which the original tab setting was 5, then 
change it to 10, the tab settings will be automatically changed in the file. For 
example, most programs, such as the DOS TYPE command, expect the tab 
interval to be 5 characters wide. If you change tab size to 10, and then TYPE 
a file that contains tabs, the screen will display incorrectly formatted 
(although readable) output. 
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Auto-Indent 

Auto-Indent allows you to automatically indent lines of text according to 
how you have indented the first line in the paragraph. Since, in an ASCII 
file, you won't be using rulers, this is the easiest way to indent your text. It 
also comes in very handy for formatting computer programs you may 
write with Sprint. 

By default, Auto-Indent mode is Off; you can toggle it to On by choosing 
Auto-Indent, then pressing Enter. 

For example, to indent your text three spaces, space over the three spaces, 
then start typing. Sprint will automatically indent the lines of text that 
follow three spaces, until you press Enter. 

You'll also like this feature if you write computer programs, since it will 
allow you to easily indent lines of code. 

Wrap Long Lines 

Use this command to set the line length for your file, without having to use 
a ruler. You enter a column number for the right margin (default is 65); 
Sprint will wrap your lines at 65 characters, putting a hard return character 
at the end of each line. If you don't use this feature, and you don't have a 
ruler in your file, your lines won't wrap at all, but will scroll off the right 
side of the screen. 

To set the right margin, choose Wrap Long Lines, then enter a number for 
the right margin. Sprint will automatically wrap your lines at the column 
number you specify and will put a hard return character at the end of each 
line. 

If you edit a paragraph after Sprint has wrapped the line, the line breaks 
might end up too long or too short. Press Ctrl-B to reformat the paragraph 
(adjust the wordwrap). 

Formatting ASCII Files 

When you want to create straight ASCII files (with Sprint, or any other 
editor) that you can format and print with Sprint's formatter, you should 
use @-sign commands instead of the commands listed on Sprint's pop-up 
menus. As mentioned in Chapter 5, @-sign commands are the ASCII 
equivalents of menu-chosen commands. For every command on a Sprint 
menu, there is an equivalent @-sign command that performs the identical 
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function. Unlike commands listed on Sprint's menus, @-sign commands 
don't insert control codes in your file, which means you can telecommun­
icate your files, complete with formatting commands, through a modem, or 
create them with other word-processing programs and still print them with 
the Sprint formatter. 

Note: For complete information about @-sign commands discussed in this 
chapter, see Chapter 3 of the Reference Guide. 

@-Sign Commands 

@-sign commands have the same printed effect as menu-chosen formatting 
commands but have a different effect on your screen text. This section 
explains the differences between the two methods, and explains the @-sign 
approach in detail. This approach is important for users wanting to create 
straight ASCII files, while desiring to retain Sprint's formatting functions in 
these files. 

Let's say that you create files for distribution over a communications 
network, like MCI or CompuServe. Although Sprint files are ASCII files, 
some or all of the format control codes used in Sprint files could be 
misinterpreted by the communications program. But if you are sending the 
files to other Sprint users, you'll want to be able to include formatting com­
mands. You know from Chapter 8, "Basic Formatting," that if you choose 
formatting commands from Sprint's menus, the editor inserts control codes 
to change the attribute of your commands or text on the screen and to tell 
the formatter what to do when it sees the text to be affected by your com­
mands. If you strip out these control codes, the person receiving your file 
will get an unformatted version, which is probably not what you want to 
happen. Here's where @-sign commands come into play. You type these 
commands from the keyboard as straight ASCII text-there are no control 
codes in @-sign commands. If you use this method to format files for tele­
communicating, the recipient can still format and print your file, and get 
the printed results you originally specified. 

Suppose someone you know doesn't use Sprint, but is going to give you 
some files that you will then print with Sprint. That person could use @-sign 
commands in the file. Or maybe you want to create text with SideKick's 
Notepad (or some other ASCII editor) that you will later print with Sprint. 
@-sign commands are the only way you can insert formatting instructions 
in the notepad/ASCII editor. 

Again, see the Reference Guide for information on how to use @-sign com­
mands. 
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Printing ASCII Files 

In this section, we describe how to print ASCII files-that is, files that do 
not contain formatter commands, or any files that you don't want Sprint to 
format in the usual way. This includes computer programs and other non­
Sprint documents. 

Unformatted Printing 

Sprint will normally format your document before printing it (that is, it will 
interpret all formatter commands and fit the document into the defined-or 
default-page format). If you have a file that you don't want formatted 
(like a program listing), you must tell Sprint not to format. Otherwise, it 
will try to format the file. 

To print a file without formatting, choose Formatted Print from the 
Advanced Options menu and press Enter to toggle to No. 

If you want to change other print parameters, do so now. To start printing, 
choose Go from the Print menu and press Enter. 

DOS command-line method: 

SPFMT -plain FILENAME 

Your file will be paginated and each page will have a header consisting of 
the name of the document, the date and time printed, and the page number. 
The formatter will not recognize formatter commands, open/close 
delimiters (for example, the boldface delimiters will be printed as "B and 
"N ), or ruler lines (they will printed as "K). The formatter will recognize 
tabs and form feeds. 

Wordwrapping an ASCII Document 

In ASCII documents, every line ends with a hard return character. The for­
matter normally thinks that a return signals the end of a paragraph. You 
can override this by toggling Wordwrap ASCII Files (on the Print/ 
Advanced Options menu) to Yes. This tells Sprint to wrap all lines, even 
those that end with hard returns, unless the return is followed by another 
return, space, or tab. 

DOS command-line method: 

SPFMT -f FILENAME 
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Changing the Size of Tabs 

If you haven't set any tab positions in your document, you can specify the 
size of the tab character (A I) at print time. If you don't set the size, the for­
matter will use the tab size set by choosing Tab Expansion from the 
Customize/ ASCII File Handling menu. 

DOS command-line method: 

SPFMT -t=N FILENAME 

where N is the size of the tab character. (All tabs will be the same size.) 
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A p p E N D x 

F 

Glossary of Terms 

@-sign command: Alternative method of entering Sprint formatting com­
mands (vs. the menu system) using an @-sign and text enclosed within 
delimiters; for example, @chapter(The Chapter Title). Normally, you should 
only use the @-sign method when you are working with ASCII files, or 
when you are creating macros to be included in the STANDARD.FMT file. 

active file: When you have opened multiple files, the file that contains the 
cursor. 

active window: When there are multiple windows on your screen, the 
window that contains the cursor. 

argument: Information used by a Sprint command. For example, in GROUP, 
SPREAD 1, SPREAD 1 is a parameter of the GROUP command; it tells the Sprint 
formatter to put one line space between paragraphs in a grouped format. 

ASCII file: A file containing only characters, numbers, and certain control 
characters that are universally understood (for example, a file created with 
Borland's SideKick Notepad). Also, all lines in pure ASCII files end with a 
hard return. Sprint can convert ASCII files to Sprint format and vice versa 
via the File/Translate menu. Special features for use with ASCII files are 
contained on the Customize/ ASCII File Handling menu. 

attribute: 1) On the computer screen, the color or monochrome mode in 
which characters are displayed. For example, on a color monitor, the color 
red is an attribute. On a monochrome screen, underlining is an attribute. 2) 
an argument used by Sprint format macros. 

autosave: Sprint feature that automatically saves your file to disk in the 
backup file (SP.SWP) whenever you stop typing for three seconds or more. 
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background save: See autosave. 

backup file: File in which Sprint saves all open files in your editing session. 
Whenever you stop typing for three seconds or more, Sprint saves your 
work in the ba'ckup file (SP.SWP). If there should be a power failure or 
system "crash," Sprint will recover any open files. 

block: A chunk of text (one character or more) on your screen that you can 
manipulate (copy, move, change typeface, change format, etc.) with the 
Sprint editor. See also select a block. 

Clipboard: Temporary storage area in your computer's memory (RAM) in 
which Sprint stores blocks you have moved or text you have deleted. You 
can retrieve text in the Clipboard by choosing Insert-Paste ,from the Edit 
menu, or by pressing F6. 

close a file: Remove a file from the backup file and from the screen. When 
you close a file to which you have made changes since the last time you 
saved it to disk, Sprint asks you if you want to save the changes before 
closing the file. 

close a window: Remove a window from Sprint's screen. When you close a 
window, you are not closing any open files; they are still available and can 
be accessed when you choose File/Pick from List. 

Column mode: Block selection mode (turned on when you choose Edit/ 
Block Select/Column Mode) in which you select columns of text (rather 
than lines) for block operations. 

command line: See DOS command line. 

control character: Special character used by Sprint to indicate different 
typefaces and formatting commands. Unless you have set Customize/ 
Screen/ Codes to On, you cannot see these characters; Sprint displays 
different typefaces and formats in a different attribute on your screen. With 
Codes On, the characters are letters preceded by a caret symbol-for 
example, 1\ B for boldface. 

cross-reference: See tag. 

current directory: The directory in which you are currently working. 

current file: See active file. 

current window: See active window. 

Data Disk: On a floppy-disk system, the floppy disk on which you save the 
files you create with Sprint. 

delimiters: One of six possible pairs of characters used to enclose the text to 
be affected by a command. See @-sign command. 
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directory: A section of your disk (usually a hard disk, although it is 
possible to create directories on a floppy disk) in which you store similar 
files. You create directories with the DOS MD command. For example, you 
might create a directory called SPRINT to store all your Sprint files. See 
Appendix A,"A DOS Primer," for information about directories. 

discretionary hyphen: A soft hyphen, inserted by Sprint only if needed to 
break a word across lines. Contrast with hard hyphen. 

DOS: Computer operating system required to run Sprint. . 

DOS command line: The line, preceded by a prompt (usually C:> or C> for 
a hard disk, A:> or B:> for a floppy disk), on which you enter commands to 
DOS. For example, to start Sprint, you type sp followed by Enter on the DOS 
command line. 

editor: The part of Sprint that you use to create files, enter commands, and 
edit your text. When you type sp to start Sprint, what you see on your 
screen-the menus, windows, and text-is the Sprint editor. You enter for­
matting commands with the editor, but don't see the results of the com­
mands until you invoke the formatter to pri:nt your files. 

export a file: To convert (using the File/Translate menu) a file created with 
Sprint into a format understood by another word processor. 

extension: An optional 1 to 3 character extension to a file name; a period 
separates the file name from the extension. Sprint automatically adds the 
extension .SPR to any files you create if you don't specify an extension. 
Examples: NOTE.SPR, DOC.TXT (SPR and TXT are extensions). 

field: A category of information or values. Fields are enclosed by delimiters 
and set apart by separators. 

file name extension: See extension. 

fixed-width font: A type font in which all printed characters are of the 
same horizontal size. Contrast with proportional-width font. 

FMT file: File that contains special instructions used by the Sprint formatter 
to format and print your files. Aside from the default FMT file, 
STANDARD.FMT, you can create your own .FMT files, which you then 
access via the Layout/Document-Wide/Style Sheet command. 

font: A style of printed type. You can choose the default font for printing 
your Sprint documents when you run the the SP-SETUP program. You can 
also choose alternate fonts from the Typestyle/Font menu. The fonts 
available to you depend on the particular printer you are using. 

Appendix F, Glossary of Terms 357 



footer: Text that is printed at the bottom of a page. By default, Sprint prints 
the page number on each page. You can change the footer text via the 
Layout/Footer menu. 

format: The way your text appears when it is printed. Sprint provides a 
number of predefined formats that you invoke via formatting commands. For 
example, you can format lists in various ways by choosing commands from 
the Style/Lists menu. 

formatter: The part of Sprint that formats and prints your documents. You 
invoke the formatter via the Print menu, or from the DOS command line by 
typing SPFMT. You use the Sprint editor to enter formatting commands that will 
later be interpreted by the formatter. 

formatting command: Command that tells the formatter how to arrange and 
print your text. Most formatting commands are contained on the Layout 
and Style menus, with a few on the Insert menu. You enter these com­
mands while in the editor, but don't see the results until your file is printed. 

function keys: The keys labeled Fl through FlO on the grey keypad on the 
left side of your keyboard. On some keyboards, the keys are labeled Fl 
through F12 and are at the top of the keyboard. By default, Sprint assigns 
special functions to these keys. (See the Quick Reference Card for a com­
plete listing.) 

Glossary: Sprint utility (accessed via the Utilities/Glossary menu) that 
allows you to assign commonly-used keystrokes to abbreviations that you 
can recall or assign to a single key. 

hanging indent: Format in which the first word of a paragraph is printed to 
the left of subsequent lines. 

hard hyphen: Hyphen you insert by pressing the hyphen key. Contrast 
with discretionary hyphen. 

hard return: A "forced" return inserted when you press the Enter key; hard 
returns are indicated by a left arrowhead on your screen. By default, Sprint 
will not fill lines that end with hard returns unless you choose Customize/ 
ASCII File Handling and toggle Wrap Long Lines On. Contrast with soft 
return. 

hard space: See non-breaking space. 

header: Text that is printed at the top of the page. You specify text for the 
top of the page via the Layout/Header menu. 

highlight a block: See select a block. 

import a file: To convert into Sprint format (using the File/Translate menu) 
a file created with another word processor. 
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Insert mode: Typing mode in which the characters you type are inserted 
into existing text without erasing anything. By default, Sprint is in insert 
mode. You can change this default via the Customize/Options/Insert 
Mode menu, and toggle between Insert and Overwrite modes by pressing 
Ins. Contrast with Overwrite mode. 

justify: To align text at the left, right, both, or neither margin. You change 
the way Sprint justifies text via the Layout/Ruler/Justification menu. 

kern: For proportional-width fonts, to tighten the space between characters. 
Sprint automatically kerns many character pairs, but you can use the KERN 
command to make your own fine adjustments. 

logged directory: See current directory. 

macro: A sequence of keystrokes and/or commands that are executed auto­
matically. Sprint has a number of built-in macros, and you can create your 
own. Macros can be created, loaded, and executed via the Utilities/Macro 
menu. See also glossary, and refer to "Programming Sprint" in the Advanced 
User's Guide for details. 

mark a block: See select a block. 

monochrome monitor: Computer monitor that does not display in color. 

nest: To include one command inside another. For example, within the text 
affected by a Numbered command, you can nest a Figure command. 

non-breaking space: A space that Sprint will not stretch when it wraps a 
line; you insert this kind of space via the Insert/Non-Breaking Space menu. 
(Sprint stretches spaces you have entered by pressing the space bar when it 
formats a paragraph of text.) 

open file: Any file you have loaded into the Sprint editor using the File/ 
New or File/Open command, that you have not explicitly closed. All open 
files are kept in Sprint's backup file until you close them, and can be accessed 
with the File/Pick from List command. 

orphan: See widow. 

outdent: Format in which some text is printed to the left of the main body 
of text. 

outfile: The intermediate file into which SprintMerge puts your merged 
records prior to printing. The default outfile is SPM.O$$. 

Overwrite mode: Typing mode in which the characters you type write over 
and erase existing characters. Contrast with insert mode. 

paragraph mark: Character inserted by the Sprint editor when you press 
Enter (a hard return). 
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path: The sequence of directories/subdirectories leading to a file. You can 
enter the full path name in response to a Sprint prompt for a file name. For 
example, c: \ BORLAND \SPRINT\MYTEXT • SPR is the path name for a file called 
MYTEXT. SPR in a subdirectory called SPRINT. 

PostScript: Page description language used by certain laser printers (such 
as the Apple LaserWriter) and typesetters. If your printer does not 
understand PostScript, you shouldn't try to use the items on the Style/ 
Graphics menu. 

proportional-width font: A type font in which the horizontal size of 
characters varies. Contrast with fixed-width font. 

ragged: Text that is not aligned at a margin. Contrast with justify. 

record: A set of information that comprises all the values on a single entry. 

recover program: Program used by Sprint to recover your backup file if your 
computer system "crashes" or loses power while you are working with 
Sprint. 

save a file: Store a file to your floppy or hard disk. Contrast with close a file. 

select: To mark a block of text (with either F3 or Edit/Block Select/Tum 
Select Mode) that you want to move, copy, delete, or be affected by another 
Sprint command. 

shortcut: Key for which a Sprint function or feature is assigned. By default, 
your function keys and several other key combinations are assigned to 
Sprint functions; see the Quick Reference Card for a complete list. You can 
also create your own shortcuts. 

Show Codes mode: Display mode in which normally hidden control char­
acters are displayed. 

soft hyphen: See discretionary hyphen. 

soft return: Automatic line ending created by Sprint as you type. As long as 
there is a ruler in your file, Sprint wraps your lines at the right margin set 
on the ruler. Soft returns are invisible. Contrast with hard return. 

sortfile: The intermediate file into which SprintMerge puts your sorted 
records prior to printing. The default sortfile is SPM.S$$. 

SP .SWP: File name of the backup file. 

spring: See wide space. 

STANDARD.FMT: The style sheet file containing special instructions used 
by the Sprint formatter when it formats and prints your files. See also .FMT 
file. 
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status line: Highlighted line at the bottom of your screen that indicates the 
file name, typing mode, time, and column and line number. 

style sheet: An .FMT file. 

swap file: See backup file. 

tag: A "word" you make up to stand for a cross-reference that will be filled 
in by the formatter when it prints your file. 

template: 1) The format for a built-in numeric variable, chosen via the 
Insert/Variable command 2) In SprintMerge, the layout you create to 
organize the fields in your records. 

toggle: To switch between two menu settings (usually On and Off or Yes 
and No) by pressing the same key. 

typeface: See font. 

typestyle: One of several built-in typing styles (such as boldface and 
underlining) available on the Typestyle menu that you can choose for your 
printed text (if your printer has that capability). See also font. 

user interface: A program's method of operation (that is, the procedure it 
uses in responding to your commands). Besides its default user interface, 
Sprint provides several alternative interfaces that you can load by choosing 
Customize/User Interface/Load (Two-floppy system users: You have to 
rerun SP-SETUP to change user interfaces unless you have a high-density 
drive and/or the user interface you want is listed among the available user 
interfaces when you switch to another disk and choose User Interface/ 
Load). 

variable: A place holder for some characters that will be filled in by the 
Sprint formatter when it prints your file. For instance, the day variable on 
the Insert/Variable menu will be replaced by the current weekday when 
Sprint prints your file. 

wide space (spring): A space inserted by the Sprint formatter to fill any 
remaining space on a line. 

widow: A line printed by itself at the top of bottom of a page. Sprint gives 
you control over how many lines are printed at the top or bottom of a page 
with the Layout/Page Breaks/Widow-Orphan Control command. 

wildcard: The asterisk (*) or question mark (?) character that can be used 
when entering file names at Sprint prompts. These characters act like jokers 
in a deck of cards: the asterisk stands for any sequence of characters, and 
the question mark stands for any single character. 
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window: One of up to six display areas that you can open on your screen 
simultaneously. Each window can contain a different file, or part of the 
same file. 

wrap: To automatically move the cursor from the end of one line to the 
beginning of the next. Sprint breaks a line according to the right margin 
setting on the ruler, and inserts a soft return at the end of each line. 
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For the dealer nearest you 
or to order by phone 
Call (800) 543-7543 
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PARADOX® 2.0 
The Complete Database 

Paradox 2.0 is the most powerful PC data­
base ever for single or multiple users. And 
the first to let different users edit, enter, 
query and report on information in the 
same tabJe at exactly the same time! 

On your local area network, Paradox lets you 
access the most up-to-date information with the 
flexibility and responsiveness of being on a stand­
alone PC. You'll get real-time updating and screen 
refreshing. 

Instant access and reporting 
You can enter, retrieve, analyze, and report on 

your data-quicker than you've ever thought possi­
ble. Paradox's convenient query by example inter­
face lets you ask even complex questions about 
your data without programming. 
Minimum system requirements: For the IBM PS/2™ and the IBM® fam­
ily of personal computers and all 100% compatibles. Single user system 
requirements: DOS 2.0 or higher; 512K RAM; two floppy drives or one 
hard disk and one floppy drive (3% and 5% inch formats supported); 
compatible monochrome. color or EGA monitor with adapter. Network 
use system requirements: 3Com 3Plus with 3Com 3+™ operating system. 
version 1.0. 1.1. or higher; Novell with Novell Advanced Netware® ver­
sion 2.0A or higher; IBM Token Ring or PC Network with IBM PC Local 
Area Network Program version 1.12 or higher; Torus® Tapestry® version 
1.45 or higher; AT&T Starlan version 1.1 or higher; Banyan VINES ver­
sion 2.10; or other network configuration that is 100% compatible with 
DOS 3.1 and one of the networks listed above. Network workstation sys­
tem requirements: DOS 3.1 or higher; any combination of hard. floppy or 
no disk drives; 640K RAM; compatible monochrome. color or EGA moni­
tor with adapter. 

Paradox is a registered trademark 01 Borland International. Other brand and product names are trademarks or regis­
tered trademarks 01 their respective holders. Copyright C1988 Borland International. Inc. BOA 0713 

Simply call up a form and check off 
the information you want 

Its artificial intelligence lets Paradox figure out 
not just the right answer, but also the fastest way 
to get it. Query by example makes high-speed links 
between one piece data and another and quickly 
sees the relationships your question calls for. 

Create sophisticated applications 
Paradox Personal Programmer'" lets beginners 

and developers alike create sophisticated custom 
applications the easy way-without programming! 

Or program if you like with PADM

! 
The Paradox Application Language'" (PAL) gives 

you a complete application development environ­
ment. 

Suggested retail price $725 



PARA DOX® 386 
Rradox 386 is the powerful, easy-to-use 
database that takes full advantage of the 
power of your 386-based computer while 
it gives you all the features that made 
Paradox the new database standard! 

Paradox 386 breaks through the 640K memory 
barrier, using all your 386 system's RAM up to 
16Mb. It reduces time-consuming data swapping to 
and from disk. It was designed just for your 386 
system's 32-bit architecture. 

And Paradox 386 includes all the features of 
Paradox 2.0, including the same simple "query by 
example" interface and full multiuser capabili­
ties-whether it's installed on a 386 workstation 
or a network file server. You can share data on the 
file server with all the workstations on your net­
work, even if they have different processors and 
are running different network versions of Paradox. 
And all your Paradox 2.0 applications run 
unchanged under Paradox 386. 

Minimum system requirements: Single user system: Paradox 386 is designed exclu­
sively for personal computers based on the Intel 80386 microprocessor, including 
IBM Personal System/2, Model 80; personal computers equipped with Intel's Inboard 
386; and other 100% compatbile computers equipped with a 386-based microproces­
sor. Operating system: PC-DOS (MS-DOS~) 3.0 or higher. Memory: 1.5 Mb or more. 
Memory above 1 Mb configured as extended memory. Requires one hard disk and at 
least one high-density floppy drive and compatible monochrome, color, EGA or VGA 
monitor and adapter. 

Network file server requirements: Novell Advanced Netware 2.0A or higher, 3COM 
3+ operating system 1.0 or higher; Torus Tapestry version 1.45 or higher; AT&T PC 
6300 Network Program; or any other network 100% compatible with DOS 3.1 and 
anyone of the networks listed above. 

Paradox is a registered trademark of Borland International. Other brand and product names are trademarks or regis­
tered trademarks of their respective holders. Copyright @1988 Borland International, Inc. BOR 0715 

Plus, Paradox 386 runs up to five times as fast 
as Paradox 2.0 on your power operations-sorting, 
querying and reporting on very large tables (with 
tens of thousands of records or more); developing 
applications with Paradox Personal Programmer 
386; or running large PAL- applications. 

ltith Paradox 386 You Get: 
o A powerful, intuitive query system for instant 

access to your data without programming. 
o Professional reports with the Paradox report 

generator-without programming! 
o Flexible forms for data entry, editing or record 

display. Create them interactively by painting 
on the screen or use Paradox's standard forms. 

o Personal Programmer 386 to develop sophisti­
cated, customized applications without 
programming. 

o Paradox Application Language- (PAL), a high­
level programming language that helps you 
develop complex and ambitions applications 
that benefit from extended memory and 
32-bit processing. 

Suggested retail price $895 



QUATTRO® 
The Professional Spreadsheet 

o uattro has twice the speed and power 
for half the price . .. seeing is believing! 
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Better graphics built in 
To get graphics like Quattro's with another 

spreadsheet, you'd have to buy a separate package. 
Quattro gives you 10 different types of graphs and 
a huge selection of fonts, fill patterns and colors­
plus PostScript@ compatibility! 

Faster recalculation 
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Quattro's recalculations are smart-and smart is 
fast! Quattro only recalculates the formulas that 
have changed. 

Direct compatibility 
There's no relearning and nothing to lose when 

you switch to Quattro. It can understand familiar 
1-2-3@ commands and directly load, read and write 
data files created with other programs like 1-2-3, 
dBASE,@ Reflex8 and Paradox@! 

Minimum system requirements: For the IBM PS/2N and the IBM" 
family of personal computers and all 100% compatibles. PC-DOS 
(MS-DOS") 2.0 or later. Two floppies or a hard disk. 512K. 

Quattro is a registered trademark ot Bortand International, Inc, Lotus and 1-2-3 are registered trademarks of Lotus 
Development Corp. Other brand and product names are trademarks or registered trademarks of their respective 
holders. Copyright 01988 Borland International,lnc. BOR 0414A 

Easy, compatible macros 
Create macros as you work. Quattro's learn 

mode lets you instantly record your actions and 
store them. Its built-in macro debugging environ­
ment makes it easy to spot problems and fix them. 

Easy installation 
Quattro can detect most computers and screen 

types, so it's always ready to load and run-no 
installation needed! 

You can't lose! 
If you forget to save your work or a power 

shortage shuts you down, no problem; Quattro's 
transcript add-in automatically saves your work 
as you go, keeping track of all your changes! 

More Features 
o Includes SQZ!8 Plus data compression 
o 100 built-in financial and statistical functions 
o Menu Builder add-in for customizing menus 
o Supports 8087/80287/80387 math coprocessors 
o Supports EGA, CGA, VGA, and Hercules adapters 
o Context-sensitive online help 
o Supports extended and expanded memory 

Suggested retail price $247.50 



SIDEKICK® Plus 
The Professional Desktop Manager 

You hold in your hands the power of 
organization. It's SideKick Plus, the new 
professional desktop manager with seven 
supercharged productivity applications 
that finally let you work the way you think! 
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SideKick Plus lets you move back and forth 
between projects and applications instantly and 
effortlessly. And you can customize it to work the 
way you do. Set up your own menu system, func­
tion keys, and shortcuts with a few simple key­
strokes. Use SideKick Plus as either a disk-based 
or RAM-resident application. Load a few SideKick 
Plus features or all of them. Even decide how much 
memory it takes! You can't outgrow SideKick Plus 
because it changes right along with your needs. 

You get: 
o File Manager: Extended DOS file and directory 

management 
o Outliners: Nine Outliners with automatic 

numbering, tree charts, and table of contents 
o Phonebook: Complete data and voice communica­

tions that you can set to take place in the back­
ground, with auto-dialing, an encrypted glossary, 
and a full Script language. Even if you don't have 
a modem. it keeps your names, addresses, and 
phone numbers at your fingertips 

All Borland products are trademarks or registered trademarks of Borland International, Inc. Other brand and product 
names are trademarks or registered trademarks of their respective holders. 
Copyright @1988 Borland International, Inc. BOA 0501 

o Notepads: Nine file-editor Notepads, up to 
11,000 words each 

o Time Planner: Includes a Calendar, Appointment 
Book, and Schedule window, plus alarms. repeat­
ing appointments, and attached agenda. Supports 
networks via a common calendar 

o Calculators: Four types: Business, Scientific, 
Programmer, and Formula 

o Clipboard: For copy-and-paste integration 
between files and with other application programs 

o ASCII Table: To find and paste characters quickly 
o Expanded Memory and RAM disk support: 

With expanded memory, SideKick Plus runs even 
better! If you have an Intel@ Above'" Board or 
other expanded or extended memory card, you 
can load the SideKick Plus desk accessories into 
expanded memory and leave your 640K of con­
ventional memory for your other applications. 

Hard disk required. 
Suggested retail price $199.95 

Minimum system reQuirements: For the IBM PS/2N and the IBM family 
of personal computers and all 100% compatibles. PC-DOS (MS-DOS") 
2.0 or later. Minimum system memory. 384K. Minimum RAM-resident 
memory for smallest configuration 72K. Hard disk drive, Networks: 
3Com, Novell, IBM, Vianet 

Modems for dialing and data communications: Hayes or Hayes­
compatible, IBM PCjr internal. AT&T 4000, Telebit Trailblazer PC/SA, 
Cermatek infomate 212PC, Novation Access 1-2-3, Racal-Vadic Autodial 
VA212. 
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Scotts Valley, CA 95066 
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-Default 299 
-Out 295 
-Print 291 
-Remditto 292 
@-sign330 

commands 342, 348, 350, 355 
@Inc1ude command 301 
@Template 301 
@Template command 301 
@Value command 300 

A 
active 

file 140, 355 
window 355 

adding text· See entering text 
Advanced Options menu 200 
advanced user interface 17, 65, 100, 

125,212 
alignment See justification 
alphabetizing text 224 
alternate printer 203 

installation 16, 203 
alternative user interfaces 1, 37, 40, 

100, 112, 113, 361 
advanced 17, 65, 100, 125, 212 
basic 17, 42, 90, 100 
installation 17 
saving 210 
switching between 91, 112, 210, 
337 
troubleshooting 336 
tutorial 17, 42, 51 
two-floppy systems and 23 
user-defined 208,210 

AMERICAN.LEX 220 
arguments 355 
Arrange-Sort command 224 

two-floppy systems and 23, 225 
arrow keys 58 
.ASC file name extension 347 
ASCII 

editors 38 
files 343, 355 

364 

Auto-Indent mode 350 
converting Sprint files to 346 
editing with Sprint 347 
file name extension 347 

formatting 348, 350 
hard returns 348 
importing 344 
indenting 350 
printing 203, 352 

unformatted 352 
rulers 344 
tabs 349, 353 
telecommunicating 351 
wordwrapping 350, 352 

ASCII File Handling menu 347 
two-floppy systems and 343 

Assign to Key (glossary entry) 
command 227 

Asterisks command 81 
attributes 355 
Auto-Indent command 350 
Auto-Indent mode 38 
AUTOEXEC.BAT file 14,47, 319 
AUTOEXEC.SPG file 117, 228, 349 
autosave 355 
AutoSpell mode 221 

two-floppy systems and 23,223 

B 
Background Save Period command 

144,217 
Backspace key 58 
backup file 1, 13,33,50,89,98, 144, 

217,356,360 
network configuration and 323 
saving 144 
time period 217 
troubleshooting 336 

basic user interface 17, 42, 90, 100 
BASIC-type files 292 

merging 286 
.BAT files 12, 14, 20 
beep 218 
Blank Page(s) command 181 
blank space (horizontal) 181 
blank space (vertical) 181 
Block Select menu 73, 123 
blocks 122-127, 356 

centering 164 
copying 124 
deleting 125 
handling, Clipboard and 39, 74 
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moving 74, 77, 121, 124 
pasting 74, 77 
re-selecting 123 
saving 125 
selecting 72, 77, 123,360 

by lines or paragraphs 116 
Column mode 124, 224, 356 
mouse commands 115 

typestyle 72, 79, 126, 169 
unselecting 123 
writing to file 125 

Borland editors, differences from Sprint 
38 

bulleted list 81, 184 
Bullets command 81 

C 
C {ruler code} 49, 159 
canceling a command 107 
Center command 68, 164 
centering text 68,164 
Change Directory command 152 
Char command 334 
Character Size command 166, 173 
character strings 302 
choosing a menu item See menus, 

choosing from 
clearing menus 33, 107 
Clipboard 74, 121, 124, 356 

appending to 121 
troubleshooting 341 

Close command 34, 143 
closing a file See files, closing 
closing a window See windows, 

closing 
Codes command 127, 170,216 
color monitors 214 
Colors command 212 
colors, changing 212 
Column mode 123 
Column Mode command 123, 124, 

224,356 
columns 70 

exporting 332 
importing 329 
selecting 123 
sorting 224 

command line 

Index 

merging from 290 
SprintMerge commands 252 

commands 
editing 58 
entering 333 
SprintMerge 291 

CompuServe 6, 351 
conditional hyphenation See 

hyphens, soft 
Conditional Page Break command 

182 
context-sensitive help See help 
Control Character command 130 
control characters 39,68, 127,356 

deleting 129 
in searches 135 
inserting 129 
showing 216 
troubleshooting 337 
typestyle 170 

control codes See control characters 
conversion utilities 

installation 21 
two-floppy systems and 327 

Copy command 124 
copying 

blocks See blocks, copying 
distribution disks 11 
files See files, copying 

crash recovery See backup file 
creating a new file 48 
Criteria command 250 
Ctrl key 58 
Current Printer command 173,203 
cursor 29 

movement keys 57, 58, 115 
mouse 115 

customization 207-218 
colors 212 

Undo command 214 
function keys 208 
screen elements 215 

Customize menu 207 
two-floppy systems and 23,207 

D 
Data Disk 13, 356 
dBASE files, merging 258 

365 



default printer 203 
DEFAULT.REC 252, 291, 294 
DEFAULT.SPR 252, 291 
Define command 118,227 
Del key 58, 120 
deleting 

blocks 125 
changes 121, 122,341 
headers 175 
page breaks 197 
text 32, 59, 120 
Undelete command 121 

delimiters 334, 356 
Description command 192 
Destination command 203 
dictionaries 220 
directories 356 

changing 149, 152, 231, 320 
defined 317 

discretionary hyphen See hyphens, 
soft 

disk full error 152 
disks 

distribution 10 
floppy See two-floppy systems, 
special instructions for 

DisplayWrite 2, 40, 327 
Document-Wide menu 164 
DOS 315-321 

command line options 
(SprintMerge) 290,291 
commands 231, 316 
exiting to 63, 231 
PATH command 319 
printing from 204 
prompt 27 
running Sprint from 47 
running SprintMerge from 290, 
291 
wildcards See wildcards, DOS 

DOS Command command 315 
two-floppy systems and 23, 232 

Draw Box command 226 
Duplicate-Copy command 151 

E 
Edit menu 30, 38, 42, 118 
Edit on Screen command 158 

366 

editing commands 58, 111 
editor 25-35,96,111-136 

customizing 207 
EGA 17 
encapsulated PostScript See 

PostScript 
End key 58 
Ending Page command 199 
endnotes, importing 330 
.ENG files 323 
entering text 32, 59, 119 
EPS See PostScript 
Erase (glossary entry) command 228 
Erase command 125, 151 
error messages 341 

disk full 152 
logging 199 
out of memory 341 
printing 199 
SprintMerge 307 
unknown command 342 
variable not found 341 

errors, correcting 335 
Esc key 33, 58 
.EXE files 10,323 
exiting Sprint See Quit command; 

quitting Sprint 
Export command 327, 346 

F 
fields 296, 357 

containing blanks 298 
declarations 297 
default values 298, 299 
empty 298,299,301 
misalignment 302 
separators 244, 296, 297 

visible 298 
types 298 

File Manager menu 148, 150 
File menu 34 
files 33, 137-153 

active 140, 355 
ASCII See ASCII files 
closing 34,61, 143, 336, 356 
copying 151 
creating 48 
default settings 228 
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defined 27 
erasing 151 
exporting 327, 331, 343, 357 

to ASCII 346 
extensions 357 

.ASC (ASCII) 347 

.BAT 12, 14,20 

.ENG323 

.EXE323 

.FMT323 

.LEX323 

.LOG200 

.PRN203 

.SPG 117, 118,228,349 

.SPL 16 

.SPR 34, 51, 56, 138, 148 

.SWP323 

.ill 100 
File Manager menu 150 
importing 327, 343, 358 
listing 149, 151 
marking a place 136 
merging 144 
mouse commands 116 
moving between 140 
multiple 2, 61, 107, 138 
naming 138 
new 48 
opening 34, 61, 107, 138, 359 

from DOS 48 
picking 116 
printing 85 
README 9 
renaming 151 
reverting to saved 122,341 
saving 34, 55, 144,360 

under a different name 152 
telecommunicating 343, 351 
translating 327 
unnamed 48 
wildcards and 106, 138, 148, 149, 
151 
windows and 141 

Find command 77 
floppy disks 

installation 11, 21 

Index 

special instructions for See two­
floppy systems, special 
instructions for 

.FMT files 323, 357 
Font command 166, 171 
fonts 159, 166, 171,357, See also 

typestyles 
changing 172 
default 172 
fixed width 357 
printers and 173 

Footer menu 176 
footers 176, See also headers 

justification 177 
multiple line 177 
page numbers 177 
positioning 177 

footnotes, importing 330 
form letters (SprintMerge) 237,246, 

262 
Formatted Print command 202 
formatter 97, 155-193 
formatting 97, 95-110 

commands 38,155,358 
errors 87, 199,201 
in ASCII files 348 
merged files 251 
pausing 309 

function keys 100,358 
redefining 208 

Function Keys command 208 

G 
Glossary menu 226 
Glossary utility 358 

AUTOEXEC.SPG 117, 118, 228, 349 
keyboard record mode 229 
STANDARD.SPG 117,349 

Go command (printing) 85, 196 
Go command (SprintMerge) 293 
Group Together on Page command 

182 

H 
hanging indents See indenting, 

hanging indents 
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hard disk installation 13 
hard returns 120,345, See also soft 

returns 
hard spaces See non-breaking space; 

Non-Breaking Space command 
hardware requirements 5 
Header menu 173 
headers 173, See also footers 

even pages 175 
justification 174 
multiple line 175 
odd pages 175 
page numbers 175 
positioning 175 
title page 176 

Headings menu 166 
help 26, 33, 106, 113 

two-floppy systems and 23 
highlighting text See blocks, selecting 
Home key 58 
hot keys See shortcuts 
hyphenation 39,183 

two-floppy systems and 184 
Hyphenation menu 183 
Hyphens command 81,190 
hyphens, soft 183, 357 

I 
I (ruler code) 159 
Import command 327, 345 
indenting 54, 160, See also margins 

ASCII files 350 
hanging indents 160, 358 
outdenting 160 

index, printing 199 
indexing, troubleshooting 340 
Initial Record command 

(SprintMerge) 293 
Ins key 58,120 
Insert (Unconditional) Page Break 

command 182 
Insert mode 32, 58, 120,218,358 
Insert Mode command 120,218 
Insert-Paste command 74, 77, 125 
installation 9-24 

alternative user interface 17, 18, 
101 
conversion utilities 21 

368 

EGA 17 
floppy-disk systems 21 
hard disk systems 13 
printer 15, 109, 171, 196 
screen 17 
speller 20,220 

RAM disk and 20 
thesaurus 20, 224 

RAM disk and 20 
two-floppy systems 11, 21 
user interface 17 
video 17 

Inter-Paragraph.Spread command 
180 

J 
J (ruler code) 49, 159 
Jump to Line command 31 
justification 49, 157,359 

changing 159 

K 
Keep with Following Text command 

182 
kerning 359 
Keyboard Record command 229 
keyboard shortcuts See shortcuts 

L 
L (ruler code) 159 
LaserJet printer 166 
LaserWriter printer 166, See also 

PostScript 
layout See page layout 
Layout menu 155 
leading See line spacing 
leaving Sprint 26,34 
Letter File command 300 
letter files 238 

default 252 
.LEX files 323 
License Statement 6 
line breaks, conditional 183 
Line Drawing command 225 
line spacing 157, 178 
Line Spacing command 178 
List command 228 
List Directory command 149, 151 
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lists 80 
bulleted 81, 184 
description 192 
exporting 333 
hyphens 82, 190 
nesting 186, 189 
numbered 83, 188 
single-spaced 190, 192 
two-column 192 
types of 184 
unnumbered 190 

Lists menu 80, 184 
Load command 210 

two-floppy systems and 211 
loading Sprint See starting Sprint 
local area network (LAN) See 

network 
Log Errors to File command 199 
.LOG files 200 
logical operators 302 

M 
Macro language 2 
macros 38, 40, 220, 359 
mail merge See SprintMerge 
main menu 30, 38, 103 
MAKEDISK.BAT 12 
margins 28, 49,54, 117, 157, 164, See 

also indenting 
changing 158, 165 
document-wide 164 

marking a block See blocks, selecting 
Menu Display Delay command 218 
Menu Shortcuts command 113,217 
menus 29 

choosing from 104, 113 
clearing 33, 107 
Edit 30 
main 30 

Merge Field command 300 
Merge menu 250 
merging files 144 

dBASE258 
messages See prompts, responding 

to 
Microsoft Word 1,2,39, 101, 327 
Minimum Word Length command 

183 

Index 

modem 343, 351 
Modify (colors) command 213 
monitor See screen 
monochrome monitors 213 
mouse commands 115 
Mouse menu 117 
Move-Cut command 74,77,124 
moving a block See blocks, moving 
moving the cursor 58 
MSWORD.UI 101 
multiline fields and separators 298 
MultiMate 2, 40, 327 
multiple files 61, 107, 138 

N 
nesting commands 359 
network 9, 14,50, 323-325 

backup file 147 
sharing Sprint files 323 
troubleshooting 325 

New command 119, 137 
new file 48 
Next Occurrence command 131 
Non-Breaking Space command 181 
non-breaking spaces 359 
Number of Copies command 198 
Number of Passes command 202 
Numbered command 81 
numbered lists 188 
numeric keypad 29 

o 
Open command 62, 137 
opening files See files, opening 
opening windows See windows, 

opening 
Options menu 217 
Order command 250 
orphans 182,361 
out of memory message 341 
outdenting 160 
outfile 359 
Outline command 185,328 
Outlook outliner 327 
output file (SprintMerge) 295 
Overwrite mode 59, 218,359, See 

Insert Mode command 
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p 
page breaks 

conditional 182 
deleting 197 
formatter 197 
preventing 182 
previewing 197 
unconditional 182 

Page Breaks menu 178, 198 
page footer See footers 
page header See headers 
page layout 155 

exporting 333 
Paginate command 86, 197, 201 
paginating 197 
Paper Size command 165 
Paradox files, merging 256 
paragraph indent 54, 157 

changing 159 
paragraph marks 359, See also hard 

returns 
paragraph spacing 180 
path 359 
pause before printing 202 
Pause Between Pages command 202 
PgDnkey58 
PgUpkey58 
Pick from List command 124,140 
Place Mark command 136 
place markers 136 
point size 166 
pop-up menus 103 
Position command 175, 177 
PostScript 2, 39, 88, 360 
Potpourri menu 229 
Precise Settings menu 160, 164 

Font command 166, 171 
Preserve Editing Session command 

90, 146, 217, 336 
previewing See Screen Preview 

command 
Print menu 38, 85, 195 
Print Options menu 87 
printers 16 

alternate 16, 203 
changing 109 
customization 16 
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default 203 
fonts and 173 
installation 15 
PostScript 39 

printing 85, 109, 195-206 
ASCII files 203, 352 
defaults 196 
error messages 199 

.LOG file 200 
errors, correcting 200 
from DOS 196, 204 
from editor 196 
index only 199 
multiple copies 87, 198 
on alternate printer 203 
on cut sheets 202 
options 196 
partial document 198 
previewing 197 

proportionally spaced fonts and 
197 

program listings 352 
screen preview 197 
single pages 202 
table of contents only 199 
to alternate screen 205 
to file 203 
to screen 88 
troubleshooting 339 
two-floppy systems and 23, 196 
unformatted 202 

.PRN file 203 
prompts, responding to 106 
proportional-width font 360 
PROPOSAL.SPR 62 

Q 
QCARD.TXT 114,231 
Quick Reference Card 32, 114, 230 
QuickCard command 114, 230, 338 
Quit command 26, 34, 89 
quitting Sprint 34, 89 

R 
R (ruler code) 49, 159 
ragged text See justification 
RAM 335 
RAM disk 11, 20 
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README file 9 
Recall command 227 
Record File command 294, 301 
records 360 

files 238, 301 
default 291 

separators 240 
recover program 360 
Reflex records, merging 253 
region See block 
Remove Formatter Page Breaks 

command 197 
Rename-Move command 151 
replacing text See searching for text, 

search/ replace 
Reselect Block command 123 
Reserve Space command 181 
Reset Shortcuts command 114, 209 

two-floppy systems and 210 
Resize command 143 
Revert to Saved command 122, 341 
ruler line See rulers 
Ruler menu 158 
rulers 28,48, 117, 158 

ASCII files and suppressing 117, 
349 
centering 164 
customizing 118 
default settings 228 
deleting 159 
editing 52, 117, 158 
inserting 159 
justification 53 
margins 158, 159 
suppressing 117 
tabs 162 
troubleshooting 340 

running SprintMerge 290 

S 
Save (user interface) command 210 

two-floppy systems and 210 
Save command 34, 55,144 
saving 

blocks 125 
files See files, saving 
shortcuts 210 
under a different name 152 

Index 

screen 
colors See colors, changing 
customization 212 
installation 17 

Screen menu 215 
Screen Preview command (printing) 

197 
scrolling, mouse commands 115 
Search & Replace command 132 
Search-Replace menu 130 
searching for text 77, 130 

capitalization 131, 135 
control characters 135 
search/replace 132 
shortcuts 130 
troubleshooting 342 
wildcards 132 

Select mode 123 
selecting a block See blocks, selecting 
selecting text See blocks, selecting 
setting margins See margins, 

changing 
setting tabs See tabs, changing 
setup See installation 
shortcuts 31, 61, 100, 113,360 

abbreviations 226 
alternative user interfaces 208 
command 229 
Ctrl-Enter and 114 
defining 100, 114,208 
displaying 43, 113, 216, 230 
Glossary menu 226 
Menu Shortcuts command 113 
Potpourri menu 229 
QuickCard command 230 
removing 114, 209, 230 
saving 210 
troubleshooting 338 

Show Codes mode 360 
SideKick 1, 38, 39, 100, 112, 114,343, 

344,346 
SideKick Plus 327 
SIDEKICK.VI 100 
soft hyphens See hyphens, soft 
soft returns 345, See also hard returns 
sortfile 360 
sorting 
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alphabetical 304 
ASCII 304 
multiple fields 305 
numerical 304 
text 224 

SP-SETUP See installation 
SP-SETUP.EXE 10 
SP.EXE 27, 316, 323 
SP.OVL338 
SP.SWP 144, See backup file 
Space Allowable command 183 
spaces 

hard See spaces, non-breaking 
non-breaking 181, 359 
search wildcard 133 
showing 215 

spacing 
between paragraphs 180 
between words 181 

SPADV.UII00 
SPBASIC.UI 90,100 
spell checker 39 

automatic 221 
dictionaries 220 
installation 20 

and RAM disk 20 
spellchecker 220-223 
SPELLER.ENG 220 
Spelling menu 220 
SPFMT.EXE 323 
.SPG files 117, 118,228,349 

two-floppy systems and 228 
.SPL files 16 
SPM.O$$ 252, 291 
SPM.S$$295 
SPMERGE.COM 252 
.SPR files 34, 48, 51, 56, 138, 148 
spread between paragraphs See 

Inter-Paragraph Spread command 
SPRECOVE.COM 360 
springs See Wide Space. (Spring) 

command 
SPRINT.BAT 20 
SprintMerge 2, 235-312 

-alpha field type 245 
-ASCII field type 245 
-Print 293 
-Remditto 286 
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-Sort 294 
.0$$ and .S$$ files 252 
@Case command 301 
@String command 301 
basic concept 238 
BASIC files 241 
BASIC-type files 286 
Case statement 278 
command line 301 

limitations 253 
commands 

-Out 295 
-Record 294 
-Sortfile 295 
Criteria 292 
Data Format 292 
Ending Record 292 
Go 293 
Initial Record 293 
list of 291 
Merge Field 293, 300 
Order 294 
Record File 294, 301 

commas in fields 286 
Comment command 241 
Criteria command 241,292 
Data Format command 241, 250, 
292 
dBASE files 258 
default field type 246 
delimiters 242 
empty fields 301 
Ending Record command 241,292 
error messages 307, 309 
fields 297 

alphabetical 298 
ASCII 299 
default values 246 
delimiters 242, 296 
empty 245, 301 
in quotes 303 
multiline 245, 299 
names 297 
numerical 299 
separators 242,245 
types 245, 297 
with blanks 245 

form letter example 262 
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formatting files 251 
Go command 293 
Include command 241 
Initial Record command 241, 293 
labels 283 
Letter File command 246 
letter files 238, 300 

default 252, 291 
limitations 305 
mailing lists 275 
menu 250 
Merge Field command 293, 300 
multiline field type 243,246 
num field type 246 
Order command 241, 294, 304 

sorting lists 275 
Outfile command 241 
output files 252 
Paradox files 256 
personalizing names 269 
Print command 241 
print options 252 
printing 252 
program (two-floppy systems and) 
23 
quotation marks in fields 286 
Record File command 250, 294, 301 
records 301 

files 238, 301 
default 291 

Initial/Ending 250 
multiline fields 243 
selecting 275, 276, 278, 302 
separators 301 
the Template and 243, 301 

Reflex files 253 
running 290 
Screen Preview 250 
selecting records 278 
selection criteria 250 

character strings 302 
logical operators 302 
operators and precedence 302 
relational operators 303 

sort order 250 
Sortfile command 241 
sortfile, default 295 

Index 

sorting See SprintMerge, Order 
command 
sorting lists 275 
starting 291 

from DOS 252 
technical specifications 305 
template 238, 242, 306 
Template for Data command 243 
two-floppy systems and 237 
variable paragraphs 272 
variables 269 

SPTUTOR.UI 51, 100 
STANDARD.FMT 360 
STANDARD.SPG 117,349 
Starting Page command 199 
starting Sprint 23,26,38, 47, 316 
status line 49, 102, 360 
Style menu 80 
subheads See Headings menu 
swap file See backup file 
.SWP file 323 
system failure 33 

T 
T (ruler code) 159 
tab characters, viewing 216 
Tab Expansion command 349 
Tab key 58 
table of contents, printing 199 
tables, formatting 339 
tabs 157 

changing 55,69,159,162 
exporting 334 
importing 329 
in ASCII files 349, 353 
precise settings 164 

tags 361 
technical support 6 
template 238, 361 

file, default 252 
Template for Data command 242 
text alignment See justification 
THESAUR.ENG 223 
THESAUR.LEX 223 
thesaurus 39, 223 

installation 20 
RAM disk and 20 
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two-floppy systems and 224 
toggle 105, 361 
Tone command 218 
Translate menu 327, 343 

two-floppy systems and 327 
translating files 343 
troubleshooting 335-342 
Turbo Lightning 39 
Turbo Pascal 1 
Turn Select Mode command 123 
tutorial 41-91 
tutorial user interface 17, 42, 100 
two-floppy systems 

installation 11, 21 
special instructions for 

alternate user interfaces 
installing 19, 23 ' 
Arrange-Sort command 225 
ASCII File Handling menu 343 
AutoSpell mode 223 
backup file size 108, 140 
context-sensitive help 33 
conversion utilities 327 

installing 21 
creating Data Disks 22 
Customize menu 23, 207 
DOS Command command 23, 
232 
glossary files 228 
hyphenation 184 
Load command 211 
printer installation 17 
printing 23, 196 
Reset Shortcuts command 210 
Save (user interface) command 
210 
sorting text 23 
SprintMerge 23, 237 
thesaurus 224 
Translate menu 327 

typefaces See fonts 
Typestyle menu 39,65, 126, 166 
typestyles 66, 166, 361, See also fonts 

blocks and 72, 79, 126 
changing 126, 129, 169 
control codes 68,127, 167, 170,337 
display mode 66, 167 
exporting 332 
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hard returns and 170 
importing 328 
in this manualS 
list 168 
troubleshooting 337 

U 
.UI files 100 
Undelete command 121 
undeleting text 58 
underlining text 67 
unknown command (error message) 

342 
unnamed file 48 
unnumbered lists 190 
Unzoom command 143 
Use Wildcards command 132 
User Interface menu 91, 210 
user interfaces See alternative user 

interfaces 
USER.DIC 220 
utilities 62, 219-232 
Utilities menu 23, 219 

V 
variable not found message 341 
variables 361 
video setup 17 
visible field separators 299 

W 
Wang 2 
warning messages See also error 

messages 
wide space 361 
Wide Space (Spring) Command 181 
Widow-Orphan Control command 

182 
widows 182, 361 
wildcards 62, 132, 135, 361 

DOS 106, 148, 151 
in searches 132 

Window menu 141 
windows 39,108,141 

active 355 
closing 143, 356 
expanding 143 
opening 141 
shrinking 143 
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switching with a mouse 116 
Zoom command 143 

word processing, defined 27 
word spacing 181 
Word Spacing command 181 
WORDPERF.UI 101 
WordPerfect 1, 2, 39, 101,327 
WordStar 1, 2, 39, 101, 112, 114,327 
WORDSTARUI 101 
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